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Introduction to Color Grading
For over thirty years, DaVinci has pioneered the development of color correction hardware and 
software designed to enhance visual images acquired from film and video. DaVinci Resolve 14 
possesses our newest and most evolved professional color correction tools yet. However, for 
all its technological sophistication, DaVinci Resolve is merely a tool that requires the hands of a 
skilled artist to realize its full potential.

Subsequent chapters of this user manual cover the DaVinci Resolve grading tools in the Color 
page in great detail, but before getting into the specifics of color balancing and contrast 
adjustment, Power Windows and Custom Curves, it’s important to step back and consider what 
these tools are for, and why you’re learning to use this application in the first place.

This introduction is for those of you who are new to this process we call color correction, or 
color grading. If you’re a veteran colorist then you might want to skip ahead, but if you’re just 
starting out, the following sections are intended to describe the many goals of color correction, 
and how the DaVinci Resolve toolset has been designed to address them; making it fast and 
efficient to alter images in innumerable ways as we elevate raw footage to cinematic art.

The Goals of Color Correction	 644

Maximizing the Look of Your Media	 644

Emphasizing What’s Important	 647

Audience Expectations	 648

Balancing Scenes	 650

Adding Style	 651

Quality Control	 654

Never Stop Experimenting	 655
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The Goals of Color Correction
If reality is a fire hose of visual information, then digital cinema and broadcast would be 
represented by a garden hose. Color correction, therefore, could be considered the 
process of choosing which parts of the fire hose of raw image data to fit into the garden 
hose of our displays in order to create a pleasing image for the viewer. 

Maximizing the Look of Your Media
Clearly, the most fundamental aspect of the color correction process is that of making every clip 
look its best. While the job of the cinematographer is to light and expose the image with an 
artistic intent, your job is to realize this intent by making adjustments to the color and contrast of 
the image, so that the final result is as close to what the director and cinematographer had in 
mind as is humanly possible. In the process, you have the opportunity to overcome 
inconsistencies with exposure and white balance that were, for various reasons, unavoidable. 
Furthermore, you can make subtle adjustments to add warmth or contrast that was not available 
during the shoot, but that the cinematographer would have liked.

Increasingly, color correction is seen as a critical stage in the postproduction process. 
For example, the newer generation of digital cinema cameras are capable of shooting raw 
colorspace image data, or RGB image data with a log exposure, in order to preserve the 
maximum amount of image data for manipulation during the color correction process. 
However, when you acquire image data this way, it must be transformed into a viewable image 
via color correction in the same way that film negative must first be developed and printed to 
positive film.

Log encoded source 

Normalized and corrected

Source footage courtesy of Gianluca Bertone DP, www.bertonevisuals.com

Of course, there are also situations in which you may find it necessary to attempt to fix source 
media with far more substantial problems in color and exposure. In these cases, the tools exist 
to make far more involved adjustments to the image; however, the quality of your results will 
depend heavily on the data quality and “latitude” of your source media. 
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For example, Blackmagic URSA, ARRI ALEXA and RED DRAGON cameras record quite a bit of 
image data, making extreme corrections far more possible than more heavily compressed 
camera formats such as the Canon 5D. However, in either case, DaVinci Resolve provides the 
tools to process images in many different ways to adjust the image for a better look.

Under exposed source

Balanced and gain corrected

Whether clips need changes large or small, the primary DaVinci Resolve toolset adjusts the 
characteristics of hue, saturation, and contrast in a variety of ways. In the Color Wheels palette, 
Color balance wheels let you adjust all three color channels at once, altering the color 
temperature of the scene at specific ranges of tonal detail referred to as lift, gamma, and gain. 
Alternately, the slider-based Primaries Bars mode lets you make the same kinds of controls via 
independently adjustable red, green, and blue lift, gamma, and gain controls.

Primary correction wheels, Primary correction bars
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All of these controls let you adjust the color tone of the shadows independently from that found 
in the brightest highlights of an image.

Cool look

Warm look

Meanwhile, Master Lift wheels work together to let you alter image contrast in different 
ways: deepening shadows, lightening highlights, and brightening or darkening the 
midtones in between to create whatever image tonality you prefer for a given scene.

High Contrast

Low Contrast

Source footage courtesy of Gianluca Bertone DP, www.bertonevisuals.com

Separate saturation controls let you increase or decrease color intensity throughout the 
scene, while the Sat vs. Lum and Sat vs. Sat give you the ability to fine-tune saturation 
very specifically.
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High Saturation

Low Saturation

For more information on these controls, which are essential to the color correction process, see 
Chapter 42, “Primary Grading Controls.”

Emphasizing What’s Important
Another important aspect of the color correction process is the ability to make adjustments to 
emphasize or de-emphasize specific elements within the frame. It’s similar in concept to 
equalization in audio mixing, in that you’re choosing which color values to boost or suppress 
using a variety of techniques.

This can be done to direct the viewer’s gaze, for example by surrounding a specific part of the 
image with a Power Window, which lets you restrict specific adjustments made to the inside and 
outside of the Window’s shape.

Drawing a window to isolate a region of the picture to highlight

Lightening the area that’s been isolated with the window
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Specific alterations can also be made to prevent audience distraction. For example, a low-
saturation monochromatic tint may be a pleasing look overall, but in the soft wash of color, the 
viewer might lose track of the watch that’s preoccupying the protagonist. Using tools such as 
the Hue Curves and HSL Qualifier, you can quickly and easily tune the color of the woman’s 
hands and of the watch to guide the viewer’s eye, and bring some needed depth to the scene.

Source image

Curves and HSL qualification used to distinguish 
hands and highlight watch

For more information on Power Windows, see Chapter 45, “Secondary Windows.” For more 
information on Hue Curves, see Chapter 43, “Curves.”

Audience Expectations
There is another family of tools, the HSL, RGB, and Luma Qualifiers, that provide even more 
specific control, and they’re useful for adjusting ranges of color to either play into or against the 
audience expectations for color in a scene. Substantial research into what has been termed 
“memory color” shows that people have finely tuned expectations for the hues of particular 
subjects, such as flesh tone, foliage greens, and sky blues. Deviation from these expectations 
can create a sense of something being not quite right, which can be either detrimental or 
beneficial, depending on your goals for a particular scene.

HSL Qualification is effectively a chroma keyer that lets you sample the image to create a key 
that’s used to define where to apply a specific correction. For example, if you’re happy with the 
rest of the image, but the skin tone of the actor has an unhealthy green tinge to it as a result, 
you can isolate the color of that actor’s skin and adjust it to a healthier hue.

 

Source Image
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HSL qualification on the skin

Skin now has warmer grade

Another common example is the adjustment of skies. If you’re aiming for a gorgeous 
summer day, a washed out sky in the source media can be a bit of a bummer. However, 
using qualification it’s easy to isolate that wedge of blue, then push and pull it into just 
the right amount of summertime joy.

Originally graded scene

HSL qualification of the sk

Corrected and sky enhanced

For more information on using Qualifiers, see Chapter 44, “Secondary Qualifiers.”
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Balancing Scenes
It’s rare when the uncorrected shots of a scene match one another perfectly. Even the most 
carefully exposed angles of coverage can have small variances that need to be evened out. 
On the other end of the spectrum, run-and-gun programs using available light often result in 
edited scenes with huge changes in lighting and color as each shot cuts away to the next. 

Small or large, unintended variations from one shot to the next can call undue attention to the 
editing, and jar the audience’s attention in ways that throw them out of the program. Evening 
out these differences and balancing the clips in each scene to match is another of the 
fundamental tasks of the colorist. You know you’re finished when the color in the scene flows 
unnoticeably from one clip to the next.

DaVinci Resolve has a variety of tools that you can use to help you compare images with one 
another, the most important of which is the Gallery, in which you can save still images of clips 
that you can then compare to other clips using an adjustable split screen.

Timeline thumbnail view of unbalanced clips

Thumbnail view of balanced clips

By using the Gallery to play stills, either split or whole (flipping back and forth between 
the clip you’re adjusting and the still), it becomes easier to use the extensive DaVinci 
Resolve toolset to match the color and exposure of every clip in a scene.

Split screen of two shots

Left image corrected to match right
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An additional set of features let you manage grades by copying them from clip to clip, 
or by linking similar clips, either automatically, or manually using groups.

Link icon indicates clips are grouped for grading

For more information on using the Still Store, see Chapter 40, “Using the Color Page.” 
For more information on grade management, see Chapter 48, “Grade Management.”

Adding Style
Of course, it’s not all about subtlety and correction. It’s often appropriate, when grading music 
videos and commercials, for instance, to add some radical style to a piece. Here, too, DaVinci 
Resolve provides an abundance of features for manipulating unexpected aspects of the image; 
for example, by abusing the Custom Curves to create the illusion of chemical cross-processing.

Custom Curves controls

Original Image

 

Image enhanced with Curves
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DaVinci Resolve’s node-based image processing makes it possible to use more exotic 
node structures to create effects using composite modes, such as a colored glow 
generated by adding two differently graded versions of the same image together using 
a Layer node.

Node tree adding two different treatments together

Original Image

Enhanced and balanced final

You can also create complex node trees to build specific mattes, to use for isolating 
specific elements of the image. For example, if you wanted to isolate an actor in color 
against a background turned monochromatic, you can create multiple keys (pulled via 
HSL Qualification) and combine them using a Key Mixer node to build that effect.
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Node tree to isolate the man’s face and clothes

Original image

The final effect, desaturating everything except for the man

Finally, DaVinci Resolve doesn’t just have tools governing color and contrast. A Blur 
palette provides controls over blurring, sharpening, or adding mist to all or part of 
the image. When combined with the other tools that are available for isolation and color 
adjustment, these are powerful additions to your creative arsenal.

Defocus effect created in real time

For more information on all of these features, see Chapters 24 through 32 of 
this manual.
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Quality Control
Lastly, it’s important to keep in mind that, for all the creative possibilities that DaVinci Resolve 
affords, it’s still important that the final deliverables that you give to your client has appropriate 
signal levels relative to their requirements. In particular, programs destined for broadcast have 
specific outer boundaries of luma and chroma that you must not exceed, or you’ll risk having a 
show rejected for QC (quality control) violations. 

However, even if you’re not delivering a show for broadcast, it’s important to be aware of the 
mathematical limitations of a digital video signal to make sure you’re not clipping or crushing 
image detail through overzealous adjustments that you may, in fact, want to preserve.

For example, if you take a look at the next two images, you can see the perils of overzealous 
adjustments when compared to a clip that, while graded creatively, has been adjusted with 
respect to the mathematical boundaries of image data.

Image graded to preserve detail in highlights

Image graded with highlight detail blown out

Here, too, DaVinci Resolve provides tools designed to help you exercise control over 
the fine-tuning of the image. A Video Scopes window provides the standard Waveform, 
Parade, Vectorscope, and Histograms that are used to analyze your image data. These 
scopes let you see the boundaries of what’s possible, and make it easy to spot subtle 
problems, and compare the characteristics of one image to another.

Video Scopes
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When the time comes that you want to start clipping data in the highlights and shadows, as part 
of a creative look, the Soft Clip controls let you introduce a subtle or large roll-off, compressing 
the extremes of the signal so that what clipping you do is softer and more pleasing.

For more information about the Video Scopes and the Soft Clip controls, see Chapter 40, 
“Using the Color Page,” and Chapter 43, “Curves.”

Never Stop Experimenting
So now that you’ve gotten an extremely brief overview of the grading process as seen through 
the toolset of DaVinci Resolve, we invite you to use this manual to explore DaVinci Resolve 
more thoroughly. You may discover that, the more you work with the different features that are 
available, the more unexpected uses you’ll find for different controls that you thought you 
knew well.

Have fun.
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Using the Color Page
Given the origin of DaVinci Resolve as a professional grading application, the Color page is at 
the heart of the DaVinci Resolve experience. Within the Color page are all of the controls 
available for manipulating color and contrast, reducing noise, creating limited secondary color 
corrections, building image effects of different kinds, adjusting clip geometry, and making many 
other corrective and stylistic adjustments.

In this chapter, you’ll learn how to understand the Color page interface, how to customize it, and 
how to work within it to play through and navigate your project’s timeline. You’ll also learn how 
to analyze and compare clips in preparation for grading using stills, playheads, and DaVinci 
Resolve’s own internal video scopes.

The Color Page Interface	 659

The Interface Toolbar	 659

Viewer	 659

Gallery	 661

Node Editor	 662

Timeline	 663

Left Palettes	 664

Center Palettes	 664

Keyframe Editor, Video Scopes, and Information	 664

Dual Monitor Layout	 665

Customizing the Color Page	 666

Using the Viewer	 666

On-Screen Controls and External Displays	 667

The On-Screen Control (OSC) Menu	 668

The Viewer Toolbar	 669

Zooming into the Viewer	 669

Using the Scrubber Bar and Transport Controls	 670

Controlling Playback Using the Spacebar and JKL Keys	 670

Navigating Using Timecode	 670

Navigating Using the DaVinci Control Panel	 671

Viewer and Transport Timecode Displays	 671

Enhanced Viewing, Full Viewing, and Cinema Viewing	 672

Safe Area Overlays in the Viewer	 674

Use Gray Background	 674

Monitor Calibration	 675

Viewing Broadcast Safe Exceptions	 676
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Saving and Wiping Stills in the Gallery	 677

Different Viewer Reference Modes	 678

Using Split Screen Modes	 679

Using Video Scopes	 681

Video Scope Measurement and Performance	 683

Customizing the Video Scopes	 683

Navigating Using the Color Page Timeline	 685

Show Current Clip With Handles	 686

Thumbnail Info	 686

Sorting and Filtering Clips in the Thumbnail Timeline	 688

Changing Timelines	 688

A and C Mode Sorting	 688

Flags and Markers	 690

Timeline Filtering	 690

Using the Lightbox	 694

The Info Palette and Clip Information	 696

Clip Info	 696

System Info	 697

Clip Details	 697

About Undo and Redo	 698
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The Color Page Interface
The Color page is divided into seven main areas that work together to let you build a grade. 
This section provides an overview of what these areas are and how they function.

The default layout of the Color Page

The Interface Toolbar
At the very top of the Color page is a toolbar with buttons that let you show and hide different 
parts of the user interface. These buttons are as follows, from left to right:

The interface toolbar

�� Gallery: Opens and closes the Gallery panel.

�� Timeline: Opens and closes the Mini-Timeline.

�� Clips: Opens and closes the Thumbnail timeline. To the right is a pop-up menu that lets 
you choose a timeline filtering option for the Thumbnail timeline.

�� Nodes: Opens and closes the Node Editor

�� OpenFX: Opens and closes the OpenFX panel.

�� Lightbox: Opens and closes the Lightbox.

Viewer
The Viewer shows the frame at the current position of the playhead in the Timeline. At the top 
of the Viewer is a header that displays the Project and Timeline names, as well as a Viewer 
Timecode display that shows the source timecode of each clip by default. The Timeline name is 
also a pop-up display that lets you switch to any other timeline in the project. A scrubber bar 
underneath the image lets you drag the playhead across the entire duration of the clip, while 
transport controls underneath that let you control playback. A toolbar at the top provides 
controls governing Image Wipes, Split-Screen controls, and Highlight display. Additional 
controls let you loop playback, switch Unmix mode on and off, turn audio playback on and off, 
and choose which on-screen controls are currently displayed. 
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More information about using the Viewer appears later in this chapter.

The default Viewer with transport controls

You can also put the Viewer into one of three alternate modes to be able to see a 
larger image as you work. All three of these modes are available from the Workspace > 
Viewer Mode submenu.

Enhanced Viewer (Option-F to toggle this on and off) hides everything to the left and 
right of the Viewer, giving you a large working area for tasks such as window 
positioning and rotoscoping, while keeping the palettes and their controls visible 
as you work.

The default Viewer with transport controls

Full Screen Viewer (Shift-F to toggle this on and off), are available to provide more 
working area for tasks such as window positioning and rotoscoping. Full Screen Viewer 
also lets you display the OpenFX panel at full height, and you can turn the Node Editor 
on and off to access different effects controls while you work.
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The default Viewer with transport controls

Cinema Viewer (Command-F to toggle this on and off) expands the Viewer to fill your 
workstation’s entire monitor. This is useful if you want to play the current Timeline 
without any distractions. When you move the pointer over the image, transport controls 
and a jog bar appear to let you control playback. For DITs, a contextual menu is 
available by right-clicking anywhere on the image with which you can turn on and 
customize a video scope overlay (which can be dragged to different locations on 
the Viewer).

The default Viewer with transport controls

Gallery
The Gallery is used for storing still frames to use as reference, and grades you might like to 
copy; stills and grades are stored together. A button lets you open up the Album browser, used 
for organizing your stills. At the bottom of the Gallery, Memories let you store grade information 
that you can apply using a control panel or keyboard shortcuts. The Gallery on the Color page 
mirrors the contents of the Gallery page. For more information on the Gallery page, see Chapter 
47, “Using the Gallery.”
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The Gallery has Memories, stills saved in Albums and your PowerGrades

Node Editor
The Node Editor is where you assemble one or more individual corrections (nodes) together 
into a complete multi-correction grade (node tree). This is a powerful way of assembling grades, 
since different types of nodes let you create different combinations of corrections and very 
specific adjustments by reordering operations, combining keys, or changing the layer order of 
different adjustments. For more information about the Node Editor, see the “Node Editor 
Basics” section of Chapter 49, “Node Editing Basics.”

Node Editor to construct your grade processing signal flow



663

U
si

ng
 t

he
 C

o
lo

r 
P

ag
e

 
P

ar
t 

6
 –

 4
0

Timeline
The Timeline provides several ways of navigating the clips in your project, as well as keeping 
track of what has been done to which clips. The Timeline is divided into two parts, each of 
which shows different information and provides differing controls, and each of which can be 
opened or closed separately via buttons on the Interface Toolbar.

At the top is the Thumbnail timeline, in which each clip is represented by a single frame. The 
currently selected clip is outlined in orange.

The Thumbnail timeline with a Mini-Timeline below

A Timeline Ruler in the middle lets you scrub the playhead across multiple clips, and can be 
zoomed out enough to show every clip in your entire program. Underneath, the Mini-Timeline 
shows a small representation of the Timeline in the Edit page wherein each clip is as long as its 
actual duration.

The currently selected clip is orange, and you can click any clip to select it. A scroll bar at the 
bottom lets you navigate to the left and right, while using the scroll wheel of your mouse zooms 
in and out. The Mini-Timeline shows at most six tracks of video. If your project has more tracks 
than that, you can scroll up and down to reveal the hidden tracks. Any markers that were placed 
on clips or the Timeline in the Edit page appear here, and you can click any marker to reveal 
and edit its color and notes.

Much valuable information appears above and below each thumbnail such as each clip’s clip 
number, source timecode, track number, whether it’s been flagged, its codec or version name 
(you can double-click to switch), whether it’s automatically linked or part of a group, whether it’s 
been tracked, etcetera.

A Clip Thumbnail in the Mini-Timeline

As seen above, a colored outline appears around the clip number of shots that have been 
graded, and this outline is doubled if there are additional versions applied to that clip.



664

U
si

ng
 t

he
 C

o
lo

r 
P

ag
e

 
P

ar
t 

6
 –

 4
0

Left Palettes
A series of palettes at the bottom left of the Color page provide access to different sets of grading 
tools, used principally for manipulating color, contrast, and raw media format settings. Each 
individual palette is opened by clicking the corresponding icon at the top of the Palette panel.

Left palette selection buttons

The six available palettes are the Camera Raw palette (for making metadata adjustments to raw 
media formats), the Color Match palette (automatic grading based using test charts), the Color 
Wheels (graphical color balance controls and master wheels, along with a Slider mode for 
adjusting YRGB Lift/Gamma/Gain), the RGB Mixer (for mixing color channels into one another), 
and the Motion Effects palette (with controls for noise reduction and artificial motion blur). 
These palettes can be used individually or together depending on what you’re trying to 
accomplish. For more information on most of these palettes, see Chapter 42, “Primary Grading 
Controls.” For more information on the Motion Effects palette, see Chapter 59, “The Motion 
Effects and Blur Palettes.”

Center Palettes
At 1920x1080 resolution or higher, a second set of palettes is organized at the bottom center of 
the Color page. These palettes span a wide range of functionality, and the adjustments you 
make with them can be combined with those made using the Color palettes.

Center palette selection buttons

The nine available Center palettes include the Curves palette, the Qualifiers palette, the 
Power Windows palette, the Tracker palette, the Blur palette, the Key palette, and the Sizing 
and Stereoscopic 3D palettes.

Keyframe Editor, Video Scopes, and Information
The bottom right of the Color page can be switched between one of three things:

The three controls for displaying the Keyframe 
Editor, Video Scopes, or Information palette

�� Keyframe Editor: provides an interface for animating Color, Sizing, and Stereo Format 
adjustments over time. Each node in the Node Editor corresponds to a track in the 
Keyframe Editor, which lets you animate each node’s adjustments independently. 

NOTE: At lower resolutions, the Left and Center palettes are merged to fit the DaVinci 
Resolve interface into a smaller area.
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Furthermore, each node’s track can be opened up to reveal Parameter Groups, so 
that you can animate subsets of an individual node’s functions independently of 
other functions within the same node. For more information about keyframing, see 
Chapter 53, “Keyframing in the Color Page.”

�� Video Scopes: Provides a docked area where you can expose one video scope at 
a time for reference while you work. You can also “undock” the video scopes into 
a stand-alone window, in which you can show four different scopes at a time. More 
information about using the video scopes appears later in this chapter.

�� Information: Provides a way of seeing clip and system information while you work.

Dual Monitor Layout
The Color page has a dual monitor layout that provides maximum space for the Viewer, Node 
Editor, and Control palettes on the primary monitor, and a simultaneously displayed Gallery, 
Lightbox, Keyframe Editor, Metadata Editor, and Video Scope panel on the secondary monitor.

To enter dual screen mode:

Choose Workspace > Layout > Dual Screen > On.

 

The Color page in dual screen mode

To switch which UI elements appear on which monitors:

Choose Workspace > Layout > Primary Display > Display 1 or Display 2, which reverses the 
contents of both monitors in dual screen mode.
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Customizing the Color Page
The various sections of the Color page can be resized, hidden, and rearranged as needed to 
accommodate different working styles. This section covers all of the methods that are available 
for Color page customization.

You can easily resize the Viewer, Gallery, and Nodes Editor relative to one another to make the 
Viewer larger, expand the width of the Node Editor to have more workspace, or to create more 
or less room for stills in the Gallery.

To resize the Viewer, Gallery, and Node Editor:

�� Move the pointer over the vertical divider between any two areas. When the resize icon 
appears, drag the divider to the left or right to make one area larger while making the 
other smaller.

�� You can also fully expand the Gallery, the Memories, the Node Editor, and the Keyframe 
Editor to replace completely whichever interface area is adjacent.

To expand the Keyframe Editor:

�� Click the Expand control at the bottom left of whichever interface area you want to 
expand. Once expanded, clicking the Expand control again will collapse that interface 
area back to its original size, revealing whatever was hidden.

�� In Display mode, you can completely hide the Viewer, pushing the Gallery all the way 
to the right side of the DaVinci Resolve window, and expanding the Node Editor to take 
the rest of the space.

To toggle Display mode, do one of the following:

�� Right-click in the empty area of the Node Editor, and choose Toggle Display Mode from 
the contextual menu. Do this again to toggle Display Mode off and return the interface 
to the way it was.

�� Press SHIFT UP and DISPLAY/CURSOR, above the fourth trackball of the Center panel 
of the DaVinci control panel.

To show and hide the Mini-Timeline:

Click the Timeline button at the right of the palette button bar.

To show and hide the Color page Viewer upper toolbar:

Click the Viewer option menu and choose Show Viewer Options to uncheck it.

To return all pages to their default layout:

Choose Workspace > Reset UI Layout.

Using the Viewer
The Viewer is your window into the Timeline. The clip and frame at the current position of the 
playhead appears in the Viewer. The Viewer also provides a workspace for picking colors, 
adjusting Power Windows, using split-screen stills for reference, and many other display-
oriented tasks. If you have a video out interface connected to a broadcast display or projector, 
then the contents of the Viewer are typically mirrored by the video output.
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On-Screen Controls and External Displays
DaVinci Resolve has been designed for use with calibrated external displays connected to 
video output interfaces, and for most colorists working on broadcast or theatrical programs, this 
is the recommended way to work for color critical evaluation. 

Because of this, many of the on-screen controls associated with tasks such as color sampling, 
window adjustment, and key manipulation are mirrored to your video output, making it possible 
to hide the Viewer on your computer’s monitor and work with only an external display.

To choose whether on-screen controls are mirrored to video out, or disabled:

Choose an option from the View > Window Outline submenu. There are three options:

�� Off: Hides the window outline on both the external display and the Viewer.

�� On: The default, shows the window outline on both the external display and the Viewer.

�� Only UI: Hides the window outline on your external display, but leaves it in the Viewer.

To show or hide window on-screen controls using the DaVinci control panel:

Press SHIFT UP and then DISPLAY/CURSOR, above the fourth trackball on the Center panel. 
This command is a three-way toggle. The first use of this command hides the window outline on 
your external display, but leaves it in the Viewer. The second use of this command hides the 
window outline on both the external display and Viewer. The third use of this command shows 
the window outline on both the external display and Viewer.

Limitations When Grading With the Viewer on a Computer Display

Most computer displays do not operate at the color critical tolerances or specifications 
required for broadcast or theatrical delivery. An additional issue, however, is that the 
Viewer does not necessarily display each clip’s image data as it is displayed by the 
calibration that your operating system applies to your computer display, depending on 
which OS you’re running DaVinci Resolve on. This makes your computer display 
potentially unsuitable for monitoring projects destined for the sRGB standard of the 
web in its default state. For example, if you grade a project using the Color page 
Viewer on your computer display, the resulting clip may not look the same in the 
QuickTime player, or in other post-production applications.

You can address this in one of two ways:

�� If you’re using DaVinci Resolve on Mac OS X, you can turn on “Use Mac Display 
Color Profile for viewers” in the Hardware Configuration panel of the System 
Settings. This lets DaVinci Resolve use one of the preexisting profiles in the 
Color tab of the Displays panel in the macOS System Preferences, thereby taking 
advantage of ColorSync on macOS to let DaVinci Resolve display color the way 
your computer monitor does. Be aware that custom calibrated .icc profiles are not 
supported at this time.

�� Alternately, you can apply a dedicated Color Viewer LUT for calibration, using 
the 1D/3D Color Viewer Lookup Table pop-up menu that’s found in the Color 
Management panel of the Project Settings. This lets you analyze your computer 
display for calibration in the same way you would calibrate an external display, 
using a probe and color management software, and apply the resulting calibration 
LUT in DaVinci Resolve. Keep in mind that monitor calibration can only make a 
high‑quality display standards-compliant, it cannot make up for a display gamut 
that’s too small. For more information, see the “Look Up Tables” section of 
Chapter 3, “Project Settings and Preferences.”
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The On-Screen Control (OSC) Menu
The On-Screen Control pop-up menu lets you choose which on-screen controls you want to 
display and adjust in the Viewer. Some palettes automatically enable corresponding on-screen 
controls when you open them. For example, opening the Window palette displays the Power 
Window on-screen controls, and opening the Qualifier palette displays up the Qualifier on-
screen controls.

The on-screen control menu for the Viewer

There are a variety of choices, each corresponding to different adjustments you can make:

�� Off: All on-screen controls are hidden from view, giving you an unimpeded display of 
the image in the Viewer.

�� Qualifier: Turns on the Color Sample cursor, which lets you choose a color using 
the fourth trackball of the DaVinci control panel. For more about using Color Sample 
controls, see “Secondary Qualifiers.”

�� Power Window: Turns the Power Windows on-screen control on and off. For more 
about adjusting windows in the Viewer, see “Power Windows.”

�� Image Wipe: Toggles mouse control of dragging the split screen directly on the 
Viewer on and off. For more about working with split screens, see “Comparing clips in 
the Viewer.”

�� Dust Removal Tool: Activates the interactive Dirt and Dust tool. For more information, 
see Chapter 60, “Dust Removal.”

�� OpenFX: Only appears if a ResolveFX or OpenFX filter is applied to the current clip. 
Shows and hides whatever on-screen controls are exposed by an OpenFX plug-in in 
the currently selected node.

�� Color Chart: Shows and hides the color chart overlay that lets you identify a color 
chart in the picture that you want to use with the Color Match palette to create an 
automatic grade.

Strictly speaking, if you’re doing professional work, you should restrict your grading to 
a calibrated, 10- or 12-bit class-A external broadcast display of some type, connected 
via a Blackmagic Design video interface. Assuming everything is running properly, an 
image output to video from DaVinci Resolve should match an image output to video 
from any other post-production application you’re using, and this should be your basis 
for comparison when examining the output of two different applications.
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The Viewer Toolbar
The Color page has a toolbar at the top of the Viewer (underneath the title bar) that makes it 
easy to enable and disable Image Wipe, Split-Screen, and Highlight viewing by clicking one of 
these three buttons. In the process, these buttons provide an easy reference for when a 
comparison mode is enabled. In each of these Viewer modes, the appropriate controls for 
customizing that view appear to the right of the Viewer toolbar.

The Color page Viewer toolbar

This toolbar can be hidden by clicking the Viewer option menu and unchecking Show 
Viewer Options. 

Zooming into the Viewer
When using the Viewer to sample tricky colors or draw a detailed PowerCurve, it can be 
advantageous to zoom into the image.

To zoom into or out of the Viewer, do one of the following:

�� Make sure that View > Zoom > Allow Mouse Zoom is on, then move the pointer to within 
the Viewer, and then roll the scroll wheel to zoom in or out of the image.

�� Press Command-Equal to zoom in, or Command-Minus to zoom out.

To pan around the Viewer:

Move the pointer to within the Viewer, then middle-click and drag to pan around 
the image.

To reset the size of the Viewer image:

�� Choose View > Viewer Actual Size (Option-Shift-Z)

�� Choose View > Zoom > Zoom to Fit (Shift-Z)

�� Right-click anywhere within the Viewer, and then choose one of the following options 
from the contextual menu:

Actual Size: Zooms to the native resolution of the clip. If the clip is larger than the 
Viewer, it will be cut off around the edges.

Zoom to Fit: Zooms so that the entire image fits within the Viewer.

TIP: As you work, you may find you want to temporarily hide or show the on-screen 
controls so you can get an uncluttered look at the image you’re adjusting. You can 
toggle any set of on-screen controls off and on without selecting Off in the menu by 
pressing Shift-` (tilde).
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Using the Scrubber Bar and Transport Controls
One of the principal uses of the Viewer is to control playback. The scrubber bar, directly 
underneath the image in the Viewer, contains a playhead that you can drag to the left and right 
to navigate quickly through the currently selected clip as fast as you can move the pointer. The 
playhead in the scrubber bar is locked to the playheads found in the Timeline and Keyframe 
Editor. Moving one playhead moves all three.

How much of the Timeline the scrubber bar navigates depends on whether the Node Editor is 
set to Clip or Track mode. In Clip mode, the scrubber bar width equals the duration of the 
currently selected clip. In Track mode, the scrubber bar width equals the total duration of the 
entire Timeline.

A row of transport controls below the scrubber bar provides more specific control over 
timeline playback.

�� Previous clip: Moves the playhead to the first frame of the previous clip.

�� Reverse: Initiates 100% playback in reverse.

�� Stop: Stops playback.

�� Play: Initiates 100% playback.

�� Next clip: Moves the playhead to the first frame of the next clip.

�� Loop: Lets you restrict playback to the current clip, looping to the first frame if you’re 
playing forward to the end of a clip, or looping to the last frame if you’re playing in 
reverse to the beginning of a clip.

Two other buttons let you control audio playback and clip display in the Viewer:

�� Unmix: Turning on Unmix disables all transitions, composited superimpositions, and 
effects that mix two or more clips together. Unmix allows you to judge the appearance 
of a clip without distraction whenever you need to make an adjustment based on how 
the clip looks on its own, or whenever you need to make changes based on frames 
that would otherwise be hidden underneath a transition such as a dissolve or fade from 
black. When you’re ready to see how your grades work in context with transitions and 
composites again, turn Unmix off.

�� Mute: Lets you turn audio playback off and on if you’ve loaded an Audio Chase Track 
for the current edit.

Controlling Playback Using the Spacebar and JKL Keys
You can also use the spacebar to start and stop playback, or the JKL keyboard shortcut 
convention for controlling playback, where J plays in reverse, K stops playback, and L plays 
forward. There are many additional uses of of these keyboard shortcuts, for more information see 
“Using JKL to Control Playback” in Chapter 16, “Preparing Clips for Editing and Viewer Playback.”

Navigating Using Timecode
You can also use absolute or relative timecode entry to move the playhead in both the Source 
and Timeline viewers. When entering timecode, type each pair of hour, minute, second, and 
frame values consecutively, with a period representing a pair of zeros for fast entry. The last pair 
of timecode values (or period) you enter is always assumed to be the frame number, with any 
untyped values assumed to be zero. It’s not necessary to enter colons or semicolons. For more 
information, see “Moving the Playhead Using Timecode” in Chapter 16, “Preparing Clips for 
Editing and Viewer Playback.”
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Navigating Using the DaVinci Control Panel
It’s also possible to navigate the Timeline using the DaVinci control panel. A set of buttons on 
the Transport panel include:

�� PREV/NEXT SCENE: Moves the playhead among the first frame of each clip.

�� STEP REV/FWD: Moves the playhead from frame to frame.

�� FIRST FRAME/LAST FRAME: Jumps the playhead to the first and last frame of any 
given clip.

�� RWD/FFWD: Moves the playhead in rewind of fast forward.

�� REV/STOP/FWD: The standard play reverse, stop, and play forward commands.

Another set of navigation controls is available by pressing the MODE button above the fourth 
trackball on the Center panel, and then pressing the CUE MODE soft key.

You can also use the jog wheel and shuttle control on the Transport panel. The jog wheel lets 
you scrub frame by frame, while the shuttle control moves among preset rewind and fast 
forward speeds.

Finally, there are two additional methods of navigating using the DaVinci control panel that 
make it easy to jump to a specific clip or timecode value.

To move the playhead to the first frame of a specifically numbered clip:

On the Transport panel, enter a clip number using the number pad, then press 
TAKE ENTER.

To move the playhead relative to its current position:

1	 Press + or – on the number pad.

2	 Enter either a number of frames, or a timecode value using colons to divide each pair of 
digits (for example +01:00:23:12). 

3	 Press TAKE ENTER.

To move the playhead to an exact timecode value:

1	 Using the number pad, enter a timecode value, using colons to divide each pair of 
digits (for example 01:00:23:12). 

2	 Press TAKE ENTER.

Viewer and Transport Timecode Displays
The Viewer has two timecode displays, each of which defaults to a different timecode setting. 

A timecode display at the top, the Header Timecode Display, shows the Source timecode by 
default. The timecode display at the bottom, the Transport Timecode Display, shows the Record 
timecode by default. 

The bottom timecode display can be changed to show one of four different options, which are 
similar to those found in the Data Burn In palette.

NOTE: If a Gallery still is turned on for split screen comparison, the shuttle control will 
adjust the split screen center, and not the playhead position. Turning Reference Wipe 
off again frees up the shuttle control to affect playback again.
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To change a timecode display to a different setting:

The top Timecode display is a pop-up menu that can be changed to whatever timecode, frame 
number, or keykode you want to display. The bottom Timecode display can also be changed by 
right-clicking on it and choosing the type of value to show from the contextual menu 
that appears.

�� Timeline Timecode: The timecode corresponding to the playhead’s position in the 
overall Timeline.

�� Source Timecode: The timecode corresponding to the playhead’s position relative to 
the currently selected clip.

�� Timeline Frame Number: The frame count corresponding to the playhead’s position in 
the overall Timeline.

�� Source Frame Number: The frame count corresponding to the playhead’s position 
relative to the currently selected clip.

�� KeyKode: The KeyKode number corresponding to the media’s KeyKode track, if 
there is one.

�� Show Timecode at 30 FPS: Displays 24 fps timecode, via 3:2 pulldown, as 29.97 fps 
timecode. Has no effect on video playback.

In the same way, the top timecode display can alternately be changed to show keykode, if it’s 
available, within a DPX media file’s header.

Enhanced Viewing, Full Viewing, and Cinema Viewing
You can expand the Viewer into Enhanced Viewing mode by choosing Workspace > Viewer 
Mode > Enhanced Viewer mode (Option-F), or by pressing CURRENT/VIEWER on the T-bar 
panel of the DaVinci control panel.

In Enhanced Viewing mode, the Viewer works exactly as it does at its regular size, but it 
expands to fill up the entire area of the screen above the palettes and Keyframe Editor. To exit 
Enhanced Viewing mode, click the lower right-hand corner button again.

This can be useful if you need a closer view of the image for purposes of making detailed 
corrections, examining noise patterns up close, making a tricky color selection, or drawing a 
complicated PowerCurve.

Color page in Enhanced Viewer mode
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In Full Viewing mode (available by choosing Workspace > Viewer Mode > Full Screen 
Viewer, pressing Shift-F, or Option-clicking the Enhanced Viewing mode button), the 
Viewer takes up even more room by hiding the palette controls, but leaves room for the 
transport controls, the On-screen Control pop-up menu, the timecode display, and the 
page buttons along the bottom of the DaVinci Resolve UI. This mode is useful when 
you need an even closer look at the image, but you still want access to a minimal set of 
on-screen controls.

Color page in Full Viewer mode

Another option, Cinema mode, allows for full-screen viewing. Cinema mode is available 
by choosing Workspace > Viewer Mode > Cinema Mode (Command-F). In Cinema 
mode, the menu bar is hidden, and the image is presented full screen without any of 
the ordinary on-screen controls. Moving the pointer over the screen reveals a set of 
hidden on-screen controls that include a play button, scrubber bar, mute button, and 
exit button (which lets you turn off Cinema mode). 

Color page in Cinema mode

Cinema mode is useful for doing detailed reviews of media in on-set and digital dailies 
workflows when working remotely without a secondary video display.

TIP: If you’d like to superimpose timecode over the image in Cinema mode for 
reference, you can use the controls within the Data Burn-In window (Workspace > Data 
Burn-In) to set up whatever information you’d like to display during playback.
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Safe Area Overlays in the Viewer
You can show or hide a series of safe area overlays in the Viewer. All safe area overlay options 
are found in the View > Safe Area menu. Each safe area overlay option can be individually 
enabled or disabled from this menu.

Viewer displaying extents, center, safe, action and title area overlays

�� On/Off: Turns all currently selected safe area marker options on or off at once.

�� Extents: An outline showing the exact outer edge of the frame. Especially useful when 
the safe markers are set to an aspect ratio other than that currently used by the Viewer.

�� Action: An outline showing the outer 90% action safe area of the frame.

�� Title: An outline showing the outer 80% title safe area of the frame.

�� Center: A crosshairs showing the center of the frame.

�� Aspect: Enables use of the View > Select Aspect Ratio submenu to change the aspect 
ratio of the safe area markers. You can choose among the following aspect ratios: 1.33 
(a.k.a. 4:3), 1.66, 1.77 (a.k.a. 16:9), 1.85, and 2.35.

You can also access these options directly using the DaVinci control panel.

To customize safe area markers using the DaVinci control panel:

1	 Press MODES, above the fourth trackball on the Center panel.

2	 Press the SAFE AREA soft key. The Center panel soft keys are remapped with all of the 
available safe area options.

3	 When you’re finished, press EXIT.

Use Gray Background
Choosing View > Show Gray Backgrounds in Viewer sets the empty area of the Viewer 
(if there is any) to a lighter gray, making it easier to see which parts of the Viewer are black 
because of blanking, and which parts are simply empty because of the way the image is 
zoomed or panned.
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Monitor Calibration
If you use Light Illusion’s LightSpace CMS or SpectraCal’s Calman for display calibration, you 
can now use DaVinci Resolve as a sync-able pattern generator. This means you can use 
DaVinci Resolve to output color patches, synchronized by LightSpace, to your display through 
whichever video interface is connected to your computer. These synchronized color patches 
will be analyzed by a monitor probe that’s also controlled by LightSpace, which stores the 
probe data and compares it to the original color values of the output color values in order to 
characterize that display.

To use this feature, you must first have a licensed copy of LightSpace CMS, which is a Windows 
application. Synchronization depends on a wired or wireless LAN being available to connect 
the LightSpace application with DaVinci Resolve.

To synchronize LightSpace CMS to DaVinci Resolve as a pattern generator client:

1	 Open LightSpace on the Windows computer that’s running it.

2	 When LightSpace is open, click the Network Manager button. A window appears 
displaying the two network IP addresses used by LightSpace. Note these, and click the 
Enable button.

The Network Manager dialog in LightSpace CMS 

3	 In DaVinci Resolve, choose Workspace > Monitor Calibration > LightSpace. 

4	 When the LightSpace dialog opens, enter the second of the two network IP addresses 
LightSpace lists into the Remote Machine field, and make sure the Port number 
matches. Then click the Connect button.
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The Calibration dialog in DaVinci Resolve, connected 
to LightSpace CMS via WiFi

If everything is working correctly, the LightSpace dialog in DaVinci Resolve should 
show the word “Connected,” and the Network Manager dialog in LightSpace should 
show that there is “1 available client/s.” 

You can now close the Network Manager dialog in LightSpace and follow the 
procedures outlined in the LightSpace CMS documentation for characterizing your 
display and building and exporting a display LUT (in the .cube format) that you can use 
as a display LUT in DaVinci Resolve. Alternately, you can export a display LUT from 
LightSpace that can be loaded onto an outboard video processing device connected 
between your video

5	 When you’re finished, click Disconnect in the LightSpace dialog, and then click Cancel 
to close the window.

Viewing Broadcast Safe Exceptions
Choosing View > Display Broadcast Safe Exceptions sets the Color Page Viewer to show a 
false-color overlay that indicates regions of the picture that violate the currently selected 
broadcast safe level in the Color Management panel of the Project Settings in blue. 

 Areas of the image that violate broadcast safe are highlighted in blue

More information about Broadcast Safe limiting in the Color Management panel of the Project 
Settings appears in Chapter 41, “Automatic Grading Commands and Imported Grades.”
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Comparing Clips in the Viewer
The ability to compare different clips to one another is an important part of the color correction 
process. DaVinci Resolve provides three different ways of doing so. You can use the Gallery to 
display two clips for split-screen comparison. You can also use different reference modes to see 
a timeline clip or reference movie directly as part of a split-screen comparison. Finally, you can 
use the Split Screen controls to display multi-frame arrangements in the Viewer.

Saving and Wiping Stills in the Gallery
The Gallery on the Color page provides fast access to stills that you’ve saved from various clips 
in the Timeline. While the dedicated Gallery page provides a more comprehensive interface for 
browsing pre-saved “Looks,” as well as for importing stills from other projects, you can save, 
organize, and browse stills directly within the Gallery of the Color page.

Stills are saved in the DPX file format. Once you’ve saved one or more stills, you can set up 
split-screen wipes in the Viewer, which will be mirrored to your external display. 

Stills from the Gallery can be compared to the current shot making it easier to match grades

This section provides an abbreviated summary of still store and split-screen functionality to get 
you started quickly.

To save a still, do one of the following:

�� Choose View > Stills > Grab Still (Option-Command-G).

�� Right-click on the Viewer and choose Grab Still.

�� Press GRAB STILL on the Transport Panel of the DaVinci control panel.

To wipe a still, do one of the following:

�� Select a still in the Gallery, and click the Image Wipe button on the top Viewer toolbar. 

�� Choose View > Stills > Play Still (Command-W), or right-click in the Viewer and choose 
Toggle Wipe.

�� Double-click a still in the Gallery.

�� Press PREV STILL or NEXT STILL on the Transport Panel of the DaVinci control panel to 
select a still, then press PLAY STILL.
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To adjust a wipe in the Viewer, do one of the following:

�� Drag the pointer within the Viewer to move the wipe.

�� Push the T-bar control up and down on the T-bar panel of the DaVinci control panel.

To customize a wipe in the Viewer: 

�� Click one of the Wipe mode buttons in the Viewer toolbar.

�� Choose one of the following from either the View menu or the Viewer contextual menu:

Wipe Style: Cycles among the Horizontal, Vertical, Mix, Alpha, Difference, and 
Box modes.

Invert Wipe: Reverses each half of the wipe.

Copying Grades from Stills in the Gallery
Stills also store the grade from the clip they came from, and can be used to copy grades from 
one clip to another, or to store grades that you might want to use later.

To copy a grade from a still to a clip, do one of the following:

�� Select one or more clips in the Timeline, then right-click a still in the Gallery and choose 
Add Correction.

�� Select one or more clips in the Timeline, then middle-click a still in the Gallery.

When you copy a still in this way, the saved grade completely overwrites the grade in the target 
clip, unless you’ve used the “Preserve number of nodes” option, found in the contextual menu 
of the Gallery. For more detailed information on using the Gallery, including options for 
organizing the Gallery browser, instructions for using Albums, Power Grades, and Memories, as 
well as other methods of copying grades and performing advanced grade management tasks, 
see Chapter 47, “Using the Gallery” and Chapter 48, “Grade Management.”

Different Viewer Reference Modes
While it’s common to use the Gallery to wipe against reference stills, by changing the reference 
mode you can create a wipe against a clip in the Timeline, or against an offline video, if one has 
been assigned to the current Timeline.

To change the Viewer reference mode, do one of the following:

�� Choose an option from the View > Reference Wipe Mode submenu.

�� Right-click the Viewer and choose an option from the Reference Mode submenu of the 
contextual menu.

�� On the T-bar panel of the DaVinci control panel, press REF ON/OFF to toggle the 
reference mode immediately to Offline mode and back again, in order to split screen 
the current clip against an offline video.

There are three Reference Modes:

�� Gallery: The default reference mode. Lets you wipe the current clip against a 
Gallery still.

�� Timeline: Lets you wipe the current clip against another clip in the Timeline using the 
Wipe Timeline Clip command (see below).

�� Offline: Lets you wipe the current clip against an offline video that’s been assigned to 
the current Timeline.

If you want to wipe the current clip against another clip in the Timeline without saving a still to 
the Gallery first, there’s a special procedure you can follow.
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To wipe between two clips using the Timeline reference mode:

1	 Click the thumbnail of the first clip you want to compare.

2	 Right-click the thumbnail of the second clip you want to compare against, and choose 
Wipe Timeline Clip from the contextual menu.

Both clips appear split screened against one another.

Using Split Screen Modes
A set of Split Screen modes provides additional ways of comparing multiple images in the 
Viewer at the same time. These provide side-by-side and grid comparisons of multiple shots 
and multiple versions, all of which are output to video for monitoring on your external video 
display. For example, you can use the Split Screen Versions mode to display every single 
version that’s applied to the current clip in a grid, for easy evaluation. The currently selected clip 
in the Timeline is highlighted in gray, so you can keep track of what you’re doing.

To enable a split screen mode, do one of the following:

�� Click the Split Screen button on the top Viewer toolbar, and choose a split screen 
method from the pop-up menu that appears in the Viewer toolbar at the right.

�� Choose an option from the View > Split Screen submenu.

�� Press Option-Command-W to turn Split Screen on and off, using the last 
selected option.

�� Right-click the Viewer and choose an option from the Split Screen submenu in the 
contextual menu.

Four shots shown in a grid using the Split Screen > Selected Clips mode

NOTE: Wipe Timeline Clip only appears in the contextual menu if you right‑click on a 
thumbnail in the Timeline that has not been selected.

NOTE: When any of the split screen modes are selected, you cannot see any other 
on-screen controls in the Viewer, such as Power Window shapes, until you first disable 
Split Screen
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Viewing and Choosing the Current Selection
In any of the split screen modes, the current selection is indicated by a gray outline. This outline 
can be disabled for a more direct comparison by choosing View > Split Screen > Show Outline 
to toggle the outline off and on.

In certain modes, you can also double-click a particular frame of the split screen view to change 
the current clip, choose the active version, or apply a gallery grade.

Available Split Screen Modes
You can choose from among the following split screen modes:

�� Versions: Shows up to sixteen versions for the current clip, all at once, making it easy 
to evaluate a series of different versions in relation to one another. If you have more 
then sixteen versions, you deserve some manner of award. Double-clicking a version 
changes the active version.

�� Versions and Original: Shows up to the first fifteen versions for the current clip, along 
with the original ungraded clip at the upper left-hand corner. Double-clicking a version 
changes the active version, but you cannot double-click to select the original.

�� Groups: Shows up to sixteen clips that share the same group as the current clip. 
Double-clicking a frame does nothing in this mode.

�� Selected Clips: Shows all currently selected clips in the Timeline, up to sixteen at one 
time. Clicking a clip moves the playhead to the first frame of that clip.

�� Neighbor Clips: Shows four clips that immediately surround the current clip. 
The previous two clips appear as the upper left- and right-hand clips, the current 
clip appears at the lower left-hand corner, and the next clip appears at the lower 
right. Double-clicking a frame does nothing in this mode. The “Neighboring Clips 
in Split Screen” parameter in the Color panel of the User Preferences lets you 
customize how many neighboring clips appear in this mode.

�� Gallery Grades: When you choose this option, the act of selecting stills in the Gallery 
of the Color page shows each of the grades associated with those stills as they appear 
applied to the current clip, in a split screen arrangement. Double-clicking a frame 
applies that gallery grade to the current clip.

Previewing four gallery grades using the Split Screen > Gallery Grades mode

Highlight Modes: Shows a four-up display that lets you simultaneously see (clockwise) the clip’s 
RGB image, the gray matte, the the high contrast matte, and a difference matte generated by 
the node’s input compared against its output. Double-clicking a frame does nothing in 
this mode.
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Viewing a key using the Split Screen > Highlight Modes

Using Video Scopes
DaVinci Resolve has a set of four real-time video scopes that you can use to monitor the internal 
data levels of clips in your project as you work. Each scope provides an unambiguous graphical 
analysis of the various characteristics of the video signal, showing you the relative strength and 
range of individual color components including luma, chroma, saturation, hue, and the red, 
green, and blue channels that, together, comprise the color and contrast of the images in 
your program. 

The available video scopes include:

�� WFM (waveform monitor): Overlays the red, green and blue channels over one another 
so that you can see how they align. What the relative heights of the red, green, and 
blue graphs indicate is identical to the description seen for the Parade scope below. 
One thing to keep in mind, with color enabled so that the red, green, and blue graphs 
are tinted with the color they represent, it’s easy to see where all three graphs align, by 
looking for where parts of the waveform monitor appear in white, which is the result of 
the red, green, and blue graphs lining up and adding their color together.

�� Parade (RGB parade scope): Shows separate waveforms analyzing the strength of the 
R, G, and B components of the video signal. By showing a comparison of the intensity 
of the red, green, and blue channels, the parade scope makes it possible to detect 
and compare imbalances by comparing the relative heights of the RGB graphs in the 
highlights (the top of the R, G, and B graphs), shadows (the bottom of the R, G, and 
B graphs), and midtones (the middle of the R, G, and B graphs) for the purposes of 
identifying color casts and performing scene-by-scene correction. Taken altogether, 
the bottom of all three graphs indicates the black point of the image, while the tops of 
all three graphs indicate the white point. It then follows that the difference between 
the height of the bottom and top of all three graphs indicates the overall contrast ratio 
of the image you’re evaluating. Tall parade graphs indicate a wide contrast ratio, while 
short parade graphs indicate a narrow contrast ratio.
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�� Vectorscope: Measures the overall range of hue and saturation within an image. 
Measurements are relative to a centered graticule that you can enable that’s overlaid 
on the scope, which provides a frame of reference via crosshairs. DaVinci Resolve has 
a traditional vectorscope, the graph of which emulates a trace-drawn graph, with 75 
percent color bar targets indicating the angle of each of the primary and secondary 
colors around the edge of the graph, and an optional skin tone reference graticule 
(otherwise known as the In-phase reference). More saturated colors in the frame stretch 
those parts of the graph farther toward the edge, while less saturated colors remain 
closer to the center of the Vectorscope, which represents 0 saturation. By judging 
how many parts of the vectorscope graph stick out at different angles, you can see 
how many hues there are in the image, with the specific angle of each part of the 
graph showing you which hues they are. Furthermore, by judging how well centered 
the middle of the vectorscope graph is relative to the crosshairs, you can get an idea 
of whether there’s a color imbalance in the image. If the Vectorscope graph is off-
centered, the direction in which it leans lets you know that there’s a color cast (tint) in 
the image.

�� Histogram (RGB parade histogram): Displays a statistical analysis of how many pixels 
of each color channel lie at each percentage of tonality, plotted along a digital scale 
from 0 percent (black) to 100 percent (white). Comparing the left, middle, and right 
parts of the R, G, and B graphs let you evaluate the color balance in the shadows, 
midtones, and highlights of the image. Taken altogether, the left of all three graphs 
indicates the black point of the image, while the right of all three graphs indicate the 
white point. It then follows that the difference between the width of the left and right of 
all three graphs indicates the overall contrast ratio of the image you’re evaluating. Wide 
histogram graphs indicate a wide contrast ratio, while narrow histogram graphs indicate 
a narrow contrast ratio.

By default, you can view any one of these scopes at a time at the bottom left corner of the Color 
page, by clicking the Video Scope button in the palette button bar.

The Video Scope, docked next to the other palettes at the 
bottom of the Color page

Optionally, you can click the expand button at the top left of the video scope to open the video 
scopes into a floating window, within which you can display all four video scopes together, or 
individually, on any monitor connected to your workstation.
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Video scopes in a floating window

Additionally, the video scopes are available in many of the dual-screen layouts available in 
DaVinci Resolve. The video scopes aren’t just available in the Color page. They’re also available 
in the Media and Deliver pages for whenever you need to evaluate the video signal more 
objectively, such as when you’re setting up to capture from tape or scan from film, or when 
you’re setting up for output.

To open video scopes from the Media, Color, or Deliver pages, do one of the following:

�� Choose Workspace > Video Scopes > On/Off (Command-Shift-W) to open video 
scopes into a floating window.

�� Choose Workspace > Dual Screen > On to open video scopes as part of a dual 
screen layout.

Video Scope Measurement and Performance
Because you’re evaluating the internal state of the image data, the scales of the WFM and 
Parade scopes always reflect 10-bit full range data from 0-1023, regardless of the Video/Data 
Level setting you’ve selected in the Master Settings panel of the Project Settings. This gives 
you a window into how the image is being processed by DaVinci Resolve prior to being output 
via your computer’s video I/O interface.

One word about performance. Because the internal video scopes analyze every line of the 
image, the video scopes require a certain amount of video processing power to operate. 
Whenever you open any of the video scopes, you may notice your real time processing 
capabilities ever-so-slightly diminish. Closing the video scopes frees up all processing for color 
correction and effects. On high-powered workstations, you probably won’t notice the 
difference, but on less powerful computers, closing the scopes might make a small difference.

Customizing the Video Scopes
Once you’ve opened the video scopes, there are a variety of ways you can customize how the 
scopes look, and expose additional on-screen graticule information to help you measure 
what you need.
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Methods of customizing the Scopes window:

�� To change the aspect ratio of the Scopes window: Click either the 16:9 or 4:3 buttons 
at the upper left-hand corner of the window.

�� To change the size of the Scopes window: Drag the lower right-hand corner to resize 
the Scopes window to the desired size.

�� To change how many scopes are displayed at once: Click one of the buttons in the 
upper right-hand corner of the Scopes window to set 1, 2, or 4 up arrangements of the 
video scopes. You can also choose how many scopes are simultaneously displayed by 
choosing View > Video Scopes > 1-Up, 2-Up, or 4-Up.

�� To change which scopes appear in which pane: Click the Name pop-up at the upper 
left corner of each Scope’s pane, and choose a different scope.

Once open, you can resize the Scopes window to make it as large or small as you require, 
positioning on a second display if you want to make it even larger. Additionally, each video 
scope has different display options.

1	 Click the Option pop-up menu at the upper right-hand corner of any Scope pane, and 
choose Option to open that scope’s Custom Controls window.

Adjust the waveform and graticule 
brightness independently

2	 Click anywhere outside of the Custom Controls window to make it disappear.

Video Scope customization controls include:

�� Color/Monochrome button(s): Toggles color on and off for that scope either altogether, 
or a channel at a time. Color can make it easier to understand what the scopes are 
showing you, but if you find it a distraction it’s easily disabled.

�� Waveform/Parade/Vectorscope/Histogram slider: Makes that scope’s graph brighter 
or dimmer. Brighter graphs make it easier to see fine detail, but harder to see which 
parts of the graph are stronger and weaker.

�� Graticule slider: Makes that scope’s scale brighter or dimmer, making it more or less 
visible (or distracting) relative to the graph.
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�� Show Reference Levels: (Waveform, Parade, and Histogram only) You can set low and 
high reference level markers for any scope but the Vectorscope by setting the Low and 
High values to something other than their defaults.

�� Show 2X Zoom: (Vectorscope Only) zooms the vectorscope graph by 200%, making it 
easier to see fine detail, and use the Vectorscope with charts.

�� Show Skin Tone Indicator checkbox: (Vectorscope Only) Shows a line at the traditional 
Inphase angle that is useful as a general guidepost for average skin tone hue.

�� Show Graticule checkbox: (Vectorscope Only) Lets you show or hide the circular 
degrees indicator surrounding the outer edge, and the cross hairs that indicate the 
center of the Vectorscope.

Navigating Using the Color Page Timeline
The Timeline in the Color page is primarily used for navigating the current arrangement of clips, 
and for keeping track of clip properties such as whether they’re graded and ungraded, whether 
they use tracking, which version they’re using, and so on. It can also be used for quickly 
copying grades from one clip to another, for creating groups, and for comparing clips in 
the Viewer. 

The Color Page Timeline

The Timeline consists of three parts.

�� Thumbnail Timeline: Provides a concise visual representation of your project where 
each clip is a single thumbnail, regardless of its duration. Clicking a thumbnail moves 
the playhead to the first frame of that clip. Whichever clip is at the current position of 
the playhead appears with its thumbnail outlined in orange. Each thumbnail displays a 
variety of information above and below it, and differently colored outlines indicate clip 
groups, where existent.

�� Timeline Ruler: Contains the playhead, displays the record timecode of the current 
edit, and acts as a scrubber bar that spans multiple clips. The scroll wheel of your 
mouse lets you zoom in and out of your edit, and if you zoom all the way out you can 
fit every clip in the Mini-Timeline into the available width of the ruler, letting you scrub 
through every clip in the Timeline quickly. Clicking anywhere within the ruler instantly 
jumps the playhead to that frame. 

�� Mini-Timeline: Shows a miniature representation of the Timeline in the Edit page, 
where each clip’s width is proportional to its duration. The Mini-Timeline can show a 
maximum of six video tracks; if your edit uses more, a scroll bar lets you change which 
tracks are displayed. If a track has been disabled in the Edit page, it will appear grayed 
out in the Mini-Timeline. Clicking a clip in the Mini-Timeline both selects it and moves 
the playhead to its first frame. The scroll bar for the Mini-Timeline is independent 
of the scroll bar for the Thumbnail timeline, and both can be set to show different 
ranges of clips.
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Show Current Clip With Handles
If you’re working on a project that’s part of a round-trip workflow, and you know you’ll be 
rendering handles for each clip, it can be useful to temporarily expose these handles while you 
grade, so that you can apply tracking or keyframing effects to the full frame range of each clip.

To show or hide clip handles in the Mini-Timeline of the Color page:

Choose View > Show Current Clip With Handles.

While this mode is enabled, Unmix is turned on and cannot be disabled, in order to let you view 
the overlapping handles of each clip clearly. The duration of handles that are exposed is 
defined by the Default Handles Length parameter of the Editing panel in the User Preferences. 
Clip Handles can be shown or hidden at any time.

Thumbnail Info
The thumbnails make it easy to find the clips you’re looking for visually, and they always show 
the media as it’s currently graded. The most obvious piece of information is the frame that’s 
used for each clip’s thumbnail. If you feel that a particular clip’s thumbnail isn’t representative of 
its content, you can change it.

To change the current thumbnail:

Move the pointer over a thumbnail, drag to the left or right to scrub through the clip, and 
stop when you find a frame you want to use as the new thumbnail.

Dragging a thumbnail to change the representative image

If media is replaced in the middle of a color correction timeline, or if you copy or ripple a grade 
to a range of clips, the thumbnails may not immediately update to accurately represent the 
current state of each clip. In this case, you can manually refresh the thumbnails.

To refresh all thumbnails in the Timeline:

Right-click anywhere in the Thumbnail timeline and choose Update All Thumbnails.

You can also choose to display the codec used by each clip in the Timeline.

To switch the Thumbnail timeline between showing clip names and codecs:

Double-click the thumbnail clip name of any clip to display each clip’s codec, and 
vice versa.

Additional information appears above and below each thumbnail, providing a way of keeping 
track of which clips have been graded, which clips are using different versions, which clips have 
been cached, and so on.
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Each clip thumbnail has a number of valuable indications 
permitting quick comparison to other shots. 

The following list explains each piece of information that can appear above, within, or below the 
thumbnails in the Timeline.

�� Clip number: Each clip’s number appears at the top left above its thumbnail. Clips are 
numbered in ascending order according to the position of their first frame, from left to 
right, regardless of the video track in which they appear. 

�� Grade indicator: If a clip has been graded, a thin rainbow indicator surrounds the 
clip name.

�� Flag icon: If a clip has been flagged, a flag icon of the appropriate color appears at the 
upper-left of its thumbnail. If a clip has multiple flags, they’ll appear along the left of the 
thumbnail.

�� Source Timecode: The source timecode from the first frame of each clip appears on 
top of each thumbnail.

�� Linked media or group icon: If clips are set to use remote versions, and if multiple clips 
share the same source media file, then by default their remote version 1 grade will be 
automatically linked. If the current clip is linked, a small link icon appears at the bottom 
right of the thumbnail of every clip in the Timeline that’s also linked to that clip. When 
you select another clip that’s not linked, the linked clip icons disappear.

�� Tracker icon: If any node within a particular clip’s grade has been tracked, a small 
crosshairs tracker icon appears at the bottom right of the thumbnail.

�� Cache indication: Any clip that’s marked for caching, whether automatically via the 
Smart cache, or manually, has its timecode turn red to indicate that it will be cached. 
After it’s been cached, the timecode turns blue. 

�� Track number: The video track in which a clip is edited appears to the right of the 
timecode. 

�� Version name/Source format: If you create a version for a clip, the version name 
appears to the left, below its thumbnail. The version name provides information about 
whether a clip is using a remote version, or a local version, indicated by an (L). If you’ve 
given the current version a name, it appears; otherwise the version will be labeled 
“Version” with its number. Double-click the version name to toggle between displaying 
version names and the source format of that clip.

�� 3D indicator: All stereo 3D clips in the Timeline appear with this icon. Its color indicates 
which eye you’re monitoring; red indicates the left eye, while blue indicates the 
right eye.
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Sorting and Filtering Clips 
in the Thumbnail Timeline
By default, the Thumbnail Timeline displays every clip of the currently selected edit in the Edit 
page, sorted in A mode (the record order of your edit). However, the sort order and contents of 
the Timeline can be changed and filtered to make it easier for you to find specific groups of 
clips for grading.

Changing Timelines
If you’re working on a project that has more then one timeline, you can switch timelines right 
from within the Color page.

To switch timelines in the Color page:

Choose another timeline from the Timelines pop-up menu at the top of the Viewer.

Timeline selection at the top center of the Viewer

To switch among timelines using the DaVinci control panel:

Press the MODES button above the fourth trackball on the Center panel, then press the 
SWITCH TIMELINE soft key. Press MODES to return to the main page of controls when 
you’re done.

A and C Mode Sorting
By default, the Timeline is set to Record mode sorting, otherwise known as A mode sorting. In 
this mode, clips appear in the Timeline according to the order in which they were edited. This 
lets you see the order of clips as they’ll appear in the final program.

A Mode sorting, i.e., record order

However, you can change the sort order of the clips in the Timeline to Source mode, or C mode 
sorting. In C mode sorting, all clips are rearranged in ascending order from left to right 
according to their source timecode, and their record timecode is temporarily ignored.

C Mode sorting, i.e., source clip order
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Sorting by C mode makes it easy to identify a range of similar clips. For example, if you’re 
working on a narrative project, clips from each angle of coverage in the scene will naturally 
cluster together. In another example, sorting by C mode in a documentary will arrange all of a 
particular subject’s head shots from a specific interview contiguously, one after another, since 
they all come from the same range of timecode on the same source tape. In both examples, the 
close proximity of similar clips to one another that C mode creates makes it easy to copy grades 
among them, ripple changes, or group them.

When you’re finished, you can switch the Timeline back to A sort mode, and all of the clips will 
go back to being arranged in the order in which they were edited.

To toggle between A and C mode sorting, do one of the following:

�� Choose an option from the View > Timeline Thumbnail Mode submenu.

�� Press Command-Page Down to toggle to C mode sorting.

�� Press A/C MODE on the T-bar panel of the DaVinci control panel.

While in C mode, the word “SOURCE” appears at the right in the Timeline Ruler of the 
Mini-Timeline.

Source mode indicated at the right of the Timeline ruler

A checkbox in the Conform Options group in the General Options panel of the Project Settings 
lets you change the behavior of C mode sorting. Opening the Settings window and clicking the 
General Options panel of the Project Settings reveals the Sort Timeline Using Reel Name and 
Timecode checkbox.

General Options panel of the Project Settings

With this checkbox turned on (the default), all clips in the Timeline are sorted by reel number 
first, and then by source timecode. This way, clips with similar timecode from the same reel will 
appear next to one another in C mode.

If you turn this checkbox off, reel number is ignored, and all clips in the Timeline are sorted only 
by source timecode. This may result in clips from multiple sources being mixed together, but it is 
useful in specific situations. 

For example, when grading dailies from a three camera shoot, you may want to see consecutive 
clips from all three cameras lined up one after the other on the Timeline, so that Cam1_Shot1, 
Cam2_Shot1, and Cam3_Shot1 appear first, followed by Cam1_Shot2, Cam2_Shot2, and 
Cam3_Shot2, and so on. In this situation, you don’t want clips from cameras 2 and 3 to be 
placed at the end of the Timeline simply because of their reel number.
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Flags and Markers
You have the option of flagging or marking clips in the Color page just like you can in the Edit 
page, in order to keep track of specific media or frames that you may need to do something to 
later. For example, you could flag every closeup of a particular actor with a blemish that you 
want to spend some time fixing with a green flag. 

Methods of flagging and marking clips clips in the Color page:

�� To flag a clip: Right-click any clip’s thumbnail, and choose a flag color from the Flags 
submenu. Flags are not frame-specific, so flagging one clip will result in flags also 
being placed on all other clips that share the same source media in the Media Pool.

�� To remove all of a clip’s flags: Move the playhead to a clip, and choose Mark > 
Clear Flags, or right-click a clip’s thumbnail and choose Clear All option from the 
Flags submenu.

�� To mark a frame of a clip: Move the playhead to the frame of a clip you want to mark, 
then choose Mark > Add Marker (M), or right-click a clip’s thumbnail and choose a 
marker color from the Marker submenu.

�� To remove a single marker: Move the playhead to the frame with the marker you want 
to remove, and choose Mark > Delete Marker (Option-M). Alternately, you can select the 
marker in the Mini-Timeline, and press the Delete key.

�� To remove all of a clip’s markers: Right-click that clip and choose Clear All from the 
Markers submenu.

Timeline Filtering
A pop-up button to the right of the Clips button at the top left of the Color page Interface Toolbar 
presents preset options for dynamically filtering which clips are shown in the Timeline. This allows 
you hide all the other clips in the Timeline except for the subset on which you want to focus. 

Timeline filtering options
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For example, once you’ve added flags or markers to clips, it’s easy to hide every other clip in 
the Timeline that doesn’t fit the criteria; for example, hiding clips that don’t have a green flag. 
This does nothing to alter the original edit, and you can return the Timeline to its original state 
at any time.

To filter the Timeline:

Click the Timeline Filtering pop-up button to the right of the Clips button at the top left 
of the DaVinci Resolve UI, and choose an available option. While the timeline is filtered, 
an orange line appears underneath the Clips button in the UI Toolbar at the top 
of the page.

To return the Timeline to normal:

Click the Timeline Filtering pop-up button, and choose All Clips. 

You can use timeline filtering in conjunction with A or C mode sorting to arrange clips in 
whatever way is best for the task you’re trying to accomplish. Clip filtering can also be used in 
the Lightbox, and a currently selected clip filtering method will simultaneously isolate clips in 
the Timeline and Lightbox as you switch back and forth.

Preset Timeline Filters
DaVinci Resolve comes with several preset criteria by which you can filter the Timeline, which 
cover many common organizational workflows:

�� All Clips: No clips are filtered, and every clip in the current edit is shown.

�� Selected Clips: Filters all currently selected clips.

�� Graded Clips: Filters all clips that have been graded.

�� Ungraded clips: Filters all clips that have not yet been graded.

�� Modified clips: Submenu, filters all clips that have been modified within a 
specified time.

�� Unrendered clips: Filters all clips that have not yet been rendered.

�� Flagged Clips: Filters all clips that have a particular flag, a submenu presents each color.

�� Marked Clips: Filters all clips that have a particular mark, a submenu presents 
each color.

�� Stereoscopic: Filters stereo 3D clips, a submenu presents options for filtering All 
Stereo Clips, or just Stereo clips that have been Autoaligned, those with Convergence 
adjustments, those with Floating Windows adjustments, or stereoscopic clips with 
swapped media for the left and right eyes.

�� Grouped: Filters all clips belonging to a particular group, a submenu shows the 
available groups.

�� Tracked: Filters all clips with motion tracking.

�� Noise Reduction: Filters all clips using noise reduction.

�� OpenFX: Filters all clips using OpenFX.

�� Different Frame Rate: Filters all clips with frame rates that don’t match that of the project.

�� Input Sizing: Filters all clips that have had any Input Sizing parameters adjusted.

�� Common Media Pool Source: Filters all clips sharing the same source in the Media 
Pool as the current clip.

�� Matte Nodes: Filters all clips with an exposed Matte node in the Node Editor.

�� Mattes Available: Filters all clips with a matte assigned to them, whether they’re 
used or not.

�� Collaborative Update Available: Filters all clips that have been flagged as having been 
updated during a collaborative workflow.
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Creating and Using Smart Filters
If none of the preset filters does what you need, you can create your own custom Smart Filter in 
order to sift out clips based on any of the intrinsic or user-entered metadata that’s available in 
the Metadata Editor, Media Pool, and Color page timeline. Smart Filters work much the same 
way as Smart Bins, and they’re created and edited using the same procedures. For more 
information on Smart Bins, see Chapter 8, “Adding and Organizing Media with the Media Pool.”

In fact, Smart Filters can be very sophisticated, allowing you to filter the contents of the 
Thumbnail timeline by multiple criteria, and using multiple groups of multiple criteria for 
situations where you need to find clips that match all of one set of criteria, but only one of a 
second set of criteria. In this way, you can create Smart Filters to solve a wide variety of 
workflow needs as you work in the Color page.

It’s important to point out, however, that as much intrinsic metadata is available to every clip in 
DaVinci Resolve (clip properties including frame rate, frame size, codec, file name, et cetera), 
the more time you take entering extra metadata in the Metadata Editor to prepare your project 
for work for editing and grading (for example, entering scene and take information, and 
keywords for things like character names, day and night, interior and exterior, framing, et 
cetera), the more powerful Smart Filters can be in helping you to sift and sort through the 
contents of a program you’re grading.

Imagine being able to filter out all the closeups associated with a particular person in a 
program, or finding all the establishing shots corresponding to a particular location. If you or an 
assistant can take the time to enter metadata for the source material in a project that identifies 
these characteristics, you’ll be able to work even more quickly to match shots together and find 
the clips you need for any given situation.

To create a Smart Filter:

1	 Click the Timeline Filtering pop-up button to the right of the Clips button at the top left 
of the DaVinci Resolve UI, and choose Create Smart Filter.

2	 In the Create Smart Filter dialog, enter a name for the filter, and use the following controls 
to create one or more filter criteria (you can have as many filter criteria as you like):

The Create Smart Filter dialog

Match options: For multi-criteria filtering, choosing All ensures that every single criteria 
you specify is met for a clip to be filtered. Any means that if only one out of several 
criteria is met, that clip will be filtered.

Filter criteria enable checkbox: Lets you enable or disable any criteria without having 
to delete it.

Metadata category pop-up: Lets you choose which category of metadata you want to 
select a criteria from. Each category of metadata that’s available in the Metadata Editor 
is available from this pop-up menu. Additionally, Color Timeline Properties (containing 
many properties unique to the Color page timeline) and Media Pool Properties 
(containing every column in the Media Pool) provide access to additional metadata you 
can use for filtering.

Metadata type pop-up: For choosing which exact type of metadata to use, of the 
options available in the selected metadata category.
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Metadata criteria pop-up: Lets you choose the criteria by which to filter, depending on 
the metadata you’ve selected. Options include “true/false,” integer ranges, date ranges, 
string searches, flag and marker colors, et cetera.

Add filter criteria button: Lets you add additional criteria to create multi-criteria filters. 
You could use multiple criteria to, for example, find all clips from Scene 2, that also 
contain the keyword “Diana,” that also have the keyword “CU” in order to find all the 
Scene 2 close-ups of Diana. Additionally, if you Option-click this button, you can add a 
nested match option in order to create even more sophisticated filters, where the filter 
must match all of one set of criteria, and any of another set of criteria.

A complicated Smart Filter with multiple criteria and a second match option setting

As you’re editing the filter criteria, the Thumbnail timeline automatically updates to 
show you how the Smart Filter you’re creating is working.

3	 When you’re done editing the filter criteria, click Create Smart Filter. The resulting Smart 
Filter appears at the bottom of the Filter pop-up menu, and is turned on by default.

Methods of modifying existing Smart Filters:

�� To rename a Smart Filter: Click the Timeline Filtering pop-up and choose the Smart 
Filter you want to rename from the Rename Smart Filter submenu, then change the 
name in the Smart Filter Name dialog, and click OK.

�� To edit a Smart Filter: Click the Timeline Filtering pop-up and choose the Smart 
Filter you want to edit from the Edit Smart Filter submenu, then edit the filter criteria, 
and click OK.

�� To delete a Smart Filter: Click the Timeline Filtering pop-up and choose the Smart 
Filter you want to delete from the Delete Smart Filter submenu. It’s immediately deleted.

Submenus available for modifying Smart Filters
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Using the Lightbox
The Lightbox shows you all clips in the Timeline as a grid of thumbnails, arranged in rows from 
left to right and top to bottom. This lets you quickly evaluate, compare, and search for clips you 
want to use when making selections, creating groups, flagging clips, or when scanning for a 
particular scene or looking for an individual clip.

The Color page Lightbox displays all the clips in the Timeline

At the right of the Lightbox is a vertically oriented Timeline Ruler letting you know the timecode 
value at the beginning of each row of clips. At the bottom right is a Zoom slider that lets you 
change the size of the thumbnails.

Selecting a clip in the Lightbox is the same as selecting a clip in the Timeline, and right-clicking 
a clip in the Lightbox shows the same contextual menu items you’d see if you right-clicked a clip 
in the Timeline. Furthermore, you can also grade the current clip in the Lightbox using a control 
panel, or by exposing the color controls to grade the current clip using a mouse or other 
input device.

Methods of using the Lightbox:

�� To show or hide the Lightbox: Click the Lightbox button in the toolbar, or at the bottom 
right of the Lightbox if the color controls are hidden.

�� To show color controls in the Lightbox: Click the Show Color Controls button in the UI 
control bar above the Lightbox.

The Color Controls button, with the sidebar 
and Thumbnail Info buttons below

�� To show thumbnail info in the Lightbox: Click the Clip Info button, which is the second 
control at the upper left-hand corner of the Lightbox, to turn each clip’s thumbnail Info 
off and on.
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�� To resize clips in the Lightbox: Drag the Zoom slider to the right to increase thumbnail 
size, or to the left to decrease thumbnail size.

The Lightbox button, Zoom slider,  
and Monitor Output buttons

The contents of the Lightbox can be filtered using the same options that are available for 
filtering the Thumbnail timeline.

To filter the Lightbox:

1	 Click the Show sidebar button at the upper left-hand corner of the Lightbox. This 
reveals all of the filtering options that are available in the Lightbox, including custom 
Smart Filters you’ve created.

The Lightbox sidebar, with controls for filtering the Lightbox

2	 Click one of the options appearing in the sidebar. The Lightbox should immediately 
update to show just those clips that match the selected criteria.

3	 To go back to seeing every clip in the Timeline, click All Clips.

The Lightbox can also be output to video, in order to see its contents on a broadcast display or 
projector.
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To output the contents of the Lightbox to video: 

Click the Output Lightbox to Video button at the upper right-hand corner of 
the Lightbox.

The button for outputting the Lightbox to video

For more information about clip selections, groups, and grade management, see Chapter 48, 
“Grade Management.”

The Info Palette and Clip Information
The Info palette is hidden by default. Clicking the Info palette button at the far right of the 
toolbar reveals it at the right of the Timeline. The Info palette has two tabs that display different 
information. There are no user-editable controls in the Info palette.

Info palette displaying Clip Info and System Status

Clip Info
The first tab displays information about whichever clip is currently selected in the Timeline. 
This information is not editable, but is provided for reference, and includes:

�� File Name: The name of the media file on disk.

�� Reel Name: The reel name of that clip, if one is being read properly.

�� Start T/C: The source timecode value of the first frame in the clip.

�� End T/C: The source timecode value of the last frame in the clip.

�� Duration: The duration of the clip, in timecode.
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�� Frames: The duration of the clip, in frames.

�� Version: The name of the remote or local version used by that clip.

�� Frame Rate: The frame rate used by that clip.

�� Source Res: The native resolution of the source clip.

�� Codec: The codec or format used by the source clip.

System Info
The second tab displays information about operational modes currently in use by DaVinci 
Resolve. It’s meant to provide the status of different DaVinci Resolve features that can be 
enabled, disabled, or cycled among various options. This information includes:

�� Clips: The total number of clips in the Timeline.

�� Proxy: The status of Proxy mode (On or Off).

�� Clip Cache: The status of the Clip Cache mode (Off, All, Dissolves, User, User & D).

�� Ref Transform: The status of Reference Still reposition. 

�� Ref Mode: The status of the Reference mode (Gallery, Timeline, Offline).

�� Wipe Style: The currently selected Wipe Style for split screens (Wipe-H, Wipe-V, 
Wipe-M, Wipe-A).

�� Convergence: The current Convergence setting (Linked Zoom, Opposite)

�� Stereo Grade: The currently displayed Eye and Gang mode (Left or Right - 
Gang or Solo).

�� Stereo Display: The current Stereo Display mode (Mono or Stereo).

Clip Details
You can right-click the currently selected clip in the Thumbnail Timeline and choose View Clip 
Details to show a small window with all of that clip’s information available at a glance. You can 
drag this window anywhere you like, even to another display.

The Clip Details window
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This information is not editable, but is provided for easy reference, and includes:

�� File Name: The name of the media file on disk appears at top.

�� Start Timecode: The source timecode value of the first frame in the clip.

�� End Timecode: The source timecode value of the last frame in the clip.

�� Duration: The duration of the clip, in timecode.

�� Frames: The duration of the clip, in frames.

�� Reel Name: The reel name of that clip, if one is being read properly.

�� Version: The name of the remote or local version used by that clip.

�� Format: The format used by the source clip, along with the frame size and bit depth.

�� Codec: The codec used by the source clip.

�� Folder: Which directory on disk the source media resides in.

�� Description: The description field of the Metadata editor.

�� Notes: The notes field of the Metadata editor.

�� EDL Comments: EDL comments for that event, if any exist.

About Undo and Redo
The Undo and Redo commands in DaVinci Resolve work differently depending on which page 
is currently open. In the Edit and Fairlight pages, Undo and Redo affect edits made to the 
Timeline (covered in more detail in Chapter 14 and Chapter 62). In the Color page, Undo and 
Redo affect color adjustment operations made to individual clips.

Every time you adjust a control or a parameter in the Color page, a memory of that state of the 
grade is saved to an internal list for that clip. Each clip has its own memory stack, which means 
that Undo and Redo will undo different operations depending on which clip is the current clip. 
Each clip’s undo stack is unlimited, however the memory stack of every clip in a project is 
cleared when you quit DaVinci Resolve, and every time you start DaVinci Resolve each clip is a 
clean slate.

To Undo and Redo, do one of the following:

�� Choose Edit > Undo (Command-Z).

�� Choose Edit > Redo (Shift-Command-Z)

�� On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

If you have the DaVinci control panel, there is one other control that lets you control the Undo 
stack more directly when using the trackballs, rings, and pots. Pressing RESTORE POINT 
manually adds a memory of the current state of the grade to the Undo stack. Since discrete 
undo states are difficult to predict when you’re making ongoing adjustments with the trackball 
and ring controls, pressing RESTORE POINT lets you set predictable states of the grade that 
you can fall back on.
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Chapter 41

Automated 
Grading 
Commands and 
Imported Grades 
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Automated Grading Commands 
and Imported Grades
While DaVinci Resolve has a wide variety of manual grading controls that afford you control 
over just about every component of digital imagery, DaVinci has spent a lot of time investigating 
ways of increasing colorist efficiency by creating automated grading tools. Furthermore, with 
integrated editing bringing professional editors into the world of editing, grading, and finishing 
in DaVinci Resolve, the same automated tools being developed to help colorists go home 
earlier can also be used to give non-colorists a hand in taking care of simple grading tasks.

Color Match Palette	 701

Tips for Properly Shooting a Color Chart	 702

How to Use Color Match	 703

Configuration Controls	 705

Reset Controls	 705

Automatic Adjustments in the Color Wheels Palette	 705

White Balance Eyedropper	 705

Pick Black Point and Pick White Point	 706

Auto Color	 707

Auto Color Using the DaVinci Control Panel	 708

Shot Match	 708

Shot Match Guidelines	 709

How to Use Shot Match	 709

Suggestions for Using Shot Match	 710

Broadcast Safe	 711

Black Sun Highlight Correction	 712

Using CDL Grades	 713

Using ARRI Looks	 713
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Color Match Palette
If the camera and lighting departments had the foresight to shoot a color test chart for each of 
the major lighting setups in the project you’re grading, DaVinci Resolve lets you superimpose a 
sampling grid over a chart in a clip and mathematically analyze the sampled colors to generate 
an automatic correction. Using controls in the Color Match palette, you can specify the Source 
Gamma, Target Gamma, and Target Color Space to make sure that the resulting correction is 
correct for the camera you used, and the project you’ve set up.

The Color Match palette works with several standardized color charts:

�� Datacolor SpyderCheckr 24

�� DSC Labs ChromaDumonde 24+4

�� DSC Labs SMPTE OneShot

�� X-Rite ColorChecker Classic

�� X-Rite ColorChecker Video

�� X-Rite ColorChecker Passport Video

The X-Rite ColorChecker, Datacolor SpyderCheckr, and 
DSC Labs SMPTE OneShot charts compared, of of which 
are supported by the Color Match palette
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The result is analyzed to generate an automatic color correction to use to create a neutral 
grade for the image, to use as a starting point for the rest of your grade.

Tips for Properly Shooting a Color Chart
The results you get using Color Match are completely dependent on how the charts were shot 
in the field. If the charts were properly shot, you’ll get great results. If the charts were improperly 
shot, the results will be unpredictable.

To get the best results using Color Match, adhere to the following guidelines:

�� The chart must be lit evenly such that the lighting on each patch is the same intensity 
(level) and color. Any shadows or changes in lighting color across the chart will result 
in Color Match trying to compensate for these changes, and an inaccurate match will 
result. When viewing a chart being lit prior to a shoot shooting via a waveform monitor, 
the top of each individual patch as seen on the scope should appear as a rectangle 
with a “flat top.”

Poorly lit chart with irregularly topped waveforms

Well lit chart with flat-topped waveforms

�� No patches on the chart should be clipped in any of the RGB color channels. A clipped 
channel will force Color Match to use incorrect RGB values, and the resulting match will 
be inaccurate. 

�� The white patch on the recorded chart should be captured between 70-95 IRE. Correct 
exposure is essential to getting a good result, and while Color Match does allow for 
some adjustment via the White Level option, this will only give accurate results if the 
original chart is shot so that the white patch sits within the 70 – 95 IRE range when 
viewed on a waveform monitor. It is not recommended that a white patch be shot with 
a signal level above 95 IRE, since this usually means that one of the RGB channels is 
close to or actually clipping which will cause an inaccurate match. 
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�� The Source Gamma setting must be set to match the encoded OETF (opto-electrical 
transfer function, or gamma) of the recorded image. To be able to create an accurate 
adjustment, the Color Match function requires image data that is scene linear (linear 
to light). Most captured or recorded image data is encoded with a tone curve (gamma 
curve) to maximize the efficiency of the bit depth being used, and different cameras use 
different gamma curves to maximize the image data from different sensors. Since the 
Color Match algorithm converts image data into a scene linear space before creating 
an adjustment, it needs to undo the gamma curve created by the camera or debayering 
process. If the wrong Source Gamma setting is selected in the Match Color palette, 
then the data will not be linearized correctly and the resulting match will be inaccurate.

�� Lighting in the scene with an unusual spectral response or a strong color cast can 
cause an inaccurate match. Scenes lit with lights that have an unusual spectral 
response (such as cheap fluorescent bulbs, or mercury vapor fixtures that exhibit a 
very narrow or spiky spectral power distribution) can cause metameric errors in both 
the camera’s response and the Color Match function, resulting in the creation of an 
inaccurate adjustment. The most accurate results are obtained when the scene uses 
lighting with a chromaticity that is close to the black body locus (with a highly correlated 
color temperature) and a relatively smooth spectral power distribution. In other words, 
use high-quality lighting that doesn’t have spikes in specific parts of the spectrum.

�� Large differences between the color temperature of the lighting shining directly on the 
chart and ambient lighting elsewhere in the scene can cause perceptual errors. Often 
the problem is one of perception and not an incorrect color adjustment. For example, 
outdoor scenes being artificially lit with instruments shining extremely warm light (low 
color temperatures of 3200K or less) but that have cooler ambient lighting may appear 
overly blue if matched with a Target Color Temp of 6500K. This happens because the 
chart under direct lighting is lit at the lower (yellower) color temperature, but areas of 
the scene in shadow are much cooler because of the ambient “blue” light from the sky; 
the result is an automatic color adjustment that’s correct for the chart, but exaggerated 
in the background.

How to Use Color Match
The following procedure shows how to use the Color Match palette and overlay to create a 
color correction.

The Color Match palette
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To sample a color chart to make an automatic correction:

1	 Select the clip with a chart you want to sample. If necessary, you can use the View > 
Show Current Clip With Handles option to show additional frames at the beginning of 
the current clip to reveal a color chart in the leader of your media. 

2	 If necessary, choose an option from the Source Gamma pop-up menu that corresponds 
to the gamma with which the media was recorded. 

3	 Then, choose a target gamma and color space that corresponds to the format you want 
this clip to be matched to. 

4	 Click the Viewer tool pop-up, choose the Color Chart overlay, and use its corner-
pinning controls to line the sampling boxes up with the color patches of the chart. 

Aligning the Color Match target with the chart in the video

5	 When you’re finished, click the Match button, and the clip will be automatically 
corrected.

A clip before and after automatic color matching

Keep in mind that not every shot needs to have a chart. If the lighting of the location used in a 
scene is consistent, you really only need a single chart analysis to generate a correction that 
you can copy to all other clips in the same scene. Of course, if you are using multiple cameras in 
a scene, you should have a chart analysis for each separate camera if you want to try and match 
them more closely together.
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Configuration Controls
Here’s a more detailed explanation of each of the parameters found in the Color Match palette.

�� Source Gamma:  Defines the source gamma the media was recorded with. You must 
select the correct gamma or the results will not be as accurate.

�� Target Gamma:  Lets you select a target gamma that you want the corrected clip to 
use. While this will most likely be the gamma you’re outputting the finished program at, 
you can choose other target gamma values for specialized workflows.

�� Target Color Space:  The color space you’ll be outputting the finished program with.

�� Color Temp: An adjustable color temperature control that lets you manually adjust the 
target color balance of the resulting correction to be warmer (lower values) or cooler 
(higher values).

�� White Level:  A checkbox that’s disabled by default, which lets you manually choose 
the target white point that the automatic correction should use. Raising or lowering this 
value will stretch or compress the contrast of the final correction. 

�� Match button:  Once you’ve chosen the appropriate settings, and aligned the color 
match target with the chart that was recorded, click to execute the match. The 
default is 6500K.

�� Chart type pop-up menu:  You can choose from among the supported chart types in 
this pop-up. At the time of this writing, these include the Datacolor SpyderCheckr24, 
theChromaDuMonde 24+4, the DSC Labs SMPTE OneShot, the X-Rite ColorChecker 
Classic, the X-Rite ColorChecker Video, and the X-Rite ColorChecker Passport Video.

�� Reset All button:  Resets all controls and adjustments in this palette.

Reset Controls
The Color Match option menu has a variety of commands you can use to reset your work in the 
Color Match palette.

�� Reset Match Configuration:  Resets the Configuration parameters described above.

�� Reset Match:  Resets the matching operation without resetting the 
Configuration controls.

Automatic Adjustments in 
the Color Wheels Palette
There are four controls found in the Color Wheels palette that can be used for automatically 
making different color adjustments, in order to give you a head start whenever you’re trying to 
neutralize a color cast in the image or choose better black and white points for exposure.

White Balance Eyedropper
The White Balance eyedropper, found at the bottom-left corner of the Color Wheels palette 
next to the Automatic Correction button, provides an automated way of neutralizing a color cast 
in your image that you can guide by manually selecting a feature in the image that is supposed 
to be white.
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To auto white balance an image with an undesirable color cast or tint:

1	 Click the White Balance eyedropper button. The pointer turns into the White Balance 
eyedropper.

The White Balance eyedropper

2	 In the Viewer, click on any feature that is supposed to be white such as a white wall, 
white trim around a window, white blinds, a white shirt, etcetera. As you drag the 
eyedropper around, the RGB values appear as a tooltip to give you a better idea of 
what the color is of the feature you’re about to click on. Make sure the feature you click 
on is (a) supposed to be white, and not off-white, and (b) that it corresponds to an image 
detail that’s not clipped, because that can make parts of the image seem white that 
aren’t really.

As a result, the white balance of the image should appear much more neutral than 
before. Note that this adjustment is not applied via any of the controls in the Color 
Wheels palette; it’s an invisible, self-contained adjustment.

Pick Black Point and Pick White Point
The Pick Black Point and Pick White Point eyedropper controls, found at the upper left-hand 
corner of the Lift and Gain controls of each mode of the Color Wheels palette, let you both 
adjust contrast by lowering the black point or raising the white point of the image, and also 
corrects for unwanted color casts in the shadows or highlights of the image.

Note: It’s easy, using the Pick Black and White Point controls, to inadvertently boost the 
highlights or lower the shadows so much that you end up clipping part of the image. To give 
these controls the best chance of succeeding, it’s advisable to find the absolute brightest or 
darkest parts of the image to sample, according to the following instructions.

To automatically adjust the black point of an image:

1	 Click the Pick Black Point control. The pointer turns into the Black Point tool.

The Auto Pick Black Point control

2	 In the Viewer, click on any feature that is supposed to be black such as the deepest 
part of a shadow in the background or within a fold of clothing, black fabric, or 
something painted black. As you drag the Black Point tool around, the RGB values 
appear as a tooltip to give you a better idea of what the color is of the feature you’re 
about to click on. Make sure the feature you click on is (a) supposed to be black, and 
not some very dark hue, and (b) that it corresponds to an image detail that’s not clipped, 
because that can make parts of the image seem black that aren’t really.

As a result, the darkest parts of the image should appear much darker than before, and 
any color imbalance in the shadows should be neutralized. Unlike the White Balance 
eyedropper, this adjustment is applied via the Lift controls in the Color Wheels palette, 
which should appear with some manner of adjustment as a result.
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To automatically adjust the white point of an image:

1	 Click the White Point control. The pointer turns into the White Point tool.

The Auto Pick White Point control

2	 In the Viewer, click on any feature that is supposed to be white such as a white wall, 
white trim around a window, white blinds, a white shirt, etcetera. As you drag the White 
Point tool around, the RGB values appear as a tooltip to give you a better idea of what 
the color is of the feature you’re about to click on. Make sure the feature you click on 
is (a) supposed to be white, and not off-white, and (b) that it corresponds to an image 
detail that’s not clipped, because that can make parts of the image seem white that 
aren’t really.

As a result, the lightest parts of the image should appear much lighter than before, and 
any color imbalance in the highlights should be neutralized. Unlike the White Balance 
eyedropper, this adjustment is applied via the Gain controls in the Color Wheels 
palette, which should appear with some manner of adjustment as a result.

Auto Color
The Auto Color command provides a quick way to automatically balance the blacks and whites 
of a clip based on the current frame at the position of the playhead. DaVinci Resolve looks for 
the darkest levels in the image to neutralize the RGB color balance in the blacks, and the 
brightest levels to neutralize the RGB color balance in the highlights. Furthermore, Master Lift 
and Master Gain are adjusted to maximize image contrast at the outer boundaries of 0 and 100 
percent. Using this control with the Primaries Bars mode open makes it easier to see what’s 
been changed after these automatic adjustments are made.

The advantage of Auto Grade is that it gives you an immediate result for any clip without the 
requirement for sampling the image or having a specific test pattern to analyze, but the 
disadvantage is that this lack of guidance makes the usefulness of this command somewhat 
hit-or-miss. When it works, it can work very well to give you a neutral starting point for further 
grading. When it fails, you’re better off resetting the resulting adjustment and grading the old 
fashioned way.

To make an automatic correction:

�� Open the Color Wheels palette to any mode, and click the A button in the lower left-
hand corner.

�� Choose Color > Auto Color (Option-A)

�� Press the AUTO COLOR button on the T-bar panel.

The Auto Color button
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Auto Color Using the 
DaVinci Control Panel
If you crave a bit more control over how the automatic color adjustment is made, and you have 
a DaVinci control panel, you can use the cursor to choose which color values to sample when 
making an automatic color balancing and contrast adjustment. It’s like a cross between the Auto 
Color control and the White and Black Point controls found in the GUI. This additional bit of 
guidance can make the results a lot more predictable.

To use Auto Grade to sample a feature using the DaVinci Control Panel:

1	 Press the CURSOR button, on the trackball panel.

2	 Use the fourth trackball to move the cursor to a feature you want to use to define the 
automatic correction. Whichever color you move the cursor over will be sampled to 
form the basis of the resulting color and contrast adjustment. Ideally, you should place 
the cursor over a feature that’s supposed to be neutral, such as a black shadow, grey 
wall, or white T-shirt. Don’t place the cursor over a feature that actually consists of 
saturated color, or that’s overexposed, as DaVinci Resolve will overcompensate and 
you’ll get poor results.

3	 With the cursor placed over the desired neutral feature, press AUTO COLOR on the 
T-bar panel.

DaVinci Resolve calculates an appropriate correction, which is applied to the 
selected node.

Shot Match
The previously available automated color correction commands, Auto Color and Color Match, 
are both useful for adjusting a selected clip to give it a clean, neutral starting point when you’re 
either in a hurry, or if you’re having trouble manually working out a solution. However, this is 
only the first step in grading a scene.

After you make a general adjustment to improve the color of a clip in a scene, one of the other 
principal tasks of the colorist is to adjust all of the clips in that scene so that they match the clip 
you started with, such that they all look like they were shot at the same time and in the same 
place. This is called scene-to-scene color correction, scene balancing, or shot matching. While 
there are abundant tools in DaVinci Resolve to ease the process of doing this manually, 
wouldn’t it be nice if you could just select a series of clips that you want to match, and have the 
software do the work?

(Top) Original scene, (Bottom) After using shot match to match all selected clips to clip 62
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That’s exactly what Shot Match has been designed to do. Whether you’re a colorist in a hurry, 
trying to blast through a low-budget feature with an absurd schedule, a DIT making best light 
dailies who just wants to make them match a little more closely before sending media off to 
editorial, or an editor who isn’t fast at color correction who needs to give a rough cut a quick 
color balance before showing the project to the client for the first time, the Shot Match feature 
of DaVinci Resolve has been created to quickly make different clips in a timeline match one 
another more closely, with a minimum of steps.

Shot Match Guidelines
Keep in mind that Shot Match isn’t supposed to make your clips look good, it’s supposed to 
make them look the same as the clip you choose to match to, or to at least get as close as 
possible without creating a color correction that will do harm to the image. The purpose of Shot 
Match is to make it easier for you to match a scene’s worth of clips together so you have a 
starting point for building the rest of the look you want for that scene, on top of this initial match.

The clip you choose to match to may have a correction applied to it, but for the best results, you 
should limit yourself to simple Lift/Gamma/Gain primary adjustments. If you make Custom curve 
or secondary adjustments to the image, it will be much more difficult for Shot Match to give you 
a good result.

Shot Match works best with normalized clips. If you’ve got a timeline edited with log-encoded 
clips, you may want to use DaVinci Color Management to normalize all the clips in the Timeline 
before you use Shot Match, to get the most accurate results. It’s certainly possible to use Shot 
Match with log-encoded media, but the flat color signal of log-encoded media may make it 
harder to get good results, depending on the scene. 

Furthermore, Shot Match is not the right tool to use to try and match un-normalized log-
encoded clips that use different types of log encoding, such as LogC and RedLogCine, or to try 
and match normalized and un-normalized clips. Because log-encoding is similar to a set of red, 
green, and blue curve operations, Shot Match is not equipped to achieve a successful result in 
this situation.

Shot Match is not designed to apply corrections to clips that already have node adjustments. 
The results will be unpredictable, and probably won’t match. While the clip you’re matching to 
may have simple primary adjustments applied to it, the other selected clips that are being 
matched should be completely ungraded.

Lastly, Shot Match has been designed to do no harm to the image. This means if you use Shot 
Match to try and match an underexposed interior shot to an exterior shot exposed at high noon 
on a sunlit day, the Shot Match algorithm will do its best to “split the difference” in order to make 
the difference between these two clips less jarring, while at the same time taking care not to 
stretch the color and contrast adjustments being made to the underexposed clips to the point 
where the image falls apart.

How to Use Shot Match
There’s no way to easily describe what Shot Match does. It’s a complex algorithm designed to 
try and deal with an impossibly varied number of different situations. As a result, Shot Match 
doesn’t apply adjustments to any of the user-editable controls in the Color page. Instead, the 
image adjustment created by Shot Match is applied invisibly, as the very last adjustment to the 
node that was selected when Shot Match was used, similar to a LUT.
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A Shot Match adjustment applied to a clip

The procedure for using Shot Match is deceptively simple. However, getting a good result 
requires some careful thought in terms of choosing which clips to match to one another.

To match one or more selected clips to a specific clip:

1	 Following the guidelines presented in this section, Command-click or Shift-click one or 
more clips that you want to be matched. The clip you want to match to may or may not 
be part of the selection. You may select as few as one clip, or as many as you like.

Selecting clips you want to be matched

2	 Next, right-click the clip you want to match all of the selected clips to, and choose Shot 
Match to This Clip.

Shot Match command used on the clip you 
want to match the other selected clips to

If the resulting automated match looks good and plays well, then congratulations, you’ve got an 
excellent starting point for additional grading. However, keep in mind that even if the resulting 
match isn’t perfect, it may have taken care of enough inconsistencies between the clip you’re 
matching to and the clips that are being matched, that you need only make smaller, easier-to-
spot adjustments in order to nail the final match between the shots in a scene. Either way, you 
can save time.

Suggestions for Using Shot Match
It’s certainly possible to select every clip in a scene and use Shot Match, and the results may be 
wonderful depending on what kind of visuals are in the scene. However, for other scenes, this 
may not always get you the best results. 

TIP: If you want to make it easier to notice the before and after, you can turn 
on Split Screen, and choose Selected Clips from the mode pop-up in the 
Viewer Options. This lets you see all the clips you’re about to match in a grid.
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Be strategic about which clips you select to match to one another. Don’t use Shot Match on 
shots that you know already have the same lighting, as you’ll risk having Shot Match make a 
minor adjustment that may actually make the shots match less well. Think of Shot Match as a 
tool for matching clips that look different.

It can also help to use Shot Match an angle at a time, and to do a small test before committing 
yourself to matching a bunch of clips. For example, suppose you have a scene consisting of 
angle A (an over of character 1), angle B (an over of character 2), and angle C (a master shot), 
and you want to match the scene entire scene to angle C since it has the best lighting. First, 
match one shot from angle B to your favorite shot from angle C, and see how you like the result. 
If it’s good, then go ahead and select every angle B clip and match them to angle C, before 
moving on to test one shot from angle A. This way, if there’s ever an angle that doesn’t work 
well using Shot Match, you can try matching it to one of the other angles in the scene that 
you’ve already matched to see if you get a better result.

Beware of clips with large areas of color in the background that don’t match any of the other 
angles in a scene, such as a shot-reverse-shot sequence that cuts between someone standing 
in a back yard and someone standing against a purple wall. You can try it to see what happens, 
but this kind of color distribution can often throw Shot Match results off.

Broadcast Safe
If you regularly deliver to restrictive QC standards, then you can enable Broadcast Safe in the 
Color Management panel of the Project Settings while you grade to limit both the luma and 
chroma of the video signal to one of three levels of acceptable overshoots and undershoots.

The Broadcast Safe parameters in the Color Management panel of the Project Settings

�� Broadcast safe IRE (mV) levels: A pop-up menu for choosing one of three levels of 
aggressiveness when limiting the signal. Choose the range that corresponds to your 
QC requirements. The options are “–20 - 120” (permissive), “–10 - 110” (conservative), 
“0 - 100” (very conservative).

�� Make Broadcast Safe: A checkbox that turns broadcast safe limiting on and off.

NOTE: IKeep in mind that, since each clip in the Timeline has its own undo stack, you 
cannot undo a shot match operation applied to multiple clips all at once.

NOTE: The clipping imposed by Broadcast Safe itself does not have an inherently soft 
roll-off. For best results, Broadcast Safe should be used in conjunction with the Soft 
Clip controls in the Color page, or a Soft Clip LUT (for more information see Chapter 3, 
“Project Settings and Preferences”).
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Black Sun Highlight Correction
If your project uses media shot with one of the Blackmagic Cinema, Production, Pocket, or Ursa 
cameras, and you have clips that exhibit so-called “black sun” artifacts, where bright on-screen 
highlights appear with a dark magenta spot, a command exists to quickly and easily remove 
these artifacts.

Black Sun artifact seen in image; 

Artifact removed using Black Sun Highlight Correction

To remove black sun artifacts from Blackmagic camera footage:

Right-click the affected clip’s thumbnail in the Thumbnail timeline of the Color page, and choose 
Black Sun Highlight Correction from the contextual menu.

The command for removing black sun artifacts
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Using CDL Grades
Only available in DaVinci Resolve Studio.

There are two instances where primary grading adjustments may be applied to a clip outside of 
adjustments that you make within the Node Editor of the Color page. If you import a CDL 
(Color Decision List), then the CDL adjustment for each clip is made available to you via a 
contextual menu command in the Thumbnail timeline of the Color page. 

For more information, see Chapter 54, “Copying and Importing Grades Using ColorTrace.”

Using ARRI Looks
Only available in DaVinci Resolve Studio.

If you’ve ingested ARRI raw media or Amira SXT QuickTime media, with embedded ARRI Look 
metadata (CDL + LUT), the embedded look can be copied to the currently selected node in the 
Color page.

To copy an ARRI look from the source media to the current node:

1	 Select a node in the Node Editor to which you want to apply the look data.

2	 Right-click that clip’s thumbnail and choose Apply ARRI CDL and LUT. A LUT and Color 
Wheels adjustment will be applied to the selected node.

Using the Apply ARRI CDL and LUT 
command copies a look from the source 
media to a node in the Node Editor
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Chapter 42

Primary 
Grading Controls 
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Primary Grading Controls
This chapter focuses on the core color adjustments that you’ll be making to create “primary” 
corrections that alter the overall color and contrast of the image. These include clip-specific 
Camera Raw adjustments and the Lift/Gamma/Gain/Offset adjustments available in the Color 
Wheels palette, as well as more esoteric adjustments such as mixing colors between channels 
using the RGB Mixer.

Color Controls Covered in this Chapter	 716

Camera Raw	 716

Copying, Versioning, and Protecting Camera Raw Settings	 717

Making Changes to Clip Camera Raw Settings	 717

Clip Decoder Settings	 718

Resetting Camera Raw Settings	 719

Color Wheels Palette	 720

Opening the Color Wheels Palette Using the DaVinci Control Panel	 720

HDR Grading Using Color Wheels Palette Controls	 721

How to Use Color Balance Controls and Master Wheels	 721

Understanding the Primaries Wheels Controls	 722

Shared Adjustment Controls	 725

The Log Mode of the Color Wheels Palette	 727

The Primaries Bars Mode of the Color Wheels Palette	 732

RGB Lift/Gamma/Gain Sliders	 732

Offset Sliders, Offset Wheel, and Printer Points	 733

RGB Mixer Palette	 736

Preserve Luminance	 736

Resetting the RGB Mixer	 737

Swap Channels Buttons	 737

Using the RGB Mixer in Monochrome Mode	 737

RGB Mixer Controls on the DaVinci Control Surface	 739
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Color Controls Covered in this Chapter
The Left Palette panel contains four palettes that relate to color and contrast adjustments in 
different ways. The controls found within these palettes provide the foundation for any grade, 
and this chapter covers how you use the Camera Raw, Color Wheels, and RGB Mixer palettes. 
For more information on the Motion Effects palette, see Chapter 59, “The Motion Effects and 
Blur Palettes.”

Primary color adjustment palettes in the Left Palette panel

Camera Raw
When a timeline uses clips that are linked to camera raw source media recorded from cameras 
from Blackmagic Design, RED, ARRI, Sony, and Vision Research, all clips in raw media formats 
are initially debayered using the settings found in the Camera RAW panel of the 
Project Settings.

However, if there are individual clips that you want to apply different raw settings to, for example 
altering the ISO to pull more detail out of the highlights or shadows, then you can use the 
controls found in the Camera RAW palette to individually alter the parameters found within.

The Camera Raw palette showing the available parameters for CinemaDNG media.

The Camera Raw palette is automatically set to the mode (seen within the Mode pop-up menu) 
that is appropriate to the clip that’s currently selected. If the current clip is not in a raw format, 
then the parameters within the Camera Raw palette are disabled.

All settings that currently populate the Camera Raw palette are also accessible from the DaVinci 
control panel.

NOTE: If you’re using DaVinci Resolve with a computer monitor that’s smaller than 
1920x1080, then the Left and Center Palette panels are consolidated into a single 
panel, and all the buttons in the Palette toolbar appear together.
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To access camera raw settings on the DaVinci control panel:

1	 Press the CAMERA RAW soft key on the Center panel.

2	 Use the Center panel knobs to make camera raw parameter adjustments.

3	 When you’re finished, press the MAIN soft key to return to the main page of controls.

This section covers general use of the Camera Raw palette. For in-depth documentation about 
specific Camera Raw parameters, see Chapter 4, “Camera Raw Settings.”

Copying, Versioning, and Protecting Camera Raw Settings
Ordinarily, a clip’s camera raw settings are copied along with its grade, or saved inside stills 
grabbed from that clip, when you use the various grade management techniques covered in 
Chapter 48, “Grade Management.” 

When you create new versions, you have the option to save individual camera raw settings for 
each version, so long as the Save with Version checkbox is turned on in the Camera 
Raw palette.

Camera Raw master settings

This means that you can have different versions with different camera raw settings, if, for 
example, you wanted to compare the results of two different camera raw adjustments on the 
same clip.

If you’re copying and rippling grades among multiple clips, you can also protect each clip’s 
camera raw settings from being overwritten using the “Copy Grade: Preserve Source Settings” 
option found in the contextual menu of the Gallery. For more information on the Copy Grade 
settings, see Chapter 48, “Grade Management.”

Making Changes to Clip Camera Raw Settings
If you want to make individual adjustments to a particular clip’s camera raw settings, choose 
“Clip” from the Decode Using pop-up menu in the Camera Raw palette. This makes all the 
parameters in the Camera Raw palette editable, and changes you make override the project-
wide camera raw settings.

Changes to the parameters in the Camera Raw palette can also be rippled across multiple 
clips at once.
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To ripple camera raw adjustments across multiple clips:

1	 First, you must select a range of clips in the Color page timeline.

2	 Open the Camera Raw palette, and make whatever adjustments are necessary to the 
current clip. The name of each parameter you adjust changes to amber, showing you 
which parameters have been modified, and which have not.

3	 To ripple your changes, do one of the following:

�� Click the Use Changes button to ripple only the altered parameters (in amber) to the 
other clips you’ve selected in the Timeline. This preserves differences between clips 
in the parameters you haven’t adjusted (in gray).

�� Click the Use Settings button to ripple every parameter of the current clip to the other 
clips you’ve selected, overwriting all the camera raw settings at once. 

The Use Changes and Use Settings buttons in the Camera Raw palette

Clip Decoder Settings
There’s much more information on the various format-specific Master settings, as well as the 
occasionally format-specific Clip Decoder settings, in Chapter 4, “Camera Raw Settings.” 
However, with the exception of the RED Clip Decoder settings that appear for R3D clips, most 
other formats share a set of DaVinci Resolve-specific controls that provide wide-latitude access 
to the raw image data for purposes of making different kinds of adjustments. 

Camera Raw Clip Decoder settings

These controls include:

�� Color Temp: Designed to alter the “warmth” of the image. Adjustable in degrees 
Kelvin. Lower values correct for “warmer” lighting, while higher values correct for “cool” 
lighting. +6500 is unity. The range is +2000 to +50,000.

�� Tint: Color balance correction for images with a green or magenta color cast, such as 
fluorescent or sodium vapor bulbs. 0 is unity. The range is –150 to +150.

�� Exposure: Increases or lowers image lightness in units relative to ƒ-stops. If your 
intended exposure adjustment lifts image data above the maximum white level, don’t 
worry; all image data is preserved and can be retrieved in subsequent adjustments. 0 is 
unity. The range is –4 to +4.
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�� Sharpness: A debayer-specific sharpness filter applied to provide the appearance of 
enhanced image detail. 20 is unity. The range is 0 to 100.

�� Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-
dynamic-range media by lowering this parameter, and achieves a smooth blend 
between the retrieved highlights and the unadjusted mid tones for a naturalistic result. 
0 is unity. The range is –100 through +100.

�� Shadows: Lets you selectively lighten or darken shadow detail. Raising this value 
retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 
is unity. The range is –100 through +100.

�� Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, 
sometimes referred to as a vibrance operation. Can be used also to lower the 
saturation of regions of low saturation. 0 is unity. The range is –100  through +100.

�� Saturation: Adjusts the color intensity of the image. 0 is unity. The range is –100 
through +100.

�� Midtone Detail: When this parameter is raised, the contrast of regions of the image with 
high edge detail is raised to increase the perception of image sharpness, sometimes 
referred to as definition. When this parameter is lowered to a negative value, regions 
of the image with low amounts of detail are softened while areas of high-detail are left 
alone. 0 is unity. The range is –100 through +100.

�� Lift: Adjusts the black point of the media, raising it or lowering it while scaling all 
midtone values between it and the white point. Regardless of how you adjust this 
control, all image data is preserved and can be retrieved in subsequent adjustments. 
The range is –100 to +100. 

�� Gain: Adjusts the white point of the media, raising or lowing it while scaling all midtone 
values between it and the black point. Regardless of how you adjust this control, all 
image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. 
The range is –100 to +100.

�� Contrast: Raising contrast reduces shadows and raises highlights, while leaving 
midtones at 50 percent unaffected. Regardless of how you adjust this control, all image 
data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The 
range is –100 to +100.

Resetting Camera Raw Settings
If you’ve made changes to the parameters of the Camera Raw palette and you decide you need 
to reset them, there are two options, found in the Options menu.

�� Reset: Resets all parameters in the Camera Raw palette to their default settings.

�� Revert: Similar to the “Original Memory” command, Revert changes all camera raw 
parameters back to the state they were at when you first selected the current clip.
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Color Wheels Palette
If you’ve had any exposure to color correction tools in any application, the controls found within 
the Color Wheels palette should look familiar. These controls correspond to the most basic 
color correction functionality available in DaVinci Resolve, and are designed to let users without 
control panels have easy access to color balance and YRGB contrast manipulation using a 
mouse, tablet, or trackpad.

Color Wheels for primary grading, in Primaries mode

The Color Wheels palette has three distinct modes of operation:

�� Primaries Wheels mode contains the traditional DaVinci Lift/Gamma/Gain/Offset 
controls that allow tonally specific yet widely overlapping regions of adjustment. 

�� Primaries Bars mode affects the same Lift/Gamma/Gain/Offset controls as the Primaries 
Wheels mode, but the bars interface lets you make vertical slider-driven adjustments to 
YRGB lift, YRGB gamma, and YRGB gain, as well as providing a slider-driven interface 
for Offset.

�� Log mode contains Shadow/Midtone/Highlight/Offset controls that offer more 
restrictive yet customizable regions of adjustment intended for making adjustments to 
log-encoded image data.

Which mode you use depend entirely on what kinds of adjustments you need to make.

Opening the Color Wheels Palette 
Using the DaVinci Control Panel
You can open any mode of the Color Wheels palette by doing one of the following:

�� To open the Primaries Bars: Press SHIFT DOWN and then PRIMARY.

�� To open the Color Wheels: Press SHIFT UP and then PRIMARY.

�� To open the Log controls: Press SHIFT DOWN and then PRIMARY. Alternately, you can 
open any of the other Color Wheels palette modes, and then press the LOG soft key on 
the Center panel of the DaVinci control panel. Press the MAIN soft key to return to the 
more traditional Lift/Gamma/Gain mode of adjustment.
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HDR Grading Using Color Wheels Palette Controls
When using various grading controls in the Color page to grade wide-latitude images for HDR 
output, you may find it useful to enable the HDR Mode of the node you’re working on by 
right-clicking that node in the Node Editor and choosing HDR Mode from the contextual menu 
(only available in Resolve Studio). 

Using a node’s contextual menu to put 
that node into HDR mode

This setting adapts that node’s controls to work within an expanded HDR range. Practically 
speaking, this makes it easier to work with wide-latitude signals using controls that operate by 
letting you make adjustments at different tonal ranges such as Lift/Gamma/Gain, Custom 
Curves, Soft Clip, etcetera.

How to Use Color Balance Controls and Master Wheels
Each of the modes in the Color Wheels palette use the same controls, albeit in different ways. 
This section explains, in a generic way, how to use these controls to make adjustments.

Color Balance controls provide a way to adjust all three color channels simultaneously with a 
single move of the pointer, according to the mode that’s currently selected. These controls 
correspond to the trackballs found on the DaVinci control panel, but there are a variety of 
keyboard modifiers that let you make specific adjustments via the GUI.

To make adjustments using the Color Balance controls:

�� Click and drag anywhere within the color ring: Moves the Color Balance indicator 
relative to its previous position, and rebalances the three color channels in whatever 
range of image tonality is governed by that control. You don’t need to drag the Color 
Balance indicator itself. This simulates the kind of relative control you get when using 
a trackball to manipulate these parameters. As the Color Balance indicator moves, 
the RGB parameters underneath change independently to reflect the independent 
adjustments being made to each channel.

�� Shift-click and drag within the color ring: Jumps the Color Balance indicator to the 
absolute position of the pointer, letting you make faster, more extreme adjustments to 
the color balance governed by that control.

�� Double-click within the color ring: Resets the color adjustment without resetting the 
corresponding contrast adjustment for that control.

�� Command-click and drag within the color ring: Adjusts YRGB contrast identically as if 
you were dragging that control’s master ring.

�� Click the reset control at the upper-right of a color ring: Resets both the Color 
Balance control and its corresponding master ring.
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The Master Wheels, located below the Color Balance controls, let you adjust the YRGB 
channels together to adjust Lift, Gamma, and Gain by individually adjusting the black point, the 
white point, and distribution of midtones that fall in-between. This has the practical effect of 
letting you adjust image contrast when you manipulate any two of these wheels together.

Lift, Gamma and Gain master wheels to balance the grades

The Master Wheels correspond to the rings surrounding the trackballs on the DaVinci control 
panel, which let you modify image contrast via YRGB adjustment (as opposed to modifying 
image contrast via Y-only adjustment, covered later in this chapter).

To adjust a Master Wheel:

Dragging a Master Wheel to the left makes the corresponding tonal region of the image 
darker, and dragging it to the right makes that tonal region of the image lighter. The 
effect will vary according to the Color Wheels mode you’re in. As you make an 
adjustment, the YRGB parameters located underneath all change together to reflect 
the simultaneous adjustment you’re making to all channels.

Understanding the Primaries Wheels Controls
The Color Wheel palette’s Primaries Wheels mode lets you rebalance color and adjust contrast 
via the traditional DaVinci controls, which govern three overlapping tonal ranges referred to as 
Lift, Gamma, and Gain. The Lift/Gamma/Gain color balance and Master Wheel controls are tied 
to the YRGB Lift/Gamma/Gain sliders found in the Primaries palette; adjustments made to one 
set of controls are mirrored in the other.

Though they may look different, the Primaries Wheels and Primaries Bars 
actually adjust the same components, but in different ways.
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These tonal ranges are defined by image lightness, on a scale where 0 is absolute black and 
1023 is absolute white. The following illustration shows an approximation of how the Lift, 
Gamma, and Gain tonal zones broadly overlap, and how each zone’s influence falls off towards 
the opposing extremes of image tonality.

Graphic displays the relationship of the Lift, Gamma and Gain 
controls over the image brightness range that they control

The Lift color balance control region of influence starts at black, and then falls off through the 
middle grays to diminish to no influence at white. Meanwhile, the Gamma color balance control 
has its greatest influence over the image in the middle grays, and its influence diminishes 
towards black and white. Lastly, the Gain control is the inverse of Lift, having its greatest effect 
on the image at white, with its influence falling off to diminish at black.

Because these tonal ranges overlap so broadly, you can make very soft, subtle, naturalistic 
adjustments using these controls. Furthermore, you can capitalize on their overlap by moving 
an adjacent color balance control toward a color that’s complementary to an adjustment you’ve 
just made to restrict further how much of the image is affected.

The following image shows the interaction of extreme corrections made to a grayscale image 
using all three Color Balance controls. Lift has been pushed toward green, Gamma has been 
pushed toward blue, and Gain has been pushed toward red.

Extreme adjustments showing the overlap of the Lift, Gamma, and 
Gain color balance controls

Notice how, even though these corrections are extreme, the colors blend smoothly. This is the 
reason for the broad overlap among all three controls, and why Lift, Gamma, and Gain are so 
effective in making corrections to the ambient color temperature of a scene to account for 
inconsistencies in lighting or camera settings.

Lift Gamma Gain
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3-Way Master Wheel Adjustments
The Master Wheels located below the Color Balance controls let you precisely modify image 
contrast by YRGB adjustments, which individually alter the black point, the white point, and 
distribution of midtones that fall in-between. 

These controls correspond to the rings surrounding the trackballs on the DaVinci 
control surface.

�� Lift: Lets you adjust the perceived shadow density of the image by altering the black 
point of the image. Dragging the Lift master wheel to the left makes the darkest values 
in the image darker, increasing the distance between the black and white points of 
the image, and stretching all the midtone values in-between. Dragging the Lift master 
wheel to the right makes the darkest values in the image lighter, reducing contrast and 
squeezing all the midtone values between the black and white points.

�� Gamma: Lets you adjust the overall perceived lightness of the image by altering the 
distribution of midtones that fall between the Lift and Gain master wheel settings. 
Dragging the Gamma master wheel to the left darkens the overall image, while 
dragging it to the right brightens it. Most Gamma contrast adjustments have a minimal 
effect on the black and white point of the image, but large adjustments may push 
either boundary of image lightness farther out. This interaction is described in more 
detail below.

�� Gain: Lets you adjust the lightness of the highlights by altering the white point of the 
image. Dragging the Gain master wheel to the left makes the lightest values of the 
image darker, squeezing the midtones between the white and black points of the 
image. Dragging Gain to the right makes the lightest values even lighter, eventually 
clipping at maximum white.

Waveform display shows the clips contrast range

These contrast adjustments are not limited by one another. For example, raising or lowering the 
Gamma master wheel by a large amount may push the highlights of the image higher or the 
shadows of the image lower, regardless of the current Lift or Gain contrast setting. 

As a result, these controls are somewhat interactive, and you may find yourself going back and 
forth between controls as you make your final contrast adjustments. This is one of the reasons a 
control surface is valuable, as it allows you to adjust all three settings simultaneously.
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Offset Color and Master Controls
The fourth set of Color Balance and Master Wheel controls is actually shared with the Log 
controls and with the Offset sliders in the Primaries palette. These are the Offset controls, which 
let you make linear adjustments to rebalance the entire tonal range of the RGB channels.

�� The Offset color balance control: Works as a simultaneous adjustment to all three 
Offset sliders located in the Primaries palette; adjustments made to the Offset color 
balance control also alter the Offset sliders. Used subtly, this makes it easy to neutralize 
color imbalances in the darkest part of the image, while simultaneously rebalancing 
every other part of the image. Used more dramatically, this control makes it easy to add 
a color wash throughout the entire image.

�� The Offset master wheel: Acts as a global adjustment to image lightness, an operation 
sometimes referred to as setup, raising or lowering all YRGB channels together.

When using a DaVinci control surface, the Offset color balance control is adjusted in either Lift/
Gamma/Gain or Log modes via the fourth trackball, while the Offset wheel is adjusted via the 
ring surrounding the fourth trackball.

Shared Adjustment Controls
The three modes of the Color Wheels palette all share two pages of controls for making more 
specific adjustments to different aspects of the image such as Contrast, Saturation, Hue, 
Highlight retrieval, Color boost, et cetera. 

Page 1 Adjustment Controls
The shared Contrast, Pivot, Saturation, Hue, and Lum Mix controls are located in a set of 
“Page 1” controls found at the bottom of the Color Wheels palette.

The Page 1 adjustment controls

The Contrast parameters let you quickly narrow or widen image contrast about a user-definable 
pivot point. Regardless of which mode you’re in, these parameters are identical. Contrast and 
pivot can also be adjusted using the DaVinci control surface via the CONTRAST and PIVOT 
knobs on the Center panel’s default page, regardless of whether you’re in Lift/Gamma/Gain or 
Log mode. 

�� Contrast: This one parameter lets you increase or reduce the distance between the 
darkest and lightest values of an image, raising or lowering image contrast. The effect 
is similar to using the Lift and Gain master controls to make simultaneous opposing 
adjustments. Bright and dark parts of the image are pushed apart or brought together 
about a center point defined by the Pivot parameter. The “Use S-curve for contrast” 
setting in the General Options panel of the Project Settings (on by default) sets 
the contrast control to apply an “S-curve” to the image, such that the shadows and 
highlights of a signal will not be clipped when you increase the value. If you would 
prefer for these contrast adjustments to be made linearly, and for the signal to be 
allowed to clip when you reach the upper and lower boundaries of the video signal, you 
can turn this checkbox off.

�� Pivot: Changes the center of tonality about which dark and bright parts of the image 
are stretched or narrowed during a contrast adjustment. Darker images may require 
a lower Pivot value to avoid crushing the shadows too much when stretching image 
contrast, while lighter images may benefit from a higher Pivot value to increase shadow 
density adequately.
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The Saturation, Hue, and Lum Mix parameters mirror the three knobs found at the right of the 
Center panel of the DaVinci control surface.

�� Saturation: Increases or decreases overall image saturation. At higher values, colors 
appear more intense, while at lower values, color intensity diminishes until, at 0, all 
color is gone, leaving you with a grayscale image.

�� Hue: Rotates all hues of the image around the full perimeter of the color wheel. The 
default setting of 50 shows the original distribution of hues. Raising or lowering this 
value rotates all hues forward or backward along the hue distribution as seen on a 
color wheel.

�� Lum Mix: Lets you control the balance between YRGB contrast adjustments you’ve 
made using the Master Wheels or ganged Custom curves, and Y-only adjustments to 
contrast made using the Y channel Lift/Gamma/Gain controls of the Primaries palette 
or the unganged Luma curve. At the default of 100, YRGB and Y-only adjustments to 
contrast contribute equally. Reducing this value diminishes the effect of Y-only contrast 
adjustments until, at 0, Y-only contrast adjustments are turned off. 

Additionally, you’ll notice that at a Lum Mix setting of 100, individual adjustments to R, G, 
or B using the RGB sliders or unganged Custom curves result in automatic adjustments 
being made to the other two color channels in order to maintain constant Luma levels. 
At a Lum Mix setting of 0, individual color channel adjustments have no effect on the 
other color channels.

Like most parameters in DaVinci Resolve, clicking and dragging a parameter’s name or value to 
the left or right lowers and raises that parameter with a virtual slider, while double-clicking that 
parameter’s number lets you edit it numerically, and double-clicking that parameter’s name 
resets the parameter to its default position.

Page 2 Adjustments Controls
The “Page 2” section of the Color Wheels palette has the same kind of highlight and shadow 
recovery, Color Boost, and Midtone Detail controls that are found on the Camera Raw palette. If 
you’re grading a camera raw format, then these controls on the Camera Raw palette will give 
you greater latitude for adjustment. However, the identically named controls in the Color 
Wheels palette can be used for any media format you like. 

The Page 2 adjustment controls

Even though you won’t have the kind of wide latitude that you do when using these controls 
with raw clips, you can still accomplish quite a lot, depending on the format you’re adjusting.

�� Temperature: A specifically-constrained Gain color balance adjustment that lets 
you adjust the image along a warm/orange to cool/blue axis corresponding to the 
naturalistic spectrum of color temperatures used for lighting. Raising this parameter 
performs a Gain color balance adjustment toward orange, while lowering this parameter 
to a negative value performs a Gain color balance adjustment toward a blue/cyan split. 
0 is unity. The range is –4000 to +4000.

�� Tint: A specifically-constrained Gain color balance adjustment that lets you adjust the 
image along a magenta to green axis corresponding to the unnatural spectrum of color 
temperatures found in artificial lighting sources such as fluorescent and sodium vapor 
lighting fixtures. Raising this parameter performs a Gain color balance adjustment 
toward magenta (sometimes referred to as “minus green” to correct for fluorescent 
lighting), while lowering this parameter to a negative value performs a Gain color 
balance adjustment toward green (“plus green” to correct for other kinds of lighting). 0 
is unity. The range is –4000 to +4000.
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�� Midtone Detail (MD): When this parameter is raised, the contrast of regions of the 
image with high edge detail is raised to increase the perception of image sharpness, 
sometimes referred to as definition. When this parameter is lowered to a negative 
value, regions of the image with low amounts of detail are softened while areas of high-
detail are left alone. 0 is unity. The range is –100 through +100.

�� Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, 
sometimes referred to as a vibrance operation. Can be used also to lower the 
saturation of regions of low saturation. 0 is unity. The range is –100 through +100.

�� Shadows: Lets you selectively lighten or darken shadow detail. Raising this value 
retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 
is unity. The range is –100 through +100.

�� Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-
dynamic-range media by lowering this parameter, and achieves a smooth blend 
between the retrieved highlights and the unadjusted mid tones for a naturalistic result. 
0 is unity. The range is –100 through +100.

Auto Correction in the Primaries Mode Controls
The Auto Color button provides a quick way to automatically balance the blacks and whites of a 
clip based on the current frame at the position of the playhead. DaVinci Resolve looks for the 
darkest levels in the image to neutralize the RGB color balance in the blacks, and the brightest 
levels to neutralize the RGB color balance in the highlights. Furthermore, Master Lift and Master 
Gain are adjusted to maximize image contrast at the outer boundaries of 0 and 100 percent. 
Using this control with the Primaries Bars mode open makes it easier to see what’s been 
changed after these automatic adjustments are made.

The Log Mode of the Color Wheels Palette
The Shadow/Midtone/Highlight color balance and Master Wheel controls operate 
independently of the Lift/Gamma/Gain color balance and Master Wheel controls found in the 
Primaries mode. While the Log mode uses the same types of controls as the Primaries mode, 
the way each control affects the image is very different. 

To switch between the Primaries and Log modes of the Color Wheels:

Choose an option from the mode pop-up, click the right mode button, or press Option-Z.

Log color wheels, with behavior that is very different from the Primaries mode color wheels

There are two ways of using the Log mode controls. The first takes advantage of the way these 
controls work to make fast, filmic adjustments to log-encoded media while it’s normalized by 
LUTs or manual adjustments added after it in the image processing pipeline.

The other way of using the Log controls is to take advantage of the more restrictive, but 
adjustable tonal range of the Shadow/Midtone/Highlight controls to stylize normalized clips by 
tinting specific regions of the image.
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Using the Log Mode Controls to Grade Log-Encoded Media
The Log controls are so named because they’re designed to work specifically with media with 
Log-C or similar gamma and color encoding, derived from the Cineon Log gamma curve, 
developed by Kodak to digitally store flat-contrast, wide-gamut image data that preserves 
image detail with a wide latitude for adjustment. 

An example of a log-encoded clip

The same clip after being normalized

You can debayer most raw formats to a log-encoded image in order to derive the maximum 
amount of image data and adjustable latitude from that source (For more information, see 
Chapter 4, “Camera Raw Settings,”). However, the resulting image needs to be normalized to 
occupy the final range of color and contrast that you intend for the final result. 

Whether or Not to Use Legacy Log Grading Ranges and Curve

DaVinci Resolve 12.5 introduced a modification to the Log grading controls that 
provides smoother, more pleasing results using the same controls. To maintain 
backward compatibility with older projects, a “Use legacy Log grading ranges and 
curve” checkbox in the General Options panel of the Project Settings lets you switch 
your project between the older Log control behavior and the newer one. Older 
projects that are opened in DaVinci Resolve have this checkbox turned off by default, 
while new projects have this turned on by default.
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You can do this one of two ways:

�� You can make a very careful curves adjustment in a second node to stretch the log-
encoded out to fit the contrast profile you want. By making this adjustment in Node 2, 
you make room for a customizing adjustment made using the Log controls in Node 1, 
prior to the normalization adjustment. This is key.

�� You can also apply a 1D Output or 3D LUT to the first node of a clip to normalize the 
image. This is a faster, if less flexible operation, but a smooth tonal range may be easier 
to obtain. Since a LUT applied within a node is always the last adjustment within that 
node’s order of operations, you can also use Node 1’s Log controls to customize the 
look of the footage.

In either case, it’s important that the normalizing adjustment happens after your Log control 
adjustments, for the Log control adjustments to work as they should. With your node tree set up 
in this way, you’ll be monitoring an ordinary-looking image, but taking advantage of the Log 
mode controls’ unique tonal ranges to manipulate the log-encoded image data with great 
specificity. 

When using the Log mode controls, here’s a workflow to consider as you learn how they work:

�� First, use the Offset master wheel to set the black point, and use the Contrast and Pivot 
parameters to stretch or compress contrast as necessary to achieve the tonal range 
you require.

�� Second, use the Offset color balance control to adjust the overall color balance of the 
image to your liking.

�� Third, use the Shadow/Midtone/Highlight color balance and Master Wheel controls 
to make specific, targeted adjustments to the color and contrast of the image in tonal 
ranges that match where that data is in the log-encoded image.

Working in this way, you’ll find that adjustments made with the Offset color balance and Master 
Wheel controls and Contrast controls control the log-encoded image very nicely to create an 
overall adjustment, while the Shadow, Midtone, and Highlight controls allow you to fix specific 
issues, such as shadow balance and density, after your main adjustment has been set.

The following illustration shows an approximation of how the default ranges of the Shadow, 
Midtone, and Highlight controls divide the tonal range of a log-encoded image. 

This graphic shows the tonal range of each of the Log controls 
when used with a log-encoded image

As you can see, when used with a log-encoded image the color interactions between each 
adjustment overlap very softly, while still allowing more specific adjustments than those made 
by the Lift/Gamma/Gain controls.
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Furthermore, the boundaries of the Shadows, Midtones, and Highlights Log controls can be 
customized using the Low and High Range parameters. This gives you added flexibility to apply 
more specific contrast and color adjustments.

Once you’ve made an adjustment using Log mode controls along with a normalizing LUT or 
curve adjustment, you can always apply additional nodes and use the Primaries mode of the 
Color Wheels palette to make further alterations to the now normalized image, working as you 
normally would with any of the other tools in DaVinci Resolve.

Using the Log Mode Controls to Stylize Normalized Media
You can also use the Log mode controls on normalized images. Although the results you get 
will be somewhat different, this can be a fast way to create interesting stylizations. Whereas the 
broadly overlapping tonal ranges of the Lift, Gamma, and Gain color balance controls allow 
subtle adjustments to be made very easily, the Log palette’s color balance controls affect much 
more restrictive tonal zones that overlap much less when used on normalized images.

The following illustration shows an approximation of how the Shadows, Midtones, and 
Highlights, by default, divide the tonal range of the image into non-overlapping thirds. As you 
saw in the previous section, these divisions were originally intended to map to log-encoded 
media. However, with normalized media these divisions provide a different, and potentially 
useful, set of ranges from the Primaries mode controls. 

This graphic shows the tonal range of each of the Log controls with the 
additional low and high range to expand or contract the range

With normalized media, the Shadows really do only affect the darkest shadows, falling off at 
approximately the bottom third of image tonality. The Midtones affect only the middle third of 
grays, and the Highlights affect the brightest top third of image values. However, these default 
ranges of image tonality can be adjusted using the Low Range and High Range controls, which 
are described in more detail later.

The following image shows the default interaction of extreme corrections made to a grayscale 
image using the Log mode controls. The Shadows have been pushed toward green, the 
Midtones have been pushed toward blue, and the Highlights have been pushed toward red.

Extreme adjustments showing the overlap of the Shadow, 
Midtone, and Highlight color balance controls

Shadows Midtones Highlights

High RangeLow Range
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As you can see, with normalized media the color interaction between each adjustment is very 
subtle. The darkest shadows end up bright green, the midtone values are vivid blue, and the 
highlights are almost pure red. This restrictiveness is useful when you want to limit a correction 
to a specific tonal range within the image without needing to use a Luma qualifier. It’s also quite 
useful for making bold, stylistic color adjustments when creating a non-naturalistic look.

Adjusting Tone Ranges In Log Mode
Two parameters let you modify the range of Shadows and Highlights that each Color Balance 
control affects, in turn narrowing and widening the range of Midtones. Keep in mind that while 
the ranges can be customized, the amount of overlap between each range cannot.

�� Low Range: Moves the border where the Shadows and Midtones meet. Lowering 
this parameter widens the range affected by the Midtones, and narrows the range 
affected by the Shadows. Raising this parameter narrows the Midtones and widens 
the Shadows.

�� High Range: Moves the border where the Midtones and Highlights meet. Lowering the 
High Range parameter narrows the range affected by the Midtones, and widens the 
range affected by the Highlights. Raising this parameter narrows the Highlights and 
widens the Midtones.

There are also Saturation and Hue parameters which mimic these settings found within other 
palettes and modes.

Adjusting Contrast in Log Mode
When using the Log mode controls, your primary tools for adjusting image contrast will usually 
be the Offset master wheel and Contrast and Pivot parameters. Using these three controls, you 
can set a black point and adjust the overall contrast very quickly.

The Shadow, Midtone, and Highlight master wheels let you adjust image lightness within the 
same restrictive ranges of image tonality that are defined by the Low Range, High Range, and 
Pivot parameters. These adjustments should appear smooth, if somewhat narrower then the 
Lift/Gamma/Gain controls, when used with log-encoded media. However, when used with 
normalized images, severe adjustments made with one master wheel may not always make a 
smooth transition to the next adjacent range of image lightness.

Log Offset Color and Master Controls
The Log controls also share the same Offset color balance and Master Wheel controls that 
appear in the Lift/Gamma/Gain mode of the Color Wheels palette (which are tied to the Offset 
controls of the Primaries palette). 

�� The Offset color balance control: Works as a simultaneous adjustment to all three 
Offset sliders located in the Primaries palette; adjustments made to the Offset color 
balance control also alter the Offset sliders. Used subtly, this makes it easy to neutralize 
color imbalances in the darkest part of the image, while simultaneously rebalancing 
every other part of the image. Used more dramatically, this control makes it easy to add 
a color wash throughout the entire image.

�� The Offset wheel: Acts as a global adjustment to image lightness, an operation 
sometimes referred to as setup, raising or lowering all YRGB channels together.

NOTE: Because these controls are so restrictive when used with normalized images, 
it’s easy to create solarization effects by raising the shadows to be higher than the 
Midtones, or lowering the Highlights to fall below the Midtones, to give two examples.
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Switching to Log Mode Using the DaVinci Control Surface
You can switch to the Log grading mode of the currently selected node by doing one of the 
following:

�� Press SHIFT DOWN and then PRIMARY.

�� Press the LOG soft key on the Center panel of the DaVinci control surface. Press the 
MAIN soft key to return to the more traditional Lift/Gamma/Gain mode of adjustment.

The Primaries Bars Mode of the Color Wheels Palette
The Primaries Bars palette contains the original set of DaVinci Resolve color adjustment sliders. 
These sliders serve two uses. First, they’re highly visible indicators of the individual YRGB 
channel adjustments that are made using the trackballs, rings, and knobs of a control surface. 
Second, they provide control of individual YRGB Lift/Gamma/Gain parameters using a mouse, 
tablet, or trackpad.

Primary grading controls

RGB Lift/Gamma/Gain Sliders
The main controls of the Primaries Bars mode are the individual Luma (or Y), Red, Green, and 
Blue sliders, four each for Lift, Gamma, and Gain. These sliders correspond to a set of knobs on 
the POTS page of the DaVinci control surface, and provide precise Lift/Gamma/Gain style 
control over each of the YRGB channels of the image. When used in conjunction with a Parade 
Scope video analysis of the image, these controls can enable you to fix irregular color 
imbalances in specific channels quickly.

Additionally, the Luma (Y) Lift/Gamma/Gain sliders correspond to the three knobs arranged 
vertically to the left of the Center panel of the DaVinci control surface. These three controls 
allow easy Y-only adjustments to contrast, where an increase in contrast results in perceptually 
diminished color saturation. 

Making Y-only adjustments to contrast is a great way to increase contrast when you’re going for 
muted saturation or a gritty look. This kind of adjustment is also useful in situations where you’re 
trying to increase shadow density without increasing image colorfulness.

Four Master Wheel controls appear underneath each group of Lift/Gamma/Gain sliders. 
The first three of these controls are identical to the Lift/Gamma/Gain master wheels in the 
Primaries mode of the Color Wheel palette, and control YRGB contrast, while the fourth is 
identical to the Offset master wheel found in the Log mode of the Color Wheel palette.

Finally, each group of Lift/Gamma/Gain sliders has its own reset button. To reset individual 
channels, double-click the single-letter label underneath that slider.
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To adjust RGB Lift/Gamma/Gain using the DaVinci control surface:

1	 Press the POTS soft key on the main page of the Center panel.

2	 Use the variously identified LUM/RED/GREEN/BLUE and OFFSET/BLACK/GAMMA/
GAIN knobs to make the required adjustments.

3	 Press the MAIN soft key to return to the Center panel’s main page.

Offset Sliders, Offset Wheel, and Printer Points
These vertical sliders mirror the settings of the Offset color balance controls in the Color Wheel 
palette, except that they provide individual control over the Red, Green, and Blue color 
channels. When you drag one of the Offset sliders up or down, you raise or lower that color 
channel in its entirety, which can be useful for adjusting color channels that are particularly 
problematic, or for imposing the kind of traditional linear color adjustments that color timers of 
film have employed for decades. In fact, many colorists consider the simplicity of these controls 
a virtue, and embrace the slight shadow or highlight contamination that can result from color 
balancing in this linear way as a hallmark of traditional cinema color adjustment.

Offset RGB and master controls

Adjusting Printer Points in the Primaries Bars Palette 
Each Offset slider also has a pair of arrow buttons, one at the top and one at the bottom. 
These buttons provide “Printer Point” adjustment of these values, which let you adjust each 
Offset channel in discrete increments. Printer Points can be useful for projects that have tight 
integration with a film lab, and are designed to emulate color adjustments made using 
optical printers.

NOTE: Unlike the other Color Wheels control adjustments described in this chapter, 
the Offset controls do not use the Lum Mix parameter to control whether individual 
adjustments to the R, G, or B channels result in automatic adjustments being made to 
the other two color channels in order to maintain constant Luma levels. All Offset and 
printer points adjustments made to a specific color channel affect only that 
color channel.
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The “plus” and “minus” red, 
green, and blue buttons for 
making printer point adjustments

The Offset wheel control underneath the Offset sliders lets you adjust all three sliders at once, 
performing a setup adjustment. The Offset sliders, Printer Point buttons, and Offset wheel can 
be adjusted using the DaVinci control surface.

Adjusting Printer Points Using the DaVinci Control Panel
The DaVinci Resolve Advanced and Mini color grading panels have support for adjusting printer 
points using rotary controls for the Red, Green, and Blue channels, as well as All 
channels together.

To adjust the Offset sliders individually using the DaVinci Resolve Advanced or Mini panels:

Use the MASTER OFFSET, RED OFFSET, GREEN OFFSET, and BLUE OFFSET knobs on 
the main page of the Center panel.

If you have the DaVinci Resolve Advanced panel, there are dedicated printer points buttons 
you can use.

To adjust Offset Printer Points using the DaVinci control surface:

1	 Press the PRINTER LITES soft key on the main page of the Center panel to display the 
Printer Points controls page on the Transport panel.

2	 Use the + and – MASTER, RED, GREEN, and BLUE buttons that appear on the 
Transport panel.

3	 Press PRINTER LITES again to return the Transport panel controls to their 
previous state.

There’s also a special set of keyboard shortcuts, mapped to the numeric keypad of an 
extended keyboard, that lets you make Printer Point adjustments in discrete 
increments, adding or subtracting a point at a time.

Adjusting Printer Points Via Keyboard Shortcuts
One of the best ways of using printer points if you don’t have a color control panel that supports 
them is to enable the numeric keypad to use dedicated keyboard shortcuts just for 
printer points.

To use the Printer Lights Hotkeys:

Choose Color > Printer Lights Hotkeys, or press Option-Command-Grave Accent (`)
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When you enable Printer Lights Hotkeys, there are two sets of shortcuts you can use to 
manipulate printer points. First, if you want to directly manipulate RGB, there’s one set for that.

Red Green Blue

7 - Plus Red 8 - Plus Green 9 - Plus Blue

4 - Minus Red 5 - Minus Green 6 - Minus Blue

However, if you want to work in the classic way by manipulating cyan, magenta, and yellow, 
there’s another set of shortcuts for that, using the remaining keys on the numeric keypad.

Cyan Magenta Yellow

1 - Plus Cyan 2 - Plus Magenta 3 - Plus Yellow

Minus (–) - Minus Cyan 0 - Minus Magenta Period (.) - Minus Yellow

The increments used by the Printer Point buttons are defined by the Printer Light Step 
Calibration parameters, found in the Color panel of the User Preferences. The default settings 
are designed to emulate traditional film printer adjustments, but these settings can be 
customized to align DaVinci Resolve’s printer points adjustments with those of a particular film 
lab’s equipment. However, if you’re not working with a lab, you can change the Step and 
Density settings to alter how much of an adjustment each printer point makes. For more 
information, see Chapter 3, “Project Settings and Preferences.”

Controls in the Color panel of the User Preferences to 
adjust Printer Point functionality

There are also a pair of keyboard modifiers that gives you finer control over printer points 
adjustments made with these special keyboard shortcuts, while retaining the coarser default 
adjustments that let you make bigger changes more quickly:

�� Hold down Command while using these key shortcuts to adjust printer points in 
half‑increments. 

�� Hold down Shift-Command while using these key shortcuts to adjust printer points in 
quarter increments.

TIP: If you’re feeling left out because all the cool kids are using printer points and 
you’re unfamiliar with them, making the Parade scope visible is a great way to learn 
how these adjustments work while seeing their specific effects on the red, green, and 
blue channels of the video signal.
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RGB Mixer Palette
The RGB Mixer palette lets you remix different amounts of image data from one channel to 
another, and has a wide variety of creative and utilitarian uses. Furthermore, the RGB Mixer can 
be used either to remix the color channels, or to add different proportions of each color channel 
into a monochrome image.

RGB Mixer palette

By default, the RGB Mixer palette is set to mix any amount of the Red, Green, and Blue color 
channels into any of the other channels. Each color channel has a dedicated control group of 
Red, Green, and Blue sliders that you use to do the mixing, and the default values of these can 
be seen in the screenshot above.

Each slider has an overall range of -2.00 to +2.00. This means that you also have the option of 
subtracting any combination of color channel values from a particular channel. For example, you 
can lower the Red control group’s Green slider to -.24 to subtract 24 percent of the Green 
channel from the Red channel.

Preserve Luminance
With the “Preserve Luminance” checkbox turned on, any channel adjustment you make is 
prevented from altering the luma of the image by automatically raising or lowering the other two 
channels to compensate. In the following example, you can see that when “Preserve 
Luminance” is turned on, lowering the Green control group’s Green slider results in the Red and 
Blue channels being raised by the same amount (as seen in the Parade scope). Conversely, 
raising a color channel’s slider ends up lowering the other two channels by the same amount to 
keep overall image luminosity the same.

The result of an RGB Mixer adjustment with “With luminance level preserved” turned on.  
You can see that lowering the green channel slider also raises red and blue.
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Resetting the RGB Mixer
Clicking the Reset button at the top right-hand corner of the RGB Mixer resets each slider to its 
default position, where Red = 1.00 for Red output, Green = 1.00 for Green output, Blue = 1.00 for 
Blue output, and all other sliders = 0.

Swap Channels Buttons
A set of three buttons at the bottom of the RGB Mixer lets you easily swap two channels with 
one another. This can be useful as part of a creative look, or corrective in instances where two 
channels are accidentally reversed.

�� Swap Red and Green: Swaps these two color channels.

�� Swap Green and Blue: Swaps these two color channels.

�� Swap Red and Blue: Swaps these two color channels.

Using the RGB Mixer in Monochrome Mode
When you turn on the Monochrome checkbox, two of the sliders within each Output group are 
disabled. This leaves the Red > Red slider, the Green > Green slider, and the Blue > Blue slider 
as the only available controls.

Sliders at their default values when “To monochrome” is enabled

Keeping in mind that each of the color channels that makes up an image is itself a grayscale 
channel, the RGB sliders in Monochrome mode let you add different proportions of the Red, 
Green, and Blue color channels together to create custom grayscale versions of a shot.

To understand why this is useful, let’s consider the default values of the Red, Green, and Blue 
sliders. To emulate the human eye’s sensitivity to the wavelengths of light, the Rec. 709 video 
standard defines an isolated Luma (Y’) component as consisting of 0.2126 of the Red channel, 
0.7152 of the Green channel, and 0.0722 of the Blue channels added together. This can be 
seen in the default values (rounded to the nearest integer percentage) of 21, 71, and 7.

This is the standard method of deriving a black and white version of a color image, and in fact 
produces identical results to those obtained by setting the Saturation parameter to 0. 

However, there have traditionally been other ways of mixing the colors of life into different 
grayscale interpretations. For example, photographers often use colored filters in conjunction 
with black & white film stocks, such as a yellow/green filter to emphasize pleasing skin tone for 
lightly-complexioned people. A much older example is the use of black & white film stocks with 
different sensitivities (old orthochromatic stocks were not sensitive to red wavelengths, 
recording only blue and green to create an image).



738

P
ri

m
ar

y 
G

ra
d

in
g

 C
o

nt
ro

ls
 

P
ar

t 
6

 –
 4

2

Using the RGB Mixer with “To monochrome” turned on gives you the ability to mix your own 
custom blends of all three color channels to emphasize the creative characteristics you require. 
For instance, increasing the mix of blue and decreasing red and green can give skin tones a 
darker, metallic sheen. The following screenshots show multiple versions of the same image 
with different monochrome mixes.

Three monochrome mixes of the same image. The top 
image is the result of setting saturation to 0.

Like the parameters in Color mode, you can use the RGB Mixer’s Monochrome mode to 
subtract one color channel from the others, for even more creative effects.
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RGB Mixer Controls on the DaVinci Control Surface
All of the RGB Mixer palette controls are available from the DaVinci Resolve control surface.

To open the RGB Mixer curve controls on the DaVinci Resolve control surface:

Press the CURVES soft key on the main page of the Center panel.

To exit the RGB Mixer curve controls:

Press the MAIN soft key on the Center panel.

To adjust the principle color regions using knobs:

�� Adjust one of the four groups of knobs on the Center panel. All are labeled to 
identify which RED/GREEN/BLUE source channels are paired with RED/GREEN/BLUE 
destination channels. For example GREEN->BLUE adds or subtracts an amount of the 
Green color channel from the Blue color channel.

�� Press the PRESERVE LUM soft key to turn on the “With luminance level 
preserved” checkbox.

�� Press MONO to turn on the “To monochrome” checkbox.

�� Press COLOR to turn off the “To monochrome” checkbox.
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Chapter 43

Curves
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Curves
The Color page has a powerful curves interface that provides controls for adjusting color and 
contrast with the Custom Curves, as well as a variety of “Hue” or “HSL” curves that let you make 
more targeted adjustments to hue, saturation, and luminance in a variety of ways.

Introduction to Curves	 742

Adjusting Curves Using the Mouse	 742

Sampling Images to Place Control Points on Curves	 744

Showing Picker RGB Values	 744

Custom Curves	 745

Editing the Top and Bottom Control Points of Curves	 746

HDR Grading Using Curves	 747

Enabling Editable Splines in the Custom Curves	 747

Adding Default Anchors to the Custom Curves	 748

Ganging and Unganging Custom Curves	 748

Copying Custom Curves From One Color Channel to Another	 749

Curve Intensity Sliders	 749

YSFX Sliders	 750

Adjusting Custom Curves with the DaVinci Control Panel	 750

Soft Clip	 752

Ganging and Unganging Soft Clip Controls	 753

Soft Clip Controls	 754

Using Soft Clipping Controls with the DaVinci Control Panel	 757

The HSL Curves	 757

Image Sampling for Hue and Sat Curves	 759

Additional Controls in the Hue and Sat Curves	 759

Hue vs. Hue	 759

Hue vs. Sat	 760

Hue vs. Lum	 760

Lum vs. Sat	 761

Sat vs. Sat	 761

Using HSL Curves with the DaVinci Control Panel	 762
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Introduction to Curves
The Curves palette, selectable via one of the toolbar buttons above the Center Palette panel of 
the Color page, has six modes that provide different curve-based methods of manipulating the 
color and contrast of an image. Each curve lets you adjust a customizable region of the image 
based either on image tonality (zones of lightness or darkness), hue (specific colors), or 
saturation (intensity of color). All curves can be adjusted using either the pointer, or knobs on 
the DaVinci control panel.

Adjusting Curves Using the Mouse
All Color curves in DaVinci Resolve use the following controls for basic on-screen adjustment 
using the pointer, controlled either with your mouse, pen, or other input device of choice.

Methods of adjusting curves using the on-screen interface:

�� To add a control point: Click anywhere on or around a curve. A control point is added 
at the position of the mouse where you clicked, and the curve is altered, if necessary, to 
match the new control point’s position.

�� To add a control point without altering the curve: Hold the Shift key down, and click 
anywhere on or around a curve. A control point is added to the curve at the position of 
the pointer where you clicked, but the curve is not altered.

�� To snap a control point to the neutral diagonal of the curve: (Custom curve only) Hold 
the Option key down while dragging any control point on the curve. A diagonal line 
appears indicating the neutral state of the image, and the control point will snap to it. 
When you release the Option key, the diagonal guide line disappears.

Snapping a curve’s control point back to its neutral position by 
holding down the Option key

�� To remove a control point: Right-click any control point to make it disappear.

�� To reset a single color channel curve to a completely neutral setting: Click the reset 
button to the right of that color channel’s intensity slider.

�� To reset all color channel curves: Click the Reset Custom Curve button at the upper 
right-hand corner of the Curves palette.

TIP: All curves in DaVinci Resolve can be used to affect the overall image, or limited to 
affect only a specific portion of the image as a part of a secondary operation using 
Qualifiers, Windows, Imported Mattes, or any combination of the three.
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By default, a control point influences the portion of each curve that falls between its 
neighboring two control points. 

Control point adjustments affect the entire portion of a curve 
between adjacent control points.

In the screenshot to the left, you can see that the control point at the position of the pointer is 
affecting the larger part of the curve that falls between the lower left-hand control point (which 
is there by default), and a user-created control point placed up within the highlights of the curve.

In the screenshot to the right, an additional control point to the left of the one being adjusted 
limits the area of the curve that is adjusted. By careful placement of additional control points, 
you can make extremely targeted adjustments to images using the Custom curves. 

This example highlights the importance of using control points to “lock off” portions of a curve 
at a neutral or nearly neutral position to prevent changes to specific portions of an image, even 
while using other control points to make changes. 

NOTE: The HSL curves also have an optional adjustment mode using Bezier curves 
that will be covered in those sections.
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Sampling Images to Place Control Points on Curves
Another way you can add control points to curves is to move the pointer to the Viewer, and click 
to sample a color value and place a control point at the position on the currently open curve 
that corresponds to that value. This works with Custom, Hue, and HSL curves. 

Clicking on a feature of the image 

Creates a control point on the currently open curve

Showing Picker RGB Values
While you’re dragging the pointer over the Viewer and looking for a feature to sample, you can 
enable a tooltip that shows you the RGB Value of the pixel under the pointer by right-clicking 
the Viewer and choosing Show Picker RGB Value to toggle this feature on and off. When you 
turn this feature on, the View > Show RGB Picker Values In submenu has options for displaying 
either 8- or 10-bit tristimulus values.

The color picker tooltip that appears when you 
turn on show RGB Picker Values
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Custom Curves
DaVinci’s Custom curves provide smooth adjustment of each clip’s Y, R, G, and B channels. 
The Custom curve mode of the Curves palette is divided into two areas, the Curve Editor to the 
left, and the Curve controls to the right. The editor contains the actual Curve controls you use to 
adjust the image. The controls at the right let you choose which curves you’re adjusting, and 
adjust their intensity.

The Custom curves seen used to create a gentle “S” curve adjustment 
with four additional control points added; the middle point is selected

The Custom curves are useful for making more tonally specific, channel-by-channel 
adjustments to an image than can be accomplished using the Color Balance controls. 
They’re also useful for making strange and wonderful stylistic adjustments through unusual 
alterations to different combinations of color channels.

Although the ganged Custom curves appear to be a single curve control, starting in version 12 
the Custom curve editor is presented as a series of overlaid curves, and the YRGB curves all 
appear within a single editor. The default, neutral position of the Custom curves is a diagonal 
line that runs from the lower-left black point of the image through the upper-right white point. 

The neutral diagonal position of the curve at which no adjustment is made

The horizontal axis represents the range of image tonality in the original image, from black (at 
the left) to white (at the right), while the vertical axis represents the range of alteration you can 
make. By adding control points to the surface of the curve and raising or lowering it at different 
regions, you are actually remapping the original horizontal “input” value of a color channel to an 
“output” value of your choosing.

Additional controls appear to the right of the curve editor itself. A top row of buttons let you 
select the curve corresponding to an individual color channel for isolated adjustment, while a 
vertical stack of four sliders let you adjust the intensity of each color channel’s curve.
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The channel-editing buttons and curve intensity 
sliders appear to the right of the curve editor

Editing the Top and Bottom Control Points of Curves
You can also edit curves using the default two control points that the curve control starts out 
with in the Curve Editor. The Black Point control (at the lower-left) and the White Point control (at 
the upper-right) let you expand and compress the video signal similarly to using the Lift and 
Gain Master Wheel controls in the Color Wheels palette. 

The Curve control a  t its original state,

The Black and White Point controls dragged to the right 
and left to expand the signal

You can use the Black and White point controls in the following ways:

�� Using the Black Point control: Dragging this control up makes a lift adjustment to raise 
the black point of the signal. Dragging this control to the right makes a lift adjustment to 
lower the black point of the signal.

�� Using the White Point control: Dragging this control down makes a gain adjustment 
to lower the white point of the signal. Dragging this control to the left makes a gain 
adjustment to raise the white point of the signal.
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HDR Grading Using Curves
When using various grading controls in the Color page to grade wide-latitude images for HDR 
output, you may find it useful to enable the HDR Mode of the node you’re working on by 
right-clicking that node in the Node Editor and choosing HDR Mode from the contextual menu 
(only available in Resolve Studio). 

Using a node’s contextual menu to put that node into HDR mode

This setting adapts that node’s controls to work within an expanded HDR range. Practically 
speaking, this makes it easier to work with wide-latitude signals using controls that operate by 
letting you make adjustments at different tonal ranges such as Lift/Gamma/Gain, Custom 
Curves, Soft Clip, etcetera.

Enabling Editable Splines in the Custom Curves
When the Curve palette is in Custom mode, you can choose Editable Splines from the option 
menu to expose Bezier spline handles on any selected control point, which let you make more 
precise curve adjustments whenever necessary.

Custom Curve with editable splines enabled

NOTE: Beware of making curve adjustments that are too sharp, or with control points 
that are too close together, as they can introduce unwanted contouring within the 
image, causing flattening or solarization in parts of the image that you may not want.
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Adding Default Anchors to the Custom Curves
You can also choose Default Anchors from the option menu of the Curve palette in Custom 
mode to place three additional control points on the curve, dividing the curve into five 
segments that affect the shadows, low midtones, medium midtones, high midtones, and 
highlights of the image.

Custom curve with Default Anchors exposed

Ganging and Unganging Custom Curves
By default, the Custom curves are ganged, so that curve adjustments affect a clip’s YRGB 
channels all together, resulting in an adjustment to image contrast that’s similar to using the 
Master Wheels in the Color Wheels palette, or the ring controls of the DaVinci control panel. 
When making this type of adjustment, increasing contrast also increases image saturation, while 
reducing contrast also reduces image saturation. Since curves can be manipulated with greater 
specificity than the three Master Wheels, you can make much finer contrast adjustments using 
the YRGB curves than when using the Master Wheels only.

Turning ganging off lets you use the full power of Custom curves to alter the image. Unlike the 
Color Balance controls, each of which adjust all three color channels simultaneously, the Curve 
controls let you adjust each channel individually when Gang Custom Curves is turned off. 

To disable Custom curve ganging:

Click the Curve Edit button that corresponds to the curve channel you want to edit. 
Clicking any Curve Edit button highlights that curve to make it easy for editing when 
curves overlap one another. Once one or more curves is offset from the others, you 
can freely edit any curve by dragging its control points.

Custom Curve Edit buttons are to the left, 
the Gang button is to the right

To re-enable Custom curve ganging:

Click the Gang button to the right of the Curve Edit buttons.



749

C
ur

ve
s 

P
ar

t 
6

 –
 4

3

Editing color channels via individual curve adjustments lets you make smooth color-channel 
specific corrections, or you can make radically individual adjustments to create a wide number 
of creative effects.

Turning off curve ganging lets you independently adjust each curve

Copying Custom Curves From 
One Color Channel to Another
Even if you’ve unganged the Custom curves, you can still mirror one curve’s adjustments to 
another by copying it using the “Copy to Red/Green/Blue” commands in the Curve palette’s 
option menu. 

Curve Intensity Sliders
Four Curve Intensity sliders to the right of the Curve Editor, one for each channel, let you mix 
between the current curve’s effect on the clip, and the original state of the image before you 
altered the curve. The default Intensity of 100 results in that curve exerting its full effect on the 
image, while an intensity of 0 results in that curve having no effect on the image. The Intensity 
sliders provide an easy way to “split the difference” between a curve adjustment and the 
previous state of the image.

Lowering the Curve Mix slider 
reduces the effect of that curve’s 
adjustment on the image.

TIP: When curve ganging is disabled, the Luma curve allows you to adjust the Y 
channel by itself, which is similar to using the Y-only Lift/Gamma/Gain knobs of the 
DaVinci control panel. When making this type of adjustment, increasing luma contrast 
results in a perceptual decrease of image saturation.
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YSFX Sliders
Each of the Custom curves (Y’, R, G, and B) has a vertical YSFX slider at the upper left-hand 
corner of the Curve Editor that lets you invert any or all color channels by any amount you want, 
to create different types of stylized effects.

Image with the Luma channel modified using the vertical YSFX slider

As with all other adjustments in the Color page, YSFX may be combined with Power Windows 
or HSL qualification to limit channel inversions to specific portions of the image for 
creative purposes.

Adjusting Custom Curves with 
the DaVinci Control Panel
The controls that correspond to the Custom curves on the DaVinci control panel are available 
by default when you first open DaVinci Resolve (the rotary knobs on the Center panel will be 
labeled PRIMARIES). If these buttons are not visible, you need to switch to the Primaries 
controls using the soft keys.

To open the Primary Curve controls of the DaVinci Resolve control panel:

�� Press the PRIMARIES soft key on the Center panel.

�� If the Center panel is currently in CURVES mode, then press the MAIN soft key on the 
Center panel.

The rotary knobs on the Center panel update to show the CHANNEL OFFSET/CUSTOM 
CURVES and YSFX controls.
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To make curve adjustments:

Adjust the 0% LUM, 20% LUM, 40% LUM, 60% LUM, 80% LUM, or 100% LUM 
rotary knobs.

By default, all adjustments you make using these controls are ganged across all four YRGB 
curve controls. However, if you turn Custom curve ganging off, then these controls only affect 
the Luminance curve.

These controls correspond to the following default control point positions on the 
Curve controls.

Each rotary curve control on the DaVinci control surface 
corresponds to one of these six default control point positions

You also have the option of using the fourth trackball from the left to adjust individual control 
points on curves to any position you like. This works for all curves in DaVinci Resolve that have 
control surface mappings.

Methods of selecting and adjusting individual control points 
using the master trackball of the Center panel:

�� To select a control point to adjust: Spin the fourth ring control to the left or right to 
select the next control point in that direction (it takes about half of a turn to select 
another control point).

Selected control points are highlighted in cyan.

�� To move a selected control point: Adjust the fourth trackball to move the control point 
up, down, left, or right. Selected control points are constrained between whichever 
control points are to the left and right.

Another set of rotary knobs let you adjust Curve Mix and YSFX parameters.

To adjust the Curve Intensity sliders:

Adjust the LUM CURVE, RED CURVE, GREEN CURVE, or BLUE CURVE rotary knobs.

To make YSFX adjustments:

Adjust the LUM YSFX, RED YSFX, GREEN YSFX, or BLUE YSFX rotary knobs. 
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Soft Clip
The Soft Clip controls consist of four sliders underneath the Curve controls of the Custom 
curves, and give you an interface for adjusting highlight and shadow soft clipping either overall, 
with Ganging enabled, or on a per-channel basis. The Soft Clip controls are intended to provide 
clip-by-clip adjustment, as opposed to the Generate Soft Clip LUT settings, which let you set 
one soft-clipping setting for the entire program. For more information on the Soft Clip LUT 
setting, see Chapter 3, “Project Settings and Preferences.”

High and Low Soft Clip controls within the Curves palette

Soft clipping lets you apply a “knee” to any clipping that occurs at the upper or lower extremes 
of the image, and can be used to quickly ease off any unpleasantly harsh loss of detail that 
occurs as a result of blowing out the highlights or crushing the shadows too aggressively.

In the following example, the screenshot at top has had the highlights deliberately blown out by 
excessively boosting the highlight contrast. As you can see, the edges of the clipped area lack 
detail. The screenshot at bottom shows the same image with soft clipping increased for all three 
color channels. The result retrieves detail, compressing the highlights to bring the tops of each 
color channel back within the allowable range.
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Using High Soft Clip to pull highlight details into the viewable range

Ganging and Unganging Soft Clip Controls
Soft clipping can be simultaneously applied to all three color channels by enabling the Ganging 
control (on by  default), or you can disable Soft Clip ganging to individually adjust each channel. 
For example, using soft clipping on individual channels can be useful for legalizing RGB 
out-of-gamut errors for channels that over or undershoot your QC standards.

To disable Soft Clip ganging and edit soft clipping for individual color channels:

Click the channel control button corresponding to the color channel you want to edit, 
and then drag the sliders to create the desired adjustment.

To re-enable Soft Clip ganging:

Click the Ganging control to the right of the Soft Clip channel controls.

TIP: Applying too much soft clipping to individual color channels may add an 
unwanted color tint to the corresponding highlights or shadows of an image. To avoid 
this, use the soft clipping parameters with ganging enabled to clip all three color 
channels equally.
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Soft Clip Controls
Whether all channels are ganged or not, soft clipping is controlled via two sliders and two 
additional parameters for each color channel.

High
The High Clipping Point slider lets you adjust the maximum signal level above which the signal 
is clipped. Any pixels above the clipping level are made equal to the clipping level. 

The High Clipping Point defaults to a digital level of 1023 relative to the DaVinci Resolve internal 
video scopes. Dragging this slider to the left causes the highlights of the image to clip at a 
lower level, resulting in lower, dimmer maximum levels. 

Selecting and adjusting the high clip 

RGB Parade displays the clipped image

At the default position, no clipping occurs and image data that you push above 1023 on the 
internal scopes is preserved and passed through the image processing pipeline to subsequent 
nodes. For example, in the following two screenshots, the highlights in the screenshot at top 
are blown out raising the gain dramatically in Node 1. In the screenshot at bottom, a subsequent 
adjustment in Node 2 lowers the gain and retrieves all the previously clipped values.
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Middle–the image is clipped using the Gain control in Node 2;   
Bottom–image data that was clipped in Node 1 is  retrieved in Node 3 by lowering 
the Gain control. This illustrates the preservation of deliberately clipped data.

However, if at any point in a node tree you drag the High Clip slider to the left, even by a single 
digit, all image data above the new clipping threshold is discarded from that node forward. In 
the following example, the High Clip slider in Node 1 is lowered. The result is that all clipped 
image data is discarded. As a result, when Node 2 lowers the gain, there is no image detail left 
to retrieve, and all three channels exhibit flattening.
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Lowering the High Clip slider in Node 1 forces all image data 
above the new High Clip threshold to be irretrievably  discarded. 
Clipped data cannot be brought back by subsequent nodes.

High Soft
The High Soft slider sets the threshold, below the clipping point, at which highlights begin to 
compress before hard clipping. At 0, no soft clipping occurs. As you raise this value, more and 
more of the clipped highlight values are compressed, rather than clipped, resulting in softer, 
more pleasant “glowing” highlights.

Low
The Low Soft Clipping Point slider lets you adjust the minimum signal level at which the signal 
clips. This defaults to a digital level of 0 relative to the DaVinci Resolve internal video scopes. 
Dragging this slider to the right causes the shadows of the image to clip at a higher level, 
resulting in lighter minimum levels, and a lower-contrast image with lighter (possibly 
milky) shadows.

Low Soft
The Low Soft slider sets the threshold, above the minimum clipping point, at which shadows 
begin to compress before hard clipping. At 0, no soft clipping occurs. As you drag this slider to 
the right, more and more of the clipped shadow values are compressed, rather than clipped, 
resulting in a softer, more pleasant rolloff in the shadows.

IMPORTANT: Image data that was clipped “in camera” is not necessarily retrievable 
using the Soft Clip controls, although there may be some preserved overhead in the 
super-white highlights of Y’CbCr-encoded video data.
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Using Soft Clipping Controls 
with the DaVinci Control Panel
The soft clipping controls can also be manipulated using the DaVinci control panel, which 
provides separate controls for ganged and individual color channels.

To open the soft clipping control on the DaVinci Resolve control panel:

Press the CLIPS soft key on the Center panel.

To exit the soft clipping controls:

Press the MAIN soft key on the Center panel.

To make a ganged soft clipping adjustment:

�� Adjust the MASTER CLIP or MASTER SOFT rotary knobs of the SCENE WHITE CLIPS 
or SCENE BLACK CLIPS control groups (there are 4 individual knobs).

�� These controls adjust all four corresponding YRGB High Soft, High Clip, Low Soft, 
or Low Clip parameters simultaneously.

To adjust soft clipping for individual color channels:

�� Adjust the RED/GREEN/BLUE CLIP or RED/GREEN/BLUE SOFT rotary knobs 
of the SCENE WHITE CLIPS or SCENE BLACK CLIPS control groups (there are 
12 individual knobs).

�� Each control adjusts an individual YRGB color channel.

The HSL Curves
Three sets of Hue curves, and one additional Lum vs. Sat curve, let you make different types of 
curve-based alterations to the image. Whereas the Custom curves let you make adjustments to 
the color channels of an image based on tonality (for example, boosting the Red channel in the 
highlights while lowering it in the shadows), the Hue curves let you make adjustments to the 
hue, saturation, or luma of elements in an image based on their hue.

Curves controls including six-vector selection and bezier handle button
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For example, you could use the Hue vs. Sat curve to selectively lower the saturation of 
everything that’s blue, while raising the saturation of everything that’s red.

You can use these curves to make adjustments similar to those made using HSL qualification, 
but with one critical difference. Curve adjustments are mathematically smoother than the 
matte-limited adjustments of HSL qualifiers, so it can sometimes be easier to make specific 
alterations that blend smoothly with the rest of the image, without the potential for artifacts at 
the edges of qualified keys that can sometimes defeat a seamless result. 

On the other hand, it is often easier to define more distinct boundaries between separate 
elements using HSL qualification. Only time and experience will help you determine which tools 
are best for which situations.

Right–Original image. Left–The image as altered by the Hue vs. Sat curve shown in previous page

Unlike the Custom curves, which default to a diagonal position where lower left represents the 
black point and upper right represents the white point, Hue and Sat curves are flat. In the case 
of the Hue vs. Hue/Sat/Lum curves, the horizontal range of the curve from left to right 
represents the overall range of possible hues, from red through green through blue and then 
cycling back to red.

Because the range of hues cycle smoothly from the left to the right edge, changes that affect 
the curve near the left boundary of these curves loop smoothly around to the right boundary, 
and vice versa, such that the left and right sides of the curve always move together (as you can 
see in the above screenshot).

IMPORTANT: When using Hue curves, the range of hue that you isolate with control 
points is always relative to the RGB input connected to that node. That means if you 
change the hue of a shirt from blue to red using Hue vs. Hue and you then want to 
raise the same shirt’s saturation with the Hue vs. Sat curve within the same node, you 
need to add control points to the same range of blue for both curves.
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Image Sampling for Hue and Sat Curves
There’s an additional way to use Hue curves in DaVinci Resolve. Whenever one of the Hue vs. 
Hue, Hue vs. Sat, Hue vs. Lum, and Lum vs. Sat curve tabs are open, clicking or clicking and 
dragging over any range of pixels within the Viewer area samples the hues and/or image 
tonality of that region of the picture, and automatically places three control points on the 
currently open curve that correspond to the range of color and contrast you sampled. This also 
works if you use the cursor from the DaVinci control panel with the fourth trackball to sample a 
range of color.

Additional Controls in the Hue and Sat Curves
While the Hue vs. Hue, Hue vs. Sat, Hue vs. Lum, and Lum vs. Sat curves can be adjusted 
similarly to the Custom curves, they have additional controls running underneath the curve graph.

�� Enable Bezier button: Turning this button on forces a curve to use Bezier control 
handles, rather than the default DaVinci Resolve Curve Control points, to manipulate 
each control point on the curve. With Bezier handles enabled, click any control point to 
reveal its two Bezier handles. Drag either handle to alter the shape of the curve at that 
control point.

�� Six-Vector Color Patches: The Hue curves each have six buttons for automatically 
adding control points to manipulate the red/yellow/green/cyan/blue/magenta ranges 
of hue. Clicking any of these buttons adds three control points; two to define the outer 
range of hue to be adjusted, and a middle control point that you use to make the 
adjustment.

�� Input and Output (Hue Rotate/Saturation/Lum) fields: These two numeric fields 
correspond to the horizontal and vertical adjustment values for the currently selected 
control point. Click any control point on a curve to view or alter these values. The label 
of the second field depends on the curve that’s selected.

The following sections describe each available curve in more detail.

Hue vs. Hue
The Hue vs. Hue curve lets you change any hue to any other hue. In the following example, the 
image at top is the unadjusted original. The image at bottom has had the magenta jacket shifted 
to an olive green via a set of three control points.

Changing the hue of the woman’s jacket using the Hue vs. Hue curve;  
Right–original image, Left–altered image

One excellent use of the Hue vs. Hue curve is to quickly and subtly alter elements that require 
only minor adjustments. For example, a sky that appears a bit too cyan can be made into a 
richer shade of blue with a small adjustment. 
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Hue vs. Hue is also useful for making more radical changes to elements that might be too noisy 
to key successfully using the HSL qualifier controls. For example, red autumnal foliage blowing 
in the wind might result in a chattery matte, but you can use the Hue vs. Hue curve to change 
reds to greens, without having to worry about aliased matte edges giving your correction away.

Hue vs. Sat
The Hue vs. Sat curve lets you selectively alter the saturation of any hue within the image. 
This is a terrific tool for creative effect, allowing you to quickly and easily boost the saturation of 
elements you want to catch the viewer’s eye, while reducing the saturation of elements you’d 
prefer the audience not dwell upon.

This can be extremely useful for legalizing over-saturated overshoots or undershoots during a 
QC pass. For example, desaturating reds that are off the charts while leaving everything 
else alone.

Lowering the saturation of the woman’s jacket using the Hue vs. Sat curve;  
Right–original image, Left–altered image

The Hue vs. Sat curve can also be a powerful tool for increasing the color contrast of images 
that seem lackluster and flat. By boosting the saturation of colorful elements that are distinct 
from the dominant palette of a scene, you can add variety to an otherwise 
monochromatic image.

Hue vs. Lum
The Hue vs. Lum curve lets you increase or decrease the lightness of elements of 
specific colors.

Darkening the woman’s jacket using the Hue vs. Lum curve;  
Right–original image, Left–altered image

This is a tricky curve to use with highly compressed footage, as it can quickly reveal artifacts in 
the image if you aren’t careful. However, if you’re working with very high-quality footage, this 
can be a great tool to darken specific hues to add richness and depth, or to lighten colorful 
elements to which you want to draw attention.
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Lum vs. Sat
The Lum vs. Sat curve is similar to the Custom curves in that alterations to the saturation of an 
image are based on user-definable ranges of image tonality, rather than hue. In the following 
example, the Lum vs. Sat curve is being used to decrease selectively the saturation of 
everything falling into the highlights and shadows of the image, while increasing the saturation 
of everything within the midtones.

In the following example, a vividly saturated treatment results in shadows that seem artificially 
colorful. Using the Lum vs. Sat curve, it’s easy to gradually desaturate everything below a 
certain range, with a nice smooth falloff.

This is an outstanding curve to use for creative effect, for example, slightly boosting saturation 
within the midtones while reducing saturation in the shadows to increase the depth of the 
darkest portions of the image. It’s also a great curve to use to solve QC violations. For example, 
if you have illegal saturation in the highlights of an image, you can use the Lum vs. Sat curve 
cleanly and smoothly to lower the specific values that are causing problems.

Selective desaturation in the shadows and highlights using the  Lum vs. Sat curve;  
Right–original image, Left–altered image

Sat vs. Sat
The Saturation vs. Saturation curve lets you selectively manipulate image saturation within 
specific regions defined by the image’s original image saturation. Control points added to the 
left of this curve affect areas of progressively lower saturation, effectively letting you increase 
or decrease the saturation of lower-saturated features. Control points added to the right affect 
areas of progressively higher saturation, letting you increase or decrease the most saturated 
features of an image.
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Like all curves, this operation is extremely useful for stylizing the image. You can create custom 
vibrance operations, where you selectively increase the saturation of low-saturated regions of 
the image in different ways to give the picture more “pop.” It’s also an excellent tool for taking 
care of over-saturated areas of the picture when adhering to conservative QC requirements. 
You can specifically desaturate only the most over-saturated parts of the picture, without 
affecting similar hues at lower levels of saturation.

In the following example, you can see that the portion of the image with the highest saturation 
has been desaturated, while the rest of the image has been left alone.

Desaturating only the highest saturated elements in the picture by lower 
control points at the right of the Sat vs. Sat curve

Using HSL Curves with 
the DaVinci Control Panel
Using these curves with the DaVinci control panel unlocks their speed, letting you make fast, 
controlled adjustments to specific elements within each scene.

To open the Hue and Sat curve controls on the DaVinci Resolve control panel:

Press the CURVES soft key on the Center panel.

To exit the Hue and Sat curve controls:

Press the MAIN soft key on the Center panel.
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To adjust the principle color regions using knobs:

Adjust one of the 18 knobs in the PRIMARIES CURVE GRADE control groups 
corresponding to the RED/YELLOW/GREEN/CYAN/BLUE/MAGENTA colors paired with 
HUE/SAT/LUM.

To sample a region of a shot to place curve control points:

1	 Press the soft key corresponding to the curve you want to adjust (HUE - HUE, HUE - 
SAT, HUE - LUM, LUM - SAT).

2	 Press the CURSOR button (located above the fourth trackball).

3	 Use the fourth trackball to move the on-screen cursor to the pixel you want to sample.

4	 Press the first of the three buttons underneath the fourth trackball to sample the color 
at the position of the cursor.

Three control points appear on the currently selected curve. The outer two control 
points define region of the curve you’re adjusting, and the center control point 
(selected by default) lets you make the actual adjustment.

5	 To hide the cursor when you’re finished sampling, press the CURSOR button again.

To select and adjust control points using the fourth trackball of the Center panel:

�� To select a control point to adjust: Spin the fourth ring control to the right or left to 
select the next control point in that direction (it takes about half of a turn to select 
another control point). Selected control points are highlighted in cyan.

�� To move a selected control point: Adjust the fourth trackball to move the control point 
up, down, left, or right. Selected control points are constrained between whichever 
control points are to the left and right.
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Chapter 44

Secondary 
Qualifiers 
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Secondary Qualifiers
Secondary correction describes isolating a specific part of the image, or a specific subject, 
using a key. Keys in DaVinci Resolve are grayscale images that define which areas of the 
picture you want to alter (in white) and which parts of the picture you want to leave alone 
(in black). Keys can be generated either using the controls in the Qualifier palette, by using a 
Power Window, or by importing an external matte (for more information on how to use external 
mattes, see Chapter 51, “Combining Keys and Using Mattes”). This chapter focuses on how you 
can use qualifiers to key a range of color values (similarly to doing a green screen key) in order 
to create a matte with which to do this kind of isolated adjustment.

Secondary Qualifiers	 766

Adding a Secondary Operation to the Node Editor	 767

The Qualifier Interfaces	 768

Which Qualifier Do I Use?	 769

Basic Qualification Using the 3D Keyer	 770
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Manipulating Keys Using Additional Nodes	 788
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Secondary Qualifiers
This section covers the use of the Qualifier palette, which lets you pull a 3D, HSL, RGB, or Luma 
key, with which to isolate the correction you need. The Qualifier controls are fast and flexible 
when you need to isolate an irregularly shaped subject with a distinct range of color or 
lightness. Since you’re generating a key by sampling the image, there’s no need for tracking or 
keyframing, so in the right situation Qualifiers can be your fastest solution. In the following 
example, the client likes the slightly cool treatment overall, but wishes that the skin tones were 
a little more vibrant. This is exactly the sort of situation where Qualifiers can help out. Adding a 
second node, and using the 3D or HSL Qualifier to isolate the face makes it relatively simple to 
add color exactly where you want it.

Adding a second node and using HSL Qualification to  isolate the skin tones 

Top–The image with a simple primary correction.  
Bottom–The final adjusted image.
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Just about every control in the Color page can be limited using of the the Qualifier modes 
available in DaVinci Resolve. This makes the Qualifier palette a jack-of-all-trades tool with 101 
uses. A few practical examples include keying a red element that’s too intense for broadcast, in 
order to darken it or desaturate it; keying a range of green foliage, so you can shift its hue to a 
more attractive color; keying an actor’s skin tone in a commercial, to apply some selective 
softening to it; or keying a range of sky, in which to to add blue.

Adding a Secondary Operation to the Node Editor
Any node can be switched between functioning as a primary correction, where the adjustments 
you make affect the entire image, and a secondary correction, where you’re adjusting a specific 
element in the scene. The only difference is that nodes being used for secondary corrections 
are limited using a Qualifier, Power Windows, or an external matte.

If you’re planning to add a secondary operation to the current grade, you’ll need to first add 
another node in the Node Editor. When pulling a key to qualify part of the image, it’s important 
to understand that you’ll be sampling the YRGB values being fed to that node from any previous 
nodes in the tree. That means that the state of the image being fed to a node you’re qualifying 
affects the key you’re pulling.

For example, if the image coming out of Node 1 is well saturated and has a neutral color balance 
with a wide range of colors, but the image coming out of Node 2 applies a low saturation, 
monochromatically orange color wash, you may find it more difficult to pull a detailed key from 
Node 2 than you would from Node 1. 

Choosing your battles–the image coming out of Node 1 will be 
easier to key than the highly stylized image coming out of Node 2

This is important because you have the flexibility of determining from what image you want to 
try pulling a qualified key. By connecting the node that’s outputting the best YRGB image for 
the key you’re trying to create to the node you’re qualifying, you can control what you’re keying. 
For more information about choosing which node to use for setting up a qualifier, see 
Chapter 51, “Combining Keys and Using Mattes.”
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The Qualifier Interfaces
The DaVinci Resolve Qualifier palette interface is straightforward. To the left, graphical controls 
above numeric parameters let you manually adjust what ranges of each color component 
contributes to the key you’re creating. To the right, Selection Range tools below lets you define 
a key by sampling pixels of the image, either using the pointer, or by using the fourth trackball 
of a DaVinci control panel, while below a set of Matte Finesse parameters let you alter the 
shape of the key that’s been pulled.

Qualifier palette with HSL controls selected

The default qualification mode is the HSL Qualifier, which uses three color components, hue, 
saturation, and luma, to define a key. However, you can also use the RGB or LUM (Luma) 
qualification modes to pull keys using other combinations of color components. The LUM 
qualifier mode, in particular, lets you make targeted adjustments to specific ranges of image 
lightness. This is a technique employed by many colorists to alter color temperature within a 
specific range of image highlights or shadows.

Alternately, you can use the 3D qualifier introduced in DaVinci Resolve 12 to quickly and easily 
pull well-refined keys by drawing lines to sample colors from the image that correspond to 
volumes of color within a three-dimensional gamut. While the underlying technology is 
sophisticated, all you have to do is to draw blue lines to sample colors you want to isolate, or 
red lines to sample colors you want to subtract from the isolation you’re creating, all of which 
automatically generate a high-quality key. Each line you draw adds a sample to the selection 
list; you can turn each sample off and on to evaluate its contribution to the resulting key, or 
delete samples that don’t make a positive contribution.

The 3D qualifier
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No matter which qualifier mode you use, the Matte Finesse controls make it easy to refine the 
resulting key to be even cleaner and more usable. In some instances, you can even take a 
marginal key that would otherwise be unusable, and squeeze it into something useful using the 
Clean Black, Clean White, and Blur Radius controls.

Which Qualifier Do I Use?
The Qualifier palette’s four modes offer you the flexibility to use the best keyer for the job when 
it comes to isolating a range of color or brightness values. In some cases, keys that are difficult 
to pull using some modes are easier to pull using others. Here’s a brief summary:

�� 3D: The 3D keyer is a good one to start with if you’re trying to isolate a range of color 
such as a blue shirt, a cyan sky, a performer’s skin tone, or the orange leaves of a tree 
in autumn. Its interface of drawing lines over the part of the image you want to isolate, 
coupled with its high quality and extreme specificity, make it a fast and accurate tool 
to use in a variety of circumstances. However, the 3D keyer always samples every 
color component of the image; it’s not useful when you want to isolate specific color 
components, such as luma only, or hue and saturation without luma. The 3D keyer’s 
greatest strength, the speed with which you can sample areas of the picture to include 
(or exclude) from the final key, is also occasionally a weakness with images where your 
initial samples aren’t giving you satisfactory results, because there aren’t many ways to 
fine tune the key as it’s being generated (although you can manipulate the result). On 
the other hand, for most images you would want to qualify, two or three samples is all 
you need, in conjunction with using the Matte Finesse controls to adjust the resulting 
key. If you need to do some compositing in the Color page, the 3D keyer also does an 
excellent job doing blue and green screen keying to create transparency, and has a 
built-in Despill control as well.

�� HSL: In many instances, the HSL keyer is not as immediately accurate as the 3D keyer, 
and will include a broader portion of the image for any given sample. On the other 
hand, if the 3D keyer is not giving you satisfactory results for a particular shot, the HSL 
keyer can sometimes do a better job. Because of its interface, the HSL keyer makes it 
easier to “fine-tune” the range and softness of each individual color component that’s 
sampled, in order to improve the result. The HSL keyer also gives you the option of 
disabling color components that you don’t want to contribute to the final key, so that 
you can pull a saturation-only key, or a hue-only key, for instances where that may solve 
the issue at hand.

�� RGB: The RGB keyer shares many of the limitations and advantages of the HSL keyer, 
but since you’re sampling and adjusting red, green, and blue color components, the 
specificity with which you can fine-tune the resulting key works much differently. 

�� LUM: The LUM keyer works specifically to isolate parts of the image based on image 
tonality, lightness or darkness. This is the perfect tool when you’re trying to isolate 
highlights or shadows in the image,  which let you solve a multitude of different creative 
and technical issues. The LUM keyer is identical to using the HSL keyer with the Hue 
and Saturation qualifier controls turned off.

The following two sections provide an overview of how to use the 3D and HSL keyer modes in 
DaVinci Resolve.
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Basic Qualification Using the 3D Keyer
The 3D qualifier mode offers a fast, simple way of pulling a key to isolate a range of color in the 
image, by drawing lines over the parts of the image you want to key. Each line you draw over 
the image adds to or subtracts from the cloud of values you’re carving out of a three-
dimensional representation of all available colors; you don’t see this representation, but this 
“under the hood” functionality is what gives the 3D keyer its name.

The 3D keyer is a general-purpose keyer, letting you isolate any color you like. However, the 3D 
keyer is not good at pulling luma-only keys. If you’re looking to isolate a range of luma values in 
the image, you should use the LUM mode.

To use the 3D mode to isolate a subject in the Viewer:

1	 Open the Qualifier palette, choose 3D from the mode pop-up, and click the 
eyedropper.

2	 Click and drag across the part of the image you want to isolate to draw a line. Lines that 
add to the key are colored blue.

Drawing a line to create a key using the 3D qualifier

3	 To see the key you’re creating as you work, click the Highlight button in the Viewer 
Options toolbar at the top of the Viewer.

Viewing the key using the Highlight button

With the Highlight turned on, the lines you draw become invisible. They’ll reappear 
whenever you turn the Highlight off.
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4	 If necessary, draw additional lines to add more of the image to the key you’re creating. 
Ordinarily, it’s a good idea to not to draw more then two or three lines to sample the 
part of the image you’re trying to isolate. Ideally, you want the key you’re pulling to 
have a somewhat soft edge, which makes it easier to use the Matte Finesse controls 
to fine-tune your result later on. If you draw too many lines to sample the image, the 
result can be a key with hard, jagged edges that can sometimes be more difficult to 
adjust later on.

A hard-edged key created with three samples

5	 Alternately, if there are parts of the image that are included in the key that you want to 
omit, hold the Option key down and draw a line over these areas. When you turn the 
Highlight button off, you can see that Option-drawn lines are red, and these subtract 
areas from the key you’re creating. Again, try not to overdo drawing subtractive red 
lines, as you can end up with an overly hard-edged key that’s difficult to adjust using 
other controls in the next few steps.
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Blue lines add to the key, a red lines subtracts the grass 
from the key, as seen with the highlight turned off

6	 If you find yourself wondering whether a particular sample in the list at left is doing 
any good, you can click the color patch at the left of any entry in the list to toggle that 
sample off and on. If you decide you don’t need a particular sample, click the trash can 
button at the right to delete it.

Controls for toggling samples off and on, and deleting them from the list

7	 When you’re satisfied that the key is good enough to start fine-tuning, stop drawing 
lines. It’s all right if there’s a bit of noise, speckling, or if there are small holes in the key 
you’re creating, because you can take care of these using the Matte Finesse controls.

A sampled key that’s ready for further refinement



773

S
e

co
nd

ar
y 

Q
ua

lif
ie

rs
 

P
ar

t 
6

 –
 4

4

Nearly every key you pull will benefit from some further “post-key” refinement. What 
this means is that, once you’ve created the best key you can procedurally through 
sampling the image, you can now adjust the resulting key itself, which is just a gray-
scale image, to improve the isolated result. This is what the Matte Finesse 
controls are for.

Matte Finesse controls

8	 The three most common methods of key refinement using the Matte Finesse controls 
are to increase Clean Black to fill in “holes” in the parts of the image you’re omitting 
(the background), increase Clean White to close holes in the part of the image you’re 
isolating (the foreground), and then use Blur Radius and In/Out Ratio controls to blur the 
edge of the key and push it in and out. Using these controls, you can vastly improve 
nearly any key without the need to endlessly readjust the Qualifier controls.

More information about using the Matte Finesse controls appears later in this chapter.

9	 When you’re finished, click the Highlight control to turn the highlight off, and make 
whatever adjustment you need. In this example, the orange of the helicopter will be 
adjusted using the Hue control to make it blue instead.

Adjusting the orange color of the helicopter to be Blue instead
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Basic Qualification Using the HSL Keyer
The HSL qualifier is one of the most flexible tools in DaVinci Resolve. Using any combination of 
sampled hue, saturation, and luma, you can isolate different ranges of color and contrast for 
specific adjustment. HSL is a general-purpose keyer, meaning you can key any color you like; 
it’s not restricted to blue or green.

The most straightforward way to use any qualifier is to sample the image in the Viewer. A set of 
four controls let you sample pixels within the image in different ways. When you sample one or 
more pixels, the Hue, Saturation, and Luma values are analyzed, and set different ranges in 
each of the Hue, Saturation, and Luma qualifier controls. There are a number of different 
eyedropper controls available to control how you sample color in the image.

�� Sample Eyedropper: The first control you use whenever sampling the image. It defines 
the initial range of the qualification; you must use this tool before any of the others. 
Clicking once with this tool selects a single pixel value, while clicking and dragging 
selects a range of image values that add together.

Color Picker button

�� Add/Subtract Color Range: These two controls let you add areas of the image to, 
or subtract them from, the currently selected inner range of values that define the 
core of the key. As with the eyedropper, you can click on single pixels, or drag over a 
range of color.

Add and Subtract color buttons

�� Add/Subtract Softness: These two controls let you redefine the softness that 
transitions from the inner range of the key, falling off towards the outer edge of the key. 
Just like the other controls, you can click on single pixels, or drag over a range of color.

Add and Subtract qualifier softness

NOTE: When you select one of the sampling controls, it remains selected until you 
select another sampling control. If you select another clip in the Timeline, then click in 
the Viewer to sample a key and nothing happens, make sure that you select the 
Eyedropper control in the Qualifier palette.
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If you’re working with the DaVinci Resolve on-screen interface, the easiest way to qualify a 
subject is to use the pointer in conjunction with the sampling controls.

Example image to qualify

To use the HSL Qualifier mode to isolate a subject in the Viewer:

1	 Open the Qualifier palette, choose HSL from the mode pop-up, and click the 
eyedropper.

2	 Either click a pixel of the part of the image you want to isolate, or click and drag across 
a range of pixels within that subject.

Picking to qualify the ocean

3	 To see the key you’re creating as you work, click the Highlight button in the Viewer 
Options toolbar at the top of the Viewer. 

By default, the area of the image you’re isolating appears in color, while the area of the 
image being excluded appears solid gray. 

Viewer image with highlight turned on, isolated region 
appears in color, omitted region appears gray

Even though the highlight obscures the rest of the image, this doesn’t prevent you from 
using the sampling tools to select pixels you can’t see.
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4	 To subtract from the inner range of the key you’re creating, click the minus Color 
Range control, and click or drag across the portion of the keyed image that you’d like 
to exclude.

5	 To add softness to the outer range of the key you’re creating, click the plus Softness 
control and then click or drag across the portion of the image you’d like to include as a 
soft edge.

Once you’ve finished using the range and softness sampling controls to refine the key 
you’re using to isolate the subject, nearly every key you pull will benefit from some 
further “post-key” refinement. What this means is that, once you’ve created the best 
key you can procedurally through sampling the image, you can now adjust the resulting 
key itself, which is just a gray-scale image, to improve the isolated result. This is what 
the Matte Finesse controls are for.

Matte Finesse controls

6	 The three most common methods of key refinement using the Matte Finesse controls 
are to increase Clean Black to fill in “holes” in the parts of the image you’re omitting 
(the background), increase Clean White to close holes in the part of the image you’re 
isolating (the foreground), and then use Blur Radius and In/Out Ratio controls to blur the 
edge of the key and push it in and out. Using these controls, you can vastly improve 
nearly any key without the need to endlessly readjust the Qualifier controls.

More information about using the Matte Finesse controls appears later in this chapter.

7	 When you’re finished, click the Highlight control to turn the highlight off, and make 
whatever adjustment you need. In this example, the saturation has been raised and the 
color balance changed to make the adjustment obvious.

Altered color balance of the ocean and sky
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If you have a DaVinci control panel, you can use the fourth trackball to sample the image, 
referring to either the Viewer or the display connected to the video output of your DaVinci 
workstation.

To sample a subject using the DaVinci control panel:

1	 Press VECTORS on the T-bar panel to open the Qualifier palette, which defaults to the 
HSL Qualifier controls.

2	 Press CURSOR (the third button above the fourth trackball) on the Center panel, to 
display the small cursor crosshairs in both the Viewer and the video output display.

3	 Use the fourth trackball to position the cursor over the subject you want to sample, and 
press the leftmost of the three buttons appearing underneath the fourth trackball to 
sample the image.

4	 Press HILITE on the Transport panel to turn on the highlight so you can see the key 
you’re creating, and then use the knobs at the top of the Center panel to adjust the 
range and softness parameters to obtain the most accurate key for your purposes.

HSL Qualifier Presets
There is a set of HSL Qualifier presets, or Six Vector presets, that you can use to isolate 
automatically a predefined wedge of color (green, blue, red, magenta, yellow, or cyan) or 
chroma intensity (chroma light, chroma dark, or both). These presets are available either from 
the Color > Presets menu, or from the DaVinci control panel. 

The Color > Presets submenu

Selecting one of these presets automatically sets the HSL Qualifier to the corresponding range 
or color or lightness. Afterwards you can continue modifying the HSL Qualifier to suit 
your purpose.

To choose a Six Vector preset from the DaVinci control panel:

1	 Press the PRESETS soft key on the Center panel. The Center panel’s soft keys update 
with all the available lightness and color presets.

2	 Press the soft key corresponding to the preset you want to use. The HSL Qualifier 
updates with the new settings, and the Center panel goes back to the main page of 
soft key controls.
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Using Highlight to See 
What You’re Isolating
The Highlight control at the top of the Viewer (revealed by turning on Viewer Options in the 
Viewer’s Option menu) lets you overlay a representation of the key you’re creating over the 
current image in the Viewer. Overlays are also mirrored to your video output, so they’ll show up 
on an external display as well, in the event that you’re hiding the on-screen Viewer.

There are two types of highlights with which you can evaluate a qualification you’re creating. 
Each is useful for different tasks.

�� Flat-Gray: The default highlight that DaVinci Resolve uses shows the selected portion 
of the image with the original colors, and the unselected portion of the image with a 
flat gray. It is useful for seeing the subject you’re isolating even while you’re adjusting 
the Qualifier controls, which lets you also see the color or contrast adjustments you’re 
applying at the same time.

Oranges qualified and highlighted

�� High-Contrast: Pressing Option-Shift-H, you can show what’s called a “high-contrast” 
highlight, which should be familiar to you if you’ve used other color correction 
applications and plug-ins; it’s a more typical display wherein the selected portion of 
the image is white, and the unselected portion of the image is black. The high-contrast 
highlight is useful in situations where you need to eliminate holes in a key, or evaluate 
how “chattery” a key is since irregularities are easier to spot when divorced from the 
original image.

Hi-Contrast B&W highlighting
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To enable or disable a highlight, do one of the following:

�� In the Viewer Options toolbar at the top of the Viewer, click the Highlight control, and 
choose the type of highlight you want from the buttons that appear at the right.

�� Choose an option from the View > Highlight submenu; a regular Highlight is Shift-H.

�� On the T-bar Panel of the DaVinci control panel, press HILITE.

To enable or disable a high-contrast highlight, do one of the following:

�� Choose View > Highlight > Highlight BW (Option-Shift-H).

�� On the T-bar panel of the DaVinci control panel, press SHIFT DOWN and then 
press HILITE.

To make high-contrast black and white the default highlight:

1	 Open the Settings window.

2	 Open the General Options and turn on “Mattes display high contrast black and white.”

3	 Click Save.

The next time you click the Highlight control in the Qualifier palette, or press HILITE on 
the DaVinci control panel, the high-contrast highlight will display.

Using Highlight to Solo Nodes
There’s one other use of the Highlight control, and that’s to solo individual nodes in the Viewer 
and video out, rather then outputting the sum of the entire node tree. For example, if you’re 
trying to adjust a stack of nodes attached to a Parallel or Layer Mixer node, it’s difficult to see 
what you’re doing while adjusting one of the stack of nodes, because only the final result is 
being output. 

However, if you turn on Highlight while you’re selecting a node with no key, then only the 
currently selected node is output, making it easy to view just one node as you adjust it. Just 
make sure you turn Highlight off before moving on, or you may confuse yourself.

Showing Picker RGB Values
While you’re dragging the pointer over the Viewer and looking for a feature to sample, you can 
enable a tooltip that shows you the RGB Value of the pixel under the pointer by right-clicking 
the Viewer and choosing Show Picker RGB Value to toggle this feature on and off. When you 
turn this feature on, the View > Show RGB Picker Values In submenu has options for displaying 
either 8- or 10-bit tristimulus values.

The Color Picker tooltip that appears when you 
turn on show RGB Picker Values 
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Qualifier Parameters
Each of the Qualifier modes has parameters that correspond to the relevant color components 
for that mode, with which you can identify a range and softness, similar to using the sample 
tools. These parameters can be edited as virtual sliders using the pointer, or you can modify 
them using the knobs of the DaVinci control panel.

HSL Qualification Controls
The HSL Qualifier is by far the most versatile mode of the Qualifier palette. It’s also the qualifier 
that’s easiest to understand, and the easiest to adjust by hand if you don’t feel the need to 
sample the image. By selecting range and softness for each of three different color 
components, hue, saturation, and luma, you can isolate a wide variety of colorful subjects, or 
ranges of image lightness and saturation.

The HSL Qualifier controls in close up

One of the HSL Qualifier’s key strengths, and one of its most underutilized features, is that you 
can enable or disable each of the three HSL components using the Hue, Sat, and Lum buttons, 
using toggle controls found at the left of each Qualifier range control’s name. This lets you 
ignore specific color components, while focusing on others that are more important. 
For example, if you’re trying to isolate the saturated parts of an image, regardless of the hue or 
brightness, you can turn off the Hue and Lum qualifiers so that only Sat is used to sample 
the image.

 

Qualification with saturation only to isolate the most saturated portion of the picture
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The HSL parameters include:

�� Hue Center: Defines the center of the range of Hue being isolated.

�� Hue Width: Defines the width of the range of hue being isolated. Widening or 
narrowing this parameter widens and narrows the range of hue about the current 
Hue Center.

�� Hue Soft: Widens or narrows the falloff at both sides of the currently selected 
range of hue.

�� Hue Symmetry: Lets you selectively alter the angle of Hue Soft falloff at either the right 
or left side. Lowering this parameter makes the softness to the right of the hue range 
grow steeper. Raising this parameter makes the softness to the left of the hue range 
grow steeper.

�� Sat Low/High: Two parameters let you define the upper and lower range of saturation 
being isolated.

�� Sat Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of saturation.

�� Lum Low/High: Two parameters let you define the upper and lower range of luma 
being isolated.

�� Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of luma.

RGB Qualification Controls
The RGB Qualifier mode lets you isolate range and softness in the Red, Green, and Blue 
channels of an image. While this is not necessarily an intuitive way of manually creating a 
qualification from scratch, it can provide a different way of isolating potentially trickier ranges of 
the RGB color space. 

If you start by sampling the image, then you can widen and narrow each color channel’s isolated 
range of values. In some cases, you may find it’s faster to isolate a specific range of continuous 
color by adjusting these controls.

RGB qualification controls
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The RGB parameters include:

�� Red Low/High: Two parameters let you define the upper and lower range of the Red 
channel being isolated.

�� Red Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of red.

�� Blue Low/High: Two parameters let you define the upper and lower range of the Blue 
channel being isolated.

�� Blue Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of blue.

�� Green Low/High: Two parameters let you define the upper and lower range of the 
Green channel being isolated.

�� Green Low Soft/High Soft: Two parameters let you define the upper and lower 
softness falling off outside the current range of green.

Luma Qualification Controls
The Luma Qualifier mode simply pulls a key from the Luma channel all by itself. It’s identical to 
the HSL qualifier with H and S turned off. This single-component keyer is more useful than you 
might think; it’s a common technique to isolate a range of highlights, midtones, or shadows 
throughout the image to alter the color temperature selectively. 

The Luma Keyer mode automatically disables the Hue and Saturation controls

Also, keep in mind that the luma component is the sharpest keyable component when you’re 
working with heavily compressed video. Keys that are noisy or chunky with HSL qualification 
may be sharper if you just use the Luma Qualifier, although you won’t be able to be 
chromatically specific.

The Luma Qualifier has four parameters:

�� Lum Low/High: Two parameters let you define the upper and lower range of the luma 
component being isolated.

�� Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of luma.
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3D Keyer Controls
As discussed earlier in this chapter, the 3D Keyer works much differently than the other 
qualifiers in DaVinci Resolve. In this mode, drawing lines over parts of the image you want to 
isolate adds samples to the Sample list, some of which add to the key (when you drag with the 
pointer) and some of which subtract from the key (when you Option-drag with the pointer). 
While this functionality is very simple to use, there are other controls that are available.

The 3D Qualifier mode

The 3D parameters include:

�� Show Paths: A checkbox that lets you turn the visibility of the lines you’re drawing to 
sample the image on and off. Turning lines off does not affect the key in any way.

�� Colorspace: A pop-up menu that lets you choose whether you’re sampling colors in 
YUV colorspace or HSL colorspace. YUV is the default, but if you find you’re not getting 
satisfactory results, you can reset the Qualifier palette and switch to HSL to see if that 
works any better.

�� Softness: A single parameter lets you adjust the overall softness of the key you’re 
creating. The default value is 50. Raising this value increases key softness, lowering it 
decreases key softness.

�� Despill: If you’re using the 3D keyer to pull a blue or green screen key to create 
transparency in conjunction with the optional Alpha Output in the Node Editor, this 
checkbox lets you turn on an automatic color correction that eliminates blue or green 
spill from the image, while retaining the image’s original color.

�� Sample list: A list shows each line you drew as a sampled entry. A color patch at the 
left shows you the average color you sampled, clicking the color patch turns lets you 
temporarily turn any color sample off to evaluate its contribution to the overall key. 
A plus or minus icon shows you whether that patch is adding to or subtracting from the 
key. The average red, green, and blue color values are shown next, and a trash can 
icon at the right lets you delete any sample from the list.
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Matte Finesse Controls
After you’ve used the sample controls and Qualifier parameters to create the most useful key 
for your purposes, you may find that it has problems that cannot be overcome easily by the 
available adjustments. Issues such as chattery edges, holes, or noisy bits can sometimes be 
easily fixed using the Matte Finesse controls. These controls filter the output of the Qualifier 
controls and are adjustments that are made to the matte itself, so they may work well in some 
instances, and poorly in others, depending on what you’re trying to do.

Black Clip
Raising Black Clip applies a “lift” adjustment such that translucent areas of the matte (gray areas 
when viewing a high-contrast highlight) are pushed towards black. The range is 0 to 100, with 0 
being the default setting.

Before/After raising Black Clip

White Clip
Lowering White Clip applies a “gain” adjustment such that translucent areas of the matte (gray 
areas when viewing a high-contrast highlight) are pushed towards white. The range is 0 to 100, 
with 100 being the default setting.

Before/After lowering White Clip

Clean Black
Clean Black is a specialized operation that eliminates noise (seen as white speckling when 
viewing a high-contrast highlight) in the black area of a key that omits the regions of the image 
you don’t want to isolate, and shrinks the key by making the dark parts of a key darker the 
higher you raise this parameter, pushing dark gray areas of the key towards black. The practical 
result is that raising Clean Black lets you “fill holes” in the background portion of a key, and 
erode translucent edges.

Before/After raising Clean Black, viewing the high contrast matte
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Clean White
Clean White is another specialized operation that eliminates noise (seen as black speckling 
when viewing a high-contrast highlight) in the white portion of a key that include areas of the 
image you’re isolating, and expands the key by making light parts of a key lighter the higher you 
raise this parameter, pushing light gray areas of the key towards white. The practical result is 
that raising Clean White lets you “fill holes” in the foreground portion of a key, and grow 
translucent edges.
 

Before/After raising Clean White, viewing the high-contrast matte

Blur Radius
In small amounts, blurring a key does well to take the edge off problem edges. However, 
blurring a key can also feather the edges of a key past the border of the subject you’re keying, 
with the result being a visible “halo” around your subject depending on the adjustment you’re 
making. The range is 0 to 2000, with 0 being the default. With such a large maximum blur 
radius, combined with the capabilities that the In/Out Ratio provides in customizing the direction 
of spread, you can turn some pretty precarious mattes into surprisingly smooth and 
useful results.

Using the blur parameters to soften the edges of a key

TIP: If haloing is a problem, you can try adjusting the In/Out Ratio parameter, or you 
may want to consider using the Qualifier Softness parameters to feather the edges of 
the key, instead.
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In/Out Ratio
Controls whether the “Blur Radius” is applied equally to the inside and outside of the edge of 
the matte (zero), applied only within the matte (negative values), or applied only outside the 
matte (positive values). Using In/Out Ratio can help eliminate fringing when using the Blur 
Radius parameter.

Left–In/Out Ratio lowered so blurring ends at the edge of the matte and feathers inward,  
Right–In/Out Ratio raised so that blurring starts at the edge of the matte and feathers outward

However, you can also use In/Out Ratio even in situations where no Blur Radius is applied at all. 
Raising In/Out Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 
will eliminate speckling by pushing small white bits of the matte towards black.

Left–In/Out Ratio controls lowered to expand holes in the Matte,  
Right–In/Out Ratio controls raised to fill in small black holes in the matte

The Many Ways to Invert a Key
Sometimes, you’ll need to isolate a subject or range of values in an image, and then make a 
change to everything else. One way to do this is to add an Outside node after the node in 
which you’ve created the key. This lets you make one set of adjustments to what you’ve keyed, 
and another set of adjustments to everything outside the key.

If you just need to make a simple adjustment, you can invert the key from within the Qualifier 
palette. However, there are three other ways to invert a key.

�� The Qualifier Invert button: Clicking this control simply inverts the key being 
generated by all of the controls within the Qualifier palette.

�� Key Palette Qualifier Invert: The Qualifier Invert control within the Key palette 
provides another control with which you can invert the key that’s generated by the 
Qualifier palette.

�� Key Palette Output Invert: The Output Invert control within the Key palette is notable 
because it inverts the sum of all keys applied within that node. For example, if you’re 
using a Qualifier in conjunction with a Window, the two invert controls mentioned 
previously will only invert the Qualifier key; the Window key remains unaffected. 
However, using the Output Invert control inverts the overall combination of the Qualifier 
key and the Window, all together.
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Combining Qualifiers and Windows
This is covered in more detail in a subsequent section, but if you create a key using one of the 
Qualifier modes, and you then add a Window, the final key that’s output by that node is limited 
to the intersection of the Qualifier key and the Window. This makes it easy to use a Window to 
“garbage matte” out bits of a key that you don’t want, that can’t be eliminated by further 
adjustment of the Qualifier controls.
 

The woman’s skin tone is too close to other elements in the scene.

A Circular Power Window is used to further isolate the woman being isolated
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Manipulating Keys Using 
Additional Nodes
If you need to make more adjustments to a qualified key than the Matte Finesse controls will 
allow, you can use the Node Editor to feed the KEY output of one node to the RGB input of 
another, at which point you can use all of the second node’s color adjustment controls to 
manipulate the grayscale image that constitutes that key, to improve it.

Connecting a KEY output to an RGB input, and then connecting 
the RGB output back to the next node’s KEY input again 

You can also use the Key Mixer node to combine multiple keys in several different ways, adding 
keys together, or subtracting them from one another, in order to create exactly the key 
you need. 

Adding multiple keys together using a Key Mixer

For more information about these techniques, see Chapter 51, “Combining Keys and 
Using Mattes.”
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Chapter 45

Secondary 
Windows 
and Tracking 
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Secondary Windows and Tracking
Secondary correction describes isolating a specific part of the image, or a specific subject, 
using a key. Keys in DaVinci Resolve are grayscale images that define which areas of the 
picture you want to alter (in white) and which parts of the picture you want to leave alone 
(in black). Keys are generated either using the controls in the Qualifier palette, by using a 
Power Window, or by importing an external matte (for more information on how to use external 
mattes, see Chapter 51, “Combining Keys and using Mattes”). This chapter shows you how to 
use Power Windows to create shapes with which you can isolate parts of the image in different 
ways in order to do these kinds of targeted corrections.

Power Windows	 791

Adding Nodes with Windows	 792

The Window Palette Interface	 793

Managing Windows	 795

Showing and Hiding On-Screen Window Controls	 795

Using the High-Visibility Power Window Outline Option	 796

Window Transform Controls	 797

Window Softness	 799

Drawing a PowerCurve	 799

Converting Linear, Circular, and Polygon Windows into Bezier PowerCurves	 801

Resetting the Window Palette	 801

Combining Power Windows with the Mask Control	 802

Copying and Pasting Windows	 804

Saving Window Presets	 804

Using Windows and Qualifiers Together	 805

Manipulating Windows Using a Control Panel	 806
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Power Windows
Power Windows are another way of making secondary correction, being essentially shapes you 
can use to isolate regions of the image. Different controls let you use oval, rectangular, 
polygonal, or custom curved shapes. Because you can isolate regions of the image by drawing, 
Power Windows produce exceptionally clean results, with edges that can be precisely 
positioned and feathered to achieve a variety of effects.

Before/After PowerCurve Power Window isolates the sky area for a targeted correction

Power Windows (also referred to as simply “windows”) are excellent when what you need to 
adjust can be encompassed within a clearly defined geometrical area. For example, the oval of 
a person’s face, the front of a car, or a wide expanse of sky are all good candidates for 
windowed adjustments. A drawback of windows can be that they must be animated to follow 
whatever subject they’re isolating. Fortunately, this is where DaVinci Resolve’s powerful tracker 
comes in, making it easy to track Power Windows quickly and accurately to follow along with 
the subject being isolated.

Circular Power Window to focus attention to the skin
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DaVinci Resolve makes it easy to combine multiple Power Windows in different ways, to 
intersect with one another and create even more sophisticated shapes. For example, multiple 
windows can be added together, or one window can be used to cut out part of another window, 
which saves you from the need to make complicated keyframing operations to animate that 
window’s shape.

Multiple Windows combined to isolate and mask the image

This section covers the use of Power Windows, how to create and modify them, as well as how 
to combine multiple windows, and combine windows and qualifiers to create highly specific 
isolations.

Adding Nodes with Windows
As with qualifiers, you must first add a node to a grade’s node tree before you begin windowing 
a correction. This is because all of the windows within a particular node work together to limit 
that node’s grade. As a reminder, any node can be changed from a primary operation that 
affects the entire image, to a more targeted secondary operation, simply by turning on a 
window, using a qualifier, or enabling an external matte.

Serial nodes showing the window on Node 2

If you don’t create a new node before creating a window, you’ll discover you’ve inappropriately 
changed a primary correction into a secondary correction. If you create a new serial node, you’ll 
then need to use the controls found within the Window palette to turn on a window to customize 
for your purposes. However, there are also a set of commands you can use to add serial nodes 
with a window already turned on, saving you a few clicks or button presses in the process.
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To add a new node with a window already turned on:

�� Choose Nodes > Node + CPW (Option-C), or press the button of the same name 
on the T-bar panel of the DaVinci control panel to create a new serial node with a 
circular window.

�� Choose Nodes > Node + LPW (Option-Q), or press the button of the same name 
on the T-bar panel of the DaVinci control panel to create a new serial node with a 
linear window.

�� Choose Nodes > Node + PPW (Option-G), or press the button of the same name 
on the T-bar panel of the DaVinci control panel to create a new serial node with a 
polygonal window.

�� Choose Nodes > Node + PCW (Option-B), or press the button of the same name 
on the T-bar panel of the DaVinci control panel to create a new serial node with a 
PowerCurve window.

When you add a node with a Power Window, the Window palette automatically opens up, ready 
for editing.

The Window Palette

The Window palette is divided into three sets of controls: the Window list, the Presets, and the 
Transform and Softness controls.

The Window Palette Interface
Once you’ve created a node with which to apply a Power Window correction, you need to open 
the Window palette if it hasn’t been opened already.

To open the Window palette:

�� Click the Window palette button.

�� Press the WNDWS button on the T-bar panel of the DaVinci control panel.

The majority of the Window palette is occupied by the Window List, within which you can create 
as many windows as you need for the task at hand. There are five types of windows you can 
create, each of which has a different geometry. You can use these windows individually, or you 
can combine them to create even more complex shapes and interactions. The Window palette 
has four groups of controls that let you use these windows in different ways.
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The Window palette with the Window list

�� Window List: A row of buttons at the top of this list lets you add new windows, which 
you can then customize as necessary. Each window in the list exposes an On/Off 
button that shows the shape type,  a Layer Name field you can use to identify what 
each window is for, an Invert button, and a Mask button that governs how that window 
interacts with the other windows that are currently enabled (adding to other windows 
by default, or subtracting from other windows in Mask mode).

�� Transform parameters: Controls the overall size, aspect ratio, position, and rotation of 
the currently selected window. 

�� Softness parameters: Controls the edge softness of the currently selected window. 
Different window shapes have different softness options.

�� Window Preset browser: A browser to which you can save presets of individual or 
multiple windows for easy recall later.

�� Option pop-up menu: The Option pop-up menu has commands for resetting windows, 
deleting windows, saving and managing window presets, and copying and pasting 
track data.

Using buttons along the top of the Window palette, there are five types of windows you 
can create:

�� Linear: A four-point shape that can be edited into any kind of rectangle or trapezoid 
you might need. In addition to the center and corner controls, you can also drag any of 
the four sides to change the shape.

�� Circular: An oval that can be shaped, sized, and feathered to solve an amazing number 
of problems.

�� Polygonal: A four-point shape that can be expanded with additional control points to 
create complex sharp-cornered polygonal shapes.

�� PowerCurve: A Bezier drawing tool that you can use to create any kind of shape, 
curved, polygonal, or mixed, that you require.

�� Gradient: A simple two-handled control for dividing the screen into two halves, 
with options for the center, angle, and feathering of the shape. Good for fast sky 
adjustments.
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Managing Windows
To manipulate a window, first you need to create the type of window you want to use, or if 
you’ve got a group of windows created already, you need to select the window you want 
to work on.

Methods of creating and selecting windows:

�� To create a new window: Click the Create Window button (at the bottom of the 
Window list) that corresponds to the window you want.

�� To create a new window using the DaVinci Control Panel: Press WNDOWS on the 
T-bar panel, then use the UP and DOWN buttons on the Trackball panel to select the 
window type you want to apply, and press ADD.

�� To select a window using the on-screen controls: Click anywhere within a window to 
select it in the Viewer.

�� To select a window from the Window list: Click the Shape icon button corresponding 
to the window you want to select. 

To delete a window you no longer want: 

Select a window, then choose Delete Selected Window from the Option pop-up.

To reset one or all windows:

�� To reset one window to its default shape: Select a window, then choose Reset 
Selected Window from the Option pop-up.

�� To reset all windows: Choose Reset All Windows from the Options pop-up.

Showing and Hiding On-Screen Window Controls
When you open the Window palette, the Viewer goes into Power Window mode. Enabling a 
window makes that window’s on-screen controls appear within the Viewer, and are mirrored to 
video out so you can see the window controls on your external display. If you like, you can 
change how and where the on-screen controls appear.

To choose whether on-screen controls are mirrored to video out, or disabled, 
do one of the following:

�� Choose an option from the View > Window Outline submenu. 

There are three options:

Off: Hides the window outline on both the external display and the Viewer.

On: The default, shows the window outline on both the external display and the Viewer.

Only UI: Hides the window outline on your external display, but leaves it in the Viewer.

�� Press Option-H to toggle among all three of the above modes.

To show or hide window on-screen controls using the DaVinci control panel:

Press SHIFT UP and then DISPLAY/CURSOR, above the fourth trackball on the 
Center panel.

This command is a three-way toggle. The first use of this command hides the window outline on 
your external display, but leaves it in the Viewer. The second use of this command hides the 
window outline on both the external display and Viewer. The third use of this command shows 
the window outline on both the external display and Viewer.
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Using the High-Visibility Power Window Outline Option
Ordinarily, Power Window outlines are white (for the center shape) and gray (for the softness 
shapes). However, sometimes this color scheme can be difficult to see, so the Color panel of 
the User Preferences has an option in the General Settings section called “High visibility Power 
Window outlines.” Turning this on sets power window outlines to be drawn as green (for the 
center shape) and yellow (for the softness shapes), to make these windows easier to see in 
certain circumstances.

Default window outlines

High Visibility window outlines enabled in the Color panel of the User Preferences

TIP:  If you leave the on-screen controls visible in the Viewer, you may find that as you 
work you want to temporarily hide or show the on-screen controls in the Viewer so you 
can get an uncluttered look at the image you’re adjusting. You can quickly toggle any 
set of on-screen controls off and on without selecting Off in the menu by pressing 
Shift-` (tilde).
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Window Transform Controls
Windows have transform parameters that are similar to those found in the Sizing palette. These 
parameters let you alter the window, affecting all of its control points together. 

Window transform controls

�� Size: Scales the entire window up or down. 50.00 is the default size.

�� Aspect: Alters the aspect ratio of the window. 50.00 is the default value, larger values 
make the window wider, and smaller values make the window taller.

�� Pan: Repositions the window along the X axis. 50.00 is the default position, larger 
values move the window to the right, smaller values move the window to the left.

�� Tilt: Repositions the window along the Y axis. 50.00 is the default position, larger 
values move the window up, smaller values move the window down.

�� Rotate: The default value is 0. Increasing this parameter rotates the shape clockwise, 
decreasing this parameter rotates the shape counterclockwise. 

�� Opacity: Lets you vary the transparency of an individual window’s contribution to a 
node’s key.

The transform parameters also correspond to onscreen controls found in the Viewer, which can 
be manipulated directly using the pointer.

Manipulating the window position on the Viewer
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While many of the on-screen controls correspond to parameters within the Window palette, 
some on-screen controls, such as the control points that govern reshaping linear, polygonal, 
and PowerCurve windows, are only adjustable via the pointer.

On-screen controls for window transforms:

�� To select any window: Click on one of an arrangement of many windows to select it, 
making that window’s controls active.

�� To reposition any window: Drag anywhere within the window’s onscreen control. 
Window position corresponds to the Window palette’s Pan and Tilt parameters. For a 
Gradient window, drag the center control point.

�� To resize a Circular window while locking its aspect ratio: Drag one of the four blue 
corner points out to enlarge, or inwards to shrink. This corresponds to the Window 
palette’s Size parameter.

�� To squish or stretch a Circular window, altering its aspect ratio: Drag one of the blue 
top, bottom, left, or right control points. These adjustments correspond to the Window 
palette’s Aspect parameter.

�� To rotate a window: Drag the top inner blue rotate handle, in the middle of the window. 
For a gradient, drag the bottom arrow handle.

�� To alter window softness: Drag any one of the magenta softness handles. Different 
window shapes have different sets of handles, which correspond to the Softness 
parameters.

�� To reshape a linear window: Drag any of the green corner handles to corner pin the 
window, or drag one of the green top, bottom, or side handles to move an entire side 
segment of the window around.

�� To reshape a polygonal window: Turning on a polygonal window reveals a simple 
green rectangle with four corner control points. Click anywhere on the surface of the 
rectangle to add additional control points with which to reshape the polygon, and drag 
any green control point to alter its shape. Polygonal windows are limited to a maximum 
of 128 control points.

�� To change the size and aspect of a PowerCurve: Shift-drag a bounding box around 
the control points you want to transform, and then adjust the corners of the box to 
resize the points while maintaining the aspect ratio of the shape, or adjust the top, 
bottom, left, or right points to squish or stretch the shape.

�� To remove control points from polygonal or PowerCurve windows: Middle-click the 
control point you want to remove.

NOTE: Removing a control point from a Polygonal window that’s already been 
animated using the Keyframe Editor results in that point abruptly popping on and off at 
the keyframes creating the animation.
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Window Softness
Each type of window has different Softness parameters, depending on how adjustable that 
window is.

�� Circular: A single parameter, Soft 1, lets you adjust the uniform softness of the 
oval’s edge.

�� Linear: Four parameters, Soft 1-4, let you adjust the softness of each of the four sides of 
the linear window independently. Magenta softness control points on the top, bottom, 
left, and right let you adjust the softness of each side of the linear shape independently.

�� Polygon: Two parameters, Inside Softness and Outside Softness, let you adjust the 
overall softness of a polygonal window. There are no on-screen softness control points.

�� PowerCurve: Two parameters, Inside Softness and Outside Softness, let you adjust 
the overall softness of a PowerCurve. Using the on-screen controls, you can adjust 
the magenta inside and outside softness control points independently, creating any 
softness shape you need. 

�� Gradient: A single parameter, Soft 1, lets you adjust the uniform softness of the gradient 
window’s edge.

Drawing a PowerCurve
The PowerCurve window is the only window that doesn’t display any on-screen controls when 
it’s first turned on. Instead, you must click within the Viewer to add control points, drawing your 
own custom shape to isolate whatever region you want.

PowerCurve window to isolate a car

To draw a PowerCurve:

1	 Turn on the PowerCurve window style control.

2	 Click anywhere in the Viewer to start adding control points and drawing the shape 
you need. 

3	 Click and drag to add and shape Bezier curves, or just click and release to add a 
hard angle.

4	 To finish drawing and close the shape, click the first control point you created to 
create a corner, or click-and-drag on the first control point you created to create a 
Bezier curve.

TIP: Turning on the Viewer’s full-screen mode can make it easier to draw detailed 
shapes. You can also zoom into and out of the Viewer while you’re drawing, using 
either the scroll wheel of a mouse or by pressing Command-Plus or Command-Minus.
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Once you’ve drawn a PowerCurve, there are many ways of manipulating it.

Simple methods of modifying a PowerCurve:

�� To add points: Click anywhere on a PowerCurve to add control points.

�� To reshape a PowerCurve: Drag any control point to a new location.

�� To move a PowerCurve: Drag anywhere within or just outside a PowerCurve to move it.

�� To symmetrically alter a Bezier curve: Drag any Bezier handle. The opposite handle 
automatically moves in the other direction.

�� To asymmetrically alter a Bezier curve: Option-drag any Bezier handle. The opposite 
handle stays in place while you drag the current handle. Once you’ve created an 
asymmetric pair of Bezier handles, they move together as one if you simply drag a 
handle. You need to Option-drag to change the angle.

�� To change a curve into a corner: Option-double-click any Bezier curve control point to 
change it to a sharp-angled corner point.

�� To change a corner into a curve: Option-click any corner point and drag to pull out a 
Bezier handle, changing it to a curve.

�� To remove points: Middle-click the control point you want to remove.

You can also shift-drag a bounding box to select multiple control points on a PowerCurve to 
move, delete, or transform them all at once.

You can Shift-drag a bounding box over multiple control 
points to manipulate them all at once

To select multiple control points on a PowerCurve:

1	 Hold the Shift key down and drag a bounding box around the control points you want 
to manipulate or delete. All included control points will become highlighted.

2	 Do one of the following:

NOTE:  Removing a control point from a Polygonal window that’s already been 
animated using the Keyframe Editor results in that point abruptly popping on and off at 
the keyframes creating the animation.
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�� To move the control points: Drag anywhere within the bounding box.

�� To transform the control points: Drag one of the outer corners to resize all control 
points symmetrically, drag the top, bottom, or side handles to squish or stretch the 
control points relative to one another, or move the pointer to one of the corners until 
the rotate cursor appears, and then drag to rotate the control points.

�� To delete the control points: Press the Backspace key.

3	 When you’re finished, press the Escape key to deselect the control points.

Converting Linear, Circular, and Polygon 
Windows into Bezier PowerCurves
If you start out isolating a subject using one of the simple Linear, Circular, or Polygon shape 
windows and you realize that you need a more complex shape to accomplish the task at hand, 
you can easily convert them to a more complex Bezier PowerCurve by choosing Convert to 
Bezier from the Window palette Option menu.

Before and after converting a Circular window to a Bezier PowerCurve 
and adjusting the result, before adding softness to the edge

Once you’ve converted a simple shape to a Bezier window, you can add control points and 
manipulate the shape in any way you need to make it better conform to the subject, just as you 
would with any PowerCurve.

Resetting the Window Palette
The entire Window palette can be reset using the Option menu’s Reset command.
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Combining Power Windows 
with the Mask Control
Adding multiple windows to a single node is an easy way to create composite keys. When 
combining windows, the Mask control defines whether one window adds to another window, or 
subtracts from that window.

In the following example, Circular and PowerCurve windows have both been created, and each 
window’s Mask control is also turned on (by default), resulting in both masks being added 
together so that the sunset look correction affects both the sky and the woman’s face.

The two images show the combination of the key mattes

By turning the Mask control of the Circular window off, the Circular window is 
subtracted from the PowerCurve.

Turning off the Mask control of the Circular window
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Now, the woman’s face is being protected from the aggressive sky treatment.

The two images show the result of subtracting the circular window

Since windows can be individually tracked and keyframed, you can quickly set up 
complex interactions of windows to solve common problems you’ll encounter. For 
example, when you’re tracking a window to follow a moving subject that moves behind 
something in the frame, you can use a second window with Mask turned off to cover 
the object in front. Now, when the tracked window intersects the subtractive window, 
the correction will disappear along with the subject. 

You can also use the Mask control to create more complex shapes than you can with a 
single window.

Mattes and mask used together to make complex shapes
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Furthermore, once you reach the limits of what shapes you can create using the four available 
windows, you can combine multiple nodes containing multiple shapes and qualifiers using the 
Key Mixer. 

Copying and Pasting Windows
If there’s a particular window you’ve created that you want to either duplicate within the current 
node, or apply to another node, you can copy and paste an individual window’s shape from one 
item in the Window list to another.

Methods of copying and pasting Windows:

�� To copy a Window: Click any enabled Window in the Window list, then click the 
Window palette option menu and choose Copy Window.

�� To duplicate a Window: After copying a window, create another window of the same 
type that you copied, and then click the Window palette option menu and choose 
Paste Window.

�� To paste a Window to another node: Double-click or otherwise select another node, 
open the Window palette, choose the same type of window that you copied in the 
Window list, and then click the Window palette option menu and choose Paste Window.

Saving Window Presets
If you find there’s a particular window shape or combination of windows that you use frequently, 
you can save one or more windows as a preset for easy recall whenever needed. For example, 
if you’re working on a documentary within which you find you need to do a lot of face 
brightening, you can create preset face ovals for close-up, medium, and wide shots, to save you 
from having to customize a stock circular window for every single new shot. You can also save 
groups of windows together as a single preset, in order to reuse complicated multi-
window shapes.

Window presets are available from a group of Presets controls in the upper right-hand corner of 
the Window palette.

Controls for saving, applying, and deleting window presets

Methods of working with Power Window presets:

�� To save a window preset: Once you’ve created one or more windows you want to 
save, click the Create button, type a name into the resulting dialog, and click OK. That 
preset is now available in the Preset pop-up.

�� To recall a window preset: Click to open the Shape Preset Browser, choose a preset 
from the list, and click Load. Loaded window presets overwrite whatever other windows 
were set up in that node.
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�� To update an already saved preset: Recall a preset, change the resulting window(s), 
then click to open the Window Preset Browser, and click the Save button overwrite the 
current preset with the altered window arrangement.

�� To delete a window preset: Click to open the Shape Preset Browser, choose a preset 
from the list, and click the x button to the left the the preset you want to delete.

Once recalled, windows created by presets can be modified and tracked just like any 
other window.

Using Windows and Qualifiers Together
Another use of windows is to act as a “garbage matte” when used together with a qualifier. By 
default, when you use a window and qualifier together, a key is only output where both the 
window and qualifier intersect. This makes it easy to exclude unwanted parts of a key that are 
too difficult to eliminate by further refinement of the qualifier controls.

For example, the following qualification is intended to isolate the woman’s face, but some of the 
similarly colored wood and sky in the background is also included.

Instead of driving yourself crazy trying to eliminate the unwanted parts of the key by modifying 
the current qualification, which is doing a great job of isolating the skin tones, you could instead 
use a window to isolate her face, excluding everything outside the window, and simplifying your 
job considerably.

A qualified image with highlight on

If she moves, then you can simply track the window to follow. Simple tracking is covered in 
Chapter 46, “Motion Tracking Windows.”

Now with additional Power Window isolation
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Furthermore, you can use the window’s Invert control to do the reverse, excluding all qualified 
portions of the key inside the window, and including all qualified portions of the key outside 
the window.

If you need to build more complex qualifier/window combinations than this, you can add more 
windows, or you can use multiple qualifiers and windows with the Key Mixer node, which is 
discussed in Chapter 51, “Combining Keys and Using Mattes.”

Manipulating Windows 
Using a Control Panel
Window shape and position can also be manipulated using the DaVinci control panel. 
All Windows controls are located on the T-bar panel, except for the ADJ WINDOW button above 
the fourth trackball of the Center panel.

To enable, mask, or disable a window:

1	 Press WNDWS on the T-bar panel. The Window palette should appear.

2	 Press the soft key that corresponds to the type of window you want to turn on, CPW 
(Circular Power Window), LPW (Linear Power Window), PPW (Polygonal Power Window), 
or PCW (PowerCurve window). The appropriate window controls should appear with an 
orange highlight.

3	 Press the MATTE/MASK soft key to toggle among turning the window on, turning Mask 
on, and turning the window off.

To reposition a window using the Pan and Tilt knobs:

1	 Press the unlabeled soft key at the bottom-right of the T-bar panel to toggle between 
the current knob mappings on the T-bar panel, and the PAN and TILT mappings.

2	 Use the Pan and Tilt knobs to adjust the window’s position.

To reposition a window using the fourth trackball:

1	 If necessary, press WNDWS on the T-bar panel to open the Window palette.

2	 Press ADJ WNDW, above the fourth trackball on the Center panel.

3	 Use the fourth trackball to reposition the window.

4	 When you’re finished, press ADJ WNDW again to exit adjust window mode.

To alter a window’s Zoom, Aspect, or Rotation:

Use the ZOOM, ASPECT, and ROTATE knobs on the T-bar panel.

To alter a window’s softness, do one of the following:

�� For Circular and Linear windows: use the SOFTNESS knob on the T-bar panel.

�� For Polygonal and PowerCurve windows: press the unlabeled soft key at the bottom-
right of the T-bar panel to toggle between the current knob mappings, and the PAN, 
TILT, INSIDE SOFT and OUTSIDE SOFT knob mappings.

To invert a window:

Press the INVERT soft key on the T-bar panel.
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Chapter 46

Motion Tracking 
Windows 
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Motion Tracking Windows
While Power Windows can be manually keyframed to follow a moving subject you want to 
isolate, this chapter shows how you can use the powerful cloud and point-based motion 
tracking controls in DaVinci Resolve to make Power Windows follow along with the motion 
of subjects and the camera in the fastest, easiest way possible. Then, numerous techniques are 
presented for dealing with complicated tracking scenarios and common problems that arise for 
subjects that are difficult to track.

Motion Tracking Windows	 809

Simple Tracking Using the Tracker Menu	 809

Tracking Windows When You’ll Be Exporting Media With Handles	 811

Simple Ways of Working With Existing Tracking Data	 811

Tips For Better Tracking	 811

Tracking One Frame at a Time	 811

Copying and Pasting Tracking	 812

Tracker Palette Controls in More Detail	 812

Controls in the Window Tracker Palette	 812

Cloud Tracker Workflows	 817

Using Interactive Mode to Manually Choose Tracking Features	 817

Dealing With Occlusions When Tracking	 820

Point Tracker Workflows	 823

Tracking a Window Using the Point Tracker	 823

Removing Trackers	 825

Using Frame Mode to Offset Track	 826

Rotoscoping Window Shapes After Tracking	 828

Rotoscoping Controls	 829

Keyframing in Frame Mode	 829

A Rotoscoping Workflow	 830

Viewing a Window’s Motion Path	 833
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Motion Tracking Windows
The Tracker palette has three modes, available from the Palette menu. 

�� In Window mode, the tracking controls let you match the motion of a window to that of a 
moving feature in the frame. 

�� In Stabilizer mode, the same underlying technology is used to smooth or stabilize the 
motion within the entire frame.

�� In FX mode a Point Tracker can be used to animate ResolveFX or OFX plug-ins with 
positioning controls (For more information about the FX and Stabilizer modes, see 
Chapter 57, ”ResolveFX” and Chapter 58, “Sizing and Image Stabilization.”

DaVinci Resolve has an incredibly simple, yet powerful, 3D cloud tracker that allows you to track 
quickly and accurately any Power Window (Circular, Linear, Polygonal, PowerCurve or Gradient) 
to follow any moving feature. This avoids the need to use dynamic keyframes to manually 
animate a window’s position. 

In particular, you can use the tracker to match a window’s position, size, rotation, and its pitch 
and yaw in 3D space to either foreground or background elements that move within the frame.

A Power Window tracking a woman’s face; the motion path 
resulting from the track is shown as the wiggly white line

Simple Tracking Using the Tracker Menu
The simplest way to track a feature using a Power Window is to use the commands found in the 
Playback menu. These commands include:

�� Track Forward (Command-T): Tracks a window to a feature from the current position of 
the playhead forward, ending at the last frame of a clip.

�� Track Reverse (Option-T): Tracks a window to a feature from the current position of the 
playhead backward, ending at the first frame of a clip.

�� Track Stop (Command-Option-T): Interrupts any track. This is useful for letting 
you cancel a long track that goes wrong (the Stop button of a control panel stops 
tracking as well).

Most window tracks are easy to accomplish using these three commands.
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To track any Power Window to match a moving feature within the frame:

1	 Move the playhead to the frame of the current shot where you want to begin (you don’t 
have to start tracking at the first frame of a shot).

2	 Turn on any window, and adjust it to surround the feature you want to track.

Typically, you’ll have done this anyway, for example, framing someone’s moving face 
with a Circular Window to lighten their highlights.

3	 To initiate tracking, do one of the following:

�� Choose Color > Track Forward (press T) 

�� Choose Color >Track Reverse (Option-T)

�� On the T-bar panel of the DaVinci control panel, press OBJECT TRACK MODE, and 
then press either the TRACK FWD or TRACK REV soft keys on the Center panel.

DaVinci Resolve automatically opens the Viewer page, places a series of tracking points within 
the window you’ve created, and performs the track from the current frame; forward to the last 
frame or backward to the first frame.

DaVinci Resolve analyzes a cloud of tracking points that follow the vectors of every trackable 
group of pixels within the window you’ve created, and the results are fast and accurate. After 
tracking, the window you’ve placed automatically moves, resizes, rotates, and skews to match 
the motion of the feature you’re tracking.

Object tracking in progress. Tracking points are automatically 
placed over trackable features of the image

Once a clip has tracking data applied to one of its windows, a small tracking icon appears within 
that clip’s icon in the Thumbnail timeline.

A tracking icon in the top left corner of the Thumbnail 
timeline shows that clip has been tracked

If the track you’ve performed is unsuitable, you can reposition the window to cover a different 
area of the subject you’re trying to track, and initiate tracking again. New tracking data 
overwrites any previous tracking data applied to that window.
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Once you’re satisfied with your track, you can continue to resize, reposition, or reshape the 
window being tracked. Tracking data is separate from the window transform parameters (which 
can be keyframed), so changes you make to a window offset it from the originally tracked path.

Tracking Windows When You’ll 
Be Exporting Media With Handles
When you track windows to match moving features in a clip, the windows are only transformed 
on frames with tracking data. In Round Trip workflows where you add handles to the graded 
clips you render for editorial flexibility in the footage you deliver, you need to make sure that 
you track all windows from the beginning to the end of these handles to make sure that, if an 
editor actually trims any of the clips you give them to use the handles, all windows are doing 
what they should. 

An easy way to do this is to choose View > Show Current Clips With Handles to display each 
clip you select in the Timeline with handles defined by the “Default handles length” setting in 
the Editing panel of the User Preferences. Make sure that the “Default handles length” is equal 
to the handles you export using the “Add X Frame handles” option in the Render Settings list of 
the Deliver page. With each clip’s handles made visible in this way, you can easily track 
windows along every frame you’ll be rendering.

Simple Ways of Working With Existing Tracking Data
If there’s a portion of a shot that you haven’t tracked (for example, you started tracking at a later 
frame, or you ended tracking before the end of the shot), then the window you’re tracking 
remains wherever it was at the first or last frame that was tracked. If you want to fill in these 
gaps, you can always move the playhead to the first or last frame that was tracked, and then 
use the Track Backward or Track Forward command to track the rest of the frames in that shot.

Tips For Better Tracking
In situations where a feature changes shape in such a way as to confuse the tracker, you can try 
tracking a smaller part of the feature by using a smaller window. Once you’ve achieved a 
successful track, you can resize the window as necessary, and it will have no effect on the track 
that’s already been made.

Also, if you’re tracking a feature that moves behind something onscreen and disappears for the 
rest of the shot, there’s an easy way to avoid having an awkward window sitting in the middle of 
the scene. You can use dynamic keyframes to animate the Key Output Gain parameter (in the 
Key tab of the Color page) to fade from the correction’s full strength of 1.0 down to 0, the value 
at which the correction disappears, along with the window itself.

Tracking One Frame at a Time
You can click the “track one frame forward” or “track one frame backward” buttons in the 
Tracker palette to track a moving feature one frame at a time, making it easier to make 
adjustments to follow a difficult track when you’ve set tracking to Frame mode (by clicking the 
Frame button). 

In Frame mode, you can keyframe window transformations to more faithfully conform to 
troublesome motion as you’re moving one frame at a time through the track; manual changes to 
a window’s position will be keyframed to create frame-specific transformations, rather than 
used to offset the entire tracked motion path as in Clip mode. When you add multiple keyframes 
in the Tracker graph, animation will be automatically interpolated from keyframe to keyframe.
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Copying and Pasting Tracking
There will be plenty of times you’ll apply multiple windows to a single moving subject, such as a 
car, when you can use a single motion track for all the windows. Commands in the Option menu 
let you copy and paste track data from one window to another within the same node, saving 
time when you want several windows tracking together as one.

To copy track data from one window to another:

1	 Open the Window palette, then select a window that has tracking applied to it 
(indicated by a tracking badge in the corner of the shape icon), and choose Copy Track 
Data from the Option pop-up. 

2	 Select another window, and choose Paste Track Data from the Option pop-up. Once 
you’ve copied track data from one window, you can paste it to as many other windows 
as you like.

You can also copy tracking from the FX mode of the Tracker palette and paste it to a Window, in 
case you want to use the same tracking data for both an effect and a window.

To copy track data from an FX track to a Window:

1	 Open the Tracker palette, choose the FX mode that contains the tracking data you 
want to copy, and choose Copy Track Data from the Option pop-up. 

2	 Open the Window palette, select a window, and choose Paste Track Data from the 
Option pop-up. Once you’ve copied track data from one window, you can paste it to as 
many other windows as you like.

Tracker Palette Controls in More Detail
You can easily combine object tracking and keyframing to animate windows. For example, you’ll 
typically use object tracking to make a window follow the position and orientation of a moving 
feature, but you can add dynamic marks to the window track of the correction in the Color page 
with which to alter its size and shape to better conform to a feature’s changing form.

Controls in the Window Tracker Palette
Occasionally, you’ll run into a shot that doesn’t quite track well enough using the Tracker menu’s 
simple controls. In these cases, the Viewer page provides the complete set of object tracking 
controls that can be used to modify tracking operations in different situations.

The Tracker palette

The Object Tracking Controls are divided into seven groups.
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Tracker Palette Modes
The Tracker palette’s Option pop-up menu lets you choose between Window mode (for 
matching a window to the motion of a feature in the frame), and Stabilizer mode (for subduing 
unwanted camera motion. For more information on Stabilizer mode, see Chapter 58, “Sizing and 
Image Stabilization.”

Types of Tracking
A pop-up menu below the Tracker graph lets you choose whether to use the Cloud Tracker or 
the Point Tracker.

The tracker type pop-up

There are two options:

�� The Cloud Tracker automatically analyzes all parts of the image for trackable points, 
and uses these to automatically figure out the motion in the shot that you want to use to 
move a Power Window or stabilize a shot. This tracker type is great for quickly tracking 
a window to match the movement of almost any feature, with a minimum of work.

�� The Point Tracker lets you create one or more tracker crosshairs that you can manually 
position in order to track specific features in the shot. The more crosshairs you create 
and position, the more accurate the track can be. The Point Tracker is incredibly useful 
in situations where you need to follow the motion of a very specific feature in the 
frame. It can also be useful in cases where you want to stabilize a shot that has many 
subjects moving in different directions, and it’s difficult to obtain a good result with the 
Cloud Tracker.

Object Tracking
The Object Tracking controls provide the most basic tracking functions, some of which are 
mirrored within the Tracker menu.

Choose which type of transform you want to track before tracking

A series of five checkboxes let you turn on and off which transforms you’d like motion tracking 
to apply automatically to the window. These checkboxes must be selected before you perform 
a track in order to restrict the transforms that are used. 

�� Pan and Tilt: Enables tracking of horizontal and vertical position, when you want to 
transform a window to follow the location of a tracked subject.

�� Zoom: Enables tracking of size, when you want to transform a window to resize to follow 
a tracked subject.

�� Rotate: Enables tracking of orientation, when you want to transform a window to rotate 
with a tracked subject.

�� Perspective 3D: Enables tracking of pitch and yaw in 3D space, when you want a 
window to skew to follow the orientation of a tracked subject within the scene. Good 
when you want the window to “stick” to a surface.
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After you’ve defined the transforms you want to use for the track, the analyze controls let you 
proceed with the analysis of the subject being tracked.

�� Track One Frame Reverse button: Motion tracks a single frame in reverse. Useful for 
slow tracking of difficult subjects that may require frequent correction.

�� Track Reverse button: Initiates tracking from the current frame backward, ending at 
the first frame of the clip. Good for tracking backwards when your best starting point is 
somewhere within the middle of the shot.

�� Pause button: Stops tracking (if you’re fast enough to click this button before tracking is 
finished).

�� Track Forward button: Initiates tracking from the current frame forward, ending at the 
last frame of the clip. 

�� Track One Frame Forward button: Motion tracks a single frame forward. Useful for 
slow tracking of difficult subjects that may require frequent correction.

Clip/Frame Controls
Two buttons let you set how manual adjustments to the position of tracked windows affect the 
overall track.

Selecting clip or frame to apply adjustments

�� Clip: The default mode, in which changes you make to the position of a window are 
globally applied to the entire track. For example, if you track a feature, and then move 
the window, the window moves along a motion path that’s consistently offset from the 
original track for the duration of the clip. Use this mode if you’re happy with the track, 
but you want to modify the window’s overall shape and position relative to the motion 
path it’s following.

�� Frame: In this mode, changes you make to the position or shape of a window create 
a keyframe at the frame at the position of the playhead. Multiple keyframes are 
interpolated to create animation with which you can manually transform a window to 
solve a variety of problems. This mode is useful for rotoscoping the shape and position 
of windows to match a subject that’s tough to automatically track. Frame mode is also 
useful for making corrections to individual frames that were badly tracked, for animating 
windows to go all the way out of frame along with a subject, or for making manual, 
frame-by-frame adjustments to window position to cover untrackable sections.

NOTE: Once tracking or stabilization has been done, disabling these checkboxes 
does nothing to alter the result. To make changes, you need to enable or disable the 
necessary checkboxes first, and then reanalyze the clip.
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The Tracker Graph
The Tracker Graph provides a visual display of the tracking data that’s being analyzed. Each of 
the transform controls that can be tracked has an individual curve, which lets you evaluate each 
tracked parameter on its own, and each curve is color-coded to match the corresponding label 
of the tracking transforms listed above.

Add keyframe and Interpolate between

A vertical slider to the right of the Tracker graph lets you scale the height of the curve data 
within to make it easier to see it all within the graph. Above the Tracker graph, a Timeline ruler 
contains a playhead that’s locked to the playheads in the Viewer and Keyframe Editor.

You can draw a bounding box in the Tracker graph with which to select a portion of one or more 
curves to delete sections of low-quality tracking data using the Clear Selected Keyframes 
command found in the Palette Options menu. To eliminate the current bounding box from the 
Tracker graph, click once anywhere within the graph.

Interactive Mode Controls
The Interactive controls, at the bottom-left of the Tracker palette, let you make manual changes 
to the automatically generated tracking point cloud that DaVinci Resolve creates when you’re 
tracking with the Cloud Tracker, so you can try different ways of obtaining better tracking results 
in challenging situations.

Interactive mode controls

�� Interactive Mode checkbox: Turns the Interactive tracking mode on and off. When you 
enter Interactive mode, you can manually alter the point cloud that DaVinci Resolve 
uses to track the feature within the current window. You’ll then make your track while in 
Interactive mode.

�� Insert: Lets you add tracking points to whatever trackable features exist within 
a bounding box that you’ve drawn in the Viewer. Inserted tracking points are 
automatically placed based on trackable pixels in the image.
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�� Set Point: Lets you use the cursor (using the DaVinci Resolve control panel), to 
manually place individual tracking points, one by one, with which to track a feature. 
If there is no trackable pixel group at the coordinates where you placed the cursor, a 
tracking point will be placed at the nearest trackable pixel group.

You must place at least two tracking points at different pixel groups to track rotation, 
and at least three to track zoom.

�� Delete: Eliminates all tracking points within a bounding box that you’ve drawn in 
the Viewer.

For more information, see “Using the Interactive Tracking Controls” later in this section.

Point Tracker Controls
If you’re using the Point Tracker, then the Interactive Mode controls disappear, replaced by the 
two controls of the Point Tracker.

Point Tracker controls

�� Add Tracker: Click to create a new tracker that’s automatically positioned in the center 
of the frame. Once created, you can drag it using the pointer to line up with the feature 
you want to track. You can create as many trackers as you like. Multiple trackers are all 
tracked at once.

�� Delete Tracker: Select any tracker (selected trackers are red, de-selected trackers are 
blue), and click this button to remove it.

Additional Commands in the Tracker Palette Options Menu
There are some additional commands located in the Palette Options pop-up menu.

�� Reset Track Data on Active Window: Lets you delete the tracking data corresponding 
to the currently selected window.

�� Clear Selected Track Data: When you drag a bounding box over parts of one or more 
curves in the Tracker graph, this command lets you delete that part of the graph. This is 
useful when you want to eliminate sections of low-quality track data. Portions of curves 
that are cleared in this way have linear interpolation automatically applied to them, 
similar to if you used the Keyframes Interpolation controls.

�� Delete Keyframe: Deletes tracker graph keyframes at the current position of 
the playhead.

�� Clear All Tracking Points: Clears the tracking points in the Power Window at the frame 
you are on.

�� Show Track: Turn this checkbox on to show the motion path produced by the tracking 
you’ve done.

�� Copy Track Data: Lets you copy track data from the currently selected window. 
Windows can be selected directly in the Viewer while the Tracker palette is open.

�� Paste Track Data: Pastes copied track data to the currently selected window. Windows 
can be selected directly in the Viewer while the Tracker palette is open.
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Cloud Tracker Workflows
The next few examples illustrate how to use the Tracker palette’s controls in practical situations. 
In many circumstances, objects passing in front of a tracked subject, known as “occlusions,” can 
cause problems. While the tracker in DaVinci Resolve is highly occlusion-resistant, the following 
sections show a variety of techniques you can use when an occlusion prevents you from 
getting a useful track.

Using Interactive Mode to Manually 
Choose Tracking Features
Interactive Mode lets you manually remove or add tracking points to improve tracking 
performance in situations where the automatic image analysis in DaVinci Resolve provides 
unsatisfactory results.

For example, you can delete tracking points within a window that correspond to overlapping 
features you don’t want to track. Suppose a car that you’re tracking drives by a sign that partially 
obscures the car. Without intervention, the PowerCurve that’s isolating the car will deform 
improperly when the car moves along and then away from the sign.

Using Interactive Mode, you can delete the tracking points that will overlap the sign you don’t 
want to track, improving the result.

To eliminate specific, unwanted tracking points from a track:

1	 Open the Tracker palette.

2	 Turn on the Interactive Mode checkbox.

Selecting Interactive Mode 

3	 In the Viewer, drag a box around the tracking points you want to eliminate within the 
window, and click the Delete button. The points within the selection area are deleted.

Dragging a box around tracking points that need to be deleted 
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4	 Click the Delete button.

Deleting tracking points 

The points within the selection area are deleted.

Remaining tracking points ready to be used

5	 While Interactive Mode is still on, click Track Forward or Track Reverse to track the 
subject using the remaining tracking points.

6	 When you’re finished tracking, click the Exit Interactive button.

In another interactive tracking example, you may sometimes run into situations where you want 
to eliminate all automatically placed tracking points altogether, placing your own in specific 
regions of the image.

To eliminate automatic tracking points, adding your own instead:

1	 Open the Tracker palette.

2	 Turn on the Interactive Mode checkbox.

ISelecting Interactive Mode

NOTE: If you delete tracking points and then disable Interactive Mode without 
performing a new track first, DaVinci Resolve goes back to using automatically placed 
tracking points.
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3	 In the Viewer, drag a box around all the tracking points in the window, and click the 
Delete button to eliminate all tracking points from the image.

Selection box surrounding all tracking points

4	 	Click the Delete button to eliminate all tracking points from the image. 

Deleting tracking points 

5	 Drag a box around the specific area where you’d like to add new tracking points. In this 
case, you only want to track the top half of the woman’s face, since the bottom half is 
cut off by the fence posts.

Placing the selection box over the top of the window 

6	 Now, click the Insert Track Points button.	
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The Insert button of Interactive Mode automatically adds tracking 
points within the current bounding box.

New tracking points are automatically added to whichever features are appropriate for tracking 
within the box you’ve drawn.

Tracking with the remaining tracking points

While in Interactive Object Tracking mode you may also choose to add tracking points 
one by one. 

To add a single tracking point:

1	 Open the Tracker palette.

2	 Turn on the Interactive Mode checkbox.

3	 Using the DaVinci control panel, press the CURSOR button above the fourth trackball 
of the Center panel, and move the onscreen cursor to the detail of the image that you 
want to add a tracking point to.

4	 Click the Set Point button, within the Interactive Mode controls of the Tracker palette. 

	This adds a tracking point corresponding to the feature of the image that you clicked, 
and you’re ready to start tracking.

Dealing With Occlusions When Tracking
Sometimes you’ll find that you need to deal with a gap in the useful tracking data. For example, 
objects in the frame that pass in front of the feature you’re trying to track cause gaps in the 
tracking information for a clip.

NOTE: If no appropriate tracking features can be found, no points will be added.
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In situations where a subject being tracked becomes totally occluded by another object in the 
frame, there’s an easy method of interpolating to cover holes in the available tracking data. In 
the following example, the woman walks behind another fence post, this time one that’s taller 
then she is. The window tracking her face will become completely lost at this point, but 
interpolation will help to salvage this shot.

Original clip

Interpolating between two sets of tracking data to track past an occlusion:

1	 Move the playhead to the first trackable frame of the moving feature you’re correcting, 
and create a Power Window that surrounds it.

Adding the Power Window 

2	 Use Track Forward to track the feature as far as you can before it becomes obscured 
behind something else in the frame.

3	 When the Power Window stops tracking the feature reliably, stop the track.

The Power Window is obscured by the post 
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4	 Open the Tracker palette.

5	 Click the Frame radio button to put the Tracker controls into frame-by-frame adjustment 
mode. This is an important step.

Selecting Frame mode 

6	 Move the playhead to the frame where the feature you’re tracking reappears from 
behind the occlusion, then drag the window so that it again overlaps the feature.

Moving the playhead and position the window 

7	 Use Track Forward to continue tracking the feature until the end of the clip. Alternately, 
you could have started from the end of the clip and used Track Reverse to track the 
feature as far as possible, if that’s easier.

Now that you’ve identified the gap in reliable tracking data for this clip, it’s time to set 
up the interpolation. 

Notice the gap in the tracking data where the window was behind the post

8	 Drag a bounding box over the portion of the curves in the Tracker graph that fall 
between the good tracking data at the beginning and end of the shot.
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9	 Click the Tracker palette option pop-up menu, and choose Clear Selected Track Data.

The portions of curves that you selected are deleted, and have linear interpolation 
automatically applied to them so that there’s no hole in the track data or the motion of 
the window, which now moves smoothly from the last outgoing frame of reliable 
tracking data to the first incoming frame of new reliable tracking data.

Point Tracker Workflows
As advanced as the Cloud Tracking that is the default in DaVinci Resolve is, there are times 
when it may be simpler to track using good old-fashioned crosshairs. The Point Tracker, 
introduced in DaVinci Resolve 12.5, makes it easy to track very specific features of a subject 
with motion you need to follow. Unlike the Cloud Tracker, which automatically looks for all 
trackable points within a region of the image that you identify using a window, the Point Tracker 
lets you create one or more crosshairs that you must manually position to overlap with whatever 
high-contrast features you want to track. This section covers the three main workflows you 
need to know to use the Point Tracker.

Tracking a Window Using the Point Tracker
The following procedure describes, in a general way, how to use the Point Tracker to track a 
moving subject and apply that motion to a Power Window.

1	 Move the playhead to the frame of the current shot where you want to begin (you don’t 
have to start tracking at the first frame of a shot, since you can always track backwards).

2	 Turn on any window, and adjust it to surround the feature you want to track. Typically, 
you’ll have done this anyway, for example, framing someone’s moving face with a 
Circular Window to lighten their highlights. You want to make sure that the window 
you want to apply the tracked motion to is selected before you begin tracking. In this 
example, we’ll be tracking a circular window to follow the woman’s face.

Setting up to track a window over a woman’s face
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3	 Open the Tracker palette, and choose Point Tracker from the bottom right pop-up. 

Choosing the Point Tracker

4	 Before you start tracking, choose what types of motion you want to track and apply to 
the window you’re working on. You can choose from among Pan, Tilt, Zoom, Rotate or 
Perspective 3D. Which methods of transformation can be applied depend on how many 
points you add to track.

Choosing what type of motion to analyze

5	 Click the Add Tracker button. A new tracker crosshairs appears in the Viewer in the 
center of the frame.

Clicking the Add Tracker button

6	 Move the pointer directly over the tracker crosshairs, and when it turns into the move 
cursor, click and drag to move the crosshairs to line up on top of the feature you want 
to track. For the best results, this should be a high-contrast detail such as a corner, the 
end of a line, a small shape like a pebble, or a jagged detail. Unlike other point trackers, 
there is no inside or outside region to separately adjust, there’s only the one crosshairs 
that you need to align. In this example, this first crosshairs is placed at the inside of her 
stage left eyebrow (the corner of her eye would introduce too much jitter as the tracker 
will pick up her blinks).

Lining up the tracker crosshairs with the feature you need to track
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7	 If you want to improve the accuracy of your track, you can create more tracker 
crosshairs and position them on top of other details within the subject you’re tracking. 
For the best results, make sure that all crosshairs are placed onto details that are in the 
same plane of motion. In other words, don’t put some crosshairs on a person’s face in 
the foreground, and other crosshairs on a tree that’s far in the background, since both 
these features will have very different vectors of motion. In this example, trackers are 
placed at her inside eyebrows and at the corner of her lips.

Setting up four trackers to follow the corners of her eyebrows and mouth

8	 When you’re done placing crosshairs, click the Track Forward or Track Backward 
buttons to initiate tracking. The clip will be analyzed, and the Tracker graph will update 
with the tracking data, and the window you had selected automatically moves to match 
the motion of the feature you’re tracking.

The final track, accomplished with four point 
trackers, with the track path turned on

Removing Trackers
If you find that a particular tracker is causing problems, you can remove it by selecting it in the 
Viewer, and clicking the Delete Tracker button, before retracking the subject.

Clicking the Delete Tracker button
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Using Frame Mode to Offset Track
A common issue when point tracking is how to deal with occlusions and times when the tracked 
feature moves off screen. In DaVinci Resolve, the solution is to use the Tracker Palette’s Frame 
mode to move the tracker crosshairs onto another feature to track, while offsetting the resulting 
motion so that it continues to follow the original motion path.

1	 In this example, a point tracker crosshairs has been positioned at a corner of a window 
of a building that’s being separately adjusted using a Power Window. The window is 
being used because, as the woman turns to leave, she covers up most of the other 
trackable outer edges of the building, which would ruin the track.

Setting up to track a building moving off screen

2	 As the camera pans, the feature being tracked is about to go off frame, which is about 
to ruin the track. As this happens, click the Stop Track button.

Stopping the track on the last good frame of the track, before the tracker goes off screen

3	 Move the playhead back to the last good frame of tracking, and then click the Frame 
button in the Tracker palette to go into Frame mode.

Turning on Frame mode, to prepare to offset the track
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4	 In Frame mode, you can now drag the tracker to another feature of the building, this 
time the outer edge of the roof, that will be better to follow as the building goes out of 
frame to the left, since the Power Window will go out of frame before the right-most 
corner of the building’s roof does.

Dragging the tracker to another feature that’s better to track

5	 Now, click the Track Forward button again, and the crosshairs will begin tracking the 
new feature, but the motion will be offset, so the movement of the Power Window 
continues to follow the original motion path.

Tracking an offset feature lets the window go all the way off screen

6	 If you turn on the track path (in the Tracker palette Option menu), and move the 
playhead to the frame where you moved the tracker, you can see that the motion 
before you moved the tracker and the motion after continues smoothly along the same 
path, with no sudden breaks. When you’re finished, click the Clip button to get out of 
Frame mode.

The tracker path before and after moving the tracker 
crosshairs in Frame mode is smooth and continuous
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Rotoscoping Window 
Shapes After Tracking
While the DaVinci Resolve trackers are pretty miraculous when it comes to making a window 
follow moving subjects, or elements within a moving scene, there will be plenty of times when 
the final track isn’t quite perfect. For example, if you’re trying to isolate someone’s face with a 
very specific window, and the person turns their head, then the resulting change of shape is 
almost certainly going to require you to make animated adjustments to the window in order to 
continue making such a specific isolation.

Before and after a window tracking a turning 
head, the window doesn’t quite follow the 
edge of the woman’s face as her head turns

Fortunately, the Tracker palette’s Frame mode makes it easy to animate shape changes you 
make to windows in order to better follow a moving subject, a task often referred to as 
rotoscoping. By following the motion of a moving subject, and making a series of automatically 
keyframed adjustments to the window at every point the subject changes speed or direction, 
you can make a window isolate a moving target with surprising precision.
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Using Frame mode to rotoscope the window to better 
follow the edges of her face and the contours of the jaw

Furthermore, you can also use Frame mode to repair imprecise tracks where the window is 
veering off course because of quickly or irregularly moving features. In these cases, you have 
the option of manually tracking the window in Frame mode to fit the trajectory of the feature, 
frame by frame.

Lastly, you don’t even have to have performed a track to use the Tracker graph in Frame mode 
to keyframe animated changes to a window. In fact, using the Tracker graph in Frame mode can 
sometimes be more convenient than using the Keyframe Editor in Auto Keyframe mode, 
depending on what you’re doing.

Rotoscoping Controls
The Clip/Frame buttons determine whether or not you’re rotoscoping a shape.

�� In Clip mode: Any changes you make to a window transform it over the entire duration 
of that clip. In other words, you can track a window to a moving feature, and in Clip 
mode any changes you make to the size, rotation, position, or shape of the window 
occur equally from the beginning to the end of that clip.

�� In Frame mode: Changes you make to a window automatically create a keyframe at 
the bottom of the ruler in the Tracker graph. Making two or more changes to a window 
in Frame mode results in automatically interpolated animation from one keyframed 
window transformation to the next.

You can freely move back and forth between Clip to Frame modes to make changes to a 
window. Even if you’ve keyframed a window to change shape, you can turn on Clip mode and 
make an overall change to the window, enlarging it for example, that results in the window 
being equally enlarged at every keyframe.

Keyframing in Frame Mode
Once you’ve added keyframes to the Tracker palette, there are a number of ways you can 
edit them.

Methods of working with keyframes in the Tracker graph:

�� To add a keyframe: Click the Add Keyframe button at the upper right-hand corner 
of the Tracker graph. It looks similar to the keyframe buttons found in the Edit page 
Inspector. This is useful for adding a keyframe to a frame where the window fits the 
subject well, prior to moving forward a few frames and making an alteration to the 
window to follow the subject that will generate another keyframe.
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�� To move the playhead from one keyframe to another: Click the Previous Keyframe 
and Next Keyframe buttons at the upper right-hand corner of the Tracker graph. These 
controls look similar to those found in the Edit page Inspector.

�� To delete a keyframe: With the playhead on the same frame as the keyframe you want 
to delete, open the Tracker graph option menu, and choose Delete Keyframe.

The Previous Keyframe, New Keyframe, and Next 
Keyframe buttons in the Tracker graph

A Rotoscoping Workflow
The following procedure demonstrates how to use a window to rotoscope an on-screen feature 
that you want to isolate. In the process, it shows how to set up a window for rotoscoping using 
the Tracker palette, and discusses some best practices for rotoscoping efficiently.

To rotoscope or manually track a window using automatic keyframing:

1	 Create a window to isolate the feature you’re wanting to adjust, and use the tracker to 
make it follow the motion of the subject. If the window doesn’t follow the contours of 
the subject as precisely as you require, then you can begin manually keyframing its 
shape on top of the tracking you’ve done to rotoscope the subject.

2	 With the Tracker palette open, click Frame to change the tracking mode.

Clicking the Frame button to begin keyframing your shape

The best way to use Frame mode for tracking is to either start at the last successfully 
tracked frame and work your way forward, or start at the first successfully tracked frame 
and work your way backward. This takes the best advantage of the automatic 
keyframing and interpolation between keyframes to animate the window you’re 
transforming smoothly.

3	 With the playhead at either the first or last frame where the window fits the subject 
you’re isolating, you can either click the Add Keyframe button at the upper right-hand 
corner of the Tracker graph, or wiggle any control point by a pixel or two, to add a 
keyframe at that frame. 

Clicking the Add Keyframe button 
in the Tracker graph
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Adding a keyframe at the last frame where the window follows the subject’s motion well 
means that any future animated changes you make interpolate from this frame forward, 
rather then from previous frames where there’s no need for alterations.

Adjusting the Window in Frame mode adds a keyframe

While you’re in Frame mode, the changes you make to the window automatically 
generate a keyframe in the Tracker palette, which appears at the bottom of the Tracker 
graph’s timeline.

Keyframes appear in the Tracker graph ruler

It’s frequently essential to add a keyframe at the last frame where a window conforms 
well to the subject you’re trying to isolate, in order to limit window animation from that 
frame to the next keyframed transformation, rather than accidentally animating from the 
beginning of the clip, or from the next or previous keyframe in the Tracker graph.

4	 Next, move the playhead to the next frame where the window requires adjustment to 
better fit the moving subject, and adjust the position of the window, the control points 
of the window, or both to isolate the subject as necessary.

Readjusting the Window in Frame mode to follow 
the subject’s motion
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This results in a second keyframe being placed in the ruler of the Tracker graph.

Two keyframes creating rotoscoped animation in 
addition to any motion tracking that’s applied

5	 With your first two keyframes placed, scrub the playhead back and forth between them 
to evaluate how well the window’s animation is automatically interpolating to fit the 
motion of the subject you’re isolating. If the window doesn’t follow the motion of your 
subject well enough, move the playhead to the frame where the window divergence is 
the most pronounced and make another adjustment to correct the shape.

A frame between the two keyframes you’ve 
rotoscoped that needs further adjustment

This creates create another keyframe.

After adjusting the in-between frame
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6	 When you’re finished making adjustments between your first two keyframes, move the 
playhead farther along and add keyframes as necessary to make the window follow the 
motion of your subject. 

In general, look for the frames where your subject’s motion starts, stops, speeds up, 
slows down, or changes direction. As you work, it’s good to try and add the fewest 
number of keyframes you can to ensure smooth motion from one to another. Too many 
keyframed adjustments made too close together for a smoothly moving subject risks 
adding jerky motion if you’re not careful. On the other hand, if you have an erratically 
moving subject, you may have to add more keyframes, possibly frame by frame, to 
achieve the desired result.

7	 When you’re finished rotoscoping the window, be sure to click the Clip button to switch 
back to Clip mode, so you can trim the Window’s shape across every keyframe you’ve 
just created, if necessary. This will also prevent you from accidentally adding more 
keyframes if you select other shapes.

This technique requires a bit more work then simply using the Tracker, but it’ll let you 
quickly adjust the animation of a window to more tightly conform to a moving subject 
when you need an adjustment to be specific to that subject alone. You can also use this 
technique to reposition specific motion path points in the middle of an otherwise 
successful track to make them fit better, or to add keyframes to the beginning or end of 
a track when the subject moves offscreen but the window does not.

Viewing a Window’s Motion Path
You can turn on the motion path of the window you’re tracking by choosing Show Motion Track 
from the Tracker palette’s Option menu, or by pressing the SHOW TRACK soft key on the 
Center panel of the DaVinci control panel when you’re in OBJECT TRACK MODE.

TIP: If you’re isolating a subject with a complex shape that moves quite a lot, 
you might consider using multiple simple overlapping shapes to track and 
rotoscope it, rather then a single complicated one, to make the task easier.
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Chapter 47

Using the Gallery 
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Using the Gallery
The Gallery provides a way to save, browse, and use saved still frames from different clips in a 
program. Each project is saved with its own individual set of stills, and each still you save 
consists of a DPX image of the saved frame, and the grade metadata. You can use saved stills 
for reference when matching one clip to another, or you can use them to copy grades to other 
clips, or other timelines. 

There are two ways to work with the contents of the Gallery. The Color page has a small 
Gallery, to the left of the Viewer, that provides quick access to saved stills and grades as you 
work. The Gallery window, which can be opened via a button at the bottom of the Gallery, 
provides a dedicated interface for organizing your grades, copying grades and memories 
between projects, and for accessing a dedicated collection of DaVinci Resolve Looks.

This chapter covers the following topics:

Using the Gallery	 836

Saving and Deleting Stills	 836

Where Are Stills Saved?	 837

Playing Stills and Setting Up Image Wipes	 838

Labeling and Searching for Stills	 838

Gallery Options	 839

Organizing Stills Using Albums	 840

The Gallery Window	 842

What’s Available in the Stills Navigator	 843

Importing and Exporting Stills	 844

Using and Organizing Memories	 845
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Using the Gallery
The Gallery in the Color page and the expanded Gallery window environment share many of 
the same commands for organizing stills. However, the commands for saving stills and 
customizing split-screen views are restricted to the Color page.

Color page Viewer and Gallery with Video Scopes

Saving and Deleting Stills
One of the most common operations is to save a clip as a still for future reference.

To save an individual still in the Color page, do one of the following:

�� Choose View > Stills > Grab Still (Option-Command-G).

�� Right-click on the Viewer and choose Grab Still.

�� Press GRAB STILL on the Transport panel of the DaVinci control panel.

It’s also possible to save stills automatically for every clip in the entire Timeline. This can be 
useful if you’re planning to export a set of grades to hand off to another colorist, or if you need 
to apply a series of grades manually from one project to another when ColorTrace™ won’t work.

To save a still for every clip in the current project, right-click the Viewer, and choose one of 
the following:

�� Grab All Stills > From First Frame: The first frame of each clip in the current Timeline is 
saved to the Gallery.

�� Grab All Stills > From Middle Frame: The middle frame of each clip in the current 
Timeline is saved to the Gallery.

�� Grab Missing Stills > From First Frame: Only the first frame of clips with no stills in the 
Gallery already are saved to the Gallery.

�� Grab Missing Stills > From Middle Frame: Only the middle frame of clips with no stills 
in the Gallery already are saved to the Gallery.
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Once the Gallery is filled with many stills, it may be necessary to make multiple selections for 
operations such as reorganizing, deleting, or exporting stills.

To select a range of stills, do one of the following:

�� Click one still, then Shift-click another to select a contiguous range of stills.

�� Command-click any stills you like to make a discontiguous selection.

�� Right-click any still, and choose one of the following commands:

�� Select All: Selects every clip in the Gallery

�� Select Current to Last: Selects every still from the one you’ve clicked through the 
last still in the Gallery.

�� Select First to Current: Selects every still from the one you’ve clicked through the 
first still in the Gallery.

If you need to remove one or more stills, this can only be done using the Gallery’s 
contextual menu.

To delete one or more stills, do one of the following:

1	 Select one or more stills in the Gallery.

2	 Right-click one of the selected stills and choose Delete Selected.

Each still is also saved with a variety of metadata that is used by DaVinci Resolve to manage the 
contents of the Gallery in different ways. This metadata can also be used for searching and 
sorting, and is viewable by opening the Still Properties window.

To display a still’s properties:

Right-click a still in the Gallery and choose Properties. 

A floating translucent window appears displaying the date the still was created, what clip it was 
grabbed from, when it was grabbed, and the source and record timecode values of the frame it 
came from.

Right-click on a still to choose Still Properties 

Where Are Stills Saved?
By default, all stills you save are saved in the DPX format, and are placed in the directory path 
defined in the “Gallery stills stored at” field in the Working Folders section of the Master 
Settings panel of the Project Settings. This path defaults to a hidden “.gallery” directory that’s 
created at the location of the first Media Storage Volume you specify in the Media Storage 
panel of the System Preferences window.
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Playing Stills and Setting Up Image Wipes
There are many ways to play a still in the Color page, making it visible as an image wipe in the 
Viewer and on the external display connected to your video interface.

To play a still, displaying it as an image wipe or full screen, do one of the following:

�� Double-click a still in the Gallery.

�� Select a still in the Gallery, and click the Image Wipe button on the top Viewer toolbar.

�� Click a still in the Gallery, then right-click in the Viewer and choose Toggle Wipe.

�� From the View menu, choose Next Still (Option-Command-N) or Previous Still 
(Option-Command-P) to select a still in the Gallery, and then choose Wipe On/Off 
(Command-W) to play it.

�� Press PREV STILL or NEXT STILL on the Transport panel of the DaVinci control panel to 
select a still, then press PLAY STILL. Press PLAY STILL again to dismiss the still.

Whenever you play a still, the Viewer mode’s pop-up menu changes to Split mode.

Once displayed, the wipe between the current clip and the still being referenced can be moved 
and reoriented in different ways. If you want a full-screen view so you can flip back and forth 
between the still and the current clip, simply adjust the split until the still fills the entire Viewer.

To adjust a wipe in the Viewer, do one of the following:

�� Drag the pointer within the Color page’s Viewer to move the wipe.

�� Push the T-bar lever up and down on the T-bar panel of the DaVinci control panel.

To customize the type of image wipe that’s displayed in the Viewer, do one of the following: 

�� Click any of the controls at the top right of the Viewer toolbar to choose Horizontal, 
Vertical, Mix, Alpha, and Difference types of wipe.

�� Choose Gallery, Timeline, or Offline from the View > Reference Wipe Mode submenu, 
or the Viewer contextual menu.

�� Choose Horizontal, Vertical, Mix, Alpha, and Difference from either the View > Wipe 
Style submenu, or the Viewer contextual menu.

�� Choose View > Invert Wipe, or right-click the Source Viewer and choose Invert Wipe 
from the contextual menu to reverse each half of the wipe.

Labeling and Searching for Stills
By default, all stills are identified by a three number code. The first number is the video track 
the clip is on, the second number is the clip’s position number in the current Timeline, and the 
third number is the version number.

All stills are numbered
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If you’ve saved many stills, it can help to label the important ones with whatever text you like 
(it’s best to avoid using the forward slash character). Once labeled, you can search for stills by 
label using the search field, at the upper right-hand corner of the Gallery.

To label a still:

1	 Right-click a still in the Gallery and choose Change Label.

2	 Type a name into the Change Still Label dialog, and click OK.

The new label appears underneath the still number.

You can also label stills for easier identification

To search for a still by label:

Click the Magnifying Glass button to open the Search field, click to place the cursor 
within, and then type the name or description you are searching for.

As soon as you start typing, DaVinci Resolve automatically begins to filter the results of the 
currently selected album in the Gallery to match what’s been typed. 

Gallery Options
When you right-click the gray area of the Gallery, behind the Still icons, you can open a 
contextual menu that provides a variety of additional options for controlling how many stills are 
saved, how they’re displayed, and how they’re arranged in the Gallery. There are the 
following options:

�� Switch Wipe Mode: Switches the Reference mode between showing a “Gallery” still, a 
“Timeline” clip, or an “Offline” reference movie.

�� Trace Timeline: When enabled, selecting a clip in the Timeline also automatically 
selects the first still that was saved from that clip to the Gallery.

�� One Still Per Scene: When enabled, restricts the Gallery to save only a single still for 
each clip in the Timeline. If multiple stills have already been saved before turning this 
option on, those stills will remain in the Gallery until you save another still from the 
same clip, at which time all other stills from that clip will disappear.

�� Apply Display LUT: If you have a Display LUT selected in the Look Up Tables panel of 
the Color Management panel of the Project Settings, it’s applied to the video output via 
a connected video interface, and also to the Viewer. Ordinarily, you don’t also want the 
display LUT applied to stills you’re saving since it’s meant to be temporary. Accordingly, 
stills are saved with a LUT-free image. However, in instances where you may also want 
to save a reference to the currently used Display LUT, turning on “Apply Display LUT” 
saves the Display LUT along with the still, and applies that LUT when that still is used for 
split-screen reference. Keep in mind that the internally saved Display LUT is only used 
when playing that still in the Viewer; the DPX image that’s saved remains unaffected.
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�� Sort Stills By: Choosing an option from this submenu changes the sort order of all clips 
in the Gallery. The options are: 

Record Timecode: Sorts all stills by their position in the program.

Source Timecode: Sorts all stills by the timecode of the source clip they came from.

Create Time: Sorts stills based on when you saved each still.

Clip and Create Time: A two-level sort; stills are sorted primarily based on the ID 
number of the clips they came from, and secondarily based on the time they 
were created.

�� Apply Grades Using: This submenu contains three options for how to apply the 
keyframes that are automatically saved within each saved grade.

No Keyframes: No keyframes are copied. The state of the grade at the frame used to 
save the still is what is applied to the target clip or clips.

Keyframes aligning Source Timecode: Keyframes are copied aligning the source 
timecode of the saved grade with the source timecode of the target clip. This is the 
ideal setting when you’re copying a grade back to the clip it came from originally, or to 
a duplicate of that clip elsewhere in the Timeline, and you want the keyframes to align 
with the same frames as before. If there is no source timecode overlap, keyframes will 
be pasted aligning with the start frame of the edit, the same as the third option (below).

Keyframes aligning start frame of edits: Keyframes are copied aligning the start frame 
of the clip that still was saved from with the start frame of the target clip. This is the 
ideal setting when you’re copying a grade with keyframes from one clip to a completely 
different clip, with different timecode.

Show All Stills: This command shows all available stills in the current album if any have 
been hidden, for example by searching or by using the Show Current Timeline 
Only command.

Show Current Timeline Only: Choosing this option restricts the Gallery to only showing 
the stills that were saved from the currently selected Timeline. All other stills from other 
Timelines are hidden until you switch to that Timeline.

Organizing Stills Using Albums
All stills you save are always placed into the currently open album of the Gallery, which defaults 
for new projects to “Album 1.” However, you can create additional albums with which to organize 
your stills into whatever categories you require. Albums can be shown, created, and removed 
using the Gallery in either the Color page or Gallery windows.

Use Albums to organize your stills

NOTE: There are a variety of other commands available in this contextual menu that 
are covered elsewhere in this chapter.
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To show or hide the Albums list:

Click the Album button, at the top left of the Gallery .

If hidden, the Albums list appears, to the left of the Gallery, containing all albums that are 
currently available in the project that’s open, as well as the PowerGrade album at the bottom. If 
the Albums list is already visible, then it becomes hidden, making more room for still thumbnails 
in the Gallery.

Once you’ve displayed the Albums list, there are a variety of ways you can quickly and easily 
work with albums.

Methods of working with albums:

�� To add a new album: Right-click the Albums list, and choose Add Still Album from the 
contextual menu. A new album is created, numbered incrementally.

�� To add a new PowerGrade album: Right-click the Albums list, and choose Add 
PowerGrade Album from the contextual menu. A new album is created, numbered 
incrementally.

�� To rename an album: Double-click any album in the list, and when it is selected, type a 
new name and press Return.

�� To navigate albums: Click any album to make it the current album. Using the 
DaVinci control panel, you can use the PG UP/GALLERY/PG DOWN button; press 
SHIFT UP and GALLERY to move to the next album up the list, or press SHIFT DOWN 
and GALLERY to move to the next album down the list.

To move clips from one album to another: Drag and drop a still from the Gallery to an album.

To remove an album: Right-click any album, choose Remove Current Album, and click Delete at 
the prompt. All clips inside that album will be deleted along with the album, so use this carefully.

PowerGrade Albums
PowerGrade albums are meant to be repositories for grades you want to reuse frequently, or for 
stills that you need to reference from multiple projects, such as when grading a series that 
shares common looks from episode to episode.

PowerGrades are associated with your user login
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Unlike stills saved to the other albums in the list, which are ordinarily available only to the 
project in which they were saved, stills saved to a PowerGrade album are shared among all 
projects that have been stored within a particular database. Each database has its own unique 
PowerGrade album.

Creating a new database creates a new PowerGrade album, which starts out as a clean slate. 
However, you can always use the Gallery window to copy PowerGrade stills from other projects 
and databases to the current one, and you can create as many PowerGrade albums as you 
need to organize your grades. For more information about project management and databases, 
see Chapter 2, “Managing Projects and Databases.”

Functionally, PowerGrade albums are identical to any other album, and you can save, organize, 
and use stills in PowerGrade albums as you would with other albums. Since PowerGrade 
albums are special in that they’re maintained by DaVinci Resolve, the last PowerGrade album 
cannot be deleted.

The Gallery Window
While you can do quite a lot of stills management using the Gallery as it appears in the Color 
page, the Gallery window provides additional functionality for copying stills among different 
projects and databases, for organizing your stills and memories, and for accessing the DaVinci 
Resolve Looks that accompany the application.

Gallery window

To open the Gallery window:

Click the Open Gallery button at the upper right-hand corner of the Gallery.

The Gallery opens into a floating window, divided into four areas:

�� Stills navigator: Lets you navigate the contents of other projects and databases that 
are available. Independent projects, as well as database > user > project relationships, 
appear in this hierarchical list. Click the disclosure triangle next to any item on this list 
to reveal its contents. Click any project in the list to reveal its albums and stills in the 
Group Stills browser.
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�� Group Stills browser: Displays the contents of the currently selected item in the Stills 
navigator. One or more selected stills can be copied to the current project by selecting 
an album in the Project Stills browser, and dragging and dropping the selected stills to 
the Project Stills browsing area.

�� Project Stills browser: Contains the same Album list and Project Stills browser that’s 
visible in the Color page Gallery.

�� Project Memories: Provides a larger view of the project memories that are visible in the 
Color page Gallery.

To resize different areas of the Gallery window:

Move the pointer to the border between any areas of the Gallery. When the pointer 
changes to the resize cursor, drag the border to resize the adjacent interface areas to 
whatever size you need. Dragging all the way to the edge of the screen hides that 
interface area completely.

What’s Available in the Stills Navigator
The Stills Navigator accesses a variety of content via a hierarchical list. Disclosure triangles to 
the left of each item in the Stills browser let you access the contents of each item, and many 
items have several nested levels of content within, each accessed by its own 
disclosure triangle.

The Gallery Stills database show all projects connected so you can import those stills

�� DaVinci Resolve Looks: A collection of predefined grades, categorized by type, 
that provides excellent examples of different looks available in DaVinci Resolve. 
These grades are installed with DaVinci Resolve and cannot be altered.

�� Databases: Each database that’s available appears within this list. Each database 
has a nested series of Users, Projects, and Timelines within, as well as one nested 
PowerGrade item for each user, which provides access to the saved stills within.

�� Orphans: Stills are saved to a separate directory which is defined in the Master 
Settings panel of the Project Settings. Whenever you delete a database, the stills 
that corresponded to that database become orphaned. All orphaned stills that 
lack a connection to any current database appear within the Orphan item in the 
Stills Navigator.
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Importing and Exporting Stills
It’s possible to import still images in different graphics formats into the Gallery, which can be 
particularly useful when a client provides reference images to which they’d like you to refer. It’s 
also possible to export stills from the Gallery, which is good for sending a series of reference 
stills for approval to a remote client. In both cases, you can choose whether to import or export 
images with an accompanying LUT.

For both import and export, DaVinci Resolve supports the following file formats: DPX, CIN, TIFF, 
JPEG, PNG, PPM, BMP and XPM.

To import one or more still images:

1	 Right-click anywhere on the gray background of the Gallery.

2	 Choose one of the following commands:

�� Import: Imports image files, along with a matching DRX file, if one is present in the 
selected directory.

�� Import With Output LUT: Imports an image and DRX file, along with a matching LUT 
file, if one is present in the selected directory.

3	 When the Import Stills dialog appears, choose the type of files you want to import from 
the “Files of type” pop-up menu, then navigate to the files you want to import, select 
them, and click Import. 

To export one or more still images:

1	 Select one or more stills in the Gallery.

2	 Right-click one of the selected stills, and choose one of the following commands:

�� Export: Two files are saved for each still you selected. An image file in the format of 
your choice, and a DRX (DaVinci Resolve eXchange) file that contains the grading 
metadata that was saved with that Gallery still.

�� Export With Display LUT: If you have a Video Monitor Lookup Table specified for the 
current project in the Color Management panel of the Project Settings, this command 
will output the image as it is processed by the specified LUT. A DRX file is also output 
containing the grading metadata that was saved with that Gallery still.

3	 When the Export Stills dialog appears, choose a file format to export to from the “Files 
of type” pop-up menu, then choose a location, type a name into the Save As field, and 
click Save.

Each of the selected stills is exported with all accompanying files. Each file uses as its 
prefix the name you typed into the Export Stills dialog, followed by an underscore, the 
still ID number of the selected still, and the three letter file extension.
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Using and Organizing Memories
Stills and memories contain identical information, and can be split screened, copied, appended, 
exported, and can display their node graph just like any other still. However, stills that are 
assigned as a memory make them easier to access via keyboard shortcuts, and from dedicated 
buttons on the DaVinci control panel.

Memories are hidden by default, but you can reveal them by clicking the Memories button, to 
the right of the Gallery list button at the top-left of the Gallery.

Place grades you will use often in Memories for faster recall

The Memories thumbnail display makes it easy to keep track of which stills have been assigned 
to which memories in situations where you’re using multiple memories to copy grades 
throughout a program.

To copy stills and memories back and forth, do one of the following:

�� Drag a still onto a memory bank.

�� Drag a memory into the Gallery.

To save the current clip’s grade to a memory for future use, do one of the following:

�� Choose Color > Memories > Save Memory A–H (Option-1 through 8)

�� Using the DaVinci control panel, press CRNT on the Transport or T-bar panel, then 
press the letter of the memory bank you want to save to. Use the SHIFT UP button to 
save to another memory sharing the same button.

�� If you save a grade to a memory that already contains something, the previous memory 
is overwritten.

To apply a memory to the current clip in a timeline, do one of the following:

�� Right-click a memory and choose Apply Grade.

�� Choose Color > Memories > Load Memory A–H (Command-1–8)

�� Using the DaVinci control panel, press the letter of the memory bank you want to apply. 
Use the SHIFT UP button to apply a memory that shares the same button.

To clear a memory:

Right-click a memory, then choose Clear.

TIP: In this way, memories can be used to copy stills from one album 
to another.
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Chapter 48

Grade 
Management 
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Grade Management
The Color page offers numerous ways of saving grades, copying grades, creating and altering 
groups of clips to share grades, rippling grades and adjustments, and managing multiple 
versions of grades. All of these procedures enable you to work faster by leveraging work you’ve 
already done to apply to other clips that can benefit from the same adjustments, or by applying 
changes across multiple clips all at once.

This chapter covers the following topics:

Using Versions to Manage Grades	 848

Choosing to Copy Grades Manually or Automatically Using Versions	 848

Using Local Versions by Default	 849

Using Remote Versions to Enable Automatic Linking	 849

Working with Versions	 855

The Importance of “Version 1”	 857

Deleting Unused Versions	 857

Rendering Versions	 858

Copying Grades 	 858

Protecting Adjustments with the Copy Grade Options	 858

Clip Grades and Timeline Grades in Saved Stills	 859

Choosing Which Aspect of a Grade to Copy With All/Color/Sizing	 859

Choosing How to Copy Keyframes	 859

Copying Grades Using the Mouse	 860

Copy Forward Commands	 861

Copying Using Memories	 861

Copying Using Preview Memory	 862

Copying from Stills in the Gallery	 862

Append Node Graph	 863

Aligning Keyframes to a Specific Frame While Copying Grades	 864

Copying Individual Nodes and Settings	 865

Copying and Pasting All Settings From One Node to Another	 865

Copying From the Node Graph of Other Clips or Gallery Stills	 865

Rippling Adjustments Among Multiple Clips	 868

Appending A Node to Multiple Clips	 869

Scroll Copy Grades Using the DaVinci Control Panel	 870

Rippling Changes Using the DaVinci Control Panel	 871

Using Groups	 873

Creating and Managing Groups	 874

Using Group Modes to Control which Grades Ripple and which Don’t	 875

Collapse Group Grades	 878

Exporting Grades and LUTs	 880
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Using Versions to Manage Grades
Working quickly requires a mastery of the numerous grade management features built into 
DaVinci Resolve. These features are designed to help you copy and ripple grades to individual 
clips, among manually defined groups of clips via the Node Editor’s Clip mode, or among 
automatically linked clips that share the same source clip in the Media Pool (when using Remote 
versions). Multiple versions of grades are supported for every clip, as are various options for 
previewing, overwriting, and appending these versions.

Choosing to Copy Grades Manually 
or Automatically Using Versions
Each grade you apply to a clip is a version. Each clip can have multiple versions, although only 
one version can be applied at a time. By default, the first grade applied to every clip in a 
timeline is a local version named “Version 1.” A clip’s version name and/or number appears 
underneath the clip thumbnail, to the right. You can also see the version name, along with a list 
of all the other versions that are currently available to that clip, by right-clicking a clip in the 
Timeline and looking for the version names that appear underneath the Local 
Versions submenu.

Selecting versions of grades from the Timeline thumbnails

There are two different types of versions in DaVinci Resolve, each of which provides a different 
method of grade management and linking among the clips and timelines of a project.

�� Local Versions: The default mode of grade management. Clips using local versions are 
unlinked, so each clip has its own grade which is not shared with any other clips in any 
other timelines. Changing the grade of a clip using a local version has no effect on any 
other clip in that project. 

�� Remote Versions: An alternate mode of grade management that you can enable. 
All clips using remote versions that share the same source clip in the Media Pool are 
automatically linked, in all timelines, and share the same set of grades.

NOTE: Double-clicking the version name underneath a clip’s thumbnail in the Timeline 
toggles the version names to the codec used by each clip. Double-click again to 
toggle back.
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If you use local versions to grade all your clips, you don’t have to worry about one clip’s grade 
being accidentally copied to other clips that happen to come from the same file in the Media 
Pool, which can make it easier to work. On the other hand, you need to manually copy every 
grade that you want to duplicate, even among clips that clearly come from the same take or 
angle. You can always create a group to share a grade among clips using local versions, but 
that’s an extra step.

Switching to use remote versions, instead, puts you into a mode where clips using remote 
versions that share the same media file are automatically linked together. This gives you a 
convenient shortcut for grading your program, since a grade that’s applied to one linked clip is 
automatically copied to every other clip it’s linked to, which can be convenient when grading a 
series of headshots appearing throughout a program that come from the same interview take. 
Another use of remote versions is when you’re importing a new edit of an already graded 
timeline. Using remote versions, you can set your project up so that new incoming timelines are 
automatically relinked to the previous timeline’s grades.

The only disadvantage to using remote versions is that when you find you need to make 
individual adjustments to clips that are linked, it’s an extra step to either create another version, 
or switch that clip to use a local version, in order to keep its adjustment separate. This will be 
discussed in more detail later in this chapter.

Mixing Versions
Each clip is capable of having multiple local and remote versions at the same time; you get to 
choose which to apply. Which type of versioning is best depends on the type of project you’re 
working on, the way in which the media was shot, and how you like to work. The following 
sections explain the differences in workflow.

Using Local Versions by Default
Since local versions are the default method of grading when you first create a new project 
(unless you’ve edited your settings presets), you don’t need to do anything to enable this mode 
at first. As the name implies, local versions are local to the Timeline in which they appear, so 
local versions are not rippled to linked clips, and they’re not shared among different timelines. 
This makes it easy to avoid accidentally having grades copied when you don’t want them to be, 
but you lose the conveniences that automatic linking can provide.

However, you can always switch the clips in a timeline to use Remote versions if you change 
your mind, either individually, or all together.

Using Remote Versions to Enable Automatic Linking
Remote versions let all clips from the same source media file in the Media Pool share their 
grades automatically, either within a single timeline, or across multiple timelines in the same 
project. However, to enable the convenience of remote grades, you need to put DaVinci 
Resolve into this mode of working using the Settings Window. 

To enable remote grades to be used:

Open the Project Settings, open the General Options panel, and turn off “Use local 
version for new clips in timeline” in the Color section.

Turning this option off only affects clips that are added to Timelines from that point onward. 
You can keep track of which clips use remote versions by the (R) that appears when you 
double‑click the area underneath the thumbnail to hide the codec name in the 
Thumbnail timeline.
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Turning off “Use local version for new clips in timeline” to 
enable remote grades to be used by default

How Automatic Linking Works
When clips using remote versions have been added to a timeline, any other clips in any timeline 
that (a) use remote versions also, and (b) refer to the same file in the Media Pool are linked. 
Selecting a clip using a remote grade in the Color page that is automatically linked to one or 
more clips displays a small “linked” badge at the left of that clip’s timecode in the 
Thumbnail timeline.

The linking arrow shows this clip has the same 
source as the one selected on the Timeline

Adjustments that you apply to a remote version of one linked clip are automatically rippled to 
every other clip it’s linked to, which can save you an enormous amount of time when you’re 
getting started with a new program. For example, if every reverse angle from the same take in a 
particular angle of coverage is automatically linked using remote versions, then the grade you 
apply to one reverse angle clip will ripple to every other reverse angle clip throughout 
the Timeline.

Timeline with three automatically linked clips shown, and codec names 
hidden to reveal the (R) that shows these clips are using remote grades

So long as remote versions are enabled, there are other ways that linked clip relationships are 
formed. If, after conforming an AAF, XML, or EDL, you used the Split Clips button in the Color 
page to split one conformed clip into many, each of the clips you split would be linked, since 
they too would share the same source media in the Media Pool.

TIP: The Timeline Filtering pop-up in the Color Page toolbar has an option 
named “Common Media Pool Clips” that only shows clips in the Timeline that 
are linked to the currently selected clip.
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Finally, automated linking also occurs for clips that appear in multiple timelines that also use 
remote versions. As a result, the grade you apply to one linked clip is automatically rippled to 
every other clip it’s linked to.

Creating a Master Timeline
DaVinci Resolve version 9 and earlier would automatically create a Master Timeline whenever 
you added clips to the Media Pool. This changed in versions 10 and later, which by default have 
no Master Timeline. However, if you want to create a Master Timeline in order to use it as you 
would have before, this is easy to do.

If you want a Master Timeline to have a single timeline that always contains all clips currently in 
the Media Pool, there’s a way you can create one. However, you need to do it immediately upon 
creating a new project, before adding any media to the Media Pool. Once you’ve added one or 
more clips to the Media Pool, the option you need to do so will be disabled.

To create a new Master Timeline:

1	 Create a new project, open the General Options panel of the Project Settings, and turn 
on the “Automatically match master timeline with media pool” checkbox in the Color 
section. If you also want all clips to use Remote versions as you grade by default as 
in previous versions of DaVinci Resolve, you can turn off the “Store grade with local 
version by default.”

2	 Click Save.

3	 Open the Edit page, and choose File > New Timeline (Command-N).

4	 When the New Timeline Properties window appears, turn the Empty Timeline checkbox 
off, and click Create New Timeline.

5	 Now, in addition to the new Timeline, a Master Timeline appears in the Timeline list.

NOTE: Media management or media consolidation operations that split large source 
media files into many individual media files will defeat automatic linking within the 
same timeline, since each clip will be conformed to its own individual media file.

Starting With Remote Versions, Then Switching to Local Versions

It’s possible to combine the best aspects of remote and local versions into a single 
workflow, taking advantage of your ability to freely switch from one to the other. Since 
remote versions make it easy to copy grades among clips that are similar, you can 
switch to using remote versions first, and then grade your way though the Timeline 
until you get to the point where you need to start making much more specific changes 
to individual clips. Then, it’s easy to either switch each linked clip that needs individual 
adjustment to use a local version, or to use the Copy Remote Grades To Local 
command (described later) to copy the current remote version of each and every clip 
to a local version, at which point you can make all the specific tweaks you need to 
without worrying about changes being accidentally copied.
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Once created, the Master Timeline contains every clip in the Media Pool of the current project. 
If you color correct the clips in the Master Timeline, you’ll find there’s only one set of versions 
available, found underneath the Local submenu of the Color Page timeline’s contextual menu. 
It’s important to understand that local versions within the Master Timeline are in fact the remote 
versions found in every other timeline of that project. 

In fact, it would be fair to say that the remote versions found in other timelines are actually the 
Master Timeline’s versions. When you grade a clip in the Master Timeline, those grades ripple 
out to every other instance of that clip, in every other timeline within that project, via 
remote versions.

Sharing of remote versions among the Master Timeline and newly conformed timelines is why 
you can grade a collection of clips that you import into DaVinci Resolve without any editorial 
structure, grade and output offline media, and then reimport a project file that relinks to the 
original clips along with their grades. It’s also why you can grade clips in one timeline, and then 
import additional re-edited timelines via AAF, XML, or EDL, which automatically inherit all 
remote versions of grades that were created in previous timelines.

Differentiating Clips with Individual Versions
If you’ve enabled DaVinci Resolve to add clips with remote versions, there are times when you 
may want to suspend automatic linking. As convenient as automatic grade rippling among 
linked remote versions is, there are many instances where you may need to stop it. For 
example, if the Media Pool contains a source media file with the entire content of an interview, 
then every clip that has been conformed to that source media will be linked, which is ordinarily 
good since you’d expect they’d all share the same grade. However, if the DP fiddled with the 
exposure of the camera in the middle of the interview, such that some clips are lighter and 
others are darker, you may find yourself needing to make different adjustments to clips from 
different parts of the interview.

One way of doing this, which can be useful in timelines where you only need to make a few of 
these kinds of changes, is to create a new remote version for every clip to which you need to 
make an individual adjustment. Since each version is its own grade, and differently named 
versions don’t link to one another, this is a simple solution.

To suspend linking by creating a new remote version:

1	 Move the playhead to the clip you need to alter individually.

2	 Do one of the following:

�� Choose Color > Add Version (Command-Y).

�� Right-click the thumbnail in the Timeline, and choose Remote Versions > Create 
New Version.

�� Using the DaVinci control panel, press ADD VERSION on the T-bar panel.

3	 Grade the new version that’s appeared.
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While this method works well, keep in mind that multiple linked clips using the same version 
number will always be linked with one another. In other words, suppose Clip 12, Clip 14, and Clip 
16 are linked using the default Version 1, which has a strong blue grade applied.

Three clips automatically linked, sharing a blue grade

Then, you set Clip 14 to use Version 2 with a different grade, tinted red. Clip 14 is now unlinked 
from Clips 12 and 16.

Setting the second of the three clips to use another 
version with a different remote grade sets it apart

However, switching Clip 16 to also use the red-tinted Version 2 means that Clip 14 and Clip 16 
are now linked together, but Clip 12 is no longer linked.

Setting the third of these clips to share the same remote version as the 
second clip now links those two together, omitting the first clip

Every new remote version you create, and every change you make, becomes available to all 
other clips in all other timelines that comes from the same source Media Pool clip as the shot 
you’re working on. However, any clip can use any version, and which version is used by a linked 
clip is not rippled. 

For example, Timeline 1 contains a clip named “Max CU,” which has three remote versions. 
Timeline 5 also contains “Max CU,” which is currently set to use “Version 2.” If you open 
Timeline 1 and add one more remote version to “Max CU,” that new version will also be 
available to “Max CU” in Timeline 5, but it will still be set to use “Version 2.”

Switching Clips Between Local and Remote Versions
You can also suspend remote version grade linking by switching individual clips to use local 
versions. This makes it easy to create a situation where some clips are linked, and other clips 
are not. Keep in mind that each clip has both local and remote versions, so you can switch from 
one to the other without losing anything.

To suspend linking by setting individual clips to use a local version:

Right-click a clip thumbnail, choose the submenu of the corresponding remote version 
you want to copy, and choose Copy to Local. The remote version is copied to a local 
version, which now appears as the current version that’s used, with an (L) appearing at 
the end of the name.
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You can also set every clip in the entire timeline to use local versions. If you switch an entire 
timeline to local versions, then no clip in that timeline will be linked to any other unless you 
create a group (covered later in this chapter). This is the default state, but it’s useful even when 
you’ve switched to using remote versions when you want to grade one timeline differently from 
the others in a project, for example when doing a trim pass for another video or stereo 3D 
format, or when grading another cut, such as a trailer, that uses the same media but requires a 
different look.

To suspend linking by switching from remote versions to local versions:

Right-click any clip thumbnail, and choose one of the following commands:

�� Use Local Grades: Switches all clips to their local versions. If there are already local 
versions defined for each clip, those will appear. If there are no local versions yet 
defined, each clip will be ungraded.

�� Copy Remote Grades to Local: Copies the currently assigned remote version of each 
clip to a local version.

Because Undo is used only for individual clip operations, the Use Local Grades and Copy 
Remote Grades To Local commands cannot be undone. However, switching a timeline from 
remote to local versions is not a one-way trip. You can select Use Remote Grades to switch 
every clip in a timeline back to the remote versions at any time.

To switch a timeline back to using remote versions:

Right-click any clip thumbnail, and choose Use Remote Grades.

Furthermore, you can also copy the local grades you made to be remote grades, for instances 
where you started grading with local grades, and you want to switch to remote grading using 
your local grades as a starting point. Be aware that when you do this in a timeline with many 
clips that share the same source media, the grade of the very last shared clip in the Timeline will 
be the only remote grade that’s used for those auto-linked clips.

To copy every clip’s local grade to a remote grade:

Right-click any clip thumbnail, and choose Copy Local Grades to Remote.

If you’re switching back and forth between local and remote versions, keep the following 
rules in mind:

�� If you select Use Remote Grades, change your remote grades, and then Copy Remote 
Grades To Local on that timeline again, you’ll overwrite all of your previously graded 
local versions. This is a good workflow if you don’t like what you’ve done with your local 
versions, and you want to start over by recopying the remote versions.

�� If you select Use Remote Grades, change your remote grades, and then select Use 
Local Grades, you’ll return to your previously graded local versions, as they were 
before you selected Use Remote Grades. This is a good workflow if you just want to 
switch back to your remote versions in order to copy the remote versions of specific 
clips to local versions.
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Working with Versions
Each clip can have as many local and remote versions as you like. There are commands for 
creating, renaming, and deleting the versions that are available to each clip when using the 
pointer, keyboard shortcuts, or the DaVinci control panel. When using the DaVinci control panel, 
the buttons affect whichever type of version (remote or local) is currently applied to the 
current clip.

To create a new local or remote version quickly, do one of the following:

�� Choose Color > Add Version (Command-Y).

�� Using the DaVinci control panel, press ADD VERSION on the T-bar panel.

A new version is created, identical to the type of version that was previously selected (remote 
or local), named “Version x” where x is the number of the versions that have been created. All 
keyframes and motion tracking are copied from the previously selected version to the new one.

To create a new version, with a name, and a choice of whether to copy keyframes:

1	 Right-click a clip thumbnail, and choose one of the following:

�� Local Versions > Create New Version

�� Remote Versions > Create New Version

2	 Type a name for the version in the dialog that appears, and choose either “Copy all 
marks” or “Copy the first mark only,” depending on whether or not you want to copy all 
the keyframes into the new version. 

3	 Optionally, you can choose one of the preset version names from the pop-up list. 
These names are defined in the Versions section of the General Options panel of 
the Project Settings.

4	 Click OK.

To delete a specific version:

Right-click a clip thumbnail, choose the submenu of the remote version you want to 
delete (it can’t be the currently selected version), and choose Delete.

To delete all versions:

Right-click a clip thumbnail, and choose one of the following commands from the 
contextual menu corresponding to the scope of the versions you want to delete:

�� Local Versions > Delete All Versions

�� Remote Versions > Delete All Versions

�� Delete All Versions

All versions are deleted as specified, except for the currently selected version, which is now the 
only one remaining.

To load a particular remote or local version, do one of the following:

Right-click a clip thumbnail, choose the submenu of the corresponding remote version 
you want to copy, and choose Load.

NOTE: Motion tracking will be copied regardless of whether “Copy all marks” 
is selected or not.
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To rename a version:

1	 Right-click a clip thumbnail, choose the submenu of the corresponding remote version 
you want to copy, and choose Rename.

2	 In the Version Name dialog, type a name into the text field. Optionally, you can choose 
one of the preset version names from the pop-up list. These names are defined in the 
Versions section of the General Options panel of the Project Settings.

Selecting a Version name from the dropdown list, the names on 
the list come from assignments made using the Versions section 
of the General Options panel of the Project Settings

3	 Click OK.

That name now appears underneath the clip thumbnail in the Timeline.

If you’re going to use pre-defined names for versions, you need to define these in the Versions 
group of the General Options panel of the Project Settings. Ten pop-up menus let you choose 
from preset version names, or enter your own. These names will appear in the pop-up menu of 
the Version Name dialog..

The Version section of the Project Settings



857

G
ra

d
e

 M
an

ag
e

m
e

nt
 

P
ar

t 
6

 –
 4

8

The Importance of “Version 1”
There are specific operations in DaVinci Resolve where “Version 1,” otherwise known as “the 
default version,” is the only version that’s used, regardless of how many other versions are 
available, or which version was previously selected. The default version can be named anything 
you want, but whatever its name, the default version is the first version in the list, and it’s 
important. 

Here are some examples:

�� Importing additional timelines that use the same clips: In this case, if you’re importing 
timelines and ”Use local version for new clips in timeline” is disabled in the Color 
section of the General Options panel of the Project Settings, then only the default 
version of each clip is relinked. 

�� Whenever you switch a timeline between local and remote versions: In this case, 
every clip in the Timeline will be switched to the default version, regardless of what you 
had selected previously.

Consequently, if you plan to reconform your clips to a newer version of the edit that you’re 
importing, or pursue other workflows that are off the beaten path, it’s a good idea to make sure, 
no matter how many versions you end up creating, that the most important grade is always 
copied back to the default version.

To copy any version quickly to the default version:

1	 Choose Color > Memories > Save Memory A (Option-1). You can use any memory you 
want, but Memory A is convenient for this example.

2	 Choose Color > Default Version (Command-U).

3	 Choose Color > Memories > Load Memory A (Command-1) to apply the saved memory 
to the default version.

To copy any version quickly to the default version using the DaVinci Control Panel:

1	 Press CRNT and then press A (or any memory button you like). These controls are 
available on either the Transport or T-bar panel.

2	 Press DEFAULT VERSION on the T-bar panel.

3	 Press A (or whichever Memory button you used) to apply the saved memory.

To jump immediately to the default version, do one of the following:

�� Choose Color > Default Version (Command-U).

�� Press DEFAULT VERSION on the T-bar panel.

Deleting Unused Versions
In cases where you want to make absolutely sure there’s no alternative to the grade you want a 
clip to have, there’s an easy way to delete all versions except for the version that’s currently in 
use, thereby making it the default version.

To eliminate either local or remote versions except for the current version:

1	 Choose the local or remote version you want a clip to use.

2	 Right-click the thumbnail of the clip you want to eliminate extra versions from, and 
choose Delete Unused Versions from the contextual menu.

If you selected a local version, all unused local versions will be deleted, but remote 
versions will be left alone. Similarly, if you selected a remote version, all unused remote 
versions will be deleted, but local versions will be left alone.
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To eliminate all other local and remote versions except for the current version:

1	 Choose the version you want a clip to use.

2	 Right-click the thumbnail of the clip you want to eliminate extra versions from, and 
choose Delete All Versions from the contextual menu.

Regardless of whether you selected a local or remote version, all other local and 
remote versions not in use will be deleted.

Rendering Versions
When the time comes to render your clips in the Deliver page, each clip’s currently selected 
version will be rendered. If you need to render a different version for a given clip, you can either 
make sure it’s selected in the Color Page timeline before you open the Deliver page, or use the 
Versions submenu in the Color mode of the Deliver page Thumbnail timeline. This contextual 
menu also provides access to the Stereo 3D commands, the Edit PAR (Pixel Aspect Ratio) 
command, and a command for updating the Render Window Timeline thumbnails to reflect any 
changes you’ve made in case the they haven’t updated automatically.

Additionally, the Commercial Workflow output option, located in the Deliver page, provides a 
method of rendering multiple versions for each clip when outputting your project in Source 
Order (as individual media files). There are two additional options in the Version submenus of 
each clip in the Thumbnail timeline contextual menu that let you control which versions are 
rendered when you use Commercial Workflow.

�� Render Disabled: Turning this option on excludes that version from being rendered 
when Commercial Workflow is enabled.

�� Render Flat Pass: Turning this option on forces the selected version to render with the 
grade turned off, essentially outputting the original media.

For more information on rendering versions using the Commercial Workflow option, see 
Chapter 75, “Delivering Media.”

Copying Grades 
There are various methods you can use to copy grades from one clip to another. Which is 
appropriate to your need depends on your style of working with DaVinci Resolve.

Protecting Adjustments with the Copy Grade Options
Before going into the myriad of ways that grades can be copied from one clip to another, you 
should know of a series of options, available from the contextual menu of the Gallery (right-click 
anywhere in the gray area of the Gallery), that let you carefully specify grading, sizing, and 
stereo data to be preserved when overwriting grades in clips you’re copying to. There are 
three options:

�� Copy Grade: Preserve number of nodes: Lets you choose 0–10 nodes to be protected 
when applying a grade. When set to 1, the first node of the copied grade is ignored, but 
all other nodes are copied. When set to 5, the first five nodes of a copied grade are 
ignored, as long as there are at least five nodes in the grade of the clip you’re copying 
to. This option is useful for colorists who routinely use the first few nodes for shot 
matching and scene balancing, with additional nodes applying individual or stylistic 
adjustments.

�� Copy Grade: Preserve Camera Raw Settings: When enabled, the camera raw Source 
settings of the current clip are preserved, letting you apply stylistic grades from 
unrelated clips without overwriting clip-specific source settings.
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�� Copy Grade: Preserve Input Sizing: When enabled, Input Sizing adjustments are not 
overwritten by those of the copied grade.

�� Copy Grade: Preserve Convergence: When enabled, Convergence adjustments in the 
Stereo 3D palette are not overwritten by those of the copied grade.

�� Copy Grade: Preserve Floating Windows: When enabled, Floating Windows 
adjustments in the Stereo 3D palette are not overwritten by those of the copied grade.

�� Copy Grade: Preserve Auto Align: When enabled, Auto Alignment adjustments in the 
Stereo 3D palette are not overwritten by those of the copied grade.

�� Copy Grade: Preserve Dolby Vision™ Analysis Metadata: When enabled, Dolby Vision 
Analysis Metadata is not overwritten by that of the copied grade. Only available if 
you’re set up to do Dolby Vision grading. For more information, see Chapter 6, “Data 
Levels, Color Management, ACES, and HDR.”

�� Copy Grade: Preserve Dolby Vision™ Trim Metadata: When enabled, Dolby Vision Trim 
Metadata in the Dolby Vision palette is not overwritten by that of the copied grade. 
Only available if you’re set up to do Dolby Vision grading. For more information, see 
Chapter 6, “Data Levels, Color Management, ACES, and HDR.”

Clip Grades and Timeline Grades in Saved Stills
Every time you save a still into the Gallery or a memory, it contains both the Clip Grade, and the 
Timeline Grade, if one is applied. Which grade is applied when you copy from a still depends on 
which mode you’re in, which is selectable from the pop-up menu in the upper right-hand corner 
of the Node Editor.

Node Editor Clip and Track selector

If you’re in Clip mode, you’ll only copy the saved clip grade. If you’re in Timeline mode, you’ll 
only copy the saved timeline grade.

Choosing Which Aspect of a Grade to 
Copy With All/Color/Sizing
When copying grades using the techniques described in this section, you can use the All/Color/
Sizing setting that are available via the Keyframe Timeline Mode submenu of the Mark menu, 
the pop-up menu that’s visible at the upper-right of the Keyframes Editor, or your control panel. 
When copying a grade in conjunction with the settings in this menu, the following rules apply:

�� All: When All is selected, both the grade and the sizing are copied.

�� Color: Only the grade is copied, the target clip retains its original Input Sizing settings.

�� Sizing: Only the Input Sizing is copied, the target clip retains its original grade.

Choosing How to Copy Keyframes
When working with saved grades that have keyframes, you can choose how these keyframes 
are copied via a setting in the Gallery contextual menu. There are three options:

�� No Keyframes: No keyframes are copied. The state of the grade at the frame used to 
save the still is what is applied to the target clip or clips.
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�� Keyframes aligning Source Timecode: Keyframes are copied aligning the source 
timecode of the saved grade with the source timecode of the target clip. This is the 
ideal setting when you’re copying a grade back to the clip it came from originally, or to 
a duplicate of that clip elsewhere in the Timeline, and you want the keyframes to align 
with the same frames as before. If there is no source timecode overlap, keyframes will 
be pasted aligning with the start frame of the edit, the same as the third option (below).

�� Keyframes aligning start frame of edits: Keyframes are copied aligning the start frame 
of the clip that still was saved from with the start frame of the target clip. This is the 
ideal setting when you’re copying a grade with keyframes from one clip to a completely 
different clip, with different timecode.

To control how keyframes are copied when you’re copying grades:

Right-click anywhere in the gray background area of the Gallery, and choose one of 
these options from the Apply Grades Using submenu. 

From that point on, keyframes, should they exist, will be copied using the selected method 
whenever you copy a grade using any of the previously described methods.

Copying Grades Using the Mouse
An incredibly easy way of copying a grade from one clip to another, or from a still or memory in 
the Gallery to a clip, is by using the third button of your mouse, usually mapped as the “middle-
click” of the mouse scroll wheel. 

To copy a grade from a clip or still to one or more clips using the pointer:

1	 Select the clip thumbnail you want to copy the grade to in the Timeline; a single 
selected clip appears highlighted orange. If you want to copy a grade to several clips, 
you can either Command-click multiple non-adjacent clips, or Shift-click a continuous 
range of clips; multiple selected clips appear highlighted red.

2	 Middle-click the clip thumbnail, Gallery still, or memory you want to copy the 
grade from.

The grade of the clip you middle-clicked is copied to the previously selected 
clip or clips.

If you don’t have access to a middle-click on the pointing device you’re using, there’s another 
way of doing this using a contextual menu command.

To copy a grade from a clip or still to one or more clips using the Apply Grade command:

1	 Select the clip thumbnail you want to copy the grade to in the Timeline; a single 
selected clip appears highlighted orange. If you want to copy a grade to several clips, 
you can either Command-click multiple non-adjacent clips, or Shift-click a continuous 
range of clips; multiple selected clips appear highlighted red.

2	 Right-click the clip thumbnail, Gallery still, or memory you want to copy the grade from, 
and choose Apply Grade from the contextual menu.

The grade of the clip you middle-clicked is copied to the previously selected 
clip or clips.

TIP: If you’re using a trackpad, third party software may allow you to define a “three-
finger-click” that works the same as mouse button 3. If you’re a pen and tablet or 
trackball user, you may be able to define a stylus or other button to perform the same 
button-3 action.
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Copy Forward Commands
Another simple way of copying grades is to use the equals (=) and minus (–) keys on the 
keyboard to copy grades forward from one or two clips behind the currently selected clip. This 
is a great way to copy grades in scenes with a shot-reverse-shot structure, where you’re cutting 
between two angles of coverage, each of which uses the same grade.

To copy grades forward:

�� To copy a grade from one clip back: Choose Color > Apply Grade From One Clip Prior, 
or press Equals (=)

�� To copy a grade from two clips back: Choose Color > Apply Grade From Two Clips 
Prior, or press minus (–)

To copy grades forward using the DaVinci Control Panel:

�� To copy a grade from one clip back: Press comma (,)

�� To copy a grade from two clips back: Press colon (:)

Copying Using Memories
Memories are virtually identical to stills, except that they’re labeled with a letter (A–Z) for easy 
access via keyboard shortcuts or DaVinci control panel buttons. A memory bank above the 
Gallery browser provides a visual reference of which saved grade is assigned to which letter. 
This makes it easy to keep track of multiple saved memories in instances where you’re copying 
them to several different clips throughout a scene or program. 

For example, you might save a memory for each angle of coverage in a complicated scene, 
making it easy to copy grades forward. In another example, you might save a memory for the 
grade applied to each interview subject’s headshot in a documentary, so you can copy that 
grade forward as you work through the documentary.

To save the current clip’s grade to a memory for future use, do one of the following:

�� Choose Color > Memories > Save Memory A–H (Option-1–8)

�� Using the DaVinci control panel, press CRNT on the Transport or T-bar panel, then 
press the letter of the memory bank you want to save to. Use the SHIFT UP button to 
save to another memory sharing the same button.

If you save a grade to a memory that already contains something, the previous memory is 
overwritten.

To apply a memory to one or more clips in a timeline, do one of the following:

1	 Choose one or more clips in the Thumbnail timeline to copy to. This can be the current 
clip, or it can be a range of clips that you select by Command-Clicking or Shift-Clicking.

2	 Do one of the following to copy a grade to the selected clips:

�� Right-click a memory and choose Apply Grade.

�� Choose Color > Memories > Load Memory A–H (Command-1–8)

�� Using the DaVinci control panel, press the letter of the memory bank you want to 
apply. Use the SHIFT UP button to apply a memory that shares the same button.

To clear a memory:

Right-click a memory, then choose Clear.
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Copying Using Preview Memory
You can also preview the effect of a memory or saved grade on the current clip, with the option 
to either keep it if it works, or go back to the previous grade if it doesn’t. 

To Preview Memory:

1	 Move the playhead to a clip for which you want to preview a memory.

2	 Choose Color > Preview Memory (Option-Shift-P).

3	 Do one of the following: 

�� Right-click any saved still in the Gallery and choose Apply Grade.

�� Choose Memories > Load > Memory A–H (Command-1–8).

The selected grade or memory is now being previewed.

4	 Now, do one of the following to either accept or reject the memory:

�� If you like the effect, then you can leave it be and move on to another clip.

�� If you don’t like the effect, then choosing Color > Preview Memory (Option-Shift-P) 
again reverts the clip to the original grade.

To Preview Memory using the DaVinci Control Panel:

1	 Move the playhead to a clip on which you want to preview a memory. You can use the 
PREV SCENE and NEXT SCENE buttons to move quickly.

2	 Press PVW MEM on the T-bar panel, and then press the letter of the memory bank 
you want to preview. Use the SHIFT UP button to apply a memory that shares the 
same button.

3	 Do one of the following:

�� If you like the grade you’re previewing, there’s no need to do anything else. Simply 
move to another clip and continue working.

�� If you don’t like the grade you’re previewing, press PVW MEM again and the clip’s 
grade will revert to its original state. Pressing PVW MEM repeatedly toggles the 
current clip between its original and the previewed grade.

Copying from Stills in the Gallery
As mentioned previously, each still you store in the Gallery contains the grading information as 
well as the image of the frame it was saved from. This saved grade can be applied to any clip in 
the Timeline. 

To apply a grade from a still to one or more selected clips in a timeline, do one of the following:

1	 Choose one or more clips in the Thumbnail timeline to copy to. This can be the current 
clip, or it can be a range of clips that you select by Command-Clicking or Shift-Clicking.

2	 Do one of the following to copy a grade to the selected clips:

�� Right-click a still in the Gallery and choose Apply Grade.

�� Middle-click a still in the Gallery.

�� Double-click a still to wipe it in the Viewer against the current clip in the Timeline, 
then right-click the Viewer and choose one of the options from the Apply 
Grade submenu.

IMPORTANT: Copied grades overwrite any previously existing grades on the clip or 
clips you copy to.
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To apply a grade from a still to the current clip using the DaVinci Control Panel:

1	 Select the clip you want to copy a grade to using the PREV SCENE or NEXT SCENE 
buttons of the Jog/Shuttle panel.

2	 Press NEXT STILL or PREV STILL to select the still with a grade that you want 
copy from.

3	 Press PLAY STILL to wipe the selected still against the current clip.

4	 Press SHIFT UP and then press PLAY STILL to copy the grade from the selected still to 
the current clip.

Append Node Graph
You can also append a saved grade to any clip in a timeline. This adds the entire node graph of 
the saved still to the end of the node tree of the current clip. In other words, the current clip’s 
grade isn’t overwritten, the applied grade is added to the end of it.

By planning ahead, you can save fragmentary grades that create specific effects or adjustments 
using only a few nodes. You can then use these fragmentary grades as a toolkit that you can 
add to other grades in order to mix and match different adjustments and effects. 

For example, you could create a three-node glow effect, save it, and then apply that effect at 
the end of a completely different clip’s grade.

 

Appending grades places them after the original nodes

To append a saved grade or memory as individual nodes, do one of the following:

�� Drag a still or memory from the Gallery onto a connection line in the Node Editor; when 
the plus icon appears, drop it and its nodes will be appended within the node tree 
starting at that connection.

�� Right-click a still or memory in the Gallery, and choose Append Node Graph.
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Ordinarily, when you append the node graph from a memory or still to another node graph, you 
end up adding a whole shedload of new nodes. This may be exactly what you need, but in 
situations where you want to keep things a bit tidier, you also have the option of appending 
node graphs as compound nodes.

To append a saved grade or memory as a compound node:

Command-drag a still or memory from the Gallery onto a connection line in the Node 
Editor; when the plus icon appears, drop it and its nodes will be appended to the node 
tree as a single compound node.

To append a saved grade or memory using the DaVinci Control Panel:

1	 Select the clip you want to append a grade to using the PREV SCENE or NEXT SCENE 
buttons of the Jog/Shuttle panel.

2	 Press NEXT STILL or PREV STILL to select the still with a grade that you want 
to append.

3	 Press PLAY STILL to wipe the selected still against the current clip.

4	 Press SHIFT UP and then press NEXT STILL to append the nodes of the grade from the 
selected still to the current clip.

Once you’ve appended a compound node, you can open it up to access and modify its 
contents as you would any other compound node. For more information on compound nodes, 
see Chapter 49, “Node Editing Basics.”

Aligning Keyframes to a Specific Frame 
While Copying Grades
If you need to copy a grade with keyframes so that the start keyframe of the copied grade 
aligns with a specific frame of the Timeline, you can do so using the following procedure:

To copy a grade and align its keyframes to a specific frame of the Timeline:

1	 Save a grade with keyframes as a Gallery still by right-clicking the Viewer and choosing 
Grab Still.

2	 Choose the clip you want to copy the saved grade to in the Thumbnail timeline.

3	 Double-click the Gallery still to wipe it against the current clip in the Viewer.

4	 Move the playhead to the frame of this clip you want the first keyframe of the saved 
grade to be aligned with.

5	 Right-click the Viewer and choose Apply Grade > Align Keyframes to Current Frame.

NOTE: When you append the nodes from a gallery still to a grade, how 
keyframes are applied depends on the “Apply Grades Using” setting of the 
Gallery. For more information, see Chapter 47, Using the Gallery.
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Copying Individual Nodes and Settings
Copying grades from clip to clip copies everything except for keyframes and motion tracking. 
However, there is one way you can copy the motion tracking from one clip to another, and that’s 
by copying and pasting individual node settings. This can save time when you’re assembling 
complicated node trees by recycling specific nodes or node settings from previous grades.

Copying and Pasting All Settings From One Node to Another
The simplest thing you can do is to copy all of a node’s settings, and paste them into another 
node. This makes it easy to duplicate things like windows, qualifier settings, keyframing, or 
motion tracking that you want to re-use in another node as the basis for another operation. This 
is also a quick way to manually ripple a change you make in a node to that same node in 
another clip’s grade.

To copy a node’s settings from one clip to another, do one of the following:

�� Option-drag one node onto another. When you drop it, the settings of the node you 
dragged overwrite those of the node you dropped onto.

�� Select a node with settings you want to copy and choose Edit > Copy (Command-C). 
Then, select a node you want to paste these settings to either in the current grade or in 
the grade of another clip, or create a new node, and choose Edit > Paste (Command-V) 
to paste the settings you copied. These pasted node settings overwrite any other 
settings that node previously used.

Copying From the Node Graph of Other Clips or Gallery Stills
When constructing new grades, you may sometimes find it convenient to copy existing nodes 
or node settings from the grade of another clip or gallery still. This can be easily accomplished 
by exposing the node tree of any still that’s saved in the Gallery, or any clip in the Thumbnail 
timeline, and using the controls found in the floating node graph to copy individual nodes or 
node adjustments to the current clip’s grade shown in the Node Editor. 

Dragging a node from another clip’s node graph to the currently selected clip’s grade in the Node Editor

The floating Node Graph window has four sets of controls you can use to choose how to copy 
nodes and adjustments:

�� Clip Node Graph: By default, the Clip node graph is displayed at the left. You can drag 
any node from the floating node graph to the current grade shown in the Node Editor, 
and drop it onto an existing node to overwrite that node’s settings or onto a connection 
line to insert it as a new node.
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�� Timeline Node Graph: (Only available if there is a Timeline grade) You can switch to the 
Timeline grade, if there is one, by either clicking the second button in the Node Graph 
title bar, or by choosing Timeline from the pop-up menu at the upper right-hand corner 
of the floating Node Graph window.,

�� Apply Color/PTZR/Source/All buttons: With the Clip panel selected, four buttons let you 
selectively copy the entire grade, the sizing, the source settings, or all settings at once 
to the current clip.

�� Node Settings: Switching to the Node panel displays all of the available Color Attributes 
found within each node. Using this panel, you can selectively choose which node 
adjustments get copied and which do not. After you’ve checked the settings you want 
to selectively copy, dragging nodes to the Node Editor to copy or append them only 
copies or appends the selected attributes. For Windows and OpenFX, you also have 
the option of copying any motion tracking that’s available.

The Node panel open with the Color Corrector 
and Blur attributes selected for copying

The following procedures describe how to open the floating node graph in different situations.

To copy individual nodes or settings from any still in the Gallery:

1	 Right-click a still in the Gallery, and choose Display Node Graph. A floating Node Graph 
window appears displaying that still’s node tree.

2	 While the Gallery Node Graph window is open, you can select any other still, and this 
window will update to show the currently selected still’s node graph, ready for you to 
copy from.
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3	 Do one of the following to copy nodes or settings to the Node Editor.

�� You can drag any node from the floating node graph to the current grade shown in 
the Node Editor, and drop it onto an existing node to overwrite that node’s settings. If 
you open the Node panel and choose specific attributes, only those attributes will be 
copied to the node you drag onto.

�� Drag any node from the floating node graph to the current grade shown in the Node 
Editor, and drop it onto a connection line to insert it as a new node. If you open the 
Node panel and choose specific attributes, only those attributes will be copied to the 
new node that’s created.

�� Click Apply Color to copy the entire grade from the floating node graph to overwrite 
the current grade in the Node Editor.

�� Click Apply PTZR to copy the sizing from the floating node graph to overwrite that of 
the current clip.

�� Click Apply Source to copy the source settings from the floating node graph to 
overwrite those of the current clip.

�� Click Apply All to copy every setting from the floating node graph to the current clip.

4	 While the floating Node Graph window is open, you can also select any clip in the 
Thumbnail timeline to change the grade that’s displayed in the Node Editor, ready for 
you to copy to.

5	 Click Close when you’re finished.

To copy individual nodes or settings from any clip in the Timeline:

1	 Click the thumbnail in the Timeline of the clip to which you want to copy nodes. Its node 
graph will appear in the Node Editor.

2	 Right-click the thumbnail of another clip you want to copy nodes from, and choose 
Display Node Graph.

3	  Use any of the controls in the floating Node Graph window to copy nodes or settings 
to the Node Editor.

�� You can drag any node from the floating node graph to the current grade shown in 
the Node Editor, and drop it onto an existing node to overwrite that node’s settings. If 
you open the Node panel and choose specific attributes, only those attributes will be 
copied to the node you drag onto.

�� Drag any node from the floating node graph to the current grade shown in the Node 
Editor, and drop it onto a connection line to insert it as a new node. If you open the 
Node panel and choose specific attributes, only those attributes will be copied to the 
new node that’s created.

�� Click Apply Color to copy the entire grade from the floating node graph to overwrite 
the current grade in the Node Editor.

�� Click Apply PTZR to copy the sizing from the floating node graph to overwrite that of 
the current clip.

�� Click Apply Source to copy the source settings from the floating node graph to 
overwrite those of the current clip.

�� Click Apply All to copy every setting from the floating node graph to the current clip.

NOTE: The Display Node Graph command only appears in the contextual 
menu of a clip in the Thumbnail timeline that is not currently selected.
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4	 While the floating Node Graph window is open, you can also select any clip in the 
Thumbnail timeline to change the grade that’s displayed in the Node Editor, ready for 
you to copy to.

5	 Click Close when you’re finished.

Rippling Adjustments 
Among Multiple Clips
If you’ve graded a sequence of clips and find yourself needing to make a quick change to 
several clips all at once, you can use the Color > Ripple Node Changes to Selected Clips/
Current Group commands to quickly copy changes made to one clip to several others. 
However, these commands require that you follow certain rules in order to get the 
results you want.

Node rippling uses the number of each node to determine what changes should ripple to which 
nodes. In other words, changes made to Node 3 will ripple to Node 3 of every other selected 
clip, or to Node 3 of every other clip in the current group (depending on which command 
you use). 

Rippling changes from one clip to several others requires that all clips share the same number 
of nodes, at least for the nodes you’re rippling. If you try to ripple a change to one or more clips 
that don’t have a node with the same number as the one you’re rippling, then no change will be 
rippled to those clips.

To ripple a change in one node to several selected clips:

1	 Select the clip you want to use to make the change so that it’s the current clip, outlined 
in orange.

2	 Now, Command-click or Shift-click to select the range of clips you want to ripple your 
change to, so that they’re all selected red.

The orange outlined clip is the current clip you’re modifying, and the clips 
highlighted in red are the ones you’re rippling this change to

You don’t have to select the clips you’re going to ripple your change to prior to making 
the change, but it may be easier to keep track of what you’re doing if you set everything 
up in advance. The clip you’re changing should be outlined in orange, and the clips 
you’re rippling the change to should be highlighted in red.

3	 Select a node to modify. Ideally, every selected clip should have a node sharing the 
same number as the one you’re modifying. If some clips don’t, then those clips won’t 
inherit the change you’re going to be rippling.

4	 Make whatever changes you need to, adjusting any of the palette controls in the 
Color page you need to, except for Camera Raw, Sizing, and Data Burn, which aren’t 
node-specific.
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5	 When you’re happy with the change you’ve made, choose Color > Ripple Node 
Changes to Selected Clips.

The change you’ve made should ripple to every other selected clip with a node of the 
same number, and in a few moments the thumbnails of those clips should update to 
show the change.

If you’ve created a group, it’s even easier to ripple node adjustments to the other clips in 
the group.

To ripple a change in one node to the current group:

1	 Select the clip you want to use to make the change so that it’s the current clip, outlined 
in orange. It must be part of a group for this to work.

2	 Select a node to modify. Ideally, every selected clip should have a node sharing the 
same number as the one you’re modifying. If some clips don’t, then those clips won’t 
inherit the change you’re going to be rippling.

3	 Make whatever changes you need to, adjusting any of the palette controls in the 
Color page you need to, except for Camera Raw, Sizing, and Data Burn, which aren’t 
node-specific.

4	 When you’re happy with the change you’ve made, choose Color > Ripple Node 
Changes to Selected Clips.

The change you’ve made should ripple to every other clip in the current group that has 
a node of the same number, and in a few moments the thumbnails of those clips should 
update to show the change.

Appending A Node to Multiple Clips
If you’ve made an adjustment to a node in one clip that you’d like to apply to several other clips, 
you can quickly do that using the Color > Append Node to Selected Clips command. You can 
do this as a prelude to using one of the Ripple Node Change commands, as it’s a quick way to 
make sure several previously ungraded clips have the same nodes, but you can also do this as 
a quick way to apply the same node change to several clips, regardless of whether they have 
matching node trees.

To append a node to other selected clips:

1	 Select the clip you want to use to make the change so that it’s the current clip, outlined 
in orange. 

2	 Select the node you want to append to other clips.

3	 Now, Command-click or Shift-click to select the range of clips you want to ripple your 
change to, so that they’re all selected red.

The clip you’re changing should be outlined in orange, and the clips you’re rippling the 
change to should be highlighted in red.

4	 Choose Color > Ripple Node Changes to Selected Clips.

The selected node should be appended to the end of the node tree of each selected 
clip, and in a few moments the thumbnails of those clips should update to show 
the change.
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Scroll Copy Grades Using 
the DaVinci Control Panel
Scroll mode lets you quickly preview the effects of many different grades applied to clips in 
the Timeline on the currently selected clip, with the option to either accept or reject the 
previewed grade to which you’ve “scrolled.” This can be useful for checking to see if any of 
the previous grades you’ve created in a scene will work for the currently selected clip.

To use Scroll mode:

1	 Move the playhead to the clip to which you potentially want to copy a new grade. 
You can use the PREV SCENE and NEXT SCENE buttons to move quickly.

2	 Do one of the following to enter Scroll mode:

�� Press SCROLL on the Transport panel.

�� Press MODES, above the fourth trackball on the Center panel, then press the 
SCROLL MODE soft key.

3	 Now, do one of the following to preview different grades from other clips:

�� Press the PREVIOUS SCENE and NEXT SCENE soft keys to move from clip to clip 
in the Timeline, previewing each grade to the current clip.

�� Turn the SCROLL SCENES knob to scroll smoothly along multiple clips in 
the Timeline.

�� Turn the SCROLL FRAMES knob to scroll along different frames of any clip, 
previewing the effects of keyframed grades at different points in time.

�� Press the TOGGLE DECK KEYS soft key to use the transport controls on the 
Transport panel to play through the Timeline, previewing grades as you go.

�� Press a number on the keypad of the Transport panel, and then the SCENE 
NUMBER soft key, to jump to a clip and preview its grade.

As you scroll from clip to clip, a red outline indicates the clip with the grade being 
previewed, and an orange outline indicates the current clip to which you’re 
previewing each scrolled grade. 

4	 When you’re finished, do one of the following to either accept or reject a 
scrolled grade:

�� Press EXIT AS WAS if none of the grades you scrolled through was suitable. This 
exits Scroll mode and leaves the clip as it was previously.

�� Press EXIT AS IS if you’ve found a grade that works for the current clip. This exits 
Scroll mode and copies the scrolled grade.

When you press the TOGGLE DECK KEYS soft key in Scroll mode, each of the Transport 
Control buttons on the Transport panel functions as a means of previewing the grades of 
other clips in the Timeline.

�� STEP FWD: Move to the next clip and preview its grade.

�� STEP REV: Move to the previous clip and preview its grade.

�� FWD: Plays (scrolls) forward at 1 scene per second, previewing each new grade as 
it appears.
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�� REV: Play (scrolls) the clips in reverse at 1 scene per second, previewing each new 
grade as it appears.

�� FFWD: Shuttles (scrolls) forward through the Timeline at 4 scenes per second, 
previewing each new grade as it appears.

�� RWD: Shuttles (scrolls) reverse through the Timeline at 4 scenes per second, 
previewing each new grade as it appears.

Rippling Changes Using 
the DaVinci Control Panel
DaVinci Resolve has a mechanism for rippling specific changes made to one clip to a range of 
other clips in the Timeline. This is only possible using the controls of the DaVinci control panel.

The general idea of the ripple function is that you select a clip, make a change, and then ripple 
that change to a range of other clips. This rippled change can be applied to the same node in 
each clip, or the change can be added as an appended node within each rippled clip.

The Ripple mode that’s used when you press the RIPPLE VALUE button can be changed in the 
Color panel of the User Preferences. There are four options.

�� Exact values changed: Changes made to the current clip are rippled to the specified 
clips using the exact parameters that were changed. For example, if Lift in the current 
clip is changed to 0.75 of its range, each clip you ripple will have a Master Gain 
setting of 0.75. Only parameters you adjust are rippled. 

�� Percent value changed: Changes made to the current clip are rippled to the 
specified clips by the percentage of change you made to the altered parameters. For 
example, if the current clip has a Lift level of 1.00 and is changed to 0.90 units, then 
the Lift setting of each clip you ripple will have a relative reduction of 10% relative to 
its previous value.

�� Unit value changed: Changes made to the current clip are rippled to the specified 
clips by the same delta of change, using whichever units make sense for the effected 
parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 
0.90, each rippled scene’s master gain level increases by 0.10.

�� All values are copied: The current clip’s grade is rippled to the specified clips in its 
entirety. No comparison is made with the original clip’s parameters, and all memory 
parameters are rippled.

The following procedure describes in detail how you can use the DaVinci control panel to ripple 
a change to a range of other clips. While this procedure may appear complicated, it’s just that 
there are several options. Once you learn the sequence of commands, this process is actually 
quite fast.

To ripple a change using the Ripple Mode soft key commands:

1	 (Optional) Press MODES, then press RIPPLE MODES. Four commands appear mapped 
to the middle soft keys of the Center panel, which can be used later to execute different 
types of ripple operations.

2	 Move the playhead to the clip you want to adjust.

3	 Adjust the current clip that you want to ripple to other clips in the Timeline.
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4	 Define the range of clips you want to ripple to using the number pad on the Transport 
panel. The following combinations will work:

�� An absolute range of clips is defined by entering two clip numbers separated by a 
comma. For example, if you want to ripple the current change to clips 10 through 15, 
you’d press “10 , 15” 

�� To specify every clip from the beginning of the Timeline, use the Minus (–) key. For 
example, to specify a range of clips from the beginning to clip 20, you’d press “– , 20”

�� To specify every clip to the end of the Timeline, use the Plus (+) key. For example, to 
specify a range of clips from the clip 50 to the end, you’d press “50 , +”

�� To specify every clip in the whole Timeline, press “– , +”

5	 (Optional) You can control whether the rippled change is applied in an appended node, 
or an existing node, in every rippled clip:

�� If you want to apply the rippled change as a new node that’s appended to the end of 
every rippled clip’s grade, press SHIFT DOWN. 

�� Otherwise, the rippled change will be applied to the same node in every rippled clip 
that you made your adjustment to in the current clip. In other words, if you made a 
change to Node 2, it would be rippled to Node 2 of all the clips you specified. If one 
of the rippled clips doesn’t have the same number of nodes, you may get an error.

6	 To execute the ripple, do one of the following:

�� Press RIPPLE VALUE on the Transport panel to ripple a change using the currently 
selected Ripple Mode in the User Preferences.

�� Press one of the Center panel soft keys corresponding to the ripple function you 
want to perform. 

There are four soft keys:

�� STATIC RIPPLE: Changes made to the current clip are rippled to the specified clips 
using the exact parameters that were changed. For example, if Lift in the current clip 
is changed to 0.75 of its range, each clip you ripple will have a Master Gain setting of 
0.75. Only parameters you adjust are rippled. Identical to the “Exact values changed” 
ripple setting.

�� RELATIVE RIPPLE: Changes made to the current clip are rippled to the specified 
clips by the percentage of change you made to the altered parameters. For example, 
if the current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift 
setting of each clip you ripple will have a relative reduction of 10% relative to its 
previous value. Identical to the “Percent value changed” ripple setting.

�� ABSOLUTE RIPPLE: Changes made to the current clip are rippled to the specified 
clips by the same delta of change, using whichever units make sense for the affected 
parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 
0.90, each rippled scene’s master gain level increases by 0.10. Identical to the “Unit 
value changed” ripple setting.

�� FORCED RIPPLE: The current clip’s grade is rippled to the specified clips in its 
entirety, overwriting all previous nodes and parameters in the rippled clips.

The adjustment you made in Step 4 is applied to the designated range of clips.



873

G
ra

d
e

 M
an

ag
e

m
e

nt
 

P
ar

t 
6

 –
 4

8

Admittedly, that was a long and detailed procedure, but the actual button sequences are 
straightforward once you put them together. Here are some examples of button sequences that 
ripple an adjustment you’ve just made in different ways:

�� “10 , 15” then SHIFT DOWN then RIPPLE VALUE: Copies the change you’ve made to 
the current clip, and applies it as a new node that’s appended to the end of clips ten 
through fifteen.

�� MODES then RIPPLE MODES then “34 , 45” then FORCED RIPPLE: Copies the 
entire grade of the current clip, using it to overwrite the grade of clips 34 through 45.

�� MODES then RIPPLE MODES then “– , +” then SHIFT DOWN then RELATIVE 
RIPPLE: Copies the change you’ve made to the current clip as a relative percentage, 
and applies it as a new node appended to the end of every single clip in the 
entire Timeline.

Using Groups
Grouping is one of DaVinci Resolve’s most powerful features for organizing grades amongst 
multiple clips. Groups are manually created collections of clips with automatic linking 
relationships that make it easy for you to control the rippling of grades among sets of clips that 
you define. When clips have been grouped together, selecting one member of the group 
reveals a group “linked” badge at the top-right of each clip’s thumbnail belonging to the group.

The green link icon indicates this 
clip is in a group

You can create as many groups within a single project as you need. You can add or remove 
shots from the current group, and the current group is defined by the last shot you’ve selected 
(if it belongs to a group, that’s the new current group).

As introduced in DaVinci Resolve 11, the grading of grouped clips is easier than it has ever been. 
Once grouped, you can choose from one of four Node Editor modes to grade the current clip. 
Which mode you choose determines whether that grade will automatically ripple to every other 
member of that group, or whether the grade will only affect that one clip. In this way, you can 
combine multiple node trees, some which will ripple, and one which won’t, to create the final 
look of each clip in that group.

WARNING: Once you ripple a change in this manner, there is no going back. Since 
Undo is a per-clip operation, there is no global undo for changes made to the entire 
Timeline. Proceed with caution
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For example, you might group together every clip from the same angle of coverage in a scene. 
You might also group together every clip from a particular section of b-roll that will be graded 
with the same treatment. This way, whenever you make a change or otherwise update one 
member of the group using one of the rippled Node Editor modes, every clip in the group will 
be changed together.

This section discusses how to create and manage groups, how best to use them, and what 
issues you need to be aware of to use groups to best advantage.

Creating and Managing Groups
The following procedures describe how to create, load, modify, and delete groups.

To create a new group:

1	 Select one or more clip thumbnails in the Timeline. You can select a contiguous 
range of clips by clicking one and then Shift-clicking another, or you can make a 
discontiguous selection by Command-clicking individual clip thumbnails anywhere in 
the Timeline.

2	 Right-click one of the selected clip thumbnails, and choose Add Into New Group.

3	 Type a name into the field of the Group Name dialog, and click OK.

The new group is created, and the clips you had selected now appear with the “linked” 
group badge above the thumbnails.

To load a different group, do one of the following:

�� Move the playhead to another clip that’s a member of that group.

�� Right-click any clip belonging to any group, and choose Group > “Name of 
group” > Load.

The selected group now becomes the current group. Using the Add Into Current Group 
command will add a clip to the newly loaded group.

To add one or more clips to an existing group:

1	 Load the group you want to add clips to.

2	 Select one or more clip thumbnails in the Timeline. You can select a contiguous 
range of clips by clicking one and then Shift-clicking another, or you can make a 
discontiguous selection by Command-clicking individual clip thumbnails anywhere in 
the Timeline.

3	 Right-click one of the selected clip thumbnails, and choose Group > “Name of group” > 
Assign to Group.

The selected clips now appear with the “linked” group badge above the thumbnails.

To remove one or more clips from an existing group:

1	 Select one or more clip thumbnails in the Timeline that you want to remove from a 
group. You can select a contiguous range of clips by clicking one and then Shift-
clicking another, or you can make a discontiguous selection by Command-clicking 
individual clip thumbnails anywhere in the Timeline.

2	 Right-click one of the selected clip thumbnails, and choose Remove From Group.
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To rename a group:

1	 Right-click any clip belonging to any group, and choose Group > “Name of 
group” > Rename.

2	 Type a new name into the field of the Group Name dialog, and click OK.

The group is renamed. The new name appears as a new submenu of the Timeline 
contextual menu.

To delete a group:

Right-click a clip belonging the group you want to delete, and choose Group > 
“Name of group” > Delete.

This clears the group, while preserving the last applied grade within each clip.

Using Group Modes to Control which 
Grades Ripple and which Don’t
When you create a group and then select any clip that is a member of that group, additional 
Node Editor modes become available that let you apply multiple levels of grades to the clips in 
that group. 

Available options in the Node Editor modes pop-up

For clips that aren’t grouped, two dots at the top of the Node Editor let you switch between Clip 
and Timeline modes via a single click. If you’re working on a clip that’s part of a group, four dots 
will be displayed to allow fast access to the Pre-Clip and Post-Clip Group modes as well.

Four dots at the top of the Node Editor let you 
choose which mode you’re working on

Node trees you create using the Group Pre-Clip and Group Post-Clip modes 
automatically ripple changes to every member of a group. Node trees created with the 
Clip mode are specific to each clip. Node trees created with the Timeline grade affect 
the entire Timeline, all at once. Combining node trees made using these different 
modes makes it easy combine clip-specific changes with group-wide changes that 
make grading faster.
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�� Group Pre-Clip: Node trees assembled in this mode affect every clip in the group 
simultaneously. Pre-Clip adjustments are useful for creating an overall grade that you 
want to use as a starting point for the scene, such as when you need to normalize a 
group of log-encoded clips in a specific way, or when you want to create a base grade 
that generally improves every clip in a scene. 

�� Clip: The Clip grade corresponds to the local or remote version associated with 
that clip. Node trees assembled in the Clip mode only affect the specific clip that’s 
selected. All Local and Remote versions you create are in Clip mode. Clip adjustments 
are useful for matching clips to one another in a scene, doing clip-specific secondary 
adjustments, or making any other sort of adjustment that you only want applied to the 
current clip, rather then to the group as a whole. Clip adjustments are applied after Pre-
Clip adjustments.

�� Group Post-Clip: Node trees assembled in this mode also affect every clip in the group 
simultaneously, but these adjustments are applied after the Clip adjustments. Post-Clip 
adjustments can be useful for applying a creative look to an overall scene, so that later 
revisions to a scene’s look can be accomplished with a single set of adjustments that 
automatically affect the entire group.

�� Timeline: Node trees assembled in this mode affect every single clip in the entire 
Timeline. Timeline adjustments are useful when you have a single change that you 
want to apply to every single clip at once.

The image processing of each Node Editor mode is sequential, making it easy to keep track of 
the order of operations affecting a particular clip. 

An Example of Grading a Group of Clips
This section shows an example of how you might approach grading a group of clips using the 
different Node Editor modes that are available. Keep in mind that this is only one of many 
possible approaches you could take to the use of groups, and was chosen because it exercises 
everything you can do to a single grade.

To get started, select a series of clips that you want to group, and right-click one of them and 
choose Create New Group to group them together, entering a name and clicking OK when 
prompted. One convenient advantage of simply creating groups from a selection is that you’re 
not limited to selecting a continuous range of clips in the Timeline. Another advantage is that 
you can use the View > Timeline Thumbnail Mode > Source (C-mode) command, or Timeline 
filtering, to isolate the range of clips you want to use for creating a group.

There are different ways you might choose to group clips together:

�� All clips within a particular scene

�� All clips recorded from a specific camera

�� All headshots of a particular person

�� All clips from a particular angle of coverage

�� All exteriors of a particular location
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The list could go on and on, but you get the idea. You can group any selection of clips together 
that have reason to share a common grade. In this example, a series of shots from an exterior 
scene are selected and made into a group.

Clips made into a group

Once you’ve created a group, choose Group Pre-Clip from the Node Editor mode pop-up. This 
is the first grade that’s applied, as the underlying grade that affects the entire group. Using this 
node tree, adding a LUT to normalize the clips, a Color Wheel adjustment, and some Curve 
adjustments to tune the color provide a primary grade that now affects every single clip in 
the group.

A primary adjustment applied to the Group Pre-Clip mode

With this accomplished, you can see there’s some variation among the clips in the scene that 
needs to be corrected in order for every clip to match. Choose Clip from the Node Editor mode 
pop-up. Grades that you make in Clip mode only affect the clip to which they’re applied, so now 
you can work clip by clip using the Image Wipe and Split-Screen controls to compare clips and 
make whatever adjustments are necessary to make each one match the main look for 
the scene.

Scene balancing adjustments made using the Clip mode
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Once all the clips are balanced with one another, you can choose Post-Clip Group from the 
Node Editor mode pop-up. This lets you add one more grade on top of the Pre-Clip and Clip 
grades that you’ve already applied, that you can use for any number of things. In this example, a 
single stylistic adjustment is applied that now affects all of the clips at once. If a client wants to 
see something different, you can easily make the necessary changes to one clip, and all other 
clips in that group will immediately be altered as well.

A stylistic adjustment applied to the Group Post-Clip mode

At this point, the scene is graded via a well organized set of corrections. If the client later wants 
a change affecting the underlying primary grade that everything is built on, you can adjust the 
Pre-Clip grade. If you spot an inconsistency with your shot matching at any point, you can make 
a fast tweak to the relevant Clip grade. And if the client wants a stylistic change, you can make 
any necessary adjustments to the Post-Clip grade to change the overall look of the whole 
scene. In each case, groups give you total control over which adjustments will ripple across the 
whole group, and which adjustments will be clip-specific.

Using Undo in Groups
Each Node Editor mode has a separate undo stack, meaning that separate multiple-level undo 
is saved for Group Pre-Clip, Clip, and Group Post-Clip.

Saving Stills and Grades in Groups
When you save a still for a clip that’s part of a group, the result is that the still reflects the look of 
the combined Pre-Clip, Clip, and Post-Clip node trees, but the grade that’s saved within 
depends on the Node Editor mode you had selected when saving the still. For example, if the 
Node Editor is set to Group Pre-Clip, then you’ll only save the Pre-Clip grade; the Clip, Group 
Post-Clip, and Track grades will be ignored. Copying a saved grade to a clip in a group results 
in that grade being copied to the node tree of whichever Node Editor mode is currently open.

Collapse Group Grades
If you want to take a clip out of a group, but you want its grade to continue incorporating all 
adjustments made in the Pre-Group and Post-Group Node Editor modes, you can use the 
Collapse Group Grades command to copy all nodes in the Pre-Group and Post-Group grades to 
the Clip grade. When you do this, Pre-Group nodes are added before any pre-existing nodes in 
the Clip grade, and all Post-Group nodes are added after, in order to maintain the correct order 
of operations.
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The Clip node tree

After using the Collapse Group Grades command to flatten the 
Pre‑Group and Post-Group nodes into the Clip node tree

To flatten all group grades into a single Clip mode node tree:

Right click a clip’s thumbnail in the Thumbnail timeline, and choose Collapse Group 
Grades from the contextual menu.

Using Collapse Group Grades on a clip always removes that clip from whatever group it was 
previously a member of. This can also be an easy way of creating a single flat node tree in 
preparation for saving a grade to the Gallery for applying to other clips that aren’t themselves 
in groups.

Groups and Versions
Local or Remote versions you create relate only to the Clip grade. Group Pre-Clip and Group 
Post-Clip grades cannot be versioned.
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Exporting Grades and LUTs
If you find it necessary to exchange grades with other workstations, there are two ways you can 
do so directly: by exporting grades, or LUTs.

To export a grade:

1	 Save the grade you want to export as a still in the Gallery.

2	 Right-click the saved still in the Gallery, and choose Export.

3	 Choose a location for the resulting still image and saved grade files, type a name into 
the Save As field, and click Save.

Two files are saved. A DPX formatted file contains the still image of the frame that was 
stored. A DRX (DaVinci Resolve eXchange) file contains all the grading information.

To Import a grade:

1	 Right-click anywhere in the gray area of the Gallery, and choose Import.

2	 Choose the DPX file that was exported from your DaVinci Resolve workstation, or 
someone else’s. The accompanying DRX file must be in the same location, although 
you can’t select it directly.

The still you imported appears in the Gallery, containing the grading information you 
wanted to import.

When exporting a LUT, any nodes that use Windows or OpenFX will be ignored along with all 
corrections made within these nodes. All other nodes with Primaries palette and Custom 
Curves palette adjustments that can be translated into a LUT will have their combined result 
translated into a LUT. For any nodes that mix supported and unsupported adjustments for LUT 
export (such as sharpening or blur filtering operations), the unsupported adjustments will simply 
be ignored.

To export a LUT:

1	 Right-click a clip thumbnail in the Timeline of the Color page, and choose one of the 
following commands corresponding to the type of LUT you want to export:

�� Generate 3D LUT (CUBE): A DaVinci-developed LUT format (no relation to the Iridas 
SpeedGrade .cube format).

�� Generate 3D LUT (Panasonic VLUT): A LUT format associated with Panasonic 
VariCam cameras.

2	 Choose a location for the resulting LUT file in the file dialog. The default file path 
depends on your operating system; saving it here will make it available to DaVinci 
Resolve for future use.

�� On OS X: Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/

�� On Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\LUT

�� On Linux: /home/resolve/LUT

If you like, you can create a new folder in which to save your custom LUTs.

3	 Enter a name into the Save As field, and click Save. A LUT file is saved.
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Once created, you can use an exported LUT from within DaVinci Resolve, applying it to a clip or 
node directly, or applying it to the entire project using the settings found in the Color 
Management panel of the Project Settings. You can also copy the LUT to a memory stick to give 
to someone for monitoring or previewing in an onset workflow, or to someone using another 
grading application that can read this LUT format.

What’s the Difference Between a LUT and a Shaper LUT?

DaVinci Resolve is capable of importing and using LUTs within its 32-bit floating point 
image processing pipeline. The .cube format can be used as either a simple 33x33x33 
3D LUT, or as a shaper LUT, which is actually a method of using two LUTs, a 1D LUT 
and a 3D LUT together, that addresses signal processing issues that 3D LUT 
can’t handle.

For processor efficiency, 3D LUTs are designed with reasonable lower and upper 
limits for the data they will handle. It’s well known that when a 3D LUT is fed values 
that are outside of the range that LUT is designed to handle, the out-of-range data will 
be clipped. Since many LUTs are designed with digital cinema workflows in mind, the 
practical result is that feeding a video signal with super-white in it to a 3D LUT that’s 
designed for full-range data (0–1) will clip the super-white part of the signal.

Shaper LUTs handle this issue by first using a 1D LUT to process video signals with 
out-of-range data, fitting the signal into a range that the 3D LUT won’t clamp. The 
output of the 3D LUT includes the reverse transformation, to effectively zero out the 1D 
LUTs transform, while retaining whatever processing the 3D LUT was meant to apply.

Shaper LUTs are also useful for dealing with extremely large data sets, such as 
OpenEXR files that can theoretically handle an image data range of –infinity to 
+infinity. Using a Shaper LUT, you can remap the incoming data to fit more precision in 
the 0–1 range, leaving less important data outside the range.
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Chapter 49

Node 
Editing Basics 
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Node Editing Basics
This chapter covers the basics of using the Node Editor in DaVinci Resolve to manage all of the 
adjustments you decide to apply to a clip, as well as the fundamental procedures for editing 
and organizing nodes within a tree that are the basis for creating more sophisticated effects.

This chapter has the following topics:

Node Editor Basics	 884

The Node Editor Interface	 885

The Components of a Node Tree	 885

Node Badges and Labels	 887

Selecting Nodes	 888

Disabling Nodes	 889

Bypass All Grades	 889

Resetting Nodes	 889

Caching Specific Nodes to Improve Performance	 890

Editing Node Trees	 890

Adding Nodes	 890

Adding Nodes with Windows Turned On	 891

Deleting Nodes	 892

Connecting and Disconnecting Nodes	 892

Extracting a Node	 892

Inserting a Node	 893

Rearranging Node Order	 893

Copying and Pasting All Settings From One Node to Another	 893

Keeping Node Trees Organized	 894

Using Compound Nodes	 895

Adding Inputs and Outputs to Compound Nodes	 896

Nesting Compound Nodes	 896

Grading Compound Nodes	 896

Identifying Nodes	 896

Grading Order of Operations	 897

Putting Nodes into HDR Mode	 898

Applying a LUT Within a Node	 898

Clip vs. Timeline Grading	 899
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Node Editor Basics
By default, every clip has one node in the Node Editor that contains the first corrections you 
make. However, you also have the option of creating multiple nodes, where each node contains 
one or more corrections that affect the image.

The Node Editor showing  a reasonably full-featured grade

The specific arrangement of nodes you create lets you exert precise control over the order of 
operations performed by your grade, which provides many advantages. This section covers 
different ways of creating, editing, and arranging node trees to harness the full power of 
DaVinci Resolve.

How Many Nodes Do I Need to Use?

In this chapter and the ones that follow, you’ll learn many different techniques for 
combining adjustments and nodes in different ways to achieve highly specific effects. 
Consequently, new DaVinci Resolve users often wonder, how far do I go? There is no 
right answer, but suffice it to say that some of the world’s leading colorists achieve 
stunning results in as few as three or four nodes, while others routinely build carefully 
organized hierarchies of ten to twenty nodes, or more. The number of nodes you use 
is often dependent on the quality of media you’ve been given to work with, as well-lit 
footage usually requires less work than material shot run-and-gun with available light, 
that typically needs many more adjustments to achieve an acceptable result. 
Furthermore, the number of nodes you may use can also depend on what kind of 
program you’re working on, with commercial spots affording the colorist enough time 
in the schedule to build truly massive grades that adjust every little detail, and 
narrative features and television shows requiring you to work faster and do more 
within fewer adjustments in order to stay on track. The real answer? Each grade 
requires as many nodes as are necessary. No more, no less.
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The Node Editor Interface
As you work within the Node Editor, you may find the need to zoom into or out of it to get a 
better look at the node tree, and to pan around the working area to deal with large 
collections of nodes.

To expand the size of the Node Editor’s working area:

�� Drag the border between the Node Editor and the Gallery to the left or right to make it 
wider or narrower.

�� Right-click anywhere within the Node Editor (except on a node) and choose Toggle 
Display Mode, which hides the Viewer and moves the Node Editor to the right of the 
Gallery, enlarging it considerably. Right-click and choose Toggle Display Node again to 
return to the default layout.

�� You can toggle Display mode using the DaVinci control panel by pressing SHIFT UP 
and the DISPLAY/CURSOR button above the fourth trackball on the Center panel.

To zoom and pan within the Node Editor, do one of the following: 

�� Use the Node Editor’s zoom slider to shrink or enlarge the nodes in the Node Editor.

�� Click the Pan tool (the hand icon) at the upper left-hand corner of the Node Editor, and 
drag anywhere within the gray area of the Node Editor to pan around.

�� Press the H key to toggle between selection and pan modes in the Node Editor.

�� Middle-click and drag anywhere within the Node Editor to pan around.

�� Right-click and choose Zoom In or Zoom Out.

�� Right-click and choose Zoom to Window to fit the node tree to the current size of the 
node graph.

�� Right-click and choose Original Size to return the node graph to the default size.

The Node Editor’s Pan (Hand) tool

The Components of a Node Tree
Ambitious grades may require trees of multiple nodes to create the necessary effect. This 
section covers the mechanics of putting nodes together into the structures that are described 
in more detail later in this chapter.

Every node you add is a “Corrector” node, which is capable of either primary or secondary 
correction, depending on whether or not you enable the Qualifier/Window/Matte controls. Even 
“Serial” and “Parallel” nodes are simply Corrector nodes that are added in series or in parallel to 
the previous node in the node tree; the names are a consequence of how they’re added.

Each Corrector node has two inputs and two outputs, which lets you separately manage the 
RGB image-processing channel, and the Key channel that defines areas of isolation for image 
processing operations, or transparency for compositing. RGB inputs and outputs are light green 
and round, located at the top left and right of each node. KEY inputs and outputs are blue and 
triangular, located at the bottom left and right of each node. These inputs and outputs let you 
control the flow of image and isolation channels coming into and going out of each node 
in the tree.
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A single node, the round RGB and triangular 
KEY inputs and outputs are clearly visible

Nodes are attached to one another via “connections,” seen as lines that connect one node to 
another. Image data flows from left to right, starting with the Source input all the way at the left 
of the Node Editor, through each node in the tree, and ending at the Node Tree output at the 
right of the Node Editor.

A simple serial arrangement of corrections

Here’s an explanation of the different components of a basic node tree where all nodes are 
connected in serial, one after the other, and how they work together:

�� Source Input: The green source node to the far left is the clip’s image data as 
processed by the Sizing and Source decode settings, ungraded. The Source input 
feeds RGB data to the grade, and is connected to the RGB input of the first node in 
your tree. If necessary, you can connect the Source input to more than one Corrector 
node, creating multiple simultaneous streams of image processing emerging from the 
original source state of the image that you can eventually recombine in different ways 
using the Parallel or Layer Mixer nodes.

�� Nodes: Each node in the node graph represents a collection of image processing 
operations that can be enabled or disabled separately from any other node in the 
graph. By separating operations into multiple nodes, you’re able to precisely control the 
order of all image processing operations in DaVinci Resolve to create many different 
corrections and effects. The round green RGB inputs and outputs are used to connect 
these nodes together. Each node’s thumbnail image shows how the clip looks at that 
particular stage of the grade, giving you a visual indication of what each node is doing, 
and small badges below each node show you which specific operations are being 
applied by that node.

�� RGB Inputs and Outputs: The round green inputs and outputs at the upper right and 
left of each node are used to connect the RGB image that’s output from one node 
to the RGB input of the next node. For a Corrector node to have an effect, you must 
connect both its RGB input and its RGB output to neighboring nodes in the tree. 
Furthermore, every single node in the Node Editor must be connected for a grade to 
be enabled; having any disconnected node in the node tree disables that grade until 
it’s fully connected.
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�� Key Inputs and Outputs: The blue triangles at the bottom right and left of each node 
are used to route the key channel generated by a node’s Qualifier or Window controls, 
or imported via a Matte clip that you previously associated with a clip in the Media 
page. When you connect the Key output of one node to the Key input of another, you 
basically copy the first node’s key to the second node. You can also combine the Key 
outputs of multiple nodes in various ways using the Key Mixer node.

�� Node Tree Output: The RGB output of the last node in a tree must be connected to the 
green Node Tree output node, which “completes the circuit” of image processing, and 
passes that correction on to the next stage in the DaVinci Resolve image processing 
pipeline. If the output is not connected, the node tree is disabled and has no effect on 
the clip. You can only connect one RGB output at a time to the Node Tree output.

�� Second Source Input (for HDR): You can access the alternate highlight exposure of 
RED HDRx media by exposing this optional second Source input. For more information, 
see“Mulit-Channel RED HDRx Support” in Chapter 52, “Channel Splitting and Image 
Compositing.”

�� Alpha Output: It’s possible to create regions of transparency for compositing directly 
in DaVinci Resolve by connecting a Key output to an optional Alpha output. For more 
information, see Chapter 51, “Combining Keys and Using Mattes.”

Node Badges and Labels
Nodes appear with various labels and badges to help you identify what each node is 
contributing to the overall grade. How long a label and how many badges appear depends on 
the size of each node, as set by the Node Editor’s Zoom slider.

Nodes showing the kinds of labeling and badges that are available 
for identifying what operations each node is performing

�� Node number: Nodes are numbered in the order in which they appear in the node 
graph, making it possible for you to select specific nodes by number via the DaVinci 
control panel. If you insert new nodes or rearrange existing nodes, the node numbering 
will change to reflect each node’s new order.

�� Adjustment badges: As you apply various operations within a node, small badges 
appear at the lower right-hand corner underneath the node. How many badges will 
appear depends on how far in or out you’re zoomed in the Node Editor, and whether 
or not there’s a Color Space label; at larger sizes, more badges can appear at once. 
Each palette in the Color page has a unique badge. If you apply more operations than a 
node has area to display, a single “downward arrow” badge appears.

�� Color Space labels: If you switch a node to use a color space other than RGB, that color 
space’s three letter label appears at the lower left-hand corner of the node.

Labeling Nodes
Nodes can be labeled to identify a particular node’s function in your grade. This can make it 
easier to revise a grade months later. Node labels are also saved when you save a still, so 
labels can also make it easier to decipher a saved grade down the road. At each node’s default 
size in the Node Editor, nodes can appear with up to 12 characters of text, although larger 
nodes can accommodate more text.
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To label a node:

1	 Right-click a node and choose Change Label.

2	 Type a label above the node and press Return.

The label you entered appears above the node in the Node Editor. Once a node has a 
label, you can change the label at any time by double-clicking it.

Selecting Nodes
The node that’s currently selected in the Node Editor is highlighted in orange, and is referred to 
as the current node. When you adjust any of the parameters or settings in the Color page, 
you’re adjusting parameters within the current node. You can only select one node at a time.

To select a node, making it the current node, do one of the following:

�� Double-click any node in the node graph.

�� Choose Nodes > Previous Node (Option-Shift-;) or Nodes > Next Node (Option-Shift-‘). 
When you do this, the last node loops around to the first one, and vice versa.

�� Using the Transport panel of the DaVinci control panel, press the PREV NODE or 
NEXT NODE buttons. When you do this, the last node loops around to the first one, and 
vice versa.

�� Using the Transport panel of the DaVinci control panel, enter the number of the node 
you want to select using the keypad, and then press the SELECT NODE button.

The selected node appears highlighted in orange. You also have the ability to select multiple 
nodes, in preparation for doing things like moving them or creating compound nodes (covered 
later in this chapter).

To select multiple nodes:

�� Command-click each of the nodes you want to simultaneously select.

�� With the Node Editor Selection tool chosen (at the upper left-hand corner of the Node 
Editor) simply drag to select multiple nodes using a bounding box.

 

The Node Editor’s Selection tool

When you select multiple nodes, each one appears with a red highlight above it.

Selecting three nodes by dragging a bounding box

When you select another clip in the Timeline, the default behavior is that the last node that was 
selected when you worked on that clip is the one that’s selected when you move to that clip 
again. However, a setting in the Color panel of the User Preferences called “Switching clips,” 
lets you change this behavior. For more information on this option, see Chapter 3, “Project 
Settings and Preferences.”
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Disabling Nodes
In the process of creating a node tree, it’s often useful to turn nodes off to disable their effect 
on your grade. It’s also useful to turn the entire node tree off and on in order to see “before and 
after” views of the current clip. Disabled nodes are not processed during rendering, and they 
remain disabled when you save that grade along with a still in the Gallery and then apply that 
grade to another shot.

To toggle individual nodes off and on:

�� Click the number of any node in the node graph to disable that node by itself. 

�� Select a node, and choose Nodes > Enable/Disable Current Node (Command-D).

�� On the DaVinci control panel, press the DISABLE CURRENT button (on the T-bar panel).

To turn every node off and on at once: 

�� Choose Nodes > Enable/Disable All Nodes (Option-D) to toggle all nodes off and on. 

�� On the DaVinci control panel, press SHIFT-DOWN and then the DISABLE CURRENT 
button (on the T-bar panel).

Bypass All Grades
You can also use a separate command to disable grading altogether. This is useful if you’ve 
toggled specific nodes off in the node tree, and you want a before and after look at the node 
tree with those nodes turned off. When Bypass All Grades is enabled, grading is disabled for all 
clips in the entire Timeline until you disable it.

To toggle grading off and on, do one of the following:

�� Click the Disable Grading button at the upper left-hand corner of the Node Editor.

�� Choose View > Bypass All Grades (Shift-D)

Resetting Nodes
If you’re dissatisfied with your current operations and want to start over, there are three ways 
you can reset nodes in the Node Editor. These are available as items in the Color menu, and 
buttons on the DaVinci control panel’s T-bar panel.

�� Reset Selected Node Grade: Resets the currently selected node, eliminating all 
keyframes, to the default parameter settings.

�� Reset Grades and Keep Nodes: Resets every node in the current node tree, without 
affecting the node tree’s structure; all nodes remain where they were. However, each 
node has been reset to the default parameter settings.

�� Reset All grades and Nodes: Deletes every node and keyframe, and restores a single 
node set to the default parameter settings.

You can also reset nodes using the mouse, which can be a quick thing to do if you’re already 
working in the Node Editor to accomplish other things.

IMPORTANT: When you turn every node off and then on again, every node is 
re‑enabled, even nodes that had previously been individually disabled.
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Methods of resetting nodes with the mouse:

�� To reset a selected node: Right-click that node and choose Reset Node Grade from 
the contextual menu.

�� To reset all grades and nodes: Right-click anywhere in the background of the Node 
Editor, and choose Reset All Grades and Nodes from the contextual menu.

Previewing and Restoring Node Trees

There are two other methods of quickly dealing with unwanted changes you’ve made to node 
trees, without needing to use undo.

�� Preview Memory: Lets you preview the effect of any saved grade on the current clip. 
To preview, choose Color > Preview Memory (Option-Shift-P), and then right-click any 
saved still in the Gallery (or Memory) and choose Add Correction. In fact, you can use 
Add Correction to try out as many stills as you like. If you like any still’s effect, then you 
can leave it be. If you don’t like any of the stills you previewed, then choosing Color > 
Preview Memory again reverts the clip to the original grade.

�� Original Memory: This command lets you quickly revert a clip’s grade to its original 
state when you first selected that clip. This is useful for getting immediately back to a 
clip’s original grade if you’ve made a series of changes that you then regret. Selecting 
another clip in the Timeline and then reselecting the clip you made changes to resets 
what is considered to be the current grade.

Caching Specific Nodes to Improve Performance
You can flag specific nodes to be cached, along with all nodes appearing upstream in that node 
tree. By caching nodes using processor-intensive effects, you free up real time capability for the 
remaining downstream nodes in a grade. Choosing Playback > Render Cache > User only 
caches nodes that you’ve flagged for caching.

When you choose Playback > Render Cache > Smart mode, DaVinci Resolve automatically 
caches any nodes that use Motion Blur, Noise Reduction, or OFX plug-ins, without you needing 
to do anything.

To flag a node and all corrections made in upstream nodes for caching:

Right-click any node and choose Node Cache > On from the contextual menu.

Editing Node Trees
There is no limit to the number of nodes you can create and connect to one another, and you 
can make as many or as few parameter adjustments as you like within each node. The following 
procedures describe the ways you can add nodes to the node graph as you build each grade’s 
node tree.

Adding Nodes
The simplest thing you can do to add to the complexity of a node tree is to add additional 
nodes, in order to add more adjustments to the current grade. You can add nodes so that 
they’re automatically attached to nodes that are already in the node tree, for immediate 
adjustment, or you can add unattached nodes to empty areas of the node tree in preparation 
for assembling a particularly complicated and specific node tree to accomplish a difficult task.



891

N
o

d
e

 E
d

iti
ng

 B
as

ic
s 

P
ar

t 
6

 –
 4

9

Methods of adding nodes to the tree using a mouse, tablet, or trackpad:

�� To add any kind of node to the node graph using the mouse: Right-click any node 
in the node tree, and choose the type of node you want to add from the Add Node 
submenu of the contextual menu.

�� To add a disconnected node to the node graph: Right-click anywhere within the node 
graph’s background, then choose Add Node > Corrector from the contextual menu. 
Disconnected nodes have no effect on a node tree until they’re connected.

Methods of adding nodes to a currently selected node in the 
tree using the keyboard or control panel:

�� To add a serial node after the currently selected node: Press Option-S key, choose 
Nodes > Add Serial from the menu, or press the ADD SERIAL button on the T-bar panel 
of the DaVinci Resolve control panel.

�� To append a serial node to the very end of the node tree: Press Option-K, choose 
Nodes > Append Node from the menu, or press the APPEND NODE button on the 
T-bar panel of the DaVinci Resolve control panel.

�� To add a serial node before the currently selected node: Press Option-S, or choose 
Nodes > Add Before Current, or press SHIFT DOWN and then ADD SERIAL on the 
T-bar panel of the DaVinci Resolve control panel.

�� To add nodes in parallel to the currently selected node: Press Option-P, choose 
Nodes > Add Parallel from the menu, or press the ADD PARALLEL button on the T-bar 
panel of the DaVinci Resolve control panel.

�� To layer nodes with the currently selected node: Press Option-L, choose Nodes > Add 
Layer from the menu, or press the ADD LAYER button on the T-bar panel of the DaVinci 
control panel.

�� To add an outside node to the currently selected node: Press Option-O, choose 
Nodes > Add Outside Node from the menu, or press the ADD OUTSIDE button on the 
T-bar panel of the DaVinci control panel.

Adding Nodes with Windows Turned On
There are also dedicated commands for adding serial nodes with Circular/Linear/Polygon/Curve 
windows automatically turned on, for convenience. 

To add a node to the tree with a Window automatically enabled:

Choose an item from the Nodes menu, or press the button on the T-bar panel of the DaVinci 
Resolve control panel that corresponds to the following:

�� Node + CPW: Circular Power Window (Shift-C)

�� Node + LPW: Linear Power Window (Shift-Q)

�� Node + PPW: Polygonal Power Window (Shift-G)

�� Node + PCW: PowerCurve Window (Shift-B)

Whenever you add a node to a tree, it’s numbered consecutively to come after the next most 
recent node you’d added, regardless of the order in which it appears in the node tree. For 
example, if you’ve already added three nodes, and then you decide to add another node in 
between Nodes 1 and 2, the new node will be Node 4, and the order of the nodes will be 1, 
4, 2, and 3.
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Deleting Nodes
If there’s a node that you no longer need, you can choose to remove it completely from the 
node tree to remove its effect permanently.

To delete a node, do one of the following:

�� Select a node, then press the Forward-Delete key.

�� Right-click a node, and choose Delete Node.

�� Using the DaVinci Resolve control panel, select any node, and press the DEL-CURRENT 
button (on the T-bar panel).

After you’ve deleted a node, the node to the left and right of the node you deleted are 
automatically connected so that the node tree is unbroken. Also, all the nodes in a tree are 
renumbered after the deletion of any node, so there’s no discontinuity in node order. For 
example, if you have three consecutively numbered nodes in a tree and you delete the second 
one, the node that was formerly number 3 is renumbered to be 2.

Connecting and Disconnecting Nodes
For a node tree to work, every node in the Node Editor must be connected into a working node 
tree, from the Source input, through each node in the tree, to the Node Tree output. Any 
disconnected node will result in that clip’s grade being disabled. However, you may find the 
need to disconnect some parts of a node tree in order to reconnect them in different ways.

To connect two disconnected nodes:

Click-and-drag a connection from the RGB or Key output of one node to the 
corresponding RGB or Key input of another, and when the line highlights, release the 
mouse button.

To disconnect two nodes:

�� Click a link to select it (selected links turn orange), and then press the Delete or 
Forward-Delete key.

�� Right-click a link and choose Delete Link.

To overwrite a node’s previous connection:

You can drag a connection to a node input or output that’s already connected, which 
will overwrite the previous connection with the new one you’re dragging. When you do 
this, the connection that’s about to be overwritten appears highlighted in orange.

You can connect any node’s RGB or Key output to as many inputs as you want, but you can only 
have one connection going to a node’s input. The exception to this is a node with multiple 
inputs, designed to combine the output of multiple nodes. These include the Parallel, Mixer, and 
Key Mixer nodes.

Extracting a Node
Sometimes you need to remove a node from its current position in the node tree, such that the 
nodes to the left and right of it automatically reconnect to one another, saving you from having 
to reconnect them manually. This is called extracting a node.

To extract a node, do one of the following:

�� Select a node, and choose Nodes > Extract Current Node.

�� Select a node, and press E.

Keep in mind that disconnected nodes in the node tree suspend grading altogether, so you’ll 
want to either reconnect that node to another part of the node tree, or delete it; you cannot 
leave it disconnected in the Node Editor.



893

N
o

d
e

 E
d

iti
ng

 B
as

ic
s 

P
ar

t 
6

 –
 4

9

Inserting a Node
If there’s a disconnected node in the Node Editor, there’s a simple way you can insert it into the 
node tree between any two other nodes. This also works for nodes that you’re dragging into a 
node tree from another source, for example, from the exposed node tree of a still in the Gallery.

To insert a disconnected node between two other nodes:

Drag a disconnected node, or a node from another node tree, onto the connection 
between any two other nodes in a node tree; when a plus icon appears over the node 
you’re dragging, drop it to insert the node.

Rearranging Node Order
The order in which nodes are connected in your tree affects the result of a grade. For example, 
if you boost the highlights in the first node, and then you try to isolate a portion of the picture in 
a second node that you now realize has been clipped, you may to need to change your order of 
operations to optimize your corrections.

To swap the contents of two nodes:

Command-drag any node and drop it onto another node to swap the operations within 
each node. The nodes won’t appear to have moved, but you should be able to tell from 
the node badges underneath that the operations have been reversed.

To move a node to any other position in the node tree:

1	 Double-click any node in the node tree and press E to extract it, removing it from the 
tree so that it becomes unattached.

2	 Drag the now-unattached node to the connection line between any two other nodes in 
the tree, and when a small plus icon appears, drop it to automatically connect that node 
at that position in the node tree.

Copying and Pasting All Settings 
From One Node to Another
The simplest thing you can do is to copy all of a node’s settings and paste them into another 
node. This makes it easy to duplicate things like windows, qualifier settings, keyframing, or 
motion tracking that you want to re-use in another node as the basis for another operation. This 
is also a quick way to manually ripple a change you make in a node to that same node in 
another clip’s grade.

To copy a node’s settings from one clip to another, do one of the following:

�� Option-drag one node onto another. When you drop it, the settings of the node you 
dragged overwrite those of the node you dropped onto.

�� Select a node with settings you want to copy and choose Edit > Copy (Command-C). 
Then, select a node you want to paste these settings to either in the current grade or in 
the grade of another clip, or create a new node, and choose Edit > Paste (Command-V) 
to paste the settings you copied. These pasted node settings overwrite any other 
settings that node previously used.

Note: There are additional methods of copying nodes and individual node settings. For more 
information, see Chapter 48, “Grade Management.”
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Keeping Node Trees Organized
It’s a good idea to keep the arrangement of your nodes in the node graph clean and neat. It’ll 
make it easier to read your tree if you need to revisit a grade later on, and it will also make it 
easier for other colorists working on the same project to figure out what you’re doing. The 
following procedures describe how to rearrange the nodes in your tree, and the node tree 
working area, to help you keep on top of your grades.

To move nodes within the Node Editor:

�� Drag any node to a new position.

�� Command-click or drag a bounding box around multiple nodes that you want to move, 
and drag them all to a new position.

Of course, it’s easy to get carried away. If you’ve been working furiously on a complex grade 
and you find yourself staring at a riot of disorganized nodes, it’s easy to quickly reorganize your 
node graph using a pair of commands in the Node Editor contextual menu.

To clean up the node graph, right-click the Node Editor and choose one of the 
following commands:

�� Cleanup node graph with curves: Moves all nodes in the node graph so they appear 
in an evenly spaced grid. Connection lines are curved around nodes to minimize clutter.

�� Cleanup node graph without curves: Moves all nodes in the node graph so they 
appear in an evenly spaced grid. Connection lines cut across nodes as necessary.

Before/After using “Cleanup node graph with curves”
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Using Compound Nodes
Another node structure you can use to keep complex node trees organized is the compound 
node. You can Command-click to select any number of nodes in the node tree (selected nodes 
are highlighted red), and then use the “Create Compound Node” command to nest all selected 
nodes inside of a single node.

Before/After creating a compound node

The resulting compound node that’s created has as many inputs and outputs as are necessary 
to accommodate the connection lines that attached the nodes you selected to the rest of the 
node tree. 

You can use compound nodes to organize complicated node trees by nesting sets of nodes 
that work together to do a specific thing within a single node. You can also turn a set of nodes 
that you’re using to create a specific effect into a compound node in preparation for saving to 
the Gallery. Creating a library of effects in this way makes it easy to reuse them via the Append 
Grade command, without the undue burden of adding lots more nodes to your grade later on.

Methods for creating and working with compound nodes:

�� To create a compound node: Command-click each node you want to nest inside of 
a compound node to select them with a red highlight. Then, right-click one of the 
selected nodes, and choose Create Compound Node from the contextual menu.

�� To edit a compound node: Either hold the Command key down while double-clicking 
the compound node you want to open, or right-click any compound node and choose 
Show Compound Node from the contextual menu. The contents of that node appear in 
the Node Editor, taking the place of the overall node tree. 

�� To exit a compound node you’re editing: To return to the top level node tree, click the 
left-most item in the path control at the bottom of the Node Editor.

�� To label a compound node: Right-click a compound node, choose Change Label from 
the contextual menu, and type a new label for that node. Press the return key when 
you’re finished.
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�� To decompose a compound node: Right-click the compound node you want to 
decompose, and choose “Decompose Compound Node” from the contextual menu. 
The compound node disappears, replaced by the original nodes within. Please note, 
if you had applied an adjustment to the compound node itself, that adjustment is lost 
when you decompose it back into its constituent nodes. If you want to preserve the 
compound node adjustment itself, you can copy it, then decompose the node, and then 
create a new node and paste the adjustment you’d copied.

Adding Inputs and Outputs to Compound Nodes
When you open the contents of a compound node using the Show Compound Node command, 
you can make whatever adjustments you like to the node tree within, but you also have the 
option of right-clicking within the Node Editor and choosing Add Source to add an input to the 
compound node, or Add Output to add an output. Adding more inputs and outputs lets you set 
up the node to connect to the rest of your node tree in more complicated ways. Disconnected 
inputs and outputs have no effect on your grade.

Furthermore, you can also use the Add Alpha Source and Add Alpha Output contextual menu 
commands to add KEY inputs and outputs to a compound node, making it easy to route key or 
alpha channel data to other connections in the enclosing node tree.

Nesting Compound Nodes
Compound nodes can also be nested within other compound nodes, if necessary.

Grading Compound Nodes
After you’ve created a compound node, you can select it to make one or more adjustments 
using the compound node itself, which effectively adds those adjustments after all other 
adjustments that take place via the nodes that are inside of the compound node. This gives you 
the opportunity to “trim” the effect that compound node is having on your grade, or to limit it 
using a Qualifier or Window.

To adjust the individual nodes nested within a compound node, you need to first open the 
compound node. Then, you can select and adjust any node as you ordinarily would.

Identifying Nodes
As you make various adjustments to nodes, small badges appear underneath that indicate what 
that node is actually doing. Since nodes are capable of holding multiple adjustments, any given 
node may have multiple badges; how many badges a node can show depends on the zoom 
level of the Node Editor. Larger nodes will show more badges, whereas smaller nodes will show 
fewer badges, hiding whichever badges don’t fit.

Badges underneath each node indicate 
which adjustments it contains



897

N
o

d
e

 E
d

iti
ng

 B
as

ic
s 

P
ar

t 
6

 –
 4

9

Another nice organizational feature of the Node Editor is an automatic tooltip that appears 
whenever you hover the pointer over a particular node, that shows you a concise list of all the 
operations applied to that particular node.

Grading Order of Operations
As you construct grades more carefully in the Color page, it may help you to know what the 
precise order of operations are in the image processing pipeline of DaVinci Resolve. While you 
can control the order of operations for node-specific adjustments by being careful about what 
you do in which nodes, the order of Pre-Grade, non-node specific, and Post-Grade operations 
are all fixed.

The following illustration shows DaVinci Resolve’s order of operations:

The order of image processing operations in DaVinci Resolve

Operations that take place after nodes

Operations that take place before nodes

Operations that take place within nodes

Camera Raw
Resolve Color Management Input to

Timeline Color Space Conversion
or ACES IDT

Input LUT
Edit 

Sizing
Input
Sizing

Deliver Page
Output

Output
LUT

Output
Sizing

Resolve Colour Management to
Output Color Space Conversion

or ACES RRT to ODT

Motion
Blur

Noise
Reduction

OpenFXColor 
Match

Stereo 
Color
Match

Shot 
Match

Hue/
Saturation

Shadow/
Midtone/
Highlight

Custom
Curves

Contrast/
Pivot

Lift/
Gamma/

Gain

Color
Boost

1D or 3D
LUT

HSL
Curves

Channel
Mix

Color Page
Display LUT

Soft ClipDefocusNode
Sizing
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Putting Nodes into HDR Mode
When using various grading controls in the Color page to grade wide-latitude images for HDR 
output, you may find it useful to enable the HDR Mode of the node you’re working on by 
right-clicking that node in the Node Editor and choosing HDR mode from the contextual menu. 

Using a node’s contextual menu to put 
that node into HDR mode

This setting adapts that node’s controls to work within an expanded HDR range. Practically 
speaking, this makes it easier to work with wide-latitude signals using controls that operate by 
letting you make adjustments at different tonal ranges such as Lift/Gamma/Gain, Custom 
Curves, Soft Clip, etcetera.

Applying a LUT Within a Node
Look up tables (LUTs) are frequently used to create a starting point adjustment for media 
acquired with some sort of logarithmic (log) exposure. DPX log film scans, digital media using 
the ARRI ALEXA’s Log-C encoding, Sony’s S-Log exposure setting, or RED R3D media that is 
debayered using the REDFilmLog setting are all examples of media using a logarithmic 
exposure curve, designed to protect as much detail in the highlights and shadows of a digitally 
encoded image as possible. While log-encoded media retains a lot of image data, the picture is 
initially flat and unsuitable for use without grading. The exposure and color must be adjusted to 
“linearize” the media, making it look the way it’s supposed to, in order to start grading. You can 
do this manually, or, as a shortcut, you can use a LUT that’s tailored to your type of media and 
the exposures you’re using.

LUTs are also commonly used in onset workflows where dailies are managed with 
corresponding LUTs. These LUTs were used to monitor the media as it was being recorded, and 
define a baseline reference for how each scene is meant to look, at least so far as field 
monitoring is concerned.

In either instance, LUTs, when used in this way, are adjustments that are applied to affect the 
look of a clip, in much the same way as you’d make adjustments using any of the contrast or 
color controls in the Color page. While there’s an entire group of LUT controls in the Color 
Management panel of the Project Settings, those are designed to apply LUTs, in different parts 
of the image processing pipeline, to the entire Timeline. This is useful when you want to apply a 
single color and contrast transformation to the entire program at once, but less so if you want to 
apply different LUTs on a per clip basis. (For more information on using the Look Up Table 
settings, see Chapter 3, “Project  Settings and Preferences.”)
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DaVinci Resolve lets you apply LUTs within a grade by connecting a LUT to a particular node in 
the Node Editor. 

To apply a LUT within a node:

Right-click any node, and choose a LUT from the 1D Input LUT, 1D Output LUT,  
3D LUT, DCTL, or CLF (common LUT format) submenus.

LUTs that you apply using one of these submenus impose their transformation after all other 
Color page adjustments applied by that node. This means that you can use Color and Contrast 
controls to trim whatever effect the selected node’s LUT is having on the image. For example, 
if the contrast adjustment made by an applied LUT clips the highlights of the image too much, 
you can use that node’s Contrast controls to lower the highlights, restoring detail to the image.

The LUT submenus list whichever LUTs have been installed on your workstation. For more 
information on installing LUTs, see Chapter 3, “Project Settings and Preferences.”

Clip vs. Timeline Grading
Ordinarily, the Node Editor has two modes. The default Clip mode lets you create individual 
grades for each clip or group in the Timeline. However, the Timeline grade mode lets you apply 
a single grade simultaneously to every clip in the Timeline, as seen in the Thumbnail timeline in 
the following screenshot. 

A paragon of sophisticated grading, the author applies a red edge vignette to 
every clip in the project simultaneously using the Timeline grade.

There are a variety of reasons you might want to do this. For example, if you’re working on a 
commercial spot, you might elect to use Clip grades to do general correcting and scene-to-
scene balancing, and then use the Timeline grade to apply a single stylistic grade to the entire 
spot simultaneously. That way, any changes the client wants made to the style of the grade can 
be instantly applied to the whole spot.

Another example would be using the Timeline grade to apply corrections meant to address QC 
issues running throughout a program, desaturating highlights or selectively darkening a specific 
shade of red wherever it appears.

What LUTs are supported by DaVinci Resolve?

DaVinci Resolve uses both 1D and 3D LUTs. 3D LUTs that are created by DaVinci 
Resolve are in the .cube format, configured as 33x33x33 cubes with 32-bit floating 
point processing. However, DaVinci Resolve is also compatible with the newer CLF 
(common LUT format) type of LUT and can also read and use LUTs in the Shaperlut 
format. Finally, DaVinci Resolve can use the DCTL format of color transformation 
scripts in the same way as LUTs. For more information on DCTL, see Chapter 82, 
“Creating DTCL LUTs.”
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To switch between Clip and Timeline grading modes:

Choose the mode from the pop-up menu at the top right of the Node Editor.
 

Selecting Track mode in the Node Editor

Click the dot in the Node Editor toolbar that corresponds to the Clip or Timeline mode
 

Two dots show whether you’re in Clip or Timeline 
mode; these can be clicked to switch

Two dots at the top of the Node Editor let you switch between Clip and Timeline modes via a 
single click. If you’re working on a clip that’s part of a group, four dots will be displayed to allow 
fast access to the Pre-Clip and Post-Clip Group modes as well. For more information about 
group grading, see Chapter 48, “Grade Management.”

Timeline Grades and Saved Stills
When you save a Gallery still, the Clip and Timeline grades are both saved. However, when you 
apply a grade from that still, you only apply either the Clip grade, or the Timeline grade, 
depending on which mode the Node Editor is in. For more information on saving and applying 
grades, see Chapter 48, “Grade Management.”

NOTE: When you reset the Timeline grade using the Color > Reset All Grades and 
Nodes command, the Output Sizing parameters are reset as well.
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Chapter 50

Serial, Parallel, 
and Layer Nodes 
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Serial, Parallel, and Layer Nodes
This chapter covers the four fundamental node structures you can use to combine Color page 
adjustments in even more detailed ways. These methods let you control your order of 
operations and re-combine multiple versions of the graded image in much more specific ways.

This chapter has the following topics:

Serial, Parallel, and Layer Node Tree Structures	 903

Serial Node Structures	 903

Controlling What Feeds a Node’s RGB Input	 903

Parallel Node Structures	 904

Layer Mixer Node Structures	 906

Layer Mixer Prioritization	 906

Using Composite Modes With the Layer Mixer	 908

Adjusting Layer Node Strength Using Key Output Gain	 909

Converting Layer Mixers to Parallel Mixers	 909
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Serial, Parallel, and Layer 
Node Tree Structures
There are several ways you can organize nodes in a tree. Each method lets you control a group 
of image processing operations in different ways to achieve specific results. This section covers 
how to use Serial nodes, Parallel nodes, and Layer nodes, as well as how to use LUTs, work 
with HDR media that lets you combine two different exposures using two different Source 
inputs, and apply additional project-wide adjustments using the Timeline grade.

Serial Node Structures
The simplest, and most common node structure is a serial cascade of nodes, where a linear 
series of nodes is connected, one after another. 

Serial nodes, the output of one node goes into the next

Much of the time, this method of constructing a tree of multiple operations is all you need to do. 
It’s a simple and intuitive way of organizing your adjustments, similar in principle to the stacks of 
layers used in other grading and compositing applications to apply multiple operations to a clip.

Controlling What Feeds a Node’s RGB Input
When you create a grade using serially arranged nodes, each node’s output is used as the next 
node’s input, so the order in which the nodes are arranged determines the order of image 
processing operations. 

In the following screenshot, the node tree shows a series of three operations that are applied to 
a log-exposed, low-contrast clip. The first node expands clip contrast and increases saturation. 
The second node isolates the sky to intensify its color. The third desaturates and warms the 
image. At right, you can see the result of this node tree.

Node two pulls a clean key from the image data fed it by node one
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If, instead, we reversed the order of Nodes 2 and 3, the result will be a less effective key.

By comparison, node three pulls a less then optimal key 
from the image data fed it by node two

Because the secondary operation is sampling the desaturated image, rather than the source, 
the HSL Qualifier’s key has less image data to work with, and thus you get an inferior result.

Parallel Node Structures
Another way to organize your corrections is to use a Parallel node structure, which lets you 
apply two or more overlapping adjustments at a single stage of a node tree. You can use the 
Parallel node structure for organizational reasons when there is a group of secondary 
corrections that you want to apply all at once. You can also use this structure for the unique way 
it blends overlapping image adjustments.

The Parallel Mixer node that makes this possible has multiple RGB inputs and a single RGB 
output. This lets the Parallel Mixer mix together multiple Corrector nodes, outputting a single 
image as a result.

When you add a Parallel node to an existing node, DaVinci Resolve automatically adds one 
Corrector node below the current node, and adds a Parallel Mixer node to its output.

Adding a Parallel node to Node 2 automatically adds the Parallel Mixer

If you’re manually connecting another node to a Parallel Mixer node, you must first create an 
additional input to connect it to.

TIP: If you want to create a series of Parallel nodes that connect to the output 
of the currently selected node, create a Serial node before you create your first 
Parallel node.
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To create an additional, unconnected input on a Parallel Mixer node:

Right-click a Parallel Mixer node and choose Add One Input.

Ordinarily, the RGB input of every Corrector node that’s connected to a Parallel node is 
connected to the output of the same node. This results in a stack of nodes that take the same 
state of the image as their input. This makes it easy to apply multiple secondary operations 
without worrying about whether or not a change to one will affect the keys of the others.

Further Parallel nodes can be added as you wish 
with each using a common source

If you add another node in parallel, the Parallel Mixer automatically adds another input. You can 
have as many nodes in parallel as you need. 

The adjustments made by all nodes that are connected to a Parallel Mixer are combined 
equally, regardless of which nodes are highest. In the following example, a separate 
overlapping Window is applied by each of three nodes in parallel.

The Parallel Mixer blends all input nodes together
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As you can see in the image at right, the three tints created by the overlapping Windows are all 
mixed together equally; the colors blend with one another as if they are optically mixed. Most of 
the time, this is exactly what you want when you’re blending overlapping naturalistic color 
adjustments.

Converting Parallel Mixers to Layer Mixers
On the other hand, if you need your overlapping color adjustments to have priority over one 
another, or if you want to combine multiple adjustments using composite modes, then you may 
want to use the Layer Mixer node instead. If you’ve created a Parallel Mixer structure and you 
want to convert it to a Layer Mixer, you can.

To change a Parallel Mixer node into a Layer Mixer node:

Right-click a Parallel Mixer node and choose Morph Into Layer Mixer Node.

Layer Mixer Node Structures
The Layer Mixer is structurally quite similar to the layout used by the Parallel Mixer. However, 
there are two key differences. First, the Layer Mixer node combines multiple adjustments with 
priority given to the image adjustment in the lowest overlapping node input. Second, you have 
the option of combining all of the Corrector nodes that are connected to a Layer Mixer using 
one of several different composite modes, to create a wide variety of visual effects.

Because of their similarities, layering nodes with the Layer Mixer works in much the same way 
as creating a Parallel node structure.

Layer Mixer Prioritization
In the following example, the same node structure from the Parallel Mixer example is shown, 
this time with the three overlapping color adjustments mixed together using the Layer Mixer.

The Layer Mixer prioritizes nodes connected to lower inputs such 
that each node’s output completely obscures whatever is behind it
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Now, instead of the three adjusted color tints being blended, you can see that the blue tint, 
which is connected to the lowest input of the Layer Mixer, is dominant and covers the 
overlapping regions of the two other adjustments. Meanwhile, the green tint, which is 
connected to the middle input of the Layer Mixer, covers the overlapping portion of the orange 
tint, which is connected to the highest input of the Layer Mixer.

Rearranging which connections are attached to which Layer Mixer inputs changes each node’s 
priority, and like the Parallel Mixer, you can add more inputs if you need to connect more 
nodes manually.

The Layer Mixer’s prioritization is most useful when you have an overlapping adjustment that 
you need to override any other adjustments happening on that stack. In the following example, 
two nodes are connected to the Layer Mixer node. Node 2 is applying a high-contrast, cool 
look to the entire clip. Node 3 isolates the skin tone, which is unflattering with the background 
stylization, and applies a different, more naturalistic adjustment.

Using the layer mixer, grades on Node 4 will have a greater priority 
over Node 2, so the final grade combines the high contrast from 
Node 2 with the adjusted skin tone from Node 4

Because of the Layer Mixer’s prioritization, the adjustment made to the woman’s skin tone 
completely covers the adjustment made to the node that comes above it, providing the best of 
both worlds with one simple adjustment.

TIP: If you want to “solo” overlapping nodes that are connected to the Layer Mixer to 
see their individual adjustment, turn on Highlight (Shift-H, or the HILITE button on the 
Transport panel of the DaVinci control panel). This lets you view just that node’s effect, 
regardless of what other nodes adjustments are overlapping.
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Using Composite Modes With the Layer Mixer
You have the option of combining the adjustments made by all nodes connected to a Layer 
Mixer node using the same Composite modes that are available when compositing clips in the 
Timeline. This lets you combine different overlapping image adjustments using compositing 
math to achieve creative effects or utilitarian fixes.

The following simple example shows two overlapping Corrector nodes connected to a Layer 
Mixer node that’s set to the Add composite mode. Node 3 has no adjustment, but Node 5 has 
an extremely high-contrast curve adjustment applied, along with a blur, that effectively isolates 
the highlights of the image and feathers them out.

 

Combining two nodes using the Layer Mixer 
set to Add to create a glowing effect

By adding both treatments together, a hot glow has been created, blowing out the highlights of 
the image. Many, many other effects are possible using the different composite modes that are 
available. For more information on composite modes, see Chapter 29, “Compositing and 
Transforms in the Timeline.”
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Adjusting Layer Node Strength Using Key Output Gain
Whether you’re combining overlapping corrections, or mixing different adjustments using 
Composite modes, you’ll run into situations where you want to reduce the influence of one 
overlapping adjustment relative to the other nodes that are connected to the Layer Mixer node. 
This can be accomplished using each overlapping node’s Key Output Gain parameter, located 
in the Key palette.

Using the Output Gain parameter in the Key palette

Key Output Gain defaults to 1.00, but lowering this value reduces the strength of that node’s 
contribution to the Layer Mixer. Using the previous example, selecting Node 4 (the 
high‑contrast image used to create the glow), opening the Key palette, and reducing the Key 
Output Gain parameter to 0.50 reduces the intensity of the Glow effect by half.

You can use Key Output Gain to mix the proportion of any number of overlapping adjustments 
in order to create the perfect combination for your purposes.

Converting Layer Mixers to Parallel Mixers
You can easily convert a Layer Mixer to a Parallel Mixer should you discover that you need to 
mix your overlapping corrections evenly rather then combine them with priority. Keep in mind 
that you’ll lose the ability to use Composite modes.

To change a Layer Mixer node into a Parallel Mixer node:

Right-click a Parallel Mixer node and choose Morph Into Parallel Node.

TIP: You can also use the Key Output Gain parameter to mix the proportion of 
adjustments being combined using the Parallel Mixer node.
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Chapter 51

Combining Keys 
and Using Mattes 



911

C
o

m
b

in
in

g
 K

e
ys

 a
nd

 U
si

ng
 M

at
te

s 
P

ar
t 

6
 –

 5
1

Combining Keys and Using Mattes
A “Key” is the actual image channel that’s generated by different secondary operations to 
isolate specific portions of images to work on. This chapter covers different ways you can 
manipulate and combine keys from multiple nodes, or propagate keys among nodes. It also 
shows different ways you can use mattes that are imported from other applications, as well as 
how to use the Key Palette to further manipulate keys in different ways.

This chapter has the following topics:

Introduction to Manipulating and Combining Keys	 912

Outside Nodes	 912

Feeding Keys from One Node to Another	 913

Connecting KEY Outputs to RGB Inputs, and Vice Versa	 916

Using External Mattes	 917

External Mattes to Limit Adjustments	 918

Extracting External Mattes from OpenEXR Layers	 920

Using External Mattes to Add Texture	 921

Using External Mattes to Create Transparency	 922

Key Palette Controls for the External Matte Node	 923

Using the Key Mixer	 924

Adding Two Keys Together	 924

Subtracting One Key from Another	 925

Adding Inputs to Key Mixer Nodes	 928

Using the Key Palette	 928

Using the Key Palette to Adjust Key Mixer Controls	 930

The Many Uses of Key Output Gain	 931
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Introduction to Manipulating 
and Combining Keys
Each node’s key input and key output makes it possible to route key channel data from one 
node to another so you can apply isolated corrections. Furthermore, the Key Mixer lets you 
combine a variety of keys from different nodes to create more detailed keys with which to 
tackle complex operations. This section covers all the ways you can recombine key data, as 
well as how keys can be used in conjunction with the Alpha Output to create regions of 
transparency in a clip for compositing right within DaVinci Resolve.

Outside Nodes
Whenever you use a Power Window or HSL Qualifier to limit a correction within one node, a 
special node structure lets you automatically create a second node, called an Outside node, to 
apply additional adjustments to the inverse of the region you isolated in the previous node. 
Outside nodes make it easy to apply separate corrections to an isolated subject and its 
surroundings. 

In the following example, the sky has been isolated using a Power Window, and an Outside 
node has been added to make an additional correction to everything else within the shot.

The Outside node automatically has its key input inverted

To add an Outside node to a node, creating a secondary correction:

1	 Select a node that has been limited using a Power Window or HSL Qualifier.

2	 Do one of the following:

�� Choose Nodes > Add Outside (Option-O).

�� Right-click a node choose Add Outside Node.

�� Press the ADD OUTSIDE button on the T-bar panel of the DaVinci control panel.

A new node is created immediately after the selected node, with the RGB and key 
outputs of the first node automatically connected to those of the new node. 
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When selecting the new node and opening the Key palette, you can see that the Key Input’s 
Invert control is on by default, which is what inverts the key from the previous node.

The Key Input’s Invert control is on by default for each node

If, instead of inverting the incoming key, you want to copy the existing key in order to perform 
another operation to the same isolated region, you can disable the key input’s Invert control.

Feeding Keys from 
One Node to Another
One of the most powerful aspects of the Node Editor is the ability to create keys based on a 
specific part of the node tree, and feed the result into a completely different correction 
somewhere else in the node tree. This is one of the reasons for the separate key input and 
output on every Corrector node.

The key that’s created whenever you use the HSL Qualifier, create one or more Windows, or 
use an external matte can be output from one node’s key output and fed to the key input of any 
other node in a tree. There are many reasons to do this, but the following example shows a 
common problem you can solve with this technique.

Using a key from one node to make an adjustment with a different node:

1	 Use Node 1 to apply a basic primary correction, increasing contrast and balancing the 
color to achieve a pleasing ambient color temperature. 

2	 Add a Serial node (Node 2), followed by a Layer Mixer node which also adds Node 4 
(as seen in the following screenshots). Then, completely desaturate Node 4 and add 
contrast make it super-high contrast black and white, desaturate Node 2 just a bit, 
and right-click the Layer Mixer node to choose the Overlay blend mode with which to 
combine these two layers.

 

Serial nodes to create a stylized image
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The result is a highly stylized image, but the skin tone on the actor’s face and hands in 
the resulting image are too monochromatic, and you want to give them some 
differentiation. Simply adding another node after the Layer Mixer and keying the skin 
tone may not work well because the low level of saturation will make a key 
difficult to pull. 

The resulting stylized image may be difficult to key accurately

3	 Add another node after the Layer Mixer (Node 5 in the screenshot), and then right-click 
in the gray background area of the Node Editor, and choose Add Node > Corrector to 
create an unattached node, (Node 6).

4	 Connect the RGB output of Node 1 to the RGB input of Node 6, and then connect the 
Key output of Node 6 to the Key input of Node 5. Now you’re ready to pull a high-
quality key from the very first correction in Node 1, skipping all the complication coming 
afterwards.

5	 Use the HSL Qualifier in Node 6 to pull a good strong skin tone key based on the 
primary image. Given the way the node tree is now set up, that key is fed to Node 5, 
and will limit whatever adjustments you make there. 

Using Node 6 to pull a key from the image output by Node 1, and 
feeding that key to Node 5

So now things are almost ready for an adjustment to be made to the actor’s skin tone, 
however the same automatic setting that makes it easy to create Outside nodes is 
inverting the key that Node 6 is feeding to Node 4, which is isolating everything except 
for the skin tone. This is the opposite of what is needed.
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6	 Double-click Node 5 to select it, open the Key palette, and click the Key Input Invert 
control so that Node 5’s key is identical to Node 6’s key.

Using the Key palette to control the key levels 

7	 Now, you can make your adjustment to Node 6’s grade, to lower the contrast, brighten, 
and increase the saturation of the actor’s skin tone.

Inverting the key being input into Node 5, to make an adjustment to the actor’s skin tone

As a result of this operation, the background remains desaturated and contrasty, while 
the actor’s skin tone has the brighter quality we need for the shot.

Before/After Selective adjustment of skin tone
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This example could have been handled in a variety of different ways, but the point is that you 
can add nodes that connect to the state of the image at any part of a node tree, and use them 
to generate keys to feed to any other node, regardless of what’s happening to the picture 
in between. 

Connecting KEY Outputs to 
RGB Inputs, and Vice Versa
There’s another way you can manipulate a key from one node using another in the Node Editor, 
and that’s to connect the KEY output from one node to the RGB input of another node. When 
you do this, you can use any of the controls of the second node to manipulate the key, and you 
can then use the result by connecting the RGB output of the second node to the KEY input of a 
third node.
 

Connecting a KEY output to an RGB input to adjust a key with a second node’s controls

In the node tree shown above, Node 2 pulls a key, Node 3 manipulates the key, and Node 4 
uses the key to make a color adjustment.

Keep in mind that a key is just a grayscale image. Setting up this kind of node structure lets you 
use any of the second node’s controls, such as the Custom Curves, Noise Reduction or Motion 
Blur controls, Sharpen, Midtone Contrast, Lift/Gamma/Gain, Contrast, or Log controls, to 
manipulate the key in ways you couldn’t do using only the Matte Finesse controls.

While this technique may not be necessary for conventional color isolations, it can come in very 
handy when making tricky isolations with hard to key subjects, or when using one of the 
Qualifier modes to pull a key to create transparency for compositing using the Node Editor’s 
Alpha output. In this instance, you can connect the RGB output of a node used for key 
manipulation directly to the Alpha output. In the example, Node 1 pulls a key, and the RGB is 
connected to Node 2 which is used to color correct the foreground image. The KEY from Node 
1 is connected to the RGB of Node 3, which manipulates the key to clean it up prior to 
connecting it to the Alpha Output block at the bottom right of the Node Editor.
 

Connecting a KEY output to an RGB input to adjust a key 
used to create transparency via the Alpha output



917

C
o

m
b

in
in

g
 K

e
ys

 a
nd

 U
si

ng
 M

at
te

s 
P

ar
t 

6
 –

 5
1

Furthermore, this capability also lets you create keys in other ways besides using the Qualifier 
palette controls. In the following example, the Contrast and Custom Curve controls in Node 3 
create a high-contrast matte of the windows which is blurred. The RGB output of Node 3 is then 
connected to the KEY input of Node 2, where the resulting key can be used for a variety of 
adjustments; in this case, to tint the product within the image green. Alternately, this technique 
could be also be used to create transparency via the Alpha Output.

Using a high contrast color correction as a key

Interconnecting KEY and RGB inputs and outputs is a powerful capability that lets you create 
many kinds of workarounds for uncommon situations.

Using External Mattes
The External Matte node has evolved over the years. What was once purely a means for 
importing matte channels for defining opacity and limiting adjustments has expanded to 
become a way to import the RGB channels of a media file to be used for overlaying grain, 
texture, and stylized distress onto an image, and even as a way to use the channels of a clip 
itself as a matte.

Matte clips are added to your project in the Media page. You can add them by attaching them 
to a clip, so a particular matte is only available to a particular clip as part of a Clip Grade, or you 
can add unattached mattes that stand alone in the Media Pool, which are then available to any 
Track Grade. For more information about adding Matte clips in the Media page, see “Adding 
and Removing External Mattes” in Chapter 8, “Adding and Organizing Media with the 
Media Pool.”

Whether attached or unattached, mattes operate within a grade using EXT MATTE (external 
matte) nodes. EXT MATTE nodes have the following outputs:

An external matte connected to the first node of a grade
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�� EXT MATTE Outputs: Four blue triangular key outputs let you output the channels 
contained within the EXT MATTE node, but which channels are available affects what 
is output. If the EXT MATTE node’s source clip has RGBA channels, then these are 
available as Alpha, Red, Green, and Blue key outputs that you can attach to any other 
node’s key input. On the other hand, if the EXT MATTE node’s source clip only has RGB 
channels, then the key outputs that are made available are Y (luma), Red, Green, and 
Blue, and a “Use Lum for Alpha Output” setting in the Node Editor contextual menu lets 
you use the Y channel as a matte.

An interesting aspect of these four outputs is that each one is dedicated to individual A, 
R, G, and B color channels. Ordinarily, External Matte clips are written with matte data 
written simultaneously to all three RGB channels. However, you could also render 
separate pure primary-colored mattes to each color channel (a so-called “disco” matte), 
so that the Red channel has one matte, the Green channel another, and the Blue 
channels still another, thereby exporting three separate mattes within a single media 
file, for convenience. If you add another matte to the Alpha channel, you can even 
export four mattes within a single file. You can then use each one of these mattes 
individually by connecting the correct output of the Ext Matte node. (Note: For 
backward compatibility, projects from versions of DaVinci Resolve previous to 12.5 
continue to output RGBY from the triangular outputs, not YRGB.)

�� RGB Output: A round orange RGB output lets you connect the RGB image data of a 
matte clip to any other clip’s RGB input. This is especially useful when you’re combining 
a matte clip with the current clip using a Layer Mixer node, to create a textured 
composite of some kind.

External Mattes to Limit Adjustments
Going back to the External Matte node’s original use, mattes are typically grayscale media files 
that represent image opacity, and are meant to be used either as alpha channels for creating 
opacity within a corresponding RGB clip, or as a matte for limiting effects. 

An example of a matte channel would be the key created by a green screen keyer. If you output 
just the key, that would be an external matte. If you receive an external matte along with an 
effects clip, you can attach the matte to its corresponding RGB clip in the Media page. Then, 
you can access that matte via an External Matte node in the Node Editor, so you can use the 
key it outputs to limit different kinds of corrections you want to apply. 

In the following example, the keyed matte of a green screen composite clip is used to apply 
different corrections to the inside and outside of a keyed composite, in order to make the 
subject match the background more convincingly.

A matte attached to clip Makeup_composite.mov, 
as seen in the Media Pool
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To use an attached matte to limit an adjustment within a Clip Grade:

1	 Right-click any node, and choose the attached matte you want to use from the Add 
Matte submenu of the contextual menu.

By default, the EXT MATTE node that appears has its first output connected to the 
Connect one of the EXT MATTE node’s triangular key outputs to the key input of a 
node you want it to limit.

2	 Select the node to which the EXT MATTE node is attached, and add an Outside node 
to make it possible to add adjustments on either side of the matte.

 

Node Editor displaying the influence of the external matte 
on multiple nodes when the keys are linked 

3	 If necessary, select Node 1, and use the Key palette controls to modify the incoming 
key, inverting or blurring it as necessary to create the isolation you need. 

At this point, you can add adjustments to the inside and the outside of this composited 
shot to improve the composite.

Before/After: An external matte is used to apply separate grades 
to the foreground and background of a previously composited clip

NOTE: Don’t select the EXT MATTE node, because it exposes different 
controls in the Key palette for transforming, flipping, looping, and freezing 
the matte.
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Ideally, external mattes are exported so that they match the size and duration of the RGB clip 
they’re supposed to accompany. If they don’t match or if you’re using some other grayscale clip 
as an external matte to create some sort of effect, then there are parameters in the Key palette 
that you can use to retime or transform a matte so it works better in your grade.

To slip the sync of a matte relative to the clip it’s attached to:

1	 Select the Ext Matte node you want to slip.

2	 Open the Key palette, and raise or lower the Offset parameter until the matte is 
perfectly aligned with the clip it’s supposed to match.

To transform a matte:

1	 Select the Ext Matte you want to transform.

2	 Open the Key palette, and turn off the Lock Matte checkbox.

3	 Use the Pan, Tilt, Zoom, Rotate, Width, Height, HFlip, or VFlip parameters to adjust the 
matte so it has the correct geometry.

It’s worth mentioning that you can attach as many external mattes to a single clip in DaVinci 
Resolve as you like. For example, if a CGI shot has been delivered with a set of isolation mattes 
for each of three characters in the scene, you can import all three mattes and use them to 
isolate adjustments that you want to make in the Node Editor.

Extracting External Mattes from OpenEXR Layers
OpenEXR media is capable of containing multiple layers and multiple alpha channels, which can 
also be accessed from EXT MATTE nodes. As a result, DaVinci Resolve uses a slightly different 
but related procedure for accessing these mattes.

To extract OpenEXR layers as external matte nodes:

1	 Right-click any node, and choose the .exr clip name from the Add Matte submenu of 
the contextual menu.

By default, the EXT MATTE node that appears has its first output connected to the 
Connect one of the EXT MATTE node’s triangular key outputs to the key input of a 
node you want it to limit.

2	 Double-click the EXT MATTE node to select it, then right-click it and choose which 
layer you want to use from the Select Matte submenu. 

Right-clicking an OpenEXR file’s EXT MATTE node to choose which layer to use
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OpenEXR files with multiple RGBA layers (or passes) embedded within them (RGBA + RGBA + 
RGBA etcetera) or OpenEXR files with multiple alpha channels (RGBA + A + A) expose multiple 
entries in this submenu. Whichever one you choose is the layer that will be used as a matte by 
that EXT MATTE node.

Once you’ve extracted an OpenEXR layer, you can use it as you would any other EXT MATTE 
node described in this section, to limit adjustments (as seen above), or to add texture or 
transparency (as seen in the following sections).

Using External Mattes to Add Texture
You can also use external mattes as creative tools, to add grain and texture. For example, you 
might use a more abstract animated matte, or a grayscale film scan of dirt and dust, to apply 
correction for effect.

Light leak and dirt and dust images From Warren 
Eagles’ Scratch FX collection (FXPHD), designed 
to add texture to your grades

Once attached to a clip, external mattes can be exposed in the Node Editor, and their key 
output can be used just like any other key in a node tree. 

To use an attached matte to create texture a Clip or Track Grade:

1	 When applying a matte as part of a Clip or Timeline grade, right-click any node 
and choose the attached or unattached matte you want to use from the Add Matte 
submenu of the contextual menu. Unattached mattes appear in the Add Matte > Track 
Mattes submenu.  

2	 Disconnect the EXT MATTE node’s Key output connection to the Key input of the node 
it’s connected to by default.

3	 Add a Layer Mixer to the end of the node tree.
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4	 Disconnect the bottom Corrector node’s RGB input, and then connect it to the EXT 
MATTE node’s round RGB output.

A node tree set up to feed an EXT MATTE node’s RGB output to the input of a node 
connected to a Layer Mixer, in order to blend it with the grade using composite modes

5	 Right-click the Layer Mixer node, and choose Overlay from the Composite Mode 
submenu to blend the Ext Matte node most effectively with the grade.

6	 If necessary, you can use the grading controls of the Corrector node to which you’ve 
attached the EXT MATTE node to change the characteristics of the texture clip, 
desaturating it for instance. You can also select the EXT MATTE node itself, open the 
Key palette, and use the Transform, Offset, Loop, or Freeze controls described later to 
change how the matte appears.

The resulting texture effect, blended with the 
grade using the Overlay composite mode 

Using External Mattes to Create Transparency
You can also use an EXT MATTE node to create transparency in a clip, for compositing with 
clips underneath it on the Timeline.

To use an attached matte to create transparency in a clip:

1	 Right-click any node, and choose the attached matte you want to use from the Add 
Matte submenu of the contextual menu. 

Adding an EXT MATTE node to a Clip Grade applies the effect to only that clip, 
whereas adding an EXT MATTE node to a Track Grade applies the effect to the 
entire Timeline.

TIP: If you want the texture you create to be unaffected by blur or sharpening 
operations within the grade, be sure to add it to the very end of the node tree.
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2	 Right-click any empty area of the Node Editor, and choose Add Alpha Output to reveal 
the Node Tree output on the right that lets you assign a key to be used to define clip 
transparency.

3	 Connect one of the EXT MATTE node’s triangular key outputs to the Alpha output at 
the right of the Node Editor.

The node setup for using an external matte to composite two layer

The areas of the matte defined by the key are now rendered transparent.
 

The final composite created using the external matte node 

Key Palette Controls for the External Matte Node
When you select an EXT MATTE node, the Key palette displays different parameters only for 
mattes. Be aware that you must turn off the Lock Matte checkbox before you can make 
adjustments to transform the matte.
 

The Key Palette showing a texture layer added as an EXT MATTE node

�� Transform: Standard Pan, Tilt, Zoom, Rotate, Width, and Height parameters let you 
transform a matte to fit the image better.

�� Flip Image: Two buttons let you flip the matte clip horizontally or vertically.

�� Offset: Adjust this parameter to offset the start point of a matte clip.
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�� Freeze: Turning on this checkbox freezes the matte clip on a single frame. Adjust the 
Offset parameter to choose which frame to freeze on.

�� Loop: Turning on this checkbox enables matte clips to loop endlessly, which lets 
shorter matte clips cover longer durations.

�� Lock Matte: When turned on, locks the sizing of a matte to whatever changes are made 
to the Input Sizing of that clip, so the matte transforms to follow the clip.

You can also use external mattes as creative tools. For example, you might use a more abstract 
animated matte, or a grayscale film scan of dirt and dust, to apply correction for effect.

Using the Key Mixer
The Key Mixer node lets you mix keys output from multiple Corrector nodes, combining them in 
different ways to create a single key output. This makes it possible to build much more intricate 
keys than you can with a single Qualifier or set of four Windows. In particular, the Key Mixer 
node is the only way to combine multiple keys made using Qualifiers and Windows, adding, 
subtracting, or intersecting them to create a highly specific result.

Adding Two Keys Together
In the following example, you’ll learn how to set up a Key Mixer to combine the keys output by 
two Corrector nodes in a node tree. Then you’ll learn how to change the way the input keys are 
combined using the Key palette.

To combine two or more keys using the Key Mixer:

1	 Right-click anywhere on the gray area of the Node Editor, and choose Add Node > 
Key Mixer.

2	 Create two Corrector nodes, then attach their RGB inputs to the RGB output from an 
appropriate node in the main part of the tree, and attach their key outputs to the key 
inputs of the Key Mixer.

3	 Next, attach the key output of the Key Mixer node to the key input of the node you 
want to use to make the correction. Remember, the objective is to use the key that’s 
output by the Key Mixer to limit the adjustment being made using another node, in this 
case Node 3.

Setting up the node tree you’ll need to combine two keys together

Keep in mind, especially since this is a significant reordering of nodes in the Node 
Editor, that every node needs to be connected properly for the overall grade to work.
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4	 Now that the node structure is fully connected, use Windows, Qualifiers, or both 
to create keys in each of the nodes that you connected to the Key Mixer. In this 
example, Node 2 is isolating the main skin tone, and Node 5 is isolating the blue of his 
jeans and hood.

By default, all keys connected to the Key Mixer are added together, as you can see in 
the Key Mixer’s thumbnail.

Combining multiple keys with the Key Mixer

If you wanted, you can use the controls in the Key palette to change this, in order to 
isolate the intersection of two keys, or to subtract one key from another. This is covered 
in the next section.

5	 Continuing with the previous setup where both keys are added together by default, 
selecting Node 3 and dropping the saturation to be very faint stylizes the entire 
background, while leaving the various hues of the man we’ve isolated alone.

 

Final grade, the talent in color with a B&W background

Subtracting One Key from Another
The way multiple keys are combined within the Key Mixer depends on a pair of Key Input 
buttons you can toggle using the Key palette. In the following example, a partial green tint is 
washed throughout the midtones of the image using a qualifier, but you want to exclude the 
man’s skin tone from this operation. Using the Key Mixer, you can subtract one key from another 
to accomplish this with ease.
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A selective blue tint added to the midtones of the 
image includes the red sign

To change the Key Input settings for a node connected to a Key Mixer:

1	 In this example, Node 2 is isolating part of the midtones of the image, and feeding 
its key through the Key Mixer to Node 4, which is using it to apply a partial blue tint. 
However, in preparation for subtracting the skin tone from this operation, Node 3 is 
isolating the man’s skin tone.

A node setup in preparation of subtracting the Bar sign from the 
midtone isolation being used to add a partial blue tint

2	 To reveal the controls you’ll use to change how the key from Node 3 interacts with the 
key from Node 2, double-click the Key Mixer node to select it.

3	 Open the Key palette; a list of all input links that are connected to the Key Mixer 
appears at the right.

 

The Input List of the Key Mixer node



927

C
o

m
b

in
in

g
 K

e
ys

 a
nd

 U
si

ng
 M

at
te

s 
P

ar
t 

6
 –

 5
1

4	 Within each list entry is the input name (Input Link 1, Input Link 2, etc.), a Matte control, a 
Mask control, a gain parameter, and an offset parameter.

To subtract Node 3’s key from that of Node 2: Turn on both the Key Input Matte button 
and the Key Input Invert button for Input Link 2

 

Turning on Matte and Invert for Input Link 2 to 
Output Node 3 subtracted from Node 2

To subtract Node 2’s key from that of Node 3: Turn on both the Key Input Matte button 
and the Key Input Invert button for Input Link 1.

 

Turning on Matte and Invert for Input Link 1 to 
Output Node 2 subtracted from Node 3

To limit the output to the intersection of both keys: Turn on the Key Input Matte button 
for either Input Link 1 or Input Link 2.

Turning on Matte for Input Link 1 to output the 
intersection of two mattes

To invert the resulting matte you’ve created: Turn on the Output Link Invert button.

When you’re finished, if you choose to subtract Node 3’s key from that of Node 2, the 
result should resemble the following screenshot.
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The result of subtracting a key of the man’s face from a key of the overall 
midtones of the image, and using that to add a selective green tint

Adding Inputs to Key Mixer Nodes
New Key Mixer nodes have two key inputs by default. If necessary, additional inputs can be 
added in order to combine even more keys with one another.

To add inputs to the Key Mixer:

Right-click a Key Mixer node, and choose Add One Input.

When combining three or more keys, the interaction of keys using the Key palette controls 
becomes even more complex, but the rules outlined above still apply.

Using the Key Palette
The Key palette contains parameters and controls that you can use to modify key channel data 
being fed into or routed out of the currently selected node. 

For example, the Key Input Invert control is always enabled, which is why the Outside node 
works automatically. Clicking this control results in keys that are fed into that node exactly 
mirroring the original key.

The controls that are available in the Key palette vary depending on what kind of node you 
have selected:

�� Corrector Nodes: Have three sets of parameters. Key Input parameters let you make 
adjustments to keys being fed through a node’s Key Input connection. Qualifier 
parameters let you make adjustments to the internal key created with the HSL Qualifier 
or Window controls. Finally, the Key Output parameters let you make adjustments to the 
key data being output by a node’s Key Output connection, and includes the incredibly 
powerful Offset Gain parameter that governs the strength of that node’s contribution to 
the overall grade. This functionality is covered more extensively in the next section.

�� Ext Mattes: Have two sets of parameters. Transform parameters let you make 
geometric transformations to a matte so it fits the clip it’s being applied to better. An 
Offset control lets you slip the sync between an external matte and the clip to which it’s 
applied. This functionality is covered in the section on External Mattes.
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�� Key Mixer Nodes: Have two sets of parameters that are dependent on which of the 
connections attached to a Key Mixer’s key inputs is selected. Input parameters let you 
adjust how much of a contribution a key makes to the total key mix, and whether the 
contribution is additive or subtractive.

The Output parameters let you adjust the inversion and strength of the key that’s output by the 
Key Mixer. This functionality is described more extensively in the Key Mixer section.

Layer Mixer and Parallel Mixer nodes have no adjustable controls in the Key palette.

Using the Key Palette to Affect Corrector Nodes
When you open the Key palette for a selected Corrector node, you can adjust the following 
parameters:

Key palette showing controls when a Node is selected

Key Input Controls
�� Input Invert: Inverts the key being fed into the key input. This control is on by default, 

which is why Outside nodes work to automatically adjust everything outside of the 
secondary operation taking place in the node before.

�� Input Matte: Lets you switch the key input between Matte and Mask modes. In Matte 
mode (on by default) the key input combines via intersection with keys generated 
internally using the Qualifier or Windows palette. In Mask mode, the key input is added 
to the internal key instead.

�� Gain: Controls the strength of the key connected to the key input.

�� Offset: Controls the contrast of the key connected to the key input.

�� Blur Radius: Blurs the key connected to the key input

�� Blur H/V Ratio: Alters the horizontal/vertical ratio of the blur that’s being applied to the 
key input.

Key Output Controls
�� Output invert: Inverts the overall key.

�� Gain: Using the key output, this parameter governs the strength of that node’s 
contribution to the overall grade. Setting Gain to 0 results in that node having no effect 
at all, while the default setting of 1.00 applies the full strength of any adjustments 
made with that node. The maximum setting of 2.00 increases the intensity of any part 
of the key output that’s less than 100 percent white. You can also use this parameter 
to keyframe the key output to fade that node’s contribution in or out with one set of 
keyframes.

�� Offset: Lets you adjust the contrast of the Output key. This has no effect if the entire 
key is 100 percent white (a solid key).
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Qualifier Controls
�� Qualifier invert: Inverts the key created by that node’s Qualifier palette.

�� Qualifier matte: Lets you switch the interaction of the keys generated by the Qualifier 
and Window palettes between Matte and Mask modes. In Matte mode (the default), the 
Qualifier and Windows palettes combine via intersection. In Mask mode, they’re added 
together instead.

�� Gain: Lets you raise or lower the strength of the key generated by the Qualifier palette.

�� Offset: Lets you adjust the contrast of the key generated by the Qualifier palette.

Using the Key Palette to Adjust Key Mixer Controls
When you open the Key palette for a selected Key Mixer node, you can adjust the 
following controls:

Key palette showing controls when a Key Mixer is selected

�� Input List: A list of every input that’s connected to the Key Mixer. Each entry on the list 
has the following controls:

Input name: The name of each node connection attached to that key mixer, such as 
Input Link 1, Input Link 2, etcetera.

Input Invert: Inverts the key being fed into this particular input. Off by default.

Input Mask: Lets you switch the key input between Matte and Mask modes. In Matte 
mode (on) the key input combines via intersection with other inputs connected to the 
Key mixer. In Mask mode (off by default), the key input is added to the other key inputs 
connected to the Key mixer.

Gain parameter: Decreases or increases the intensity of that input matte’s contribution 
to the resulting output matte.

Offset parameter: Adjusts the contrast of that input matte’s contribution to the resulting 
output matte.

�� Output invert: Inverts the overall result of the various Input Link interactions.

�� Gain: This parameter increases or reduces the strength of the resulting output key. 
Setting Gain to 0 results in all inputs being set to black, while the default setting of 1.00 
outputs the combined mattes at full strength. The maximum setting of 2.00 increases 
the intensity of any part of the key output that’s less than 100 percent white, which 
can have the practical effect of “growing” soft edges. You can also use this parameter 
to keyframe the key output to fade that node’s contribution in or out with one set of 
keyframes.

�� Offset: Lets you adjust the contrast of the Output key.
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The Many Uses of Key Output Gain
Several of the techniques discussed in here and in “Secondary Qualifiers,” can be further 
customized using the Key Output Gain parameter, which makes it easy to control the strength of 
a node’s effect on your grade with a single adjustment. In the following example, two simple 
Serial nodes are applied to a clip, with the first one expanding image contrast, and the second 
one using a variety of controls to add some extreme warmth to the highlights.
 

A tint applied only to the highlights of the image

If you decided that you want to reduce the amount of warmth added by the second node 
without readjusting the controls you used to create the effect, you could open the Key palette 
and lower the Key Output Gain parameter to fade the effect with a single adjustment.

Four versions of this grade shown using the Versions option of the Split 
Screen controls, with Output Gain set to 1, .75, .5, and.25 for comparison

This principle also works for controlling the strength of individual nodes that are being 
combined in parallel, that are combined using the Layer node, or for simply fading out the effect 
of any node in the node tree you want to “turn down” a bit.
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Chapter 52

Channel Splitting 
and Image 
Compositing 
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Channel Splitting and 
Image Compositing
This chapter begins by showing node structures you can use to isolate, split apart, convert, and 
recombine the image channels of clip in different ways. This includes ways of using the 
additional image channels that are provided in some types of media. 

The second part of the chapter shows ways that you can do image compositing right in the 
Color page, with techniques for using external mattes for compositing, and using qualifier keys 
to do green- and blue-screen compositing against other layers in the Timeline.

This chapter has the following topics:

Isolating, Splitting, and Converting Color Channels	 934

Enabling, Disabling, and Converting Node Channels	 934

Splitting Channels With the Splitter/Combiner Nodes	 936

Multi-Channel RED HDRx Support	 938

Introduction to Compositing Using the Alpha Output	 941

Using a Qualifier Key to Create Transparency	 941

Using a Matte to Create Transparency	 944

Use an OFX Plug-in to Create Transparency	 945
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Isolating, Splitting, and 
Converting Color Channels
DaVinci Resolve provides two different methods of making channel-specific adjustments, 
depending on whether you need to apply an adjustment to just one channel within a single 
node, or apply separate adjustments to all three channels across several nodes.

Enabling, Disabling, and 
Converting Node Channels
Within the contextual menu of each node in the Node Editor is a series of four options:

Disabling channels and switching color spaces

�� A Color Space submenu that lets you change the color space that node works 
in between RGB (the default red/green/blue), YUV (actually Y’/Cb/Cr), HSL (Hue/
Saturation/Lightness), and LAB (Luminosity/A/B).

�� Three checked Enable Channel 1-3 options let you turn individual channels off or on, 
limiting which channels operations within that node will affect.

In combination, these controls let you choose a color space for a node to work within, and then 
choose which channels of that color space you want to affect with that node’s adjustments. In 
the following example, you’ll see how to use these features to selectively sharpen just the Y’ 
(luma) of an image without affecting the chroma, which can be a more subtle effect than simply 
sharpening the entire image.
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To use channel disabling and color space conversion to sharpen luma only:

1	 Add a node with which to apply the sharpening you want to the current clip.

2	 Right-click the new node, and choose YUV from the Color Space submenu of the 
contextual menu.

3	 Apply sharpening by doing one of the following:

�� Using that node’s contextual menu, uncheck Enable Channel 2 and Enable Channel 
3, which correspond to the U (Cb) and V (Cr) channels, leaving only Channel 2 (Y) 
enabled. Then, open the Blur palette, and drag the ganged Radius sliders down to 
sharpen the Y channel.

�� You can also just open the Blur palette, ungang the Radius sliders, and drag the 
red slider down to sharpen the Y channel, since any control with three gangable 
sliders will automatically assign those sliders to whichever channels are used by the 
currently selected Color Space.

Before - The original image, After - Sharpening 
applied to only the Y’ channel of the image 

As you can see, while the Blur palette ordinarily provides separate R, G, and B controls that can 
be unganged from one another, the Color Space submenu lets you apply sharpening to the 
channel definitions of other colorspaces, providing many other corrective and creative 
possibilities with the same controls.
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Splitting Channels With the 
Splitter/Combiner Nodes
Another method of applying corrections to individual color channels is using the Splitter/
Combiner nodes, which  break the Red, Green, and Blue channels apart into separate node 
tree branches, each capable of accepting multiple serial and parallel nodes of image 
adjustment. There are two ways you can create a Splitter/Combiner node structure.

Methods of adding Splitter/Combiner nodes:

�� To add a pre-made Splitter/Combiner node structure: Choose Nodes > Add Splitter/
Combiner Nodes (Option-Y). A Splitter and Combiner node appear already connected 
to three Corrector nodes, one for each color channel.

�� To manually construct a Splitter/Combiner node structure: Right-click in any empty 
area of the Node Editor, and choose from the Add Node submenu to create a Splitter 
node, a Combiner node, and three Corrector nodes, wiring them together as necessary 
to create the desired effect.

The Splitter Combiner node structure

Supported Color Spaces for Conversion

The Colorspace submenu available when you right-click a node in the Node Editor 
supports four different color spaces that you can set each node to work within. When 
you choose a color space other than RGB, all channel-specific controls (the Custom 
curves, Soft curves, RGB Lift/Gamma/Gain sliders, and RGB mixer) operate on the 
particular channels of that color space, rather than the default YRGB channels. By 
switching color spaces, you can achieve very different kinds of adjustments by 
swinging values among mathematically different axes.

YUV converts the image into Y’, Cb, and Cr channels. The Y’ channel governs 
luminance, while the Cb and Cr are color difference channels that work within the 
broadcast model of color.

HSL converts the image into Hue, Saturation, and Lightness channels. Lightness is 
identical to Luminance, while Hue and Saturation are exactly as described.

LAB operates on the L, A, and B channels. The L channel governs luminance, while the 
A and B channels are color difference channels; A adjusts color on an axis from 
magenta to green, B adjusts color on an axis from yellow to blue
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The Splitter node takes an incoming image and provides individual outputs for each color 
channel (top/red, middle/green, bottom/blue). When you connect each of these output to a 
Corrector node, that color channel automatically connects to all three internal channels of that 
node, so that the default three nodes in a Splitter/Combiner structure are internally processing 
red/red/red, green/green/green, blue/blue/blue. The Combiner then pulls the Red, Green, and 
Blue channels out of each node connected to its three inputs, and reassembles them into a 
single RGB image again. Of course, what happens in between the Splitter and Combiner is 
entirely up to you.

One of the simplest ways of showing the possibilities of this node structure is to combine it with 
Node Sizing in the Sizing palette. Using Node Sizing, you can correct for misaligned channels in 
older archived video, or create channel misalignments for creative looks. In the following 
example, a simple Node Sizing adjustment to a split Blue channel will create an interesting 
“prism vignette” effect.

To use Node Sizing on individually split channels:

1	 Choose Nodes > Add Splitter/Combiner Node (or press Option-Y) to add a pre-made 
Splitter/Combiner node structure to the Node Editor.

2	 Select the middle of the three Corrector nodes appearing in between the Splitter and 
Combiner nodes (Node 5 in the following screenshot).

3	 Open the Sizing palette, choose Node Sizing from the Mode pop-up, and then raise the 
zoom parameter by a small amount; this example uses 1.014. 

Zooming just one color channel using the Splitter/Combiner nodes

As you can see in the screenshot, just the Green channel has been zoomed in on 
across the entire image. This is only possible using Node Sizing. This is cool, but not 
quite what you need.

4	 Open the Window palette, add a Circular window, turn on its Invert control, and 
transform it to be a very soft, horizontally aligned vignette. This limits the individual 
scaling done to the Green channel to just the outer edge of the image, similar to a lens 
with excessive chromatic aberration.

The resulting channel split effect 

You could easily keep going, applying varying amounts of zoom with different window 
shapes to each of the other color channels, and perhaps adding some blur to enhance 
the effect, but this example should show the creative potential available when using 
this technique.
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Multi-Channel RED HDRx Support
The RED EPIC, SCARLET, DRAGON, and WEAPON cameras are all capable of shooting in an 
HDR mode that effectively “brackets” two different exposures of each frame. The resulting 
image data stores two channels of image data: the regular exposure, and a “highlight exposure” 
that’s underexposed by a user-selectable margin (+3, +4, +5, or +6 ƒ-stops difference).

By default, the Input bar in the node graph feeds the regular exposure to your grade’s node 
tree. To take advantage of the additional “highlight” exposure, you can add an additional 
Source input to the node graph that feeds a second stream of image data that you can mix with 
the regular exposure in different ways.

To set up a node tree combining the normal and highlight HDR versions:

1	 Using the first default node (Node 1), grade the image to see if you even need to use 
the alternate exposure that’s available. We’ll assume for this example that you do. In this 
example, the sky of the default exposure is pretty blown out, but there may be detail 
that can be retrieved using the highlight exposure.

Using HDRx images with the Layer Mixer

2	 Create a Layer Mixer node by choosing Nodes > Add Layer (Option-L), or press the 
ADD LAYER button of your control panel.

Two nodes are created, a Layer Mixer node that’s added after Node 1, and a third node 
(Node 3) that’s connected to a second RGB input of the Layer Mixer node in parallel 
to Node 1.

The Source currently supplies two input, but you can add a second source, which is the 
short exposure in the HDR image

NOTE: You can also take advantage of the highlight exposure of RED HDRx media by 
enabling and adjusting the Magic Motion controls in the Camera Raw palette.
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3	 Right-click anywhere within the node graph (except on a node) and choose Add Source 
from the contextual menu.

A second Source input appears underneath the first, which outputs the highlight 
exposure of the image as a separate image stream.

A node tree that uses a Layer Mixer node to mix two Corrector 
nodes, each connected to separate outputs for the regular and 
highlight exposures.

4	 Delete the connection between the top Source input and Node 3, and then connect 
the bottom Source input to the RGB input of Node 3.

Immediately, the image in the node thumbnail and Viewer updates to show the darker, 
underexposed version of the HDR image. This is because, by default, the Layer Mixer is 
mixing 100% of Node 3 over Node 1.

5	 Select Node 3 and use one of the following two procedures to create a useful 
combination of the two exposures:

To create a mix of the two exposures, open the Key tab, and drag the Key Output Gain 
slider to lower the contribution of Node 3 to the overall image (you can also do this 
using the DaVinci control panel by pressing the KEY MODE soft button, and then using 
the Post Mix Gain rotary control). Using dynamics (keyframing), this is a good way to 
animate a dissolve from the regular exposure to the highlight exposure if you’re going 
from a dark environment to a bright environment in the same take and you want to 
create a smooth transition between both exposures.

Dissolving between the regular and highlight exposures 
of RED HDRx media using the Key Output Gain slider of a 
Corrector node connected to a Layer Mixer node.

TIP: You can also use the Blend Type and Blend Bias parameters in the 
Camera Raw palette to blend the two exposures without building a dedicated 
node tree.
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To use the highlight exposure to selectively put detail back into the image (for example, 
to retrieve blown-out windows), use a Power Window, HSL Qualification, or a 
combination of the two to isolate the region you want to retrieve in Node 3. (Be careful 
if you’re using HSL Qualification to combine both exposures, as keyed edges can be 
tricky to blend.)

Isolating a region of the image to replace using the 
highlight exposure image of a RED HDRx clip 

Final node display with isolations

A Note About RED HDRx Media and Performance

Since RED HDRx media records two complete streams of image data, DaVinci Resolve 
must simultaneously decode two separate tracks whenever you add a second Source 
input. (If you don’t add the second Source input, only the first stream is decoded.)

Because of this, whether you’re relying on your computer’s CPU to decode RED 
media, or you’re using a single RED ROCKET card, you’ll get half the performance 
when using the highlight stream of an HDR clip. 

To improve performance, you can set any RED HDRx clip’s Render Cache Mode to 
“User” by choosing Playback > Render Cache > User, pressing Option-R, or pressing 
the CACHE MODE button on the T-bar panel of your control panel repeatedly until you 
toggle to User mode. DaVinci Resolve renders all cached clips in the background, so 
the next time you play a cached clip, it will play at full speed.

If you regularly use RED HDRx media, two RED ROCKET cards are recommended for 
optimal decoding performance.
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Introduction to Compositing 
Using the Alpha Output
While DaVinci Resolve can use the alpha channel of imported media for compositing, the 
Alpha output in the Node Editor is an optional output that you can turn on to create clip 
transparency using operations inside DaVinci Resolve to create composites against other clips 
on lower video tracks. There are many ways of using the Alpha output, but this section will 
focus on three examples.

Using a Qualifier Key to 
Create Transparency
In this first example, the Alpha output will be used to composite a green screen clip with a 
background plate. 

A green screen clip, ready for compositing

In preparation for this composite, the background plate is on track V1 of the Timeline, and the 
green screen clip has been superimposed on track V2.

 

A superimposed green screen clip on track V2 of the Timeline, 
above a background plate on track V1, ready for compositing.

To create a chroma-key composite in the Color page:

1	 Right-click anywhere within the gray area of the Node Editor and choose Add Alpha 
Output to add the Alpha output at the left of the node graph.



942

C
ha

nn
e

l S
p

lit
tin

g
 a

nd
 Im

ag
e

 C
o

m
p

o
si

tin
g

 
P

ar
t 

6
 –

 5
2

An Alpha output appears underneath the Node Tree output at the right of the 
Node Editor.

 

The image Node Tree output with Alpha output below

2	 You’ll want to use Node 1 to color correct the image to optimize it for keying. In 
this example, the foreground plate is log-encoded, so a LUT is added to Node 1 to 
normalize it. 

3	 Add a Serial node after Node 1 and connect its key output to the Alpha output. This is a 
fast way to build this composite if you’re confident that the corrections you’ve made in 
Node 1 won’t adversely affect the key (or if you know they’ll improve it by expanding the 
contrast of a flat-contrast source clip).

Alternately, you could create a second processing branch by adding a disconnected 
node (Node 2), connecting the Source node to its RGB input, and then connecting its 
key output to the Alpha output you just added. Creating a second image processing 
branch from which to pull your key lets you key directly from the source (assuming the 
source is fit to key without adjustment), avoiding any problems that grading the first 
node could introduce to the key.

Node 1 grades the clip, expanding contrast to improve both the image, and its ability to be keyed. 
Node 2 uses Qualifier controls to pull the key.

4	 Use the Qualifier controls of Node 2 to key out the green background, and then turn on 
the Invert checkbox to create the proper composite. In this example, we’re using the 3D 
Qualifier mode to pull a high-quality key.
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An HSL Qualification to key the green feeding the 
Alpha Output to create transparency

5	 If there’s green spill in the composite (or blue in cases where you’re keying a 
bluescreen) you can turn on the Despill checkbox to eliminate it.

6	 	You can also use a Power Window to garbage matte out any elements you don’t want 
intruding into the shot, using the Tracker palette if necessary to make the window 
follow the motion of the foreground subject.

A Power Curve used to garbage matte out unkeyable lighting fixtures

7	 If necessary, you can add another node to the output of Node 2 to make whatever 
corrections are necessary to the background plate clip to make the composite blend 
more seamlessly. For example, with this additional node selected, you could right-click 
the background clip and choose “Shot Match to This Clip” to use the automatic shot 
matching in DaVinci Resolve to adjust the foreground to match the background.

 

Adding more color adjustments to a node added after the Qualifier

With all this set up, you end up with a nice green screen composite that’s visible in both 
the Color and Edit pages.
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The result, with a window garbage matte cropping out the 
equipment, ready for further refinement 

Using a Matte to Create Transparency
If you’ve been provided with a separate Matte clip for defining clip transparency, you can use 
that Matte clip within the node tree of a superimposed clip to create a composite using the 
Alpha Output.

To create a composite using an external matte:

1	 To associate an external matte with a clip, open the Media page, select the clip you 
want to add a matte to in the Media Pool, navigate to the matte file using the Library 
browser, and then right-click the matte file and choose Add as Matte. For more 
information on importing mattes, see Chapter 51, “Combining Keys and Using Mattes.”

2	 Open the Color page and select the foreground clip in the Thumbnail timeline, then 
right-click Node 1 in the Node Editor and choose the matte you added from the Add 
Matte submenu.

An EXT MATTE node appears underneath Node 1, with the first of its four key outputs 
connected to Node 1’s key input. (Working with external mattes is covered in more 
detail in a prior section of this chapter.)

3	 Now, right-click anywhere within the node graph (other than on a node) and choose 
Add Alpha Output from the contextual menu.

An Alpha output appears underneath the Node Tree output.

4	 Drag a connection line from the second key output of the EXT MATTE node to the 
Alpha output.

 

Using an external matte in the grade and to the Alpha output

You should now see a successful composite, with the external matte creating a region 
of transparency in the foreground clip though which the background clip 
shows through.
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Before and after the final composite, created by connecting an 
Ext Matte node to the Alpha Output in the node graph

Use an OFX Plug-in to Create 
Transparency
If you’ve installed an OFX plugin capable of keying, you can right-click the node you’ve 
applied it to and choose Use OFX Alpha to route the key created by the plug-in out the KEY 
output of that node. When Use OFX Alpha is enabled, the HSL Qualifier and Window palette 
output is ignored, the only key that’s output is from the OFX plug-in.

Choosing Use OFX Alpha in the Node Editor

Once Use OFX Alpha is enabled, and you’ve created a key using your OFX plug-in of choice, 
you can right-click anywhere within the node graph (other than on a node) and choose Add 
Alpha Output from the contextual menu to make the Alpha output appear, and you can then 
connect the KEY output from the node with the OFX plugin to the Alpha output to use it to 
create transparency.
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Setting up a composite using an OFX plugin

Combining an OFX key with a Window using a Key Mixer to add a Garbage matte

Compositing Entirely Within an OFX Plug-In
Certain OFX plug-ins that are capable of combining two image streams to create a composite 
can be used as of DaVinci Resolve version 11.1 by exposing a “second layer input” on the node 
to which that plug-in has been applied. This makes it possible to composite the image you’re 
grading with the RGB output from an EXT MATTE node.

Combining a clip with an EXT MATTE image using the second 
layer input of a node with an OFX plug-in applied to it

NOTE: When Use OFX Alpha is enabled for a node, you cannot use a 
window to create a garbage matte within that node as you would 
when keying with the HSL Qualifier. To create a garbage matte with 
which to exclude unwanted and unkeyable elements from the edges 
of the picture, you’ll need to combine the key from a window in 
another node with the key output by the OFX plugin using a Layer 
Mixer node.
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To create a composite using an OFX plug-in:

1	 Open the OpenFX Panel, use the Library to find the OFX compositing plug-in that you 
want to use, and drag it onto the appropriate node to apply it. The above example 
shows the Boris Effects plug-in “BCC Composite,” which mathematically combines two 
image streams using one of a long list of blending modes.

2	 Right-click the node with the OpenFX plug-in applied to it, and choose Second Layer 
Input from the contextual menu. A second RGB input should appear on the left of the 
node, underneath the first.

Adding the second layer input of a node with an 
OFX plug-in applied to it

3	 Open the Media page, locate the clip you want to composite in the Library, and import it 
as an unassigned matte.

4	 Open the Color page again, right-click the node with the OpenFX plug-in applied to it, 
and choose Add Matte > Track Mattes > “name of matte imported in step 3” from the 
contextual menu.

5	 By default, the EXT MATTE node that appears is connected via one of its key outputs. 
Delete the key connection, and drag a new connection line from the EXT MATTE 
node’s RGB output to the second RGB input of the node with the OpenFX plug-in.

The composited image, node tree, and OFX parameters shown side by side

6	 At this point, the node tree is wired up to composite the clip with the EXT MATTE 
image, and you need only adjust the parameters of the OpenFX plug-in to achieve the 
result you desire.
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Chapter 53

Keyframing in 
the Color Page 
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Keyframing in the Color Page
The Color page has a dedicated Keyframe Editor, found at the right of the palette area, that you 
can use to animate grading changes from one frame to another. Because grading is a 
fundamentally different task than editing, the Color page Keyframe Editor operates somewhat 
differently from the Cure Editor in the Edit page.

This chapter has the following topics:

Introduction to Keyframing	 950

The Keyframe Editor Interface	 950

All/Color/Sizing	 952

Keyframing Methods	 953

Dynamic Keyframes (Dynamics)	 953

Static Keyframes (Marks)	 954

Mixing and Converting Dynamic and Static Keyframes	 954

Using Specific Keyframing Tracks	 955

The Corrector Keyframing Tracks	 956

The Sizing Keyframing Tracks	 957

The Ext Matte Node’s Freeform Isolation Track	 957

Automatic Keyframing	 957

Modifying Keyframes	 958

Navigating Among Keyframes	 958

Moving Keyframes	 958

Changing Keyframe Values	 958

Changing Dynamic Attributes	 959

Deleting Keyframes	 960

Copying Keyframes	 960

Keyframes and Saved Stills	 961

Adding EDL Marks	 961
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Introduction to Keyframing
Whether it’s referred to as keyframing, dynamics, or marks, DaVinci Resolve provides an 
interface for automatically interpolating color adjustment parameters in various ways from one 
setting to another. For example, if you have a clip with varying exposure settings, you can 
animate a series of contrast adjustments using Dynamic keyframes to make the changes in 
exposure less distracting. 

 

The Keyframe Editor with dynamic keyframes animating the parameters of Node 2

In another example, suppose you’re grading a documentary, and an archival clip that’s edited in 
the middle of the Timeline actually consists of six different shots from a program in the eighties. 
If you’re in a hurry, you can insert Static keyframes (marks) at the cut points of each of these 
shots, creating one-frame transitions between different sets of adjustments, which allows you to 
create individual adjustments for each shot.

 

Round static keyframes added to all parameters, enabling individual 
adjustment of shots merged together within a single clip

In both cases, you use the Keyframe Editor to create a series of keyframes with which to 
change parameters from one value to another. In this section, you’ll learn how to work with the 
Keyframe Editor to set up these kinds of animated changes.

The Keyframe Editor Interface
The Keyframe Editor has all the controls necessary to create and modify keyframes for the 
currently selected clip. If necessary, you can even make it wider in a single screen layout by 
clicking its expand button (at the top right of the Keyframe Editor), or use the Color page’s Dual 
Screen layout to place the keyframe editor on a second screen, for even more room.
 

The Node Editor shown in wide mode, pushing all other palettes to the left
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The Keyframe Editor consists of the following components:

�� The Timeline Ruler: Mirrors the record timecode of the currently selected clip; dragging 
within the Timeline Ruler moves the playhead, and a timecode display to the left shows 
the current frame.

�� The Keyframe Track Header: Each node in the current grade has a corresponding 
keyframe track, and the header contains controls you can use to manage the 
keyframing. 

 

The Keyframe Track Header

�� Track Disclosure Triangle: Exposes individually keyframable groups of parameters 
underneath the main keyframe track. 

�� Enable/Disable Button: A round orange button lets you enable or disable that track’s 
corresponding node. 

�� Lock Button: Lets you prevent any changes from being made to that track’s 
corresponding node. Nodes that have been locked show a lock icon.

Nodes 1 and 2 have been locked in the Keyframe Editor of the Color page

�� Auto-Keyframe Button: Turn this button on to automatically create a Dynamic keyframe 
every time you adjust any parameter within that node.

�� Keyframe Tracks: To the right of the track header, the keyframe tracks are where you 
create and edit the keyframes that animate parameter changes. A topmost “master 
keyframe track” shows every keyframe applied on every keyframe track in the 
Keyframe Editor, even keyframes applied to a keyframing track hidden inside a track 
with a closed disclosure triangle.

�� Keyframes: Each keyframe appears as a small diamond for a Dynamic keyframe or as 
a circle for a Static keyframe. Dynamic keyframes are associated with dissolves while 
Static keyframes (marks) act instantly. Grades are linked to the preceding keyframe, 
which may be a default one on the first frame of the master clip. Keyframes can be 
selected by clicking on them, or moved by dragging them to another position in the 
keyframe track.
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�� Sizing track: The Pan, Tilt, Zoom, Rotate, and Convergence (in Stereo 3D projects) 
parameter have an entirely separate track for creating animated pan and scan 
adjustments.

�� Track Selection Bar: A colored bar shows the currently selected scope of keyframing: 
all tracks at once, just the current correction node, or the Sizing settings, as defined by 
the Keyframe Timeline mode discussed in the next section.

Ordinarily, the Keyframe Editor takes up the rightmost bottom third of the Color page. However, 
you can make it wider to have more room to work if you have a scene requiring complex 
keyframing.

To expand and collapse the Keyframe Editor:

�� Click the Expand/Collapse button at the lower left-hand corner of the Keyframe Editor. 

�� The Keyframe Editor widens or narrows accordingly.

To zoom into and out of the Keyframe Tracks:

�� Use the Zoom slider to zoom into or out of the Keyframe Editor.

�� Right-click any keyframe track and choose Maximum Zoom to zoom all the way in.

�� Right-click any keyframe track and choose Reset Zoom to fit the entire clip into the 
available width of the Keyframe Editor.

All/Color/Sizing
Perhaps the most important control for keyframing, the Keyframe Timeline mode, lets you 
switch the scope of what tracks get keyframed when you use the Start Dynamic or Add Static 
Keyframe commands, either from the keyboard or via the buttons of your control panel. This 
command alternates among three modes:

�� All: The default mode. Adds keyframes to every track in the Keyframe Editor, 
keyframing every parameter in every node all at once, including the Sizing settings. In 
this mode, an orange bar appears highlighting the topmost “master keyframe track.”

�� Color: Only adds keyframes to the node currently selected in the Node Editor. In this 
mode, a green bar appears highlighting the keyframe track corresponding to the node 
currently selected.

�� Sizing: Only adds keyframes to the Sizing track, which is useful when you’re keyframing 
“pan and scan” style transforms. In this mode, a blue bar appears highlighting the 
Sizing track.

�� EXT MATTE: Only appears if there’s an External Matte node in the node tree. Lets you 
keyframe External Matte-specific parameters in the Key palette.

Even though All is the default setting, it may be to your advantage to switch to the Color or 
Sizing keyframing modes to avoid creating a lot of unnecessary keyframes. Even though 
keyframing everything all at once is a fast way to work, the extra keyframes may slow you down 
when you later need to make adjustments to nodes that didn’t need to be keyframed in the 
first place.

To change the keyframing mode, do one of the following:

�� Choose an option from the Keyframe Mode pop-up at the top right of the 
Keyframe Editor.

�� Choose an option from the Mark > Keyframe Timeline Mode submenu.

�� Press the ALL/COLOR/Sizing button on the Transport panel of the DaVinci control panel 
repeatedly until you’ve chosen the mode you need.
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Keyframing Methods
There are two different types of keyframes used by DaVinci Resolve to create automated 
changes. Each type of keyframe interpolates parameters differently.

Dynamic Keyframes (Dynamics)
Dynamic keyframes are the most conventional type of keyframe you’ll use, and are the type of 
keyframe used for creating animated changes from one state to another. For example, if you 
need a grade to become brighter over time to compensate for a change in lighting conditions, 
you’ll use Dynamic keyframes.

Nearly every parameter and control in the Color page can be keyframed, but it’s important to 
understand that the Interface controls do not animate to match whatever dynamically 
keyframed changes are taking place. Instead, visible Interface controls that correspond to 
keyframed changes will jump from their initial position at one keyframe to their final position 
when the playhead reaches the next keyframe. 

This can be most confusing with Curves, which can be interpolated using Dynamic keyframes 
just like any other control or parameter. Just keep in mind that the actual settings are animating, 
even though the controls are not.

To animate a node using Dynamic keyframes:

1	 Move the playhead in the Keyframe Editor’s Timeline ruler to the frame where you want 
to begin a change.

2	 Do one of the following to place a Dynamic keyframe at that frame:

�� Choose Mark > Add Keyframe (Command-[).

�� Press the START DYNAMIC button on either the T-bar or Transport panels of the 
DaVinci control panel.

�� Turn on the Auto Keyframe button for the track you want to animate in the 
Keyframe Editor.

Dynamic keyframes are diamond-shaped.

3	 If necessary, adjust your clip at this first position of your animated change. If you’re 
using Auto Keyframe, then you have to make an adjustment for a keyframe to 
be created.

4	 Now, move the playhead to the frame that is at the second position of the animated 
change you’re making, and create another Dynamic keyframe if you’re creating 
keyframes manually, or make another adjustment if Auto Keyframe is on.

5	 After you’ve created this second keyframe, make whatever adjustments are necessary 
to the clip to create the final look you need.

At this point, playing from the first keyframe to the second keyframe should show a 
smoothly animated change from the first adjustment to the second. When you’re 
finished, make sure you turn Auto Keyframe off if it was enabled.

TIP: This control has one other function. Choosing a mode also affects what is copied 
when you use the various grade management tools in DaVinci Resolve. For example, if 
you choose Color, then you can copy a clip’s color grade without copying its sizing. 
If you choose Sizing, then you can copy the sizing without copying the color grade. 
For more information, see “Copying Grades” in Chapter 48, “Grade Management.”
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Static Keyframes (Marks)
Static keyframes, or marks, are keyframes that are used to create abrupt, one frame changes 
from one state to another. They’re typically used to mark edit points separating one shot from 
another when multiple shots appear within a single clip. However, Static keyframes are also 
useful in any situation where you need a sudden change from one setting to another, such as 
when creating a lightning effect.

Static keyframes are round

To automate a node using Static keyframes:

1	 Find the frame at which you want the abrupt change to take place, and place a 
keyframe at that frame by doing one of the following:

�� Choose Mark > Make Static Keyframe (Command-]).

�� Press the MARK button on either the T-bar or Transport panels of the DaVinci 
control panel.

Static keyframes (marks) are round.

2	 Move the playhead to any frame before the keyframe to make changes to the entire 
segment of the clip leading up to the keyframe, or move the playhead to any frame 
after the keyframe to make changes to the entire segment of the clip appearing after 
the keyframe. The playhead does not need to be on top of the keyframe, but if it is, 
you’ll be adjusting the second portion of the clip.

Mixing and Converting Dynamic and Static Keyframes
Typically, if you’re creating multiple animated changes within a clip, you’ll want to use all 
Dynamic keyframes. Similarly, if you’re creating a series of abrupt changes, you’ll use all Static 
keyframes. However, you can mix Dynamic and Static keyframes together, so long as you keep 
in mind the following rules:

If you add a Dynamic keyframe to the right of a Static keyframe: There will be no interpolation 
from the Static keyframe to the Dynamic keyframe. However, if you add a Static keyframe to the 
right of a Dynamic keyframe, there will be interpolation.

No dynamic interpolation following the static keyframe

NOTE: If you’re using Static keyframes to automate grading changes between multiple 
shots appearing within a single clip, keep in mind that you can’t add nodes from one 
keyframe to the next as you would if you had split the clip in the Edit page.
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If you accidentally create the wrong kind of keyframe, it’s easy to convert it into the type of 
keyframe you need.

To change one kind of keyframe into another:

1	 Click the keyframe you want to convert to select it.

2	 Right-click the selected keyframe, and choose either Change to Dynamic Keyframe or 
Change to Static Keyframe.

Using Specific Keyframing Tracks
If you’re simply using the Color mode of the All/Color/Sizing command to do keyframing, then 
you’ll be adding keyframes to every parameter of the currently selected node whenever you 
apply a single keyframe. However, often that’s overkill in situations where you only need to 
keyframe a single setting or group of settings.

For example, you may find that you need to keyframe a color adjustment in order to change the 
color temperature and brightness when the camera pans across a window, but you don’t want 
to keyframe the Windows palette controls because you want to adjust them independently. This 
can be done by opening a Corrector track to expose the keyframing tracks within.

Individual keyframing tracks within a Color Corrector node

Keyframing tracks let you keyframe different sets of similarly functioning parameters separately 
from one another. For example, there’s one keyframing track for all the color adjustment 
parameters, and another keyframing track governing the parameters found within the 
Qualifier palette.

Try Creating Keyframed Changes in a Separate Node

One tip to keep in mind is that you don’t have to create keyframed changes within the 
same nodes you’re using to create other adjustments. If you want to create some 
automated changes without altering the nodes you’ve already adjusted, you can 
simply create a new node in which to make your keyframed changes. That way, if you 
don’t like the result, or you somehow find yourself hopelessly tangled up in a 
needlessly complicated set of keyframes, its easy to reset either just the keyframes or 
the entire node without affecting the rest of your grade.
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To reveal a node’s keyframing tracks:

Click the disclosure triangle next to the number of the node you’re keyframing.

To keyframe an individual keyframing track manually:

1	 Make whatever adjustments you need to the currently selected node, and click its 
disclosure triangle to reveal its keyframing tracks.

2	 Move the playhead in the Keyframe Editor to where you want to add the first keyframe, 
then right-click within the keyframing track you want to animate, and choose Add Static 
Keyframe or Add Dynamic Keyframe (this example shows a Dynamic keyframe).

A keyframe appears at the position of the playhead in that keyframing track.

3	 Move the playhead in the Keyframe Editor to where you want to add the next keyframe, 
then right-click within the keyframing track and again choose either Add Static 
Keyframe or Add Dynamic Keyframe (this example shows a Dynamic keyframe).

Keyframing just the Circular Power Window using its individual keyframe track

Now, you can make whatever changes you need to the controls governed by the keyframing 
track you keyframed, in order to create the necessary animated effect.

The Corrector Keyframing Tracks
All of the parameters governing the adjustment of color and contrast controls, as well as various 
effects, Power Windows, and other adjustments are sorted into various sub-tracks within the 
Corrector track.

�� Linear Win: Controls parameters corresponding to the Linear Window.

�� Circ Win: Controls parameters corresponding to the Circular Window.

�� Polygon Win: Controls parameters corresponding to the Polygon Window.

�� PowerCurve: Controls parameters corresponding to the PowerCurve Window.

�� Gradient Win: Controls parameters corresponding to the Gradient Window.

�� Color Corrector: Controls all parameters found in the Camera Raw, Color Wheels, 
Primary Controls, RGB Mixer, and Curves palettes.

�� Qualifier: Controls all parameters in the Qualifier palette.

�� Defocus: Controls all parameters in the Blur and Key palettes.

�� NR: Controls the Spatial and Temporal Noise Reduction and Motion Blur parameters 
found in the Motion Effects palette. 

�� OFX: Controls all parameters of whichever OFX plugin is applied to the current node.

�� Node Format: Controls all parameters of the node sizing mode of the Sizing palette for 
the current node.

TIP: You can also animate individual keyframing tracks using automatic keyframing, 
explained in more detail later in this chapter.
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The Sizing Keyframing Tracks
The Sizing keyframing tracks govern sizing transforms and stereoscopic adjustments separately 
from the color controls.

�� Input Sizing: Controls the Input Sizing parameters found within the Sizing palette. 

�� Convergence: Controls the Convergence parameter in the Stereo 3D palette.

�� Float Window: Controls the Left, Right, Top, and Bottom Position/Rotate/Softness 
Floating Windows parameters.

�� Auto Align: Controls the Pitch and Yaw parameters in the Stereo 3D palette.

The Ext Matte Node’s Freeform Isolation Track
If your node tree has an External Matte, the EXT MATTE node exposes a Freeform Isolation 
track in the Keyframe Editor. This is useful for time offsets or Sizing repositioning of the Ext 
Matte image.

Automatic Keyframing
Every track in the Keyframe Editor has an Auto-Keyframing button that can be turned on or off. 
When auto-keyframing is enabled for a particular track, every change made to a parameter or 
control associated with that keyframe track automatically generates a keyframe.

Used with a keyframing track, auto-keyframing makes it simple to set up animated changes to 
specific adjustments within a node. This is a lot easier than manually placing keyframes 
one by one.

On the other hand, turning on auto-keyframing for the Corrector track correspondingly enables 
auto-keyframing for every keyframing track belonging to that node. In this case, keyframes will 
automatically be placed on whatever keyframing track corresponds to the parameters or 
controls you adjust.

 

Auto-keyframing selected for Circular 
Window on Node 1

When auto-keyframing is disabled, changes you make alter existing keyframes. How this 
alteration works depends on the location of the playhead, and the type of keyframes in the 
Keyframe Editor. For more information, see the next section.

TIP: Output Sizing can only be keyframed when you choose Track mode in the 
Node Editor.
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Modifying Keyframes
Once you’ve started adding keyframes to animate changes to a grade, there are a variety of 
methods available to navigate and edit these keyframes to further customize these effects. 
This section covers the different ways you can navigate among, alter, and remove keyframes.

Navigating Among Keyframes
For many operations, it’s necessary to move the playhead directly on top of the keyframe you 
want to modify. While you can always use the transport controls or pointer to move the 
playhead, there are also commands for jumping to a specific keyframe.

To move the playhead among a series of keyframes, do one of the following:

�� Choose Playback > Next Keyframe (the right bracket key) or Playback > Previous 
Keyframe (the left bracket key).

�� On the Transport panel of the DaVinci control panel, press SHIFT then STEP REV 
to move the playhead to the previous keyframe, or press SHIFT then STEP FWD to 
move the playhead to the next keyframe.

Moving Keyframes
If you need to change the timing of a series of keyframes, you can move the position of any 
keyframe, along with whatever values that keyframe contains.

To move a single keyframe using the on-screen interface:

�� Use the pointer to drag any keyframe to another location.

�� Drag keyframes in a top-level Corrector or Sizing track to simultaneously move all 
other keyframes on the same frame within that corrector.

To move a single keyframe using the DaVinci control panel LIFT MARK button:

1	 Move the playhead to the keyframe you want to move. This procedure works for either 
Dynamic and Static keyframes.

2	 Press LIFT MARK on either the T-bar or Transport panels.

3	 Move the playhead to the frame you want to move that playhead to.

4	 Press MARK on either the T-bar or Transport panels. 

To move multiple keyframes at the same time:

�� If necessary, open the keyframe track with the keyframes you want to move.

�� Drag a bounding box around the keyframes you want to move. Selected keyframes 
appear highlighted in red.

�� Drag any of the selected keyframes to move them to the left or right.

Changing Keyframe Values
Unlike many other applications, DaVinci Resolve lets you alter keyframe values when the 
playhead isn’t directly on an existing keyframe. How this works depends on the location of the 
playhead relative to the keyframes that are in the Keyframe Editor, and what kind of keyframes 
you’re editing.

�� If the playhead is to the left or on the first Dynamic keyframe: The Dynamic 
keyframe at or to the right of the playhead updates with the new adjusted values.

�� If the playhead is to the left or on the last Dynamic keyframe: The Dynamic 
keyframe at or to the left of the playhead updates with the new adjusted values.
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�� If the playhead is between two Dynamic keyframes: The Dynamic keyframe to the 
left of the playhead updates with the new adjusted values, but the Dynamic keyframe 
to the right is unaffected.

�� If the playhead is between two Static keyframes (marks): Adjustments made 
between two Static keyframes always affect the keyframe to the left of the 
playhead. The entire segment of the clip between that keyframe and the next is 
affected equally.

Changing Dynamic Attributes
By default, the transition from one Dynamic keyframe to the next is linear. However, if you need 
to alter the acceleration of value interpolation from one Dynamic keyframe to the next, then you 
can change that keyframe’s Dynamic Attributes.

To change a keyframe’s Dynamic Attributes:

1	 Right-click a keyframe in the Keyframe Editor, and choose Change Dynamic Attributes.

2	 When the Dynamic Attributes window appears, do one or both of the following:

�� Choose a new outgoing acceleration curve using the Start slider, affecting the 
interpolation occurring to the right of that keyframe.

�� Choose a new incoming acceleration curve using the End slider, affecting the 
interpolation occurring to the left of that keyframe.

As you choose different acceleration curves, the display to the right shows the 
resulting curve graph.

Changing the dissolve profile

3	 When you’re happy with the curve, click OK.

By using different Start and End values, you can make animated adjustments “ease in” or “ease 
out” of a particular keyframe, to create a more gradual or abrupt transition.

TIP: The default dynamic profile start and end of each new keyframe can be set via 
the Dynamics Profile values in the General Options panel of the Project Settings.
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Deleting Keyframes
You have the option to delete individual keyframes, or to delete all the keyframes within a 
particular grade at once.

To delete individual keyframes, do one of the following:

�� Move the playhead on top of the keyframe you want to delete, then choose Mark > 
Delete Keyframe (Option-]). Every keyframe at the position of the playhead is deleted.

�� Using the DaVinci control panel, press DELETE on either the T-bar or Transport 
panels. Every keyframe at the position of the playhead is deleted.

�� Using the pointer, click a keyframe in the Keyframe Editor to select it, then right-click 
that keyframe and choose Delete Selected Keyframe. Only the selected keyframe 
is deleted.

To delete every keyframe for the current clip:

Choose Mark > Delete All Keyframes.

Copying Keyframes
It’s possible to copy a set of keyframes from one node to another, either within the current 
grade, or in another clip entirely. It’s also possible to copy an entire grade with keyframes from 
one clip to another.

To copy a set of keyframes from one node to another:

1	 Select a node to copy keyframes from, and choose Edit > Copy (Command-C).

2	 Select another node to paste keyframes to, and choose Edit > Paste (Command-V).

To copy an entire grade with keyframes from one clip to another:

1	 Click the thumbnail of the clip you want to copy to in the Thumbnail timeline.

2	 Right-click the thumbnail of the clip you want to copy from, and choose Add Correction 
With Keyframes from the contextual menu.

TIP: This procedure also works for tracking data that you want to copy from one node 
to another, either in the current clip, or another clip altogether.

NOTE: When copying a grade with keyframes from one clip to another, the keyframes 
will automatically be placed at matching frames that correspond to the source 
timecode of the originating clip. This makes it easy to copy a grade with keyframes to 
the same clip elsewhere in the Timeline, but it may not provide the desired results if 
you’re applying a grade with keyframes from one clip to a completely different one.
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Keyframes and Saved Stills
If you save a still from a clip using keyframes within the grade, by default keyframes are not 
saved. However, the still and grade that are saved reflect whatever parameter values are 
contained by the next keyframe to the left of the position of the playhead. For example, if a clip 
has a dynamically keyframed transition from a saturation of 50 to a saturation of 0, and you 
place the playhead right in the middle of both keyframes when you save a still, the grade and 
still that are saved have a saturation of 50.

However, if you right-click the Gallery and turn on Use Timeline Keyframes in the contextual 
menu, then grades saved within a still are saved with the keyframes, which reference the 
source timecode of the original clips. This means that if you apply a saved grade with keyframes 
to a clip, the keyframes will automatically be placed at matching frames that correspond to the 
source timecode of the original clip. This makes it easy to copy a grade with keyframes to the 
same clip elsewhere in the Timeline, but it may not provide the desired results if you’re applying 
a grade with keyframes from one clip to a completely different one.

Adding EDL Marks
Just as clip grades are separate from the track grade that can be applied to the entire Timeline, 
so clip keyframes are separate from track keyframes. Keyframes you apply to the track grade 
work exactly the same as clip keyframes. However, there is one extra option you have when 
keyframing the track grade.

If you find yourself wanting to adjust a track grade individually to take into account variations 
from one clip to the next, you can use the Add EDL Marks on Tracks command to add a Static 
keyframe (mark) to the Keyframe Editor at the position of every edit point in the entire Timeline.

To add EDL Marks:

1	 Choose Track from the Node Editor’s mode pop-up menu.

2	 If you want to keyframe a grade, then create whatever grade you need to apply to 
the entire Timeline. If you want to keyframe Sizing settings, you don’t need to do 
anything else.

3	 Right-click the Corrector track or the Sizing track in the Keyframe Editor, and choose 
Add EDL Marks on Tracks.

Marks appear at the frame of every edit point in the Timeline. You may want to widen 
the Keyframe Editor to make it easier to work with all these keyframes.

After you’ve added EDL marks, you can delete them if you decide you don’t want 
them any more.

To delete EDL marks:

Right-click the Corrector track in the Keyframe Editor, and choose Delete EDL Marks 
on Tracks.

If you’ve added your own keyframes in addition to the EDL marks, then the Delete EDL Marks 
on Tracks command only eliminates the EDL marks. Your custom marks are left alone.
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Chapter 54

Copying and 
Importing Grades 
Using ColorTrace 
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Copying and Importing 
Grades Using ColorTrace
ColorTrace is a key feature of DaVinci Resolve, which lets you copy grades quickly and easily 
from the clips of one timeline to those within another, based on the source timecode of each 
clip (or using clip names when in Automatic mode). You can even use ColorTrace to copy grades 
between timelines within the same project, and ColorTrace one stereo timeline to another.

This chapter covers the following topics:

Copying Grades Using ColorTrace	 964

Using ColorTrace in Automatic Mode	 965

Using ColorTrace in Manual Mode	 968

Importing CDL Data Using ColorTrace	 970

Using CDL Adjustments	 972

Calculating CDL Functions	 972
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Copying Grades Using ColorTrace
Users familiar with previous versions of DaVinci Resolve will be happy to know that as of 
DaVinci Resolve version 11, ColorTrace copies whichever version of a clip’s grade was applied in 
the Source timeline you’re copying from, either local or remote, depending on which grades 
each clip in the Source timeline is set to use. Furthermore, in DaVinci Resolve version 11.1, 
ColorTrace gained support for copying Group Pre-Clip and Group Post-Clip grades. These 
improvements make this an extremely reliable tool for copying grades from one timeline to 
another in a wide variety of situations.

To use ColorTrace:

1	 Open the Edit page and select the Timeline you want to use ColorTrace with from 
the Media Pool, then open it and choose Timelines > ColorTrace > ColorTrace 
From Timeline.

 

Choosing ColorTrace for a selected Timeline

The ColorTrace Setup window appears, which shows every database, user, project, and 
timeline within a single hierarchical list.

2	 Using the Project List browser, select the specific Timeline you want to copy 
grades from.

You’ll need to click the disclosure triangle to the left of the database, user name, and 
project that contains that Timeline in order to select it.

ColorTrace project and Timeline selection window
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3	 (Optional) If you’re using ColorTrace with a project that has numerous VFX clips in a 
workflow where all VFX clips have specific reel names that identify them, you can enter 
these names (with asterisks (*) used as wildcards that indicate text in each Reel Name 
that can vary) in the “Effects Shot Definitions” field. This speeds automatic ColorTrace 
operations by enabling DaVinci Resolve to use fuzzy string matching when a clip’s reel 
number qualifies it as a VFX shot so that the best match is displayed first on the list. 
You can enter multiple VFX reel names with wildcards, one per line, for simultaneous 
string matching. You can use whatever Reel Name text makes sense for your workflow, 
some examples of VFX reel names are as follows:

*_COMP_*

VFX*

EFFECTS*

4	 Click Continue.

The ColorTrace window appears with two tabs that let you choose how to work.

5	 Choose which mode to work in by clicking the Automatic or Manual tab:

�� In Automatic mode, ColorTrace automatically searches for matching clips between 
the selected Timeline and the current Timeline. Each clip is color coded depending 
on the correspondence that’s been identified.

�� In Manual mode, you copy grades yourself, using the Copy and Paste procedures, or 
by dragging and dropping using your mouse.

The ColorTrace window is complex; details about the operation of each mode are 
covered separately in the following sections.

6	 When you’re finished using ColorTrace, click Close.

Using ColorTrace in Automatic Mode
In Automatic mode, ColorTrace automatically finds the correspondences between clips in the 
selected Timeline that you want to copy grades from (the Source timeline), and those in the 
current Timeline that you want to copy grades to (the Target timeline).

Selecting the Automatic or Manual ColorTrace 

Each clip in the Target Timeline Thumbnail timeline is outlined with a color that indicates 
its status.

�� Red: No match was found at all. Generally true for clips in the current Timeline that 
weren’t used in the Timeline you’re ColorTrace matching to.

�� Blue: Due to overlapping timecode and reel names, multiple correspondences have 
been found (similar to a reel conflict), and you must select the correct one for each 
clip. This often happens with VFX and motion graphics clips that you’ve imported with 
timecode starting at 00:00:00:00.

�� Green: A match has been found. 
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ColorTrace Thumbnail outlines indicate matching, overlapping and non matching clips

In Automatic mode the correspondence between each clip in the Source timeline and 
each clip in the Target timeline should be automatically made. However, overlapping 
timecode and reel names can cause problems. The other controls in the ColorTrace 
window help you deal with the subset of clips that can’t be automatically matched, or 
are matched in error. These controls are:

The ColorTrace window shown in Automatic mode

�� Matching Source Clips list: Shows a scrollable collection of thumbnails that might 
correspond to the selected clip in the Target timeline.

�� Target Timeline: Shows each clip in the Timeline you want to copy grades to, color 
coded according to how good a match it is.

�� Clip Info pane: Displays two columns of properties for the source clip and the target 
clips that you’ve selected. These properties include the reel, source timecode, 
record timecode, clip name, project names, and timeline names of each clip, for easy 
comparison.

�� Attributes and options checkboxes: A series of checkboxes lets you specify which clip 
attributes are copied as part of the ColorTrace operation.

Color: Enables the copying of grades.

Preserve Num Nodes: When copying grades, lets you prevent the first X nodes of the 
target clip grades from being overwritten by the first X nodes of the source clip grades.

Sizing: Enables the copying of Edit sizing attributes.

Input Sizing: Enables the copying of Input Sizing attributes.

Convergence: Enables the copying of Convergence for Stereo 3D projects.

Floating Windows: Enables the copying of Floating Windows for Stereo 3D projects.

Auto Align: Enables the copying of Auto Align settings for Stereo 3D projects.

All Versions: Copies all versions, rather then just the current version, from the source to 
the target clips. The currently selected version of each source clip is always 
correctly copied.

Version Camera Raw Settings: Enables the copying of versioned Raw settings, rather 
than just the current Raw setting.
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Track Marks: Enables the copying of keyframes.

Flags and Markers: Enables copying of all flags and markers.

Hide Matching Clips: Hides all clips which have been successfully matched, and only 
show the clips with multiple or no matches. This lets you focus on the subset of problem 
clips within a potentially long timeline.

Ignore Reel Names: If you believe the reel names are in error, you can turn this 
checkbox on to ignore them, matching all source and target clips by timecode alone.

�� Copy Grades: Copies the matched source grades to each green and purple target clip.

�� Copy Grades & Exit: Once you’ve finished making all the grade matches you can, click 
this button to copy the matched source grades to each green and purple target clip, 
and close the ColorTrace window.

Here’s how to use these controls to sort out which source clips to copy from for each blue and 
red target clip in the Target timeline.

To manually choose which source grades should be copied to which target clips:

1	 Click any blue clip thumbnail in the Target timeline.
 

Revealing a number of different possible correspondences in the Matching Source Clips timeline

A collection of clips with overlapping timecode and reel names appears. If you want to 
ignore the reel names because you believe they might be in error, turn on the Ignore 
Reel Names checkbox.

2	 If a comparison of the Source and Target thumbnails doesn’t make the choice obvious, 
then click any of the clips in the Matching Source Clips timeline to view its metadata for 
comparison in the source/target columns below.

Source and Target clip metadata for comparison
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3	 Once you’ve decided on a clip correspondence, double-click the Matching Source Clip 
thumbnail you want to copy from. If no clip in the Matching Source Clip pane is a good 
match, double-click the “Set As New Shot” box.

The Source and Target thumbnails both turn purple, to show that you’ve created a 
correspondence.

The matching Source and Target clips now both marked with purple outline

Continue working your way through every thumbnail with Blue and Red Xs until you’ve 
found matches for every clip in the Timeline for which it’s possible.

4	 When you’re finished, click Copy Grades & Exit.

Using ColorTrace in Manual Mode
Manual mode is ideal for situations where you want to copy grades between programs with 
clips that have no timecode or reel name correspondence at all. The Manual ColorTrace 
interface is designed to let you move through two different timelines, either a clip at a time, or in 
matching multiples of clips, copying grades from the Source timeline to the Target timeline.

For example, if you’re trying to copy grades from a timeline that was conformed from individual 
media files, to another timeline that was conformed from a flattened master media file, you can 
use the ColorTrace Manual mode to accomplish this.

The manual interface consists of two sets of controls that correspond to the Source timeline 
(labeled “Timeline to copy from”), and the Target timeline (labeled “Timeline to paste to”). The 
general idea is that you move through both sets of timelines one clip at a time, or in matching 
multiples of clips at a time, and copy grades from the “Copy from” timeline to the “Paste 
to” timeline.

ColorTrace Manual window
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Manual mode has the following controls:

�� Source timeline: Shows all clips in the Source timeline you selected; the clips you’re 
copying grades from. Click any one clip thumbnail to select it, or click a thumbnail, 
and then shift-click another thumbnail to select a contiguous range of clips. You 
cannot select a noncontiguous range of clips.

�� Copy Range controls: Two fields show the range of clips in the current selection 
that you’ll be copying from, referred to by their numeric position in the Source 
timeline. You can change the range numerically by either entering new numbers in 
the fields, or by using the up/down arrow buttons to alter the value by one. The First 
button automatically adds all clips from the first one in the Timeline into the current 
selection. The Last button automatically adds every clip going to the last one in the 
Timeline to the current selection.

�� Target timeline: Shows all clips in the Target timeline you selected; the clips you’re 
pasting grades to. Selecting clips works identically as with the Source timeline.

�� Paste Range controls: Two fields show the range of clips in the current selection that 
you’ll be pasting to, referred to by their numeric position in the Source timeline. All 
controls work identically to the Copy Range controls.

�� Attributes and options checkboxes: Turn off the checkboxes of any clip 
characteristics that you don’t want to copy as part of the ColorTrace operation. A 
more complete description of these options appears in the section on the Automatic 
ColorTrace mode.

�� Paste button: Once you’ve selected one or more source clips and a matching 
number of target clips, clicking Paste copies the grades, PTZR settings, and marks 
(depending on the corresponding checkboxes).

�� Undo Last: Lets you undo the most recent paste action.

�� Undo All: Lets you undo all paste actions in Manual mode.

�� Done: Finishes the operation and closes the ColorTrace window.

If you’re cherry picking individual grades from one timeline to paste into shots in another, you 
can copy grades one at a time.

To copy one source grade to one target clip:

Click a thumbnail in the Source timeline (on top) to copy from, then click a thumbnail in 
the Target timeline (on the bottom), and click Paste.

You can also simultaneously copy the grades of entire scenes of clips from one timeline to 
another. For example, if you’re copying grades from an originally graded timeline to a re-edited 
version of the same program, you can copy every grade from a 10-clip scene in the Source 
timeline to the same 10 clips in the Target timeline which have been pushed back later in 
the Timeline.

To copy a group of source grades to a group of target clips:

1	 Choose a continuous range of source clips by doing one of the following:

�� Click the first clip in the range, and then Shift-click the last clip in the range.

�� Enter the clip number of the first clip in the left “Copy Range” field, and then enter the 
clip number of the last clip in the right field.

�� Click a clip, and then click First to select every clip from that one to the first clip in 
the Timeline.

�� Click a clip, and then click Last to select every clip from that one to the last clip in 
the Timeline.

2	 Choose a continuous range of Target clips by using the same procedures as in the 
previous step, but using the “Paste Range” controls.
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Group copy and paste of grades

3	 When you’ve made your selections, click Paste.

The grade settings from the source clips are pasted to the destination clips, in order. In 
other words, if you copy from clips 5 through 9 to clips 11 through 15, then grade 5 is 
copied to shot 11, grade 6 is copied to shot 12, grade 7 is copied to shot 13, etcetera.

Importing CDL Data Using ColorTrace
The ColorTrace CDL command lets you import ASC CDL file formats from other applications into 
DaVinci Resolve. DaVinci Resolve version 11.1 also added the ability to read DRX filenames from 
CDL files, allowing a CDL to load exported DaVinci Resolve grades.

There are three supported file formats:

�� CMX EDL: An EDL with comments referring to CCC/CDL XML files, or even Slope, 
Offset, and Power (SOP) data within the comment area.

�� CCC and CDL XML: A file format that contains various color correction looks, and 
even references.

To import CDL data into DaVinci Resolve:

1	 If you’re importing CCC/CDL XML correction looks:

Open the Gallery page, right-click anywhere within the Stills tab, and choose “Import” 
from the contextual menu. 

When the Import Stills dialog appears, open the CDL/CCC files. When these are 
finished importing into the Gallery, an ASC logo will appear along with them.

2	 Open the Edit page and select the Timeline you want to use ColorTrace with in the 
Timeline list.

3	 Right-click anywhere within the Timeline, and choose ColorTrace from CDL.

4	 Select an EDL using the Select EDL dialog, and click Open.

5	 Select its corresponding CDL and CCC files using the Select CDL Files dialog. If there 
are no CDL or CCC files (which is the case if there are inline SOP comments within the 
EDL), you should click cancel.

6	 Using the ColorTrace With CDL window, copy the source grades from the CMX EDL/
CCC & CDL XML files to the Target timeline.

At this point, the ColorTrace window works identically as previously described.

IMPORTANT: You must select the same number of target clips as you did 
source clips for the Paste button to become enabled.
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For formatting reference, here are some examples of CMX, CCC and CDL files.

Example CMX EDL File
TITLE: Final EDL FCM: NON-DROP FRAME 010 001 V C 01:19:28:16 
01:19:28:16 01:00:41:18 01:00:42:18 *ASC_CC_XML test_cc.102 011 001 V C 
00:00:00:00 01:19:28:16 01:00:42:18 01:00:43:18 *ASC_SOP (0.9 1.2 0.5)(0.4 
-0.5 0.6)(1.0 0.8 1.5)

Example CCC File
<ColorCorrectionCollection xmlns:”urn:ASC:CDL:v0.5” >

<InputDescription> test corrections for ref_input_image.1920

</InputDescription> <ViewingDescription>

for mathematical analysis only </ViewingDescription>

<ColorCorrection id=”test_cc.100”> <SOPNode>

<Description> for ref_output_image.0100 </Description> <Slope> 1.0 
1.0 1.0 </Slope> <Offset> 0.0 0.0 0.0 </Offset> <Power> 1.0 1.0 
1.0 </Power>

</SOPNode> </ColorCorrection>

<ColorCorrection id=”test_cc.101”> <SOPNode>

<Description> for ref_output_image.0101 </Description> <Slope> 1.0 
1.5 0.6 </Slope> <Offset> 0.0 -0.1 0.01 </Offset> <Power> 1.0 1.5 
0.5 </Power>

</SOPNode> </ColorCorrection>

</ColorCorrectionCollection>

Example CDL File
<ColorDecisionList xmlns=<94>urn:ASC:CDL:v0.5<94> >

<InputDescription> GeneralProducts M1 std thru GP M1 LUT4 </
InputDescription> <ViewingDescription> GP P1, DCI P3, Pathe color 
emul </ViewingDescription> <ColorDecision>

<MediaRef ref=<94>/some/Project/frame%250900-0954%5B.dpx<94>/> 
<ColorCorrection id=”cc03340”>

<SOPNode> <Description>change +1 red, contrast boost</Description> 
<Slope>1.2 1.3 1.4</Slope> <Offset>0.3 0.0 0.0</Offset> <Power>1.0 1.0 
1.0</Power>

</SOPNode> </ColorCorrection>

</ColorDecision> </ColorDecisionList>
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Using CDL Adjustments
Once you’ve imported a CDL (Color Decision List), then the CDL adjustment for each clip is 
made available to you via a contextual menu command in the Thumbnail timeline of the 
Color page.

Calculating CDL Functions
To turn the SOP values into a primary correction, the following math is used by DaVinci Resolve:

Output = (Input * Slope + Offset)Power

Output refers to the final grade. Input is the value of each pixel within each color channel (on a 
scale from 0-1). The detente value for Slope is 1. The detente value for Offset is 0. The detente 
value for Power is 1.
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Chapter 55

DaVinci Resolve 
Control Panels 
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DaVinci Resolve Control Panels
The DaVinci Resolve Control Panels make it easier to make more adjustments in the same 
amount of time than using a mouse, pen, or trackpad with the on-screen interface. Additionally, 
using a DaVinci Resolve Control Panel to control the Color page provides vastly superior 
ergonomic comfort to clutching a mouse or pen all day, which is important when you’re 
potentially grading a thousand shots per day.

This chapter covers details about the three DaVinci Resolve Control Panels that are available, 
and how they work with DaVinci Resolve.

About The DaVinci Resolve Control Panels	 975

DaVinci Resolve Micro Control Panel	 976

Trackballs	 976

Control Knobs	 977

Control Buttons	 978

DaVinci Resolve Mini Control Panel	 979

Palette Selection Buttons	 979

Quick Selection Buttons	 981

DaVinci Resolve Advanced Control Panel	 982

Menus, Soft Keys and Soft Knob Controls	 983

Trackball Panel	 983

T-bar Panel	 985

Transport Panel	 990

Copying Grades Using the Advanced Control Panel	 994

Copy Forward Keys	 994

Scroll	 994

Rippling Changes Using the Advanced Control Panel	 995
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About The DaVinci Resolve 
Control Panels
There are three DaVinci Resolve Control Panel options available and each are designed to 
meet modern workflow ergonomics and ease of use so colorists can quickly and accurately 
construct both simple and complex creative grades with minimal fatigue.

This chapter provides details of the each of the panel functions and should be read in 
conjunction the previous grading chapters to get the best from your panel.

The DaVinci Resolve Micro Control Panel is ideal for edit suites that need a professional grading 
panel for occasional grades or quick adjustments to shots. You will also find it on set where its 
small size, portability and low power needs are ideal for those on the move.

DaVinci Resolve Micro Control Panel

For many facilities the DaVinci Resolve Mini Control Panel is an elegant, compact yet powerful 
full featured grading panel. The direct selection palette keys, soft knobs and menus offer 
considerably more flexibility than the Micro panel and a better grading experience as a result.

DaVinci Resolve Mini Control Panel
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For the ultimate grading panel to make an impact on your clients and give you the speed for long 
and complex grading sessions the DaVinci Resolve Advanced Control Panels features dozens of 
keys and menu driven soft knobs so grading operations are just a keystroke or two away. With 
high resolution liquid crystal displays (LCD) and backlit hard keys to accommodate a darkened 
grading environment. The color and intensity of the keys and the LCD panel brightness are user 
programmable, so each colorist can set up his/her personal panel configuration.

DaVinci Resolve Advanced Control Panels

DaVinci Resolve Micro Control Panel
The Micro control panel features a row of direct control knobs at the top of the panel, three 
trackballs with rings for color grading and to the right, transport and commonly used keys to 
speed up your grading session. Above the trackballs are reset buttons and also mode selection 
buttons for Log, Offset and the Viewer selector. When selecting the Viewer mode the full 
display will switch to the Cinema Viewer which is ideal for playback and review of clips. The Log 
and Offset selections are described below.

Trackballs
The three trackballs, from left to right, are in the traditional DaVinci format of Lift, Gamma, and 
Gain when Resolve is set for Primary grading. This is the default mode for the panels but you 
can quickly toggle to Log mode using the LOG key just above the center trackball. When in Log 
grading the trackballs control the Lowlights, Mid-tones, and Highlights. 

You can also select the OFFSET button whether in PRIMARY or LOG modes. This is a toggle 
operation and when selected the left hand side ring surrounding the trackball controls the color 
temperature of the image, the center trackball ring the color tint and the right hand side 
trackball controls the image offset balance and master exposure with the ring. 

By rotating the trackball the colorist can alter the balance between the red, green and blue 
levels of the image. Using the vectorscope as a rough guide, moving the trackball towards the 
three thirty clock position adds more blue while reducing the red and green.
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The control ring surrounding these trackballs provides a master amplitude control of the 
associated trackball.

Above the three trackballs you will see three buttons for resetting the grade:

�� RGB: This key only resets the RGB balance to default detent.

�� All: Select All to reset both RGB and level.

�� Level: Select the Level key to reset the level while maintaining RGB differential.

Log, Offset, Viewer and Trackball reset buttons

Control Knobs
The top of the panel features 12 high resolution endless turn optical encoder control knobs with 
detent resets. These are spaced in groups of three for fast operation in dark suites. From left to 
right the knobs control:

�� Y Lift: This black level adjustment primarily influences the darker areas. The mid tone 
and to a lesser amount the brighter areas of an image will also change.

�� Y Gamma: Use the gamma knob for primarily midtone contrast changes with some 
influence on the darker and brighter sections.

�� Y Gain: The Y Gain control will influence the brighter parts of the image at a greater 
extent to the mid and darker portions.

�� Contrast: This one parameter lets you increase or reduce the distance between the 
darkest and lightest values of an image, raising or lowering image contrast. The effect 
is similar to using the Lift and Gain master controls to make simultaneous opposing 
adjustments.

�� Pivot: Changes the center of tonality about which dark and bright parts of the image 
are stretched or narrowed during a contrast adjustment.

�� Midtone Detail: When this parameter is raised, the contrast of regions of the image with 
high edge detail is raised to increase the perception of image sharpness, sometimes 
referred to as definition. When lowered to a negative value, regions of the image with 
low amounts of detail are softened while areas of high-detail are left alone.

�� Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, 
sometimes referred to as a vibrance operation. Can be used also to lower the 
saturation of regions of low saturation.

�� Shadow: Lets you selectively lighten or darken shadow detail. Raising this value 
retrieves shadow detail while leaving the midtones alone. 0 is unity.

�� Highlight: Makes it easy to selectively retrieve blown-out highlight detail in 
high‑dynamic range media by lowering this parameter, and achieves a smooth blend 
between the retrieved highlights and the unadjusted mid tones for a naturalistic result.

 

LOOP BYPASS DISABLE

PLAY
STILL

PREV
MEM RESET

GRAB
STILL UNDO REDO

PREV
NODE

NEXT
NODE
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FRAME

NEXT
FRAME
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NEXT
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

ALL

RGB
LEVEL

OFFSETLOG VIEWER
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�� Saturation: Increases or decreases overall image saturation. At higher values, colors 
appear more intense, while at lower values, color intensity diminishes until, at 0, 
all color is gone, leaving you with a grayscale image.

�� Hue Rotation: Rotates all hues of the image around the full perimeter of the color 
wheel. The default setting of 50 shows the original distribution of hues.

�� Luminance Mix: Lets you control the balance between YRGB contrast adjustments 
you’ve made using the Master Wheels or ganged Custom curves, and Y-only 
adjustments to contrast made using the Y channel Lift/Gamma/Gain controls of the 
Primaries palette or the unganged Luma curve. 

Additional detail can be found in the color page basics chapter and each of these operations 
can be seen on the Primary palette of the user interface.

Control Buttons
On the right hand side of the trackballs there are three groups of control buttons. 

Control Buttons

The top group includes

�� Grab Still: At any time when you are grading, selecting the Grab Still key will 
automatically grab a full resolution frame from the Timeline and attach the node graph 
metadata for later display and use.

�� Undo: Undo is one of the favorite keys of colorists. Try any grade, and if you don’t like 
it, simply Undo. There are multiple steps of undo available within the page.
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�� Redo: Sometimes you hit Undo once too many times. Redo will put back into effect the 
last item you undid. As with Undo, there are multiple levels of Redo.

�� Play Still: Using Play Still, DaVinci Resolve will automatically display a wipe on the 
Viewer between the current scene and the current still. You can use your mouse on 
the viewer to move the wipe position. Selecting Play Still a second time will toggle 
this mode off.

�� Prev Mem: Each clip, by default, has a memory of its grade, sizing, etc. which is saved in 
reference to the source timecode. If you are grading a clip and move from it to another 
clip, the grade is saved automatically in a memory for that clip. If you come back to the 
clip and make a change to the grade, then decide you don’t like the change, select 
Prev Mem to return to the previous grade status you found when selecting the clip.

�� Reset: This key resets the grades and clears the keyframes for the current node.

�� Loop: You may wish to repeat a review of a grade of a clip, or a selection of clips on the 
Timeline; this Loop toggle key selects or deselects the Loop operation.

�� Bypass: This toggle selects the node graph bypass mode.

�� Disable: This toggle enables or disables the current node.

The middle group of buttons include:

�� Prev Node: Within the Node Editor on the Color page you are likely to have a number 
of nodes. These are numbered based on the order that you added them. DaVinci 
Resolve node graphs are completely user configurable, so you can add nodes 
anywhere and in any order you like. Thus, the Previous Node key will select the node 
one lower in numerical order.

�� Next Node: Similar to the Previous Node key, this selects the node adjacent to the 
current node, in this case the next higher numerical position.

�� Prev Frame: To step the viewer one frame in reverse along the Timeline.

�� Next Frame: A single frame step forward for each key press.

�� Prev Clip: Selects the first frame of the previous clip.

�� Next Clip: Selects the first frame of the next clip.

The bottom group includes the timeline transport buttons for reverse play, stop and play.

�� Left Arrow: Select this key to play the clip/timeline in reverse.

�� Stop: You guessed it. This stops the playback.

�� Right Arrow: The forward key will play the clip/timeline forward.

DaVinci Resolve Mini Control Panel
The Mini control panel has an identical feature set and controls as the Micro panel for the lower 
trackball deck. In addition the panel has an upper sloped desk with dual high resolution LCD 
displays with four soft knobs and keys that are menu driven. There are also two banks of control 
buttons, on the left hand side for palette selection and on the right hand side for commonly 
used operations.

Please refer to the Micro Panel details above for the lower deck features.

Palette Selection Buttons
On the left hand side of the top deck you will find 15 palette selection buttons. To quickly select 
the main palette toolsets in DaVinci Resolve simply select the appropiate button and the menus 
on the LDC screens will update to the correct display.
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Palette selection buttons

�� Home: This key is used for the inital setup of the panel and also selects the top most 
menu. Additional palettes in DaVinci Resolve without their own direct access button will 
be available here in future releases. 

�� Left Arrow: A number of menus have multiple pages as indicated by the small dots in 
the centre of the LCD displays. The left arrow will move the menu display left.

�� Right Arrow: The right arrow moves the menu display right.

�� Raw: This palette contains groups of parameters that correspond to every camera raw 
media format that’s supported by DaVinci Resolve.

�� Primary: The first grade for every clip will be likely be a primary. This is where you 
balance the clip and correct for offsets in the black and white balance. Selecting 
Primary switches DaVinci Resolve from other grading modes and automatically selects 
the Primary menus for the LCD displays.

�� Vectors: When you select and isolate a particular color, and change that color, you are 
making a secondary correction. The Vectors key updates the menus to provide all the 
Secondary controls, including the hue selection and control.

�� Sizing: The input and output image resizing engines are controlled using the menus 
selected by Sizing.

�� Windows: The Windows key opens the menus for Circular, Linear, Polygon, 
PowerCurve and Gradient windows that can be used as a matte or mask for primary 
and secondary grades.

�� Motion: The Motion Effects palette (only available in the Studio version) contains two 
sets of controls for applying optical-flow-calculated effects to clips in your program. 
These include enhanced Spatial and Temporal noise reduction, and motion-estimated 
artificial motion blur.

�� Curves: The Curves palette has six modes that provide different curve-based methods 
of manipulating the color and contrast of an image. Each curve lets you adjust a 
customizable region of the image based either on image tonality (zones of lightness or 
darkness), hue (specific colors), or saturation (intensity of color).

�� Qualifier: When you select and isolate a particular color, and change that color, you are 
making a secondary correction. The qualifier key updates the menus to provide all the 
Secondary controls, including the 3D, HSL, RGB, or Luma key, with which to isolate the 
correction you need.

�� Window: Power Windows are another way of making secondary correction, being 
essentially shapes you can use to isolate regions of the image. Different controls let 
you use oval, rectangular, polygonal, or custom curved shapes. Because you can 
isolate regions of the image by drawing, Power Windows produce exceptionally clean 
results, with edges that can be precisely positioned and feathered to achieve a variety 
of effects.
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�� Tracker: The Tracker palette has three modes, available from the Palette menu. In 
Window mode, the tracking controls let you match the motion of a window to that of 
a moving feature in the frame. In Stabilizer mode, the same underlying technology is 
used to smooth or stabilize the motion within the entire frame, while in FX mode a point 
tracker can be used to animate ResolveFX or OFX plugins with positioning controls

�� Blur: With the Blur palette controls you can apply an exceptionally high-quality 
Gaussian blur, or another equally high-quality sharpening operation to your image.

�� Keyer: Each color correction node’s key input and key output makes it possible to route 
key channel data from one node to another so you can apply isolated corrections. 
These key levels are controlled in the Keyer palette.

�� Sizing: DaVinci Resolve has a powerful tool set for making geometric transforms, 
using advanced algorithms for optical-quality sizing operations and they are found in 
this palette.

�� Fx: Control of the Resolve FX plug-ins from this palette will be available here in 
future releases.

�� User: User configured menus will be available here in future releases.

Quick Selection Buttons
On the right hand side of the top deck you will find 15 quick selection buttons. These are for 
very commonly used selections that a colorist might use many time for each clip.

Quick selection buttons

�� Serial: The most common node to use on the node graph is a Serial node. A Serial 
node is a full-featured color correction processor offering primaries, secondaries, 
windows, tracking, image stabilization, sharpening and blur, matte blur, etc. Serial 
nodes are added one after the other in a cascade mode, similar to adding one layer of 
correction on top of the last. All grades in a preceding node(s) will impact the source 
image and therefore the grades in following nodes.

�� Parallel: Unlike adding a Serial node, adding a Parallel node first actually adds two 
nodes. One behaves like a Serial node with full color correction capabilities. The 
second is a Parallel Mixer node. This mixer accepts the image from the original Serial 
node and from the new Serial node and the output is a mix of these two. If the current 
node is one of the Serial nodes immediately preceding the Parallel Mixer node and 
you select Add Parallel again, another input to the mixer will be created as will another 
preceding Serial node. In each case, the input to these Serial nodes will be common, 
effectively making them in parallel to each other. The key advantage is that the source 
image is available to many nodes, whereas in a straight Serial node graph, each time 
you restrict a color in a node the following nodes have little ability or limited range to 
use that color.
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�� Layer: The Layer node is similar to the Parallel node in that it accepts the image inputs 
from more than one node. The key difference to a Parallel node is that the mixing of 
the inputs in a Layer node is prioritized towards the latest additions to the input list. 
For example, select Add Layer and DaVinci Resolve will add a node in parallel to the 
current node and link the output of the current and the newly made Parallel node to 
the two inputs of the Layer Mixer node. The previous current node will have the lowest 
priority in the mix, and the newly made Parallel node the highest priority. Add one more 
Layer node, a third input node will be created with a higher mix priority than the first 
two nodes.

�� Node + Linear: Adds a Serial node after the current node on the node graph and 
simultaneously add a Linear Power Window, thus reducing the number of keystrokes.

�� Node + Circle: Adds a node after the current node on the node graph and 
simultaneously adds a Circular Power Window.

�� Append: Often when navigating around the Node editor and making correction trims, 
the colorist decides he/she needs an additional node for more correction. Using the 
Append Node key will always add a Serial node to the very end of the node graph, 
regardless of which node in the graph is the current node.

�� Copy: Used to copy a selected nodes grade to another node.

�� Paste: Use this key to complete the copy/paste of node grade.

�� Full Viewer: The Full Viewer display shows an enlarged viewer and this includes 
transport controls at the bottom, timecodes and the selections for reference still 
modes, spilt screens, highlight modes.

�� Prev Still: If you have a still selected the Previous Still key will select the one preceding.

�� Next Still: The next still is selected if this key is used.

�� Highlight: When in the Qualifier menus making secondary qualifiers, it’s common to 
select the Highlight key to show a high contrast separation of the qualified color and all 
other parts of the image. Toggle this key to turn off.

�� Prev KF: This key steps backward one keyframe on the Clip/Track Timeline display.

�� Next KF: For keyframe steps forward on the Clip/Track Timeline display.

�� Ref: This toggle key will change the reference wipe mode between Gallery, Timeline 
and Offline sources.

DaVinci Resolve Advanced Control Panel
There are three panels in the Advanced Control Panel set. The center Trackball panel is where 
the majority of controls and feedback for the colorist are found and it includes a slide-
out keyboard.

On either side of the Trackball panel are two interchangeable panels, the position of which is 
determined by operator preference. The T-bar panel, shown above on the left, has a T-bar Mix/ 
Wipe control and a number of menu and function keys. The Transport panel, shown above on 
the right, has the Timeline Transport controls and a Jog/Shuttle control as well as a numerical 
keypad and associated function keys.

All panels have soft keys and variable control knobs within the LCD panel, which provide an 
accurate visual reference to the control without the risk of parallax errors.

A key feature of the panel design is real-time feedback, provided to the colorist via the full color 
LCD panels where you can see, at a glance, the relative settings of the controls and a highlight 
of the last control touched. For example, if a control is out of its default reset, the panels show 
this with a selectable color highlight.
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Menus, Soft Keys and Soft Knob Controls
The soft menu structure is designed to offer simultaneous control over multiple functions and a 
fast, logical and efficient way to move between the menus. These soft menus, the soft keys, 
and the operation of these in conjunction with the variable knobs are covered in the preceding 
chapters of this manual as their state changes depending on the operation being performed.

You will find the LCD on each of the panels has a two-line title description of the menu’s main 
function and there are two lines of text above each pot or switch describing the control. The 
T-bar and Transport panels also have a “more” key to the bottom right of the LCD which will 
select a second layer of menus.

The T-bar and Transport panels have quite independent controls compared to the Trackball 
panel. For example, the T-bar panel’s default menu is for Windows adjustment while the default 
menu for the Transport panel is Sizing. This allows users to control windows or sizing at any 
time, regardless of the Trackball panel mode and eliminates the need to change the work 
surface to adjust window position or input sizing.

While the menus change with the UI, the hard keys, trackballs, T-bar and shuttle control remain 
relatively constant, so the majority of this chapter describes groups and individual key functions. 
At the end of this chapter are details on copying forward, scrolling and rippling changes using 
the Advanced Control Panel.

Shift Key Convention
Before describing the hard key operation, it is important to understand two keys on the left and 
right panels. These shift keys, Shift Up and Shift Down, provide access to potentially two more 
functions on each of the next key selected.

For example, on the T-bar panel, next to the Shift Up key is the Base Mem key. The term ‘Base 
Mem’ is a legacy DaVinci colorist description to revert to the default memory, so there is no 
grade or sizing on that node. (There is an exception discussed later in this chapter.)

If you select Shift Up and then ‘Base Mem’, the “All” operation is to “Base Mem All” or reset the 
current color correction of every node in the node graph for the current clip, leaving the nodes 
in place. To “Reset” the selected node graph or “Reset Grades and Nodes,” first select Shift 
Down, then Base Mem.

To permit a fast and single-handed operation, this function does not require you to hold the 
Shift Up or Shift Down key while selecting the second key; just select them sequentially, first 
the Shift key, then the function.

Trackball Panel
The center panel has the traditional four trackballs, each with a surrounding control ring and no 
end stop in either direction. Three variable knob controls are on each side of the panel, three 
keys above the trackballs, three below the leftmost and rightmost trackballs. On the LCD panel, 
three LCD displays, each with eight knob controls and four keys. The LCD screens are menu 
driven and thus the knobs, soft keys and the display itself depends on the application’s current 
operation. The center panel also offers a slide-out keyboard for naming files, stills and nodes, 
as well as for a number of other operations.
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The Trackball panel includes a slide-out keyboard

The three trackballs, from left to right, are in the traditional DaVinci format of Lift, Gamma, and 
Gain when DaVinci Resolve is set for Primary grading; when in Log grading they are Lowlights, 
Mid-tones, and Highlights.

By rotating the trackballl the colorist can alter the balance between the red, green and blue 
levels of the image. Using the vectorscope as a rough guide, moving the trackball towards the 
three thirty clock position adds more blue while reducing the red and green.

The control ring surrounding these trackballs provides a master amplitude control of the 
associated trackball.

Above the three leftmost trackballs you will see three buttons for resetting the grade:

�� RGB: This key only resets the RGB balance to default detent.

�� All: Select All to reset both RGB and level.

�� Level: Select the Level key to reset the level while maintaining RGB differential.

The rightmost (fourth) trackball has a number of modes. It operates similar to a mouse for 
moving the on-screen cursors, Color curve control point position, Power Windows position and 
can also act as a primary grade Offset control.

Under the leftmost and rightmost trackballs there are three unmarked buttons.

On the left hand side of the panel, the right most of the three unlabelled buttons below the 
trackball toggles the right hand side (fourth) trackball in and out of offset adjust mode.

The keys under the right-hand side trackball provide left, center, and right mouse buttons.

Above the rightmost trackball, the three keys have two modes.

When used in conjunction with the shift down button, the three buttons above the trackball 
function as resets, as per the buttons above the other trackballs.

�� Shift Down Adjust Window: Only resets the RGB balance to default detent.

�� Shift Down Modes: To reset both RGB and level.

�� Shift Down Cursor: To reset the level while maintaining RGB differential.

In their normal operation they select:

�� Adjust Window: Selection turns on the Viewer Shape cursors for the current node and 
allows the trackball to position the current window.

�� Modes: This key allows access to a number of menus and acts as an on/off toggle.
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�� Display (Shift Up Cursor): This shift function changes the cursor views on the main 
monitor. The user can select the cursor display, including: Windows, Off, On the UI but 
not the main SDI monitor, or displayed on both.

�� Cursor: The Cursor is used for the color picker when in Curves and Vector/Secondary 
modes. This key also controls the Window display.

On the left side of the panel are three luminance knobs. From top to bottom they are Luminance 
Gain, Gamma and Lift.

On the right side there are three more controls, from top to bottom: Saturation, Hue (has the 
effect of hue rotation), and Luminance Mix.

T-bar Panel
The T-bar panel, typically located on the left for a right-handed colorist, has an LCD display with 
four variable controls and nine soft keys. The lower section of the panel houses the T-bar and 
six groups of hard keys. Each group and their keys are described below.

Mode Control Group
The Mode Control group provides navigation to a number of the GUI pages and a few 
commonly used functions.

�� Config: This key opens the Project Setting window where you will set up DaVinci 
Resolve for each project. Select again to close the window without saving.

�� Browse: Select Browse to call the Media page where you can review files on attached 
storage and review the Media Pool.

�� VSR (Shift Down Browse): This selection is reserved for future use.

�� Conform: Selects the Lightbox display on the Color page.

�� Shift Up Conform: Toggles the display of the Lightbox on the SDI output.

�� Deck (Shift Up Revival): The Deck key selects the Capture mode for importing a batch 
list from an EDL.

�� Revival: This key opens the Revival Dirt and Dust-busting window.

�� Scene (Shift Down Revival): To select the Scene Cut Detection window, select the Shift 
Down key followed by the Revival key.

�� Current ~ Viewer: This key toggles between the color page and the Enhanced 
Viewer page.

�� Object Track Mode: This key selects the Tracking menus.

�� Clip/Track/Unmix: This is a toggle key between the Clip/Timeline modes of the node 
graph and the Unmix mode.

�� User (Shift Up Cache Mode): This will mark a clip for render cache of the clip output.

�� Cache: This key is a toggle function to turn the render cache on or off.

�� Editor: Selects the Edit page where you can edit the Timeline, import AAF, EDL or 
XMLs and apply speed changes, Composite and Dissolve/Wipe effects, etc.

�� Proxy On/Off: This key toggles the proxy mode on and off.

�� Auto Color: This is a popular key. Using this key, DaVinci Resolve will automatically 
make a basic primary color correction to balance the blacks and whites of your image.

�� Page Up (Shift Up Gallery): In larger projects you may have a number of gallery albums 
holding stills. This key will change the Gallery page to the next higher album on the list.

�� Gallery: Used to select the Gallery UI page where you can manage, import and export 
your stills.
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�� Page Down (Shift Down Gallery): The inverse of the Shift Up Gallery function, this 
selects the Gallery album one lower than the current.

�� A/C Mode: This toggle key will display the clips in the Timeline in the order of the EDL 
(the record order, often referred to as C Mode), or the ascending order of the source 
clip timecode, called A Mode.

�� Handles Mode: This selection exposes the handles of the selected clip to allow 
tracking and grading outside the I/O selections of the current edit.

Timeline Management Group
When grading clips, colorists often try different looks. This group of keys offers a quick way to 
navigate through these versions and to split and join clips on the Timeline.

�� Split (Shift Up Undo): This key will split the clip at the position of the cursor on 
the Timeline.

�� Undo: Undo is one of the favorite keys of colorists. Try any grade, and if you don’t like 
it, simply Undo. There are multiple steps of undo available within the page.

�� Join (Shift Up Redo): The reverse of split. Place the Timeline cursor at the junction of 
two clips that have sequential timecode and select Join to make just one clip.

�� Redo: Sometimes you hit Undo once too many times. Redo will put back into effect the 
last item you undid. As with Undo, there are multiple levels of Redo.

�� Restore Point: This selection is reserved for future use.

�� Save:  Remember this key; it’s your friend. Save often, and also consider the autosave 
options found in the User Preferences.

�� Add Version: When you make a grade on any clip, DaVinci Resolve stores the 
parameters for that clip. If you want to try different grades, don’t lose your good grades, 
just use the Add Version feature. This key will make a second, third, or more version of 
the grade for that clip.

�� Default Version: If you have multiple versions of grades for a clip, this key is used to 
select the Default version, regardless of which version is currently displayed.

�� Previous Version: This will select the grade one version lower in order. For example, 
if you are on version three, select Previous Version to get to version two. Once 
the Default version is reached, selecting Previous Version again will select the 
highest version.

�� Next Version: Use this key to select the next higher version of the grade. Once 
the top version is reached, selecting Next Version again will select the Default 
Keyframing Group.

Keyframing Group
On the bottom right of the Color page is the Keyframe timeline for the current clip. The 
Keyframing group of keys is used in association with the Keyframe timeline and controls the 
selection of marks for the start and end of dynamic transitions of the grade.

�� Start Dynamic: Use Start Dynamic to select the first keyframe in a transition. The 
transition may be a grade change, resizing, the addition of a matte, or any number 
of 100 variables, all of which are associated with the node graph and the Clip or 
Track timeline.

�� Ripple Value: If you have a grade or effect, or just an adjustment, and you would 
like to ripple this effect over another effect or over a large number of other clips, use 
Ripple Value.

�� Delete: This key deletes the selected keyframe.

�� Lift Mark: If you place a keyframe in the wrong spot, put your cursor on the keyframe 
and use Lift Mark to remove it.
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�� Trim: This key is used with the numerical keypad to trim a keyframe’s position.

�� Mark: Like the Start Dynamic key, Mark is a major key. It places a Static keyframe on the 
Keyframe timeline.

�� Scene (Shift Down Mark): This selection opens the Scene Cut Detector.

Memory Access Group
DaVinci Resolve has a number of hot keys, called Mems, where you can store a grade for quick 
reference. In fact, every time you make a grade for a clip, a memory of the grade is kept. While 
you could save a still for each clip, having thousands of stills to scroll through would take time, 
so there are 26 quick and easy memory locations to store a grade, called A-Z Mems.

Every clip has its own metadata for the grade that is stored by DaVinci Resolve as a memory. 
There are a number of keys available to select or revert to these stored metadata memories, or 
to clear the metadata to revert to a base grade or no grade state.

�� All (Shift Up Base Mem): This is used to reset the current color correction of every 
node in the node graph for the current clip, leaving the nodes in place.

�� Base Mem: Used to reset the grade of the current node.

�� Reset (Shift Down Base Mem): Used to reset the grades of the current clip.

Please note that there is an exception to the rule to clear the Base Mem. It is possible, 
in fact very helpful sometimes, to have a clip preset that is not cleared when you select 
Base Mem. For example, when a film is over scanned and the frame edges are shown 
as well as the image. Instead of making an input resize adjustment for every clip to 
remove the framing, a preset resize can be made and stored, with a label, and this 
preset is not deleted when using Base Mem.

�� Preview Mem: To preview one of the Memory grades on any clip, select the clip on the 
Timeline, select Preview Mem and then the Memory letter. This key is a toggle so if you 
do not like the grade on the memory for that clip, select Preview Mem again and the 
grade will revert to the original.

�� Original Mem: Each clip by default has a memory of its grade and sizing, etc. If you 
are grading a clip and move from it to another clip, the grade for the first clip is saved 
automatically in a memory for that clip. If you come back to that clip and make a change 
to the grade, then decide you don’t like the change, select Original Mem to return to 
the grade status you found originally.

�� Scroll: When you select Scroll you can navigate up and down the Timeline to find and 
select a clip and its grade to recall to the current clip.

�� View (Shift Up Current): The Color page has two display modes. The normal mode 
includes the viewer, stills and node graph on the top of the page. Selecting View 
toggles to the alternate page with a wide Node Graph view and stills but no viewer. 
Select View again to toggle back to the normal mode.

�� Crnt: Select Current before selecting a Mem key (A, B, C to Z) and the current grade on 
the active timeline clip will be stored in the memory selected.

�� Shift Up: The Shift Up key permits the operator to select the upper secondary function 
of keys on the control panel. This operation does not require you to hold the Shift Up 
key, just select it prior to the second key.

�� Shift Down: The Shift Down key permits the operator to select the lower secondary 
function of keys on the control panel. This operation does not require you to hold the 
Shift Down key, just select it prior to the second key.

�� Macro: This key displays the Split Screen controls on the T-bar panel LCD display.

�� Memory Keys: The A, B, C to Z keys, selected directly or with the appropriate Shift Up 
or Shift Down preselection will recall the grade stored in this memory and will apply it 
automatically to the clip that is active on the Timeline.
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Menu Navigation and Node Control Group
DaVinci Resolve is a nodal-based color enhancement system. Grades are not stored in layers, 
but in nodes. In operation they can appear to be in layers if you select the Serial nodes, but 
greater grading flexibility is available by using the Parallel and Layer nodes.

This group also gives you quick access to the main menus to control primaries, secondaries 
(known here as Vectors), image sizing and Windows. It also offers a quick way to add and 
manage nodes.

All three panels have LCD panels which display the menus

�� Primary: The first grade for every clip will be likely be a primary. This is where you 
balance the clip and correct for offsets in the black and white balance. Selecting 
Primary switches DaVinci Resolve from other grading modes and automatically selects 
the Primary and Custom Curve menus for the LCD displays.

�� Vectors: When you select and isolate a particular color, and change that color, you are 
making a secondary correction. The Vectors key updates the menus to provide all the 
Secondary controls, including the hue selection and control.

�� Sizing: The input and output image resizing engines are controlled using the menus 
selected by Sizing.

�� Windows: The Windows key opens the menus for Circular, Linear, Polygon, 
PowerCurve and Gradient windows that can be used as a matte or mask for primary 
and secondary grades.

�� Outside Node: Selecting the Outside Node key will add another node after the current 
node and automatically link both image and key paths. If the original node has a grade 
within the matte shape the new Outside node would control the grade in the inverse 
(i.e., outside the matte).

�� Add Matte: By selecting this key the Matte node will be displayed on the node graph 
for the selected node and the default matte selected.

�� Disable Current: This key is a toggle key and it disables or enables the grade on the 
current node.

�� Delete Current: To delete the current node. Remember to use Undo if you had the 
wrong node selected.

�� Bypass (Shift Up Disable Current): This toggle selects the bypass mode.

�� Enable/Disable All (Shift Down Disable Current): This toggle enables or disables 
all nodes.

�� Node + CPW: Adding a Serial node is a one button selection, Add Serial, however to 
also add a window requires a number of extra key selections. The Node + CPW key 
adds a node after the current node on the node graph and simultaneously adds a 
Circular Power Window, thus reducing the number of keystrokes.

�� Node + LPW: As above, adds a Serial node after the current node with a Linear 
Power Window.

�� Node + PPW: A Polygon Power Window is also selected when adding a Serial node.
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�� Node + PCW: This key, like the others above, adds a Serial node after the current node, 
but also sets up the PowerCurve Window to permit the marking of freeform shape 
points and Bezier spline curves on the viewer to construct a freeform window.

�� Add Serial: The most common node to use on the node graph is a Serial node. A Serial 
node is a full-featured color correction processor offering primaries, secondaries, 
windows, tracking, image stabilization, sharpening and blur, matte blur, etc. Serial 
nodes are added one after the other in a cascade mode, similar to adding one layer of 
correction on top of the last. All grades in a preceding node(s) will impact the source 
image and therefore the grades in following nodes.

�� Shift Down Add Serial (Add Serial Before): This adds a serial node before the 
current node.

�� Add Parallel: Unlike adding a Serial node, adding a Parallel node first actually adds 
two nodes. One behaves like a Serial node with full color correction capabilities. The 
second is a Parallel Mixer node. This mixer accepts the image from the original Serial 
node and from the new Serial node and the output is a mix of these two. If the current 
node is one of the Serial nodes immediately preceding the Parallel Mixer node and 
you select Add Parallel again, another input to the mixer will be created as will another 
preceding Serial node. In each case, the input to these Serial nodes will be common, 
effectively making them in parallel to each other. The key advantage is that the source 
image is available to many nodes, whereas in a straight Serial node graph, each time 
you restrict a color in a node the following nodes have little ability or limited range to 
use that color.

�� Add Layer: The Layer node is similar to the Parallel node in that it accepts the image 
inputs from more than one node. The key difference to a Parallel node is that the mixing 
of the inputs in a Layer node is prioritized towards the latest additions to the input list. 
For example, select Add Layer and DaVinci Resolve will add a node in parallel to the 
current node and link the output of the current and the newly made Parallel node to 
the two inputs of the Layer Mixer node. The previous current node will have the lowest 
priority in the mix, and the newly made Parallel node the highest priority. Add one more 
Layer node, a third input node will be created with a higher mix priority than the first 
two nodes.

�� Append Node: Often when navigating around the Node editor and making correction 
trims, the colorist decides he/she needs an additional node for more correction. Using 
the Append Node key will always add a Serial node to the very end of the node graph, 
regardless of which node in the graph is the current node.

Reference Configuration Group
This area of the T-bar panel includes six keys and the fader T-bar. It is primarily used for control 
of stills display with and without reference wipes. The fader bar controls the mix or wipe 
position when the appropriate mode is active.

�� Key: This key adds and Alpha output on the node graph.

�� Circle: This key is not yet implemented.

�� Wipe: The Wipe key selects a wipe for reference comparison with the current image.

�� H/V: This key toggles the wipe between horizontal and vertical.

�� Box: This key is not yet implemented.

�� Mix: Select this key to mix in preference to wipe.

�� Still: The Still key permits comparison of the current clip with the selected still.

�� Memory: Use this key to compare the current clip with a memory.

�� Highlight: When in the Qualifier (Vector) menus making secondary qualifiers, it’s 
common to select the Highlight key to show a high contrast separation of the qualified 
color and all other parts of the image. Toggle this key to turn off. Highlight is used so 
often it’s also on the T-bar panel and, when in Vectors mode, on the Trackball panel.
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�� Mode (ShiftDownHighlight): Used to toggle the Highlight mode from gray to 
high contrast.

�� Timeline: Select the Timeline key when you want to compare the current to the 
Timeline image.

�� Offline: Select the Offline key when you want to compare the current to the 
Offline image.

�� Reference On/Off: This toggle key will turn the reference view on or off. When on, you 
can see the current clip in comparison to a reference.

Transport Panel
The Transport panel, typically located on the right for a right-handed colorist, has an LCD 
display with four variable controls and nine soft keys. The lower section of the panel houses the 
Jog/Shuttle knob and six groups of hard keys. Each group and their keys are described below.

Reference Configuration Group
Located at the top left-hand side of the Transport panel are the Deck and Still selection keys. 
These are all related to controlling the tape deck and to grabbing and selecting stills. There is 
also an Undo and Redo key, a Shift Up and a Save key.

�� Split (Shift Up In): DaVinci Resolve associates grading information based on source 
timecode so it’s important to have each source clip identified as a different clip from 
the others. The Split key will split one clip into two on the frame selected. Each can 
therefore have its own grade. This is a quick, accurate and easy way to split a long 
image sequence into multiple clips.

�� In: When marking an In point you can use the UI, a keyboard shortcut, or this key.

�� Join (Shift Up Out): Join is the reverse of the Split key. If you have clips with contiguous 
timecode, place the playhead on the first frame of a clip and select Join to merge the 
preceding clip.

�� Out: The Out key is used to select an Out point on the Timeline or deck.

�� Duration: To define a duration, first select the time using the numerical keypad (the 
colon separates the hours, minutes, seconds and frames), and then select Duration.

�� Gang: This key is not implemented.

�� Undo: The colorist’s friend. DaVinci Resolve has virtually unlimited Undo steps available 
within the page you are working in.

�� Redo: If you want to redo a step, use Redo. Ideal when used with Undo to compare two 
grades quickly.

�� Source (L): This key is not implemented.

�� Place (Shift Up A ( R )): This key is not implemented.

�� A ( R )): This key is not implemented.

�� F: This key is not implemented.

�� Place (Shift Up B): This key is not implemented.

�� B: This key is not implemented.

�� G: This key is not implemented.

�� Place (Shift Up C): This key is not implemented.

�� C: This key is not implemented..

�� H: This key is not implemented.

�� D: This key is not implemented.
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�� I: This key is not implemented.

�� E: This key is not implemented.

�� J: This key is not implemented.

�� Shift Up: Use the Shift Up key as a pre-selector for the keys with an upper option. 
Select the keys sequentially and do not hold the Shift Up key while selecting the 
second key.

�� Preroll: The Preroll key is used in conjunction with the numerical keypad to select a 
preroll time for tape operations.

�� Cue: Selecting Cue will force the transport to the preroll position.

�� Previous Still: If you have a still selected the Previous Still key will select the one 
preceding.

�� Next Still: The next still is selected if this key is used.

�� Play Still: Using Play Still, DaVinci Resolve will automatically display a wipe on the 
Viewer between the current scene and the current still. You can use the fader T-bar 
to move the wipe position and in the Reference Wipe menus change the reference 
image as required by moving or resizing. Selecting Play Still a second time will toggle 
this mode off.

�� Save: The most important key on the panel. Besides using the auto-save feature, you 
can and should consistently save your project with this key. It only takes a few seconds 
and can save you hours.

�� Grab Still: At any time when you are grading, selecting the Grab Still key will 
automatically grab a full resolution frame from the Timeline and attach the node graph 
metadata for later display and use.

Transport Control Keys Group
Most colorists will use the Transport Control keys every minute of every grade, so they are 
located for quick and easy access. While not technically within this key group, the Jog/Shuttle 
knob is directly above these keys.

�� Jog: Rotate the Jog control to step forward or backward a few frames at a time.

�� Shuttle: On the outside of the Jog rotary control is the Shuttle knob. This knob has 
a detent at the null position and is turned clockwise or counter clockwise to shuttle 
the Transport/ Timeline forward or reverse at the rate selected by the rotation of the 
Shuttle knob.

�� Loop: You may wish to repeat a review of a grade of a clip, or a selection of clips on the 
Timeline; this Loop toggle key selects or deselects the Loop operation.

�� Render: Once you have finished your grade, the Render key selects the Deliver page 
used for configuring the render parameters for your project and starting the render.

�� Rec: (Shift Down Render) This key is not yet implemented.

�� Previous Node: Within the Node Editor on the Color page you are likely to have a 
number of nodes. These are numbered based on the order that you added them. 
DaVinci Resolve node graphs are completely user configurable, so you can add nodes 
anywhere and in any order you like. Thus, the Previous Node key will select the node 
one lower in numerical order.

�� Next Node: Similar to the Previous Node key, this selects the node adjacent to the 
current node, in this case the next higher numerical position.

�� Highlight: When in the Qualifier palette making secondary qualifiers, it’s common to 
select the Highlight key to show a high contrast separation of the qualified color and all 
other parts of the image. Toggle this key to turn on or off. Highlight is used so often it’s 
also on the T-bar panel.



992

D
aV

in
ci

a 
R

e
so

lv
e

 C
o

nt
ro

l P
an

e
ls

 
P

ar
t 

6
 –

 5
5

�� Mode: (Shift Down Highlight) Used to toggle the Highlight mode from gray to 
high contrast.

�� Shift Down: This is the preselection key for functions indicated on the lower portion of 
the second keys legend.

�� First Frame: Selects the first frame of the current clip.

�� Last Frame: Selects the last frame of the current clip.

�� Step Reverse: To step the viewer one frame in reverse along the Timeline.

�� Step Reverse Keyframe: (Shift Down Step Reverse) This key steps backward one 
keyframe on the Clip/Track Timeline display.

�� Step Forward: A single frame step forward for each key press.

�� Step Forward Keyframe: (Shift Down Step Forward) For keyframe steps forward on the 
Clip/Track Timeline display.

�� Previous Scene: Selects the first frame of the previous scene.

�� Next Scene: Selects the first frame of the next scene.

�� Rewind: Places the Transport, or Timeline, in rewind.

�� Reverse: Select this key to play the Clip/Timeline in reverse.

�� Stop: You guessed it. This stops the current transport operation.

�� Forward: The Forward key will play the Clip/Timeline forward.

�� Fast Forward: The inverse of the Rewind key; fast forward shuttles along the Timeline/
Transport.

Memory Access Keys Group
For fast and direct access to A to Z Memories, or Mems, use this section of the Transport panel. 
This is an extremely powerful feature. With any clip selected on the Timeline, with a single key 
press, for example “A,” the grading parameters stored in memory A, including the node 
structure, sizing, etc., will be automatically applied to the current clip.

�� O (Shift Up A): Selects memory O

�� A: Selects memory A

�� I (Shift Down A): Selects Memory I

�� R (Shift Up B): Selects memory R

�� B: Selects memory B

�� J (Shift Down B): Selects Memory J And so forth.

�� All (Shift Up Base Mem): This function will return all grades for all nodes on the clip to 
the default grade/settings and will clear dynamic keyframes. 

�� Base Mem: The Base Mem key clears the current node of all its grades and keyframes. 
Again, with the preset exception noted above.

�� Reset (Shift Down Base Mem Crnt): This key deletes all nodes in the clip except for the 
first node and resets the grades to default and clears the keyframes.

�� Preview Mem: To preview one of the memory grades on any clip, select the clip on the 
Timeline, select Preview Memory and then the memory. This key is a toggle, so if you 
do not like the grade on the memory for that clip, select Preview Mem again and the 
clip’s grade will revert to the original.

NOTE: There is an exception to the rule. If a Preset Size has been set for the 
clip, the Base Mem sizing will default to this preset size.



993

D
aV

in
ci

a 
R

e
so

lv
e

 C
o

nt
ro

l P
an

e
ls

 
P

ar
t 

6
 –

 5
5

�� Original Mem: Each clip, by default, has a memory of its grade, sizing, etc. which is 
saved in reference to the source timecode. If you are grading a clip and move from 
it to another clip, the grade is saved automatically in a memory for that clip. If you 
come back to the clip and make a change to the grade, then decide you don’t like the 
change, select Original Mem to return to the previous grade status you found when 
selecting the clip.

�� Scroll: The Scroll key selects a soft menu on the Trackball panel so clips or frames can 
be scrolled via the rotary control in the soft menu.

Numerical Entry Key Group
On the center right-hand side of the Transport panel is the Numerical Entry key group. Here you 
will find numbers 0 to 9 and associated keys for entering timecode and clip numbers. You will 
notice the numbers you type are displayed in a scratchpad area at the bottom of the 
Keyframe palette.

�� Current: To store a new grade in any memory, first select the Current key and then the 
memory of your choice.

�� All Color PTZR: This key is a toggle that selects the parameters that will be copied 
when updating a grade. Generally, all aspects of the grade are copied, including the 
pan, tilt, zoom and rotation sizing transforms, but on occasion you may wish to copy 
only the grade and not the sizing parameters. In this case, use the All/Color/PTZR to 
select the mode you need. You can see the Keyframe Timeline toggle between the 
master or the node selected and the input PTZR parameters.

�� Select Node: Use this key in conjunction with the numerical keys to select any node 
on the current node graph. First, select the node number, and then Select Node. The 
current node will change to the selected node.

�� Backspace: The Backspace key moves you one item left in the numerical scratch pad 
display. This permits correction of your numerical entries.

�� 0 to 9: You guessed it. These are the numbers!

�� >, (Comma): The comma is used just before the frame count if you wish to indicate a 
drop frame timecode.

�� : (Colon): When typing in timecode, the convention is to type the hours followed by a 
colon, then the minutes, a colon, the seconds, a colon, and finally the frames. DaVinci 
Resolve does not need to have leading numbers entered where they offer no value 
and the default value is 0, so to type one hour, three minutes, zero seconds and sixteen 
frames, you do not need to type 01:03:00:16. Simply type 1:3::16 and then press Enter. 
This speeds timecode entry.

�� Clear: Will clear the scratchpad number.

�� - (Minus): Select the Minus key prior to the number to reduce the number.

�� + (Plus): Select the Plus key prior to a number to increase the number.

�� Take/Enter: Select the Take/Enter key to accept or enter any input.

Keyframing Group
The Keyframe keys are on the bottom right-hand side of the Transport panel. The functions are 
replicated on the T-bar panel. On the bottom right of the Color page is the Keyframe timeline for 
the current clip in the Timeline. The Keyframe group of keys is used in association with the 
Keyframe timeline and controls the selection of keyframes for the start and end of dynamic 
transitions of the grade.

�� Start Dynamic: This key is used to select the first point in a transition, a Dynamic 
keyframe. The transition may be a grade change, a sizing or reposition, or the addition 
of a matte or any number of 100 variables, all of which are associated with the Node 
Editor and the Clip or Track Keyframe timeline.
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�� Ripple Value: If you have a grade or effect, or just an adjustment and you would like to 
ripple this effect over another effect or a large number of other clips, use Ripple Value.

�� Delete: This key deletes the keyframe.

�� Lift Mark: If you place a keyframe in the wrong spot, put your cursor on the keyframe 
and use Lift Mark to remove it.

�� Trim: This key is used with the numerical keypad to trim a keyframe position.

�� Mark: Like the Start Dynamic key, Mark is a major key. It places a Static keyframe on the 
Clip Timeline.

�� Scene (Shift Down Mark): This selection is reserved for future use.

Copying Grades Using the 
Advanced Control Panel
There are a number of methods of copying grades that are exclusive to the Advanced 
Control Panel.

Copy Forward Keys
The simplest way of copying grades using the control panel is to use the comma and colon 
keys on the keypad of the Transport panel to copy grades from one or two clips behind the 
currently selected clip. This is a great way to copy grades in scenes with a shot-reverse-shot 
structure, where you’re cutting between two angles of coverage, each of which uses the 
same grade.

�� To copy a grade from one clip back: Press comma (,)

�� To copy a grade from two clips back: Press colon (:)

Scroll
Scroll mode lets you quickly preview the effects of many different grades applied to clips in the 
Timeline on the currently selected clip, with the option to either accept or reject the previewed 
grade to which you’ve “scrolled.” This can be useful for checking to see if any of the previous 
grades you’ve created in a scene will work for the currently selected clip.

To use Scroll mode:

1	 Move the playhead to the clip to which you potentially want to copy a new grade. You 
can use the PREV SCENE and NEXT SCENE buttons to move quickly.

2	 Do one of the following to enter Scroll mode:

�� Press SCROLL on the Transport panel.

�� Press MODES, above the fourth trackball on the Center panel, then press the 
SCROLL MODE soft key.

3	 Now, do one of the following to preview different grades from other clips:

�� Press the PREVIOUS SCENE and NEXT SCENE soft keys to move from clip to clip in 
the Timeline, previewing each grade to the current clip.

�� Turn the SCROLL SCENES knob to scroll smoothly along multiple clips in 
the Timeline.

�� Turn the SCROLL FRAMES knob to scroll along different frames of any clip, 
previewing the effects of keyframed grades at different points in time.
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�� Press the TOGGLE DECK KEYS soft key to use the transport controls on the 
Transport panel to play through the Timeline, previewing grades as you go.

�� Press a number on the keypad of the Transport panel, and then the SCENE NUMBER 
soft key, to jump to a clip and preview its grade.

�� As you scroll from clip to clip, a red outline indicates the clip with the grade 
being previewed, and an orange outline indicates the current clip to which you’re 
previewing each scrolled grade.

4	 When you’re finished, do one of the following to either accept or reject a 
scrolled grade:

�� Press EXIT AS WAS if none of the grades you scrolled through was suitable. This 
exits Scroll mode and leaves the clip as it was previously.

�� Press EXIT AS IS if you’ve found a grade that works for the current clip. This exits 
Scroll mode and copies the scrolled grade.

When you press the TOGGLE DECK KEYS soft key in Scroll mode, each of the 
Transport Control buttons on the Transport panel functions as a means of previewing 
the grades of other clips in the Timeline.

�� STEP FWD: Move to the next clip and preview its grade.

�� STEP REV: Move to the previous clip and preview its grade.

�� FWD: Plays (scrolls) forward at 1 scene per second, previewing each new grade as 
it appears.

�� REV: Play (scrolls) the clips in reverse at 1 scene per second, previewing each new 
grade as it appears.

�� FFWD: Shuttles (scrolls) forward through the Timeline at 4 scenes per second, 
previewing each new grade as it appears.

�� RWD: Shuttles (scrolls) reverse through the Timeline at 4 scenes per second, 
previewing each new grade as it appears.

Rippling Changes Using the 
Advanced Control Panel
DaVinci Resolve has a mechanism for rippling specific changes made to one clip to a range of 
other clips in the Timeline. This is only possible using the controls of the DaVinci Resolve 
Advanced Control Panel.

The general idea of the ripple function is that you select a clip, make a change, and then ripple 
that change to a range of other clips. This rippled change can be applied to the same node in 
each clip, or the change can be added as an appended node within each rippled clip.

The Ripple mode that’s used when you press the RIPPLE VALUE button can be changed in the 
Color panel of the User Preferences. There are four options.

�� Exact values changed: Changes made to the current clip are rippled to the specified 
clips using the exact parameters that were changed. For example, if Lift in the current 
clip is changed to 0.75 of its range, each clip you ripple will have a Master Gain 
setting of 0.75. Only parameters you adjust are rippled.

�� Percent value changed: Changes made to the current clip are rippled to the 
specified clips by the percentage of change you made to the altered parameters. For 
example, if the current clip has a Lift level of 1.00 and is changed to 0.90 units, then 
the Lift setting of each clip you ripple will have a relative reduction of 10% relative to 
its previous value.
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�� Unit value changed: Changes made to the current clip are rippled to the specified 
clips by the same delta of change, using whichever units make sense for the effected 
parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 
0.90, each rippled scene’s master gain level increases by 0.10.

�� All values are copied: The current clip’s grade is rippled to the specified clips in its 
entirety. No comparison is made with the original clip’s parameters, and all memory 
parameters are rippled.

The following procedure describes in detail how you can use the control panel to ripple a 
change to a range of other clips. While this procedure may appear complicated, it’s just that 
there are several options. Once you learn the sequence of commands, this process is actually 
quite fast.

To ripple a change using the Ripple Mode soft key commands:

1	 (Optional) Press MODES, then press RIPPLE MODES. Four commands appear mapped 
to the middle soft keys of the Center panel, which can be used later to execute different 
types of ripple operations.

2	 Move the playhead to the clip you want to adjust.

3	 Adjust the current clip that you want to ripple to other clips in the Timeline.

4	 Define the range of clips you want to ripple to using the number pad on the Transport 
panel. The following combinations will work:

An absolute range of clips is defined by entering two clip numbers separated by a 
comma. For example, if you want to ripple the current change to clips 10 through 15, 
you’d press “10, 15”

To specify every clip from the beginning of the Timeline, use the Minus (–) key. 
For example, to specify a range of clips from the beginning to clip 20, you’d 
press “–, 20”

To specify every clip to the end of the timeline, use the Plus (+) key. For example, to 
specify a range of clips from the clip 50 to the end, you’d press “50, +”

To specify every clip in the whole Timeline, press “–, +”

5	 (Optional) You can control whether the rippled change is applied in an appended node, 
or an existing node, in every rippled clip:

If you want to apply the rippled change as a new node that’s appended to the end of 
every rippled clip’s grade, press SHIFT DOWN.

Otherwise, the rippled change will be applied to the same node in every rippled clip 
that you made your adjustment to in the current clip. In other words, if you made a 
change to Node 2, it would be rippled to Node 2 of all the clips you specified. If one of 
the rippled clips doesn’t have the same number of nodes, you may get an error.

6	 To execute the ripple, do one of the following:

Press RIPPLE VALUE on the Transport panel to ripple a change using the currently 
selected Ripple Mode in the Color panel of the User Preferences.

Press one of the Center panel soft keys corresponding to the ripple function you want 
to perform. There are four soft keys:

�� Static Ripple: Changes made to the current clip are rippled to the specified clips 
using the exact parameters that were changed. For example, if Lift in the current clip 
is changed to 0.75 of its range, each clip you ripple will have a Master Gain setting of 
0.75. Only parameters you adjust are rippled. Identical to the “Exact values changed” 
ripple setting.
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�� Relative Ripple: Changes made to the current clip are rippled to the specified clips 
by the percentage of change you made to the altered parameters. For example, if the 
current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of 
each clip you ripple will have a relative reduction of 10% relative to its previous value. 
Identical to the “Percent value changed” ripple setting.

�� Absolute Ripple: Changes made to the current clip are rippled to the specified clips 
by the same delta of change, using whichever units make sense for the affected 
parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 
0.90, each rippled scene’s master gain level increases by 0.10. Identical to the “Unit 
value changed” ripple setting.

�� Forced Ripple: The current clip’s grade is rippled to the specified clips in its entirety, 
overwriting all previous nodes and parameters in the rippled clips.

The adjustment you made in step 4 is applied to the designated range of clips.

Admittedly, that was a long and detailed procedure, but the actual button sequences are 
straightforward once you put them together. Here are some examples of button sequences that 
ripple an adjustment you’ve just made in different ways:

�� “10, 15” then SHIFT DOWN then RIPPLE VALUE: Copies the change you’ve made to 
the current clip, and applies it as a new node that’s appended to the end of clips ten 
through fifteen.

�� MODES then RIPPLE MODES then “34, 45” then FORCED RIPPLE: Copies the 
entire grade of the current clip, using it to overwrite the grade of clips 34 through 45.

�� MODES then RIPPLE MODES then “–, +” then SHIFT DOWN then RELATIVE 
RIPPLE: Copies the change you’ve made to the current clip as a relative percentage, 
and applies it as a new node appended to the end of every single clip in the 
entire Timeline.

WARNING: Once you ripple a change in this manner, there is no going back. Since 
Undo is a per-clip operation, there is no global undo for changes made to the entire 
Timeline. Proceed with caution.


